Legal information

Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are graded according to the degree of danger.

⚠️ **DANGER**

indicates that death or severe personal injury **will** result if proper precautions are not taken.

⚠️ **WARNING**

indicates that death or severe personal injury **may** result if proper precautions are not taken.

⚠️ **CAUTION** with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken.

⚠️ **CAUTION** without a safety alert symbol, indicates that property damage can result if proper precautions are not taken.

**NOTICE**

indicates that an unintended result or situation can occur if the corresponding information is not taken into account.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property damage.

Qualified Personnel

The product/system described in this documentation may be operated only by personnel qualified for the specific task in accordance with the relevant documentation for the specific task, in particular its warning notices and safety instructions. Qualified personnel are those who, based on their training and experience, are capable of identifying risks and avoiding potential hazards when working with these products/systems.

Proper use of Siemens products

Note the following:

⚠️ **WARNING**

Siemens products may only be used for the applications described in the catalog and in the relevant technical documentation. If products and components from other manufacturers are used, these must be recommended or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance are required to ensure that the products operate safely and without any problems. The permissible ambient conditions must be adhered to. The information in the relevant documentation must be observed.

Trademarks

All names identified by © are registered trademarks of the Siemens AG. The remaining trademarks in this publication may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the information in this publication is reviewed regularly and any necessary corrections are included in subsequent editions.
# Table of contents

## 1  Overview of process control system options

1. Resources...........................................................................................................11
1.1 System Overview............................................................................................11
1.2 General Information on the Process Control System Options.........................11
1.3 Configuring in the PCS 7 environment..............................................................12
1.3.1 Configuring in the PCS 7 environment.........................................................12
1.3.2 Server configuration......................................................................................14
1.3.3 WinCC Client Configuration.........................................................................14
1.3.4 Notes on configuring in the PCS 7 environment.............................................15
1.3.5 Configuring a distributed system.................................................................16
1.3.6 Web Client....................................................................................................17
1.4 Server-Server Communication...........................................................................18
1.5 Authentication of Messages.............................................................................20
1.6 Overview of the Editors of the Process Control System Options.......................20
1.6.1 Overview of the Editors of the Process Control System Options..................20
1.6.2 Optional Editor "Picture Tree Manager"......................................................22
1.6.3 Optional Editor "Lifebeat Monitoring"........................................................22
1.6.4 Optional Editor "Horn"..................................................................................23
1.6.5 Optional "OS Project Editor"..........................................................................23
1.6.6 Optional "Component List Editor"..............................................................24
1.6.7 Optional Editor "Time Synchronization"......................................................25
1.7 How to Configure the Extended Status Display................................................25
1.8 How to Configure the Extended Analog Display..............................................31
1.9 Format Function of the Analog Display..........................................................36
1.10 Migration of Extended Status and Analog Displays Prior to WinCC V6.2.............37

## 2  OS Project Editor

2. Resources...........................................................................................................43
2.1 OS Project Editor.............................................................................................43
2.2 General information about the "OS Project Editor"..........................................43
2.3 "OS Project Editor".........................................................................................45
2.4 The "Layout" Tab.............................................................................................46
2.4.1 "Layout" tab..................................................................................................46
2.4.2 Layout configuration for the overview area..................................................49
2.4.3 How to change the configured layout.........................................................50
2.4.4 Changing the monitor configuration............................................................51
2.4.5 Adapting the overview window.................................................................51
2.5 "Message Configuration" Tab..........................................................................52
111

3.2 General Information About the Audio Alarm.......................................................... 111
3.3 Limits on Voice Output in the Horn......................................................................... 113
3.4 Linking Signal Tags to Messages............................................................................ 113
3.4.1 Linking Signal Tags to Messages....................................................................... 113
3.4.2 How to assign the message class to the signal tag............................................. 115
3.4.3 Assigning a Message Priority to a Signal Tag.................................................... 116
3.4.4 Setting Additional Filter Criteria for Messages.................................................. 118
3.4.5 Creating Signal Tags............................................................................................ 118
3.4.6 Specifying a Triggering Authorization for the Signal Tags.................................. 119
3.5 How to assign a signal transducer to a signal tag..................................................... 121
3.6 How to Configure the Acknowledgment Behavior of the Audio Alarm.................. 123
3.7 Tags for controlling runtime.................................................................................... 126
3

Resources....................................................................................................................... 111
3.1 Horn............................................................................................................................ 111
Table of contents

3.8 Minimum Horn Configuration ................................................................. 127
3.9 General Information about the sound card ........................................... 128
3.10 Creating project documentation ............................................................. 129
3.11 Application Examples for Acknowledgement Behavior ....................... 130
3.11.1 Application Examples for Acknowledgement Behavior .................. 130
3.11.2 Example 1: Automatically acting WinCC clients with signal transducer 130
3.11.3 Example 2: WinCC Clients with Multiple Acknowledgment in a Group 131
3.11.4 Example 3: WinCC Clients with Multiple Acknowledgment by Tags 132
3.12 Signal module ..................................................................................... 133
3.12.1 General Information about the Signal Module ................................. 133
3.12.2 Function Characteristics of the Signal Module ............................... 135
3.12.3 ISA Bus Signal Module ..................................................................... 136
3.12.4 Structure of the Switches and Plug-In Jumpers with the ISA Bus .... 140
3.12.5 Addressing the ISA Bus Signal Module ........................................... 141
3.12.6 PCI Bus Signal Module .................................................................... 143
3.12.7 Structure of the Switches and Jumpers with the PCI Bus ................ 145
3.12.8 Installing the Signal Module ............................................................. 147
3.12.9 Testing the Signal Module ............................................................... 149
3.12.10 Pin Assignment of the External Interface ....................................... 150

4 Time Synchronization ............................................................................. 153
4.1 Resources ............................................................................................ 153
4.2 General Information on Time Synchronization ..................................... 153
4.3 The "Time Synchronization" editor ....................................................... 156
4.4 How to configure the synchronization through the system bus/CP1613 and CP1623 159
4.5 How to Configure the Synchronization through the System bus/BCE .... 162
4.6 How to configure the synchronization over the Local Area Network .... 165
4.7 Simultaneous use of Time Synchronization over System Bus and Local Area Network 167
4.8 Hardware Support of Time Synchronization ........................................ 169
4.8.1 Hardware Support of Time Synchronization .................................... 169
4.8.2 Time signal receiver ........................................................................ 170
4.9 General Information on the Time Reception Service ......................... 172
4.9.1 General Information on the Time Reception Service ....................... 172
4.9.2 Effects of the Time Reception Service ............................................. 174

5 Lifebeat Monitoring ............................................................................... 175
5.1 Resources ............................................................................................ 175
5.2 General Information About Lifebeat Monitoring ............................... 176
5.3 Function Principle of Lifebeat Monitoring .......................................... 177
5.4 How to configuring lifebeat monitoring with an OPC connection .......... 178
5.5 Visualizing the Lifebeat Monitoring in Runtime ................................... 180
6 Picture Tree Manager .......................................................................................................................... 193
6.1 Picture Tree Manager...................................................................................................................... 193
6.2 General information about the Picture Tree Manager ..................................................................... 193
6.3 Picture Tree Manager Structure...................................................................................................... 195
6.3.1 Menu bar ........................................................................................................................................ 195
6.3.2 How to save the hierarchy ........................................................................................................... 196
6.3.3 How to print the project documentation hierarchy ....................................................................... 197
6.3.4 How to set up the project documentation hierarchy ..................................................................... 198
6.3.5 How to print the project documentation group display ................................................................. 198
6.3.6 How to set up the project documentation group display ................................................................. 199
6.3.7 How to update Picture Tree Manager .......................................................................................... 199
6.3.8 How to exit the Picture Tree Manager ......................................................................................... 200
6.3.9 How to edit a picture .................................................................................................................... 200
6.3.10 How to edit container names ...................................................................................................... 200
6.3.11 How to cut a picture ................................................................................................................... 201
6.3.12 How to copy a container ............................................................................................................ 202
6.3.13 How to insert a picture or container .......................................................................................... 203
6.3.14 How to insert a picture into a container ..................................................................................... 203
6.3.15 How to insert a container after another container .................................................................... 204
6.3.16 How to insert a container before another container .................................................................. 205
6.3.17 How to insert a container into another container ..................................................................... 205
6.3.18 How to insert a new container .................................................................................................. 206
6.3.19 How to delete a picture .............................................................................................................. 206
6.3.20 How to delete a container .......................................................................................................... 207
6.3.21 How to display the properties of a picture ................................................................................. 207
6.3.22 How to display the Picture Preview .......................................................................................... 208
6.3.23 How to arrange the picture icons alphabetically ......................................................................... 208
6.3.24 How to arrange picture icons automatically .............................................................................. 209
6.3.25 How to specify Confirm for Replace Picture ............................................................................... 209
6.3.26 Confirm for Delete Hierarchy .................................................................................................... 209
6.3.27 Recalculating the group display hierarchy completely when saving ....................................... 210
6.3.28 Delta Save.................................................................................................................................... 210
6.3.29 How to call Contents and Index ................................................................................................ 210
6.3.30 How to use the online help ........................................................................................................ 211
6.3.31 About Picture Tree Manager...................................................................................................... 211
6.3.32 Standard toolbar ......................................................................................................................... 211
6.3.33 Data window ............................................................................................................................... 212
6.3.34 How to activate the status bar .................................................................................................... 213
Table of contents

6.4 Working with the Picture Tree Manager....................................................................................214
6.4.1 Working with the Picture Tree Manager................................................................................214
6.4.2 How to Display the Picture Properties..................................................................................215
6.4.3 How to add a new container by Drag&Drop...........................................................................215
6.4.4 How to add pictures by Drag&Drop........................................................................................216
6.4.5 Handling Tags with the Picture Tree Manager.......................................................................217
6.5 General information on the hierarchy......................................................................................218
6.5.1 General information on the hierarchy...................................................................................218
6.5.2 Creating a Hierarchy..............................................................................................................220
6.5.2.1 Creating a Hierarchy........................................................................................................220
6.5.2.2 How to Create the Hierarchy by Drag&Drop....................................................................221
6.5.2.3 How to create the hierarchy with the Pop-Up Menu.........................................................222
6.5.2.4 How to create the hierarchy with the Menu bar...............................................................222
6.5.2.5 How to create the hierarchy - changing the container name..........................................223
6.5.3 Changing the Hierarchy........................................................................................................224
6.5.3.1 Changing the Hierarchy...................................................................................................224
6.5.3.2 How to change the hierarchy using drag-and-drop.........................................................225
6.5.3.3 How to change the hierarchy using the shortcut menu....................................................225
6.5.3.4 How to change the hierarchy using the menu bar............................................................226
6.5.4 Deleting in the Hierarchy......................................................................................................226
6.5.4.1 Deleting in the Hierarchy................................................................................................226
6.5.4.2 How to delete the hierarchy using the drag-and-drop function.......................................227
6.5.4.3 How to delete the hierarchy using the shortcut menu......................................................228
6.5.4.4 How to delete the hierarchy using the menu bar............................................................228
6.6 Effects on other applications..................................................................................................229
6.6.1 Effects on other applications................................................................................................229
6.6.2 Effects on the User Administrator........................................................................................230
6.6.3 Effects on the Group Display................................................................................................230
6.6.4 Effects on the Text Library..................................................................................................231
6.6.5 Effects on the Alarm Logging...............................................................................................232
7 Graphic Object Update Wizard..................................................................................................233
7.1 Graphic Object Update wizard...............................................................................................233
7.2 Functionality of the Graphic Object Update Wizard...............................................................233
7.3 Example: Creation of Object Templates..................................................................................234
7.4 Dynamic Wizard of the Graphics Designer...........................................................................236
7.4.1 Dynamic Wizard of the Graphics Designer.........................................................................236
7.4.2 Exporting customized object templates..............................................................................237
7.4.3 How to import WinCC pictures............................................................................................237
7.4.4 How to update WinCC pictures............................................................................................238
7.4.5 How to change the customized object connection...............................................................239
7.5 Structure of the configuration file...........................................................................................240
7.5.1 Structure of the configuration file........................................................................................240
7.5.2 Application of the configuration file....................................................................................242
7.5.3 How to exchange script- and instance-specific picture information....................................243
7.6 File Format of the Export/Import File.....................................................................................245
# Table of contents

## 8 Component List Editor
- Resources ........................................................................................................................................ 247
- Component List Editor ..................................................................................................................... 247
- General Information About the Component List Editor .............................................................. 247
- Functionality of the Component List .............................................................................................. 249
- How to create a new measurement point .......................................................................................... 251
- How to find a measuring point ........................................................................................................ 252
- How to edit a measuring point ......................................................................................................... 253
- How to Select a Picture via the Measurement Point ...................................................................... 254
- How to configure the "Loop in Alarm" function ............................................................................... 256

## 9 Process control runtime
- Resources ......................................................................................................................................... 259
- Process control runtime .................................................................................................................. 259
- Product Overview ............................................................................................................................ 259
- System Structure ............................................................................................................................. 260
- How to set up and load the project .................................................................................................. 261
- How to activate a project for Runtime operation ............................................................................ 265
- Overview of the button functions in runtime .................................................................................. 265
- User Interface .................................................................................................................................. 270
- System operator input ..................................................................................................................... 277
- How to log on in runtime ................................................................................................................. 278
- Basic control elements in Runtime ................................................................................................ 279
- How to exit runtime ........................................................................................................................ 280
- Acknowledging Signaling Devices and Alarms ................................................................................ 280
- How to switch languages ............................................................................................................... 281
- How to Display the Content of the Picture Stack .......................................................................... 282
- "BATCH flexible" selection ............................................................................................................ 282
- "SFC Visualization" selection ........................................................................................................ 282
- "Route Control Center" selection .................................................................................................. 282
- Displaying the System Configuration Picture (Lifebeat Monitoring) ............................................ 283
- How to select the plant section ........................................................................................................ 284
- How to save a screen composition .................................................................................................. 287
- How to recall the screen composition ............................................................................................... 288
- How to delete a Screen Composition .............................................................................................. 288
- How to display reporting jobs ......................................................................................................... 288
- How to call the User Administrator ............................................................................................... 289
9.8.18 Disabling and enabling messages.................................................................290
9.9 Message system................................................................................................291
9.9.1 Message system.............................................................................................291
9.9.2 Alarms.............................................................................................................292
9.9.3 Message Window...........................................................................................294
9.9.4 Message behavior.........................................................................................296
9.9.5 How to Display Message Lists.......................................................................297
9.10 Trend system.....................................................................................................301
9.10.1 Configuring, Saving and Loading Trend Groups........................................301
9.10.2 Configuring Online Trends (Runtime).........................................................302
9.10.3 "Online Trends" dialog box..........................................................................303
9.10.4 "New Trend Group" Dialog Box.................................................................305
9.10.5 "Properties of WinCC Online Trend Control" dialog box..........................306
9.11 Group display...................................................................................................308
9.11.1 Group display................................................................................................308
9.11.2 How to display the alarm source via the group display..............................311
9.11.3 Influencing the Acknowledgement Behavior via the @EventQuit Tag.........314
9.12 Process Controlling, Graphic Pictures...........................................................315
9.12.1 Process Controlling, Graphic Pictures.........................................................315
9.12.2 How to Select a Picture via a Measurement Point......................................318
9.12.3 How to Select a Picture via the Name...........................................................320
9.12.4 Navigation through the picture hierarchy......................................................322
9.12.5 Selecting Graphic Pictures Directly.............................................................324
9.12.6 Operator Activity in Graphic Pictures..........................................................325
10 Chip card Reader...............................................................................................327
  10.1 Resources.........................................................................................................327
  10.2 General Information About the Chip Card Reader........................................327
  10.3 How to set the interface..................................................................................331
  10.4 Chip Card in User Administrator...................................................................334
    10.4.1 "Chip Card" Option in User Administrator...............................................334
    10.4.2 "Chip Card" menu extension....................................................................335
    10.4.2.1 "Chip Card" menu extension................................................................335
    10.4.2.2 How to write to a chip card.................................................................335
    10.4.2.3 How to check a chip card.................................................................336
    10.4.3 Chip card reader in runtime.................................................................337
Index......................................................................................................................339
Overview of process control system options

1 Resources

1.1 System Overview

Content

The system overview gives a summary of configuring the process control system options and their associated editors.

This documentation shows you the following:

- how to configure in the PCS7 environment
- how to configure distributed systems
- how server-server communication works
- how the optional editors are set up

1.2 General Information on the Process Control System Options

Installation of the process control options together with WinCC

The process control options must be installed on all computers in a WinCC project with multiple computers. It is not allowed, for example, to install the process control options only on one client computer.

License check for chipcard reader

WinCC V7 no longer contains a license check for the chipcard reader. The license is no longer required.

Ability to make changes to configuration data in the course of current operations

The add-on components for process control support the downloading of changes to the configuration data in runtime ("Download Changes", synonymous with "Download OS Online Delta").

You can make changes online in a central engineering station without affecting the operation of the PLC. The user specifies the point in time for downloading the changed configuration data. You do not have to deactivate/activate or terminate/restart the project. Changes to the configuration are not immediately adopted into the control and monitoring system. For reasons of stability and consistency, configuration changes only take effect after a short waiting time.
The modifications to the configuration data are automatically applied on the redundant servers once the partner server has been successfully loaded.

The capability for "downloading changes" is lost if the configuration is changed on the engineering station and changes are also made on the PCS 7 OS.

If a configuration change is not capable of downloading changes, a notice is displayed at an appropriate time. You are informed that the capability to download changes will be lost if this configuration change proceeds.

In the "General" tab of the OS Project Editor you can decide if all settings should be transferred for a complete configuration in the OS Project Editor or if only the settings for which the changes can be downloaded should be transferred.

When configuration is complete the full runtime system and alarm system are transferred to the project over again. When the OS Project Editor is started for the first time, this is the only available setting in the project. Since the ability to load changes is lost when a configuration is complete, a notice is displayed if the project can still execute the "Download Changes" function.

---

**Note**

When migrating to a new product version, you must start the OS Project Editor on the client project. You must subsequently make customer-specific changes to the basic data in the OS Project Editor.

You can then operate the system as before. All functions are available as usual.

---

1.3 Configuring in the PCS 7 environment

1.3.1 Configuring in the PCS 7 environment

Distributed systems in the PCS 7 environment

The OS Project Editor is used to create not only the basic data in server projects or WinCC client projects but also the main picture setup in their overview, working and button areas.

With PCS 7, WinCC is included in the Engineering System (SIMATIC Manager) for operator station configuration. You create the WinCC clients on the Engineering Station (ES). You introduce tags from the ES into the OS (WinCC server) with the "Transfer AS/OS connection data" function in the SIMATIC Manager. The transfer takes place only from the ES to the OS. Packages are only created on the WinCC servers. Once created, you can download the packages onto the WinCC clients.
When configuration data is transferred to an OS, the data is not available on the WinCC client until the package has been generated again on the OS (WinCC server) and loaded onto the client.

See also

WinCC Client Configuration (Page 14)
Server configuration (Page 14)
Notes on configuring in the PCS 7 environment (Page 15)
1.3.2 Server configuration

Overview
Distribution takes place in the PCS 7 environment according to the "Plant Hierarchy". In each server project, you configure one or more areas of the hierarchy.
The basic data are created the first time you run through the OS Project Editor.
The information in the "Picture configuration" section applies for the configuration of tags.

See also
WinCC Client Configuration (Page 14)
Configuring in the PCS 7 environment (Page 12)
Notes on configuring in the PCS 7 environment (Page 15)

1.3.3 WinCC Client Configuration

Introduction
You can create a complete PCS 7 project on the Engineering Station. You download a WinCC project to the OS using the menu command "PLC > Download" in SIMATIC Manager. To obtain identical WinCC client projects, you can create a WinCC client project on the Engineering Station and download it onto the various operator stations by changing the destination path in SIMATIC Manager.
It is not possible to configure the picture hierarchy on the WinCC client. Instead the WinCC client shows in runtime an overall view of all the hierarchies in all the server projects loaded by means of packages.

Change Package Name
Packages loaded on a WinCC client are displayed in the WinCC Explorer data window under "Server data". The package name is a symbolic computer name consisting of the project name and the computer name of the server on which the package was generated. Because the symbolic computer name is generally longer than the width of the buttons in the overview area of the runtime user interface, you should give the computer a nickname that indicates their assignment to the servers.

Procedure
1. In WinCC Explorer, select "Serverdata" and open the pop-up menu.
2. Select the "Preferred Server" command from the shortcut menu. The "Configure Preferred Server" dialog box will open.
3. Click on the symbolic computer name and input a new, expressive name.

4. When you have changed the symbolic computer name and closed the “Package Properties” dialog by clicking the “OK” button, a warning dialog box is displayed. This warning dialog box advises that all configuration data that has been addressed to the old symbolic computer name is invalid. Enter the new symbolic computer name in all configuration data.

See also

WinCC Client Configuration (Page 14)
Configuring in the PCS 7 environment (Page 12)
Notes on configuring in the PCS 7 environment (Page 15)

1.3.4 Notes on configuring in the PCS 7 environment

Picture Configuration

The appearance of the runtime user interface is largely governed by the settings of the layout chosen in the OS Project Editor. Various engineering tools used in Basic Process Control also define the appearance. You do not have to assign any fields, for example, in the overview or button bar. The areas in the picture hierarchy are displayed automatically for you in runtime.

The sequence of the areas on the WinCC client takes into account the sequence of the areas within the server projects. The sequence of the servers is defined on the WinCC client by the sequence of the package import. The system ensures that the hierarchy is displayed the same on all WinCC clients.

Note

You cannot include pictures from WinCC clients in the overview pictures, as they are not contained in any picture hierarchy. They can still be opened in the working area or process window using the function “Picture via name”.

In order to take fullest advantage of the Basic Process Control functionality, you should only configure picture changes using the standard functions of Split Screen Manager.

Message Configuration

All necessary data is created by the OS Project Editor. There is no need to configure alarm controls.

To configure "Loop In Alarm you must use the "Loop In Alarm" function of the Split Screen Manager instead of the "OpenPicture" function.

You can find further information on this subject in the section called "Loop In Alarm Function".
User Authorizations

Configure user authorizations in the server project and in the WinCC client project.

The user authorization matrix can only be configured on the WinCC client after the packages of all server projects with configured picture hierarchies (Picture Tree Manager) have been loaded. The areas of a server project are only displayed in the columns of the user authorization matrix on the WinCC client when the package of the server project has been loaded onto the WinCC client project.

If reconfiguration occurs within the server project at area level in the Picture Tree Manager hierarchy, the package for the server project must be generated again. You must then load the package on the WinCC client and adjust the authorization matrix.

Behavior with a Faulty Server

The areas of all server projects are displayed in the overview of the basic data picture. If a server fails, all the areas on this server are displayed as deactivated. The order of the areas is not changed as a result of this deactivation. When the server comes back online or following a change to the redundant server, the areas are displayed as enabled once more.

Lifebeat Monitoring

Lifebeat Monitoring is configured on the servers. WinCC clients can also be monitored, in addition to the OS and the AS. Manual configuration of Lifebeat Monitoring is not necessary on the WinCC client itself. The project only needs to be updated in the editor after loading the package. All server projects whose packages are loaded on the WinCC client are displayed in the plant configuration picture of Lifebeat Monitoring. If an OS or AS being monitored by the server project fails, this failure is displayed in the plant configuration picture of the WinCC client. When you click the OS icon of the relevant server project, the picture changes to the process picture of the server project. The operator station/PLC which has failed can be viewed there.

See also

Configuring in the PCS 7 environment (Page 12)

1.3.5 Configuring a distributed system

Introduction

The main steps for configuring a distributed system in the PCS 7 environment are described below.

Procedure

1. Create a server project with the aid of the OS Project Editor.
2. Configure the picture hierarchy using the Picture Tree Manager.
3. Configure the user authorizations in the User Administrator.
4. Configure the Lifebeat Monitoring functions.
5. Generate the packages on the server.
6. Create a WinCC client project with the aid of the OS Project Editor. Select the area view required in runtime.
7. Download the packages
8. Configure the Lifebeat Monitoring functions on the WinCC client.
9. Configure the user authorizations in the User Administrator of the WinCC client.

**Note**

If you create a new project manually, you have to use the OS Project Editor to do so.

When creating an OS via the PCS 7 Engineering Station, the OS Project Editor is automatically started when the AS-OS connection data is transferred. If you want a configuration that deviates from the default setting, you must manually assign the parameters in the OS Project Editor.

1.3.6  Web Client

**General**

You can use the Web client for basic process control and PCS 7 via the WinCC WebNavigator like a WinCC client.

The following application possibilities are offered in the WebNavigator for process control options:

- Area-specific access rights with authorization levels
- User-specific assignment of a starting picture and language
- Look&Feel of the WinCC user interface with group display and extended status display
- All message views including loop in alarm
- Supports operator input messages
- Simultaneous access to several servers
- Uses standard faceplates and custom faceplates created by the project engineer with the Faceplate Designer

The WinCC WebNavigator must be installed in order to use the Web client and documentation for the WebNavigator.

**Restrictions When Using a Web Client**

When using a web client in connection with Basic Process Control, pay attention to the following restrictions:
Configuring the OS Project

- You may only use SIMATIC Standard Layouts and SIMATIC Server Views on the WebNavigator Server (OS project editor).
- No Multi VGA.

Web Client

- No "Picture selection by name".
- No "Save/Load/Delete screen composition".
- No Audio Alarm.
- No clock synchronization.
- No lifebeat monitoring.
- No Multi VGA.
- The module symbol is not highlighted in "Loop in Alarm" from the message window.
- Summary area not grayed out during connection problems.
- Navigation keys are not grayed out if operation is rendered impossible.
- Graphic pictures not directly selectable.
- No report view or printout.
- No picture information.
- No group acknowledgment of picture in work area.
- No language switch in Runtime.
- No login input using the password key.
- User authorization cannot be selected.
- Not all ODK functions are supported.
- Dat@Symphony is not supported.

Additional information may be found in the documentation and Release Notes for WinCC/WebNavigator.

1.4 Server-Server Communication

Introduction

Server-server communication offers the option in WinCC multi-user projects to access the data and functions of other multi-user projects. A PCS 7 OS that can view other PCS 7 OS by this means is described below as a superimposed PCS 7 OS or a superimposed server.

A superimposed server behaves like a WinCC client with regard to what it can view and distribute. The difference is that it also behaves like a server project. A superimposed server is configured in the same way as for conventional server projects in which additional packages can be loaded for other servers.
From the point of view of the WinCC client, all servers are still equal.

Effects on packages of process control system options
The possibility of configuring OS independent pictures and data has an effect on the individual packages of process control system options.

Picture Tree Manager
The hierarchy of a superimposed WinCC project in runtime consists of the project-specific hierarchy and the hierarchy of all projects loaded by means of packages.

Group display
In group display it is possible to connect group display objects to measuring points and pictures. From the engineering viewpoint, however, you must only connect group display objects to pictures in the same project. Group display jobs, Loop In Alarm and acknowledgments are processed by routing the superimposed WinCC server project to the servers concerned.

Lifebeat Monitoring
For the engineering or runtime functions of Lifebeat Monitoring nothing changes. If the superimposed WinCC server is used for workstations, configure Lifebeat Monitoring on that server as you would on any other WinCC server.

WinCC clients will still use Lifebeat Monitoring by importing packages from all servers.

Runtime Functions
The runtime dialog boxes for "Configure trends online", "Picture selection via measurement point" and "Picture selection by name" behave on servers with imported packages exactly as they do on WinCC clients. The restriction that only local configuration data is offered for selection on WinCC server projects is canceled.

LTO Component List
In the runtime of the superimposed WinCC server project, the LTO component list evaluates not only the data local to the project but also the imported packages. The component information for a WinCC client is located exclusively in the packages and is read from the packages for the purpose of the runtime functions.

Authorization Matrix
In the LTO specific add ins of the User Administrator, WinCC server projects can now also take package data into account in determining area information.
1.5 Authentication of Messages

Authenticating messages

Messages can be integrated into the authorization concept without assignment to the picture hierarchy or to the PCS 7 technological hierarchy. This makes it possible to check the authorization of messages without area information. This mainly affects process control messages and function-related operator input messages.

So that certain workstations can view and acknowledge process control messages that are not assigned to any area, a default area, for example, is defined on the "Message configuration" tab in the OS Project Editor. Users need authorization for this default area. This method defines which area is needed for checking the authorization of messages without area information.

The authorization of messages without area information can also be checked on an OS-independent basis in the context of server-server communication.

See also

Server-Server Communication (Page 18)
Optional "OS Project Editor" (Page 23)

1.6 Overview of the Editors of the Process Control System Options

1.6.1 Overview of the Editors of the Process Control System Options

Introduction

You can expand the performance range of the WinCC system with option packages. In order to use the individual option packs in the best way, you must install the "Basic Process Control" option package.

If you create a new project manually, you must first run the OS project editor. While creating an OS using PCS7 Engineering Station, the project is automatically called in the background and initialized using the default settings.

How to install optional editors of the process control system options

1. During the installation of WinCC, click "User-defined installation" in the "Setup Type" dialog box.
2. In the "Select Components" dialog box, select the "Options" check box. All the subcomponents available for installation are displayed as enabled on the right.
3. Clear the check boxes for the subcomponents that you do not want to install.
4. Then click "Next". The installation will continue.
Installing the editors

The following table shows you which selection boxes you use to install which editors:

<table>
<thead>
<tr>
<th>Selection Box</th>
<th>Installing the editors</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic Process Control</td>
<td>OS Project Editor, Picture Tree Manager, Time Synchronization, Horn, Lifebeat Monitoring, and the Component List Editor.</td>
</tr>
<tr>
<td>Smart card</td>
<td>Chipcard functionality for user authorization</td>
</tr>
<tr>
<td></td>
<td>Installation of WinCC with &quot;Smart card&quot; option extends the functionality of User Administrator. The &quot;Chipcard reader&quot; option adds a &quot;Chipcard&quot; item and its corresponding functions to the menu bar.</td>
</tr>
</tbody>
</table>

Optional editors in the WinCC system

If you select every option in the Setup dialog box, the following additional editors are provided for your use in the project navigation window.

<table>
<thead>
<tr>
<th>Editor</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OS Project Editor</td>
<td>The OS Project Editor is used for configuring the runtime user interface and the alarm system in accordance with PCS 7 requirements. The Project Editor provides extended options for designing user-specific basic data. With the OS Project Editor, you position the buttons in the overview area and configure the order of the areas.</td>
</tr>
<tr>
<td>Picture Tree Manager</td>
<td>The Picture Tree Manager is used to manage a hierarchy of systems, subsystems, function names, and Graphics Designer pictures.</td>
</tr>
<tr>
<td>Time Synchronization</td>
<td>You can use this feature to configure the time synchronization for plant via the Industrial Ethernet bus or the Local Area Network. The OS which is the active time-master ensures that all the other OS and AS on the system bus keep in synchronization with the current time. Slaves receive the current time via the system bus in order to synchronize their internal clock.</td>
</tr>
<tr>
<td>Horn</td>
<td>Use the Horn option to configure the assignment of required message classes to the outputs from a signal module and/or sound card. It offers you the necessary runtime functionality for selecting and acknowledging the appropriate signaling devices when messages occur.</td>
</tr>
<tr>
<td>Lifebeat Monitoring</td>
<td>Lifebeat monitoring ensures the continuous monitoring of individual OS and AS systems.</td>
</tr>
<tr>
<td>Component List Editor</td>
<td>The Component List Editor is used for the configuration of entry point pictures and the areas of measurement points.</td>
</tr>
</tbody>
</table>

See also

Optional "OS Project Editor" (Page 23)
Optional Editor "Picture Tree Manager" (Page 22)
Optional Editor "Time Synchronization" (Page 25)
Optional Editor "Lifebeat Monitoring" (Page 22)
Optional Editor "Horn" (Page 23)
Optional "Component List Editor" (Page 24)
1.6.2 Optional Editor "Picture Tree Manager"

Introduction
The Picture Tree Manager editor is used to manage a hierarchy of systems, subsystems and Graphics Designer pictures.
Your settings in the Picture Tree Manager relate to the current WinCC project.

How to open the Picture Tree Manager
1. Double-click the "Picture Tree Manager" editor in WinCC Explorer. This starts the editor.
2. Edit the hierarchy.

See also
Overview of the Editors of the Process Control System Options (Page 20)

1.6.3 Optional Editor "Lifebeat Monitoring"

Introduction
"Lifebeat Monitoring" is used for monitoring the automation and operator systems.

- The Lifebeat Monitoring function monitors the individual systems on the basis of tag connections from the WinCC data manager. You can use the "Lifebeat Monitoring" editor to define which connections are going to be monitored by Lifebeat Monitoring.
- From this, the Lifebeat Monitoring function generates the following:
  - a system configuration across all monitored connections
  - the necessary process control messages for established and relinquished connections

How to Open Lifebeat Monitoring
1. Double-click the "Lifebeat Monitoring" editor in WinCC Explorer. This starts the editor.
2. Enter all connections to be monitored.

See also
Overview of the Editors of the Process Control System Options (Page 20)
1.6.4 Optional Editor "Horn"

Introduction
The "Horn" editor is used to control optical or acoustic signaling devices or the output from audio files when messages occur.
Use the "Horn" editor to configure which signals you wish to be triggered when particular message classes/types or message priorities occur.
The horn is based on the following components:
- A component that monitors the WinCC alarm system for message-related events
- A component that is responsible for the user-configured output form

How to open the horn
Double-click the "Horn" editor in WinCC Explorer. This starts the editor.

See also
Overview of the Editors of the Process Control System Options (Page 20)

1.6.5 Optional "OS Project Editor"

Introduction
The OS Project Editor is used to configure the currently open WinCC project for use with Basic Process Control and PCS7.
The OS Project Editor offers numerous options for designing user-specific basic data and supports the generic positioning of buttons in the overview window.
When PCS 7 is used, the OS Project Editor is run automatically when the PCS 7 OS is created. The OS Project Editor therefore only has to called from the user interface if you want a configuration that deviates from the default setting

How to open the OS Project Editor.
Double-click the "OS Project Editor" in WinCC Explorer. This starts the editor. The default settings are shown the first time the OS Project Editor is started, the most recent settings are shown the next time it is started. A suitable layout for the runtime user interface is selected on the basis of the screen resolution and project type.
Structure

- In the "Layout" tab, you configure the appearance of the runtime user interface.
- In the "Message Configuration" tab, you configure settings for the alarm system. The basic settings correspond to the PCS 7 specifications for message configuration.
- In the "Message Display" tab, you can configure the runtime response of the message system and the display format of the messages in the message pages or group displays.
- In the "Areas" tab, you configure the arrangement of the plant sections in the area overview.
- In the "Runtime Window" tab, you configure the number and arrangement of the pre-configured picture windows.
- The "Basic Data" tab contains settings for copying the basic data. Here, you specify which modified picture files and actions you want to overwrite.
- The "General" tab contains settings for the OS Project Editor.

See also

Overview of the Editors of the Process Control System Options (Page 20)

1.6.6 Optional "Component List Editor"

Introduction

This editor is available only when installing a PCS7 OS.

Use the Component List Editor to configure entry point pictures and the area assignments of measurement points required for the runtime functions "Picture via measurement point" and "Loop in Alarm".

You can also create new measurement points, or define entry point pictures and areas for the components that have been created by AS-OS Engineering.

The Component List Editor provides a user interface for the following tasks:

- Creating new measuring points
- Editing existing blocks
- Searching for blocks

How to open the Component List Editor

Double-click the Component List Editor in WinCC Explorer. This starts the editor.

If you have created an OS but did not do so on an ES, you must first start the OS Project Editor in WinCC. After the OS Project Editor runs, you can edit the component list via the Component List Editor.
1.6.7 Optional Editor "Time Synchronization"

Introduction

You can use the "Time Synchronization" editor to configure time synchronization via the Industrial Ethernet bus and the terminal bus.

Depending on the configuration, an OS acting as the active time-master, for example, can ensure that the OS and AS on the system bus are synchronized to the current time. WinCC clients are synchronized via the terminal bus.

The time master sets the current time with the aid of an optional time signal receiver. If a time master fails, a standby time master takes over the time synchronization function. Time slaves receive the current time in order to set their internal clock.

"Time Synchronization" provides the following results:

- Synchronization of all operator stations and automation systems on the system bus with the current time.
- Synchronization of the WinCC clients via the terminal bus.
- Simultaneous synchronization via the system bus and over the terminal bus by taking the Windows domain concept into account.

See also

Overview of the Editors of the Process Control System Options (Page 20)

1.7 How to Configure the Extended Status Display

Introduction

Extended status display is available only when a PCS 7 OS is installed.

You can use the extended status display to define statuses on the basis of the group value and/or up to four control tags. You assign pictures to the statuses.

The group value is triggered by a tag which represents the message status. Other types of dynamizing are not possible. The group value is usually interconnected with a PCS 7 EventState.

You can use any numerical tag from the WinCC Tag Management as a status tag.

The alarm status results from the evaluation of the bits of the group value. If the group value contains multiple bits, the priority determines which status is displayed. For the bits of the group value, you assign pictures for the "Came In" (+), "Came In Acknowledged" (+Q) and "Went
Out Unacknowledged" (-) statuses. In addition, you can assign a basic picture and a flashing picture for the "OK" status.

Configuration steps

You configure the extended status display in several steps:

1. Specify how many tags you want to use. Connect these tags to the appropriate object properties "Status1" to "Status4" of the extended status display.

2. For status value generation, determine the bit assignment of the status value in accordance with a bit position of the utilized tags "Status1" to "Status4".

3. If you want to consider the alarm statuses of the group value, you determine the bits of the group value to be used. Connect the "Group value" property to a tag. In PCS 7, this is usually the "EventState" tag of a process tag.

4. Specify the priorities for the messaging characteristics in Runtime.

5. Assign basic and flashing pictures to the utilized bits of the status value or the combination of utilized bits from the status value and group value.
Procedure

1. Open the Graphics Designer, go to the Object Palette/Smart Objects and select the object "Status Display (extended)".
2. Move the object into the working area using a drag-and-drop operation. This opens the configuration dialog box for the extended status display.
3. In the "Bit selection" area, form an individual status value from a maximum of 4 interconnectable status words.
   Example A: The status value is formed solely from the "two to the power of four" bit of the tag interconnected with the "Status1" property.

4. If you want to combine the status value formation with the alarm statuses of the group value, select the "Use group value for display" check box.

5. Select the bits that you want to use for the extended status display from the group value. Use the arrow keys to move a selected bit between the two lists. The default allocation corresponds with the PCS7 standard.

6. Specify the priority order of the utilized bits for the evaluation of the group value. The entries in the "Used Bits" list show the order of the priorities. The top entry has the highest priority (priority 1). Select one entry at a time in the "Used bits" list and change the priority by clicking "Priority higher" or "Priority lower." All entries in the "Unused bits" list have the priority "0." The icons in the "Used bits" and "Unused bits" lists always reflect the PCS 7 standard, regardless of any project-specific deviation.
7. Assign the used bits in the "Assign pictures" tab. The Index is formed from the status value formation or the combination of status value and group value. You can specify the basic picture and flash picture for each combination. If a flash picture is configured, the basic picture and the flash picture will be displayed alternately in Runtime. You can use your own pictures, but these must be located in the "GraCS" directory of the project.

8. In the index list, click the status to which you want to assign pictures.

9. The file selection list shows the graphics files of the selected file type from the "GraCS" directory of the project. Double-click the desired graphic file. You assign the basic picture with the first double-click, and the flash picture with the second double-click.

10. If you want to delete a picture from a status, select the status in the table and select the appropriate menu command from the shortcut menu.

11. Click on the "OK" or "Apply" button. The settings will be applied.

12. Connect the utilized tags to the extended status display. Open the object properties.
13. Select the property "Status1" in the properties group "Other." Select the "Tag..." command from the shortcut menu of the "Dynamic" column. Select the tag from the "Select tag" window. If using multiple tags, interconnect these with the "Status2" to "Status4" properties.

14. Connect the tag for the group value in the object properties of the extended status display. Select the property "Group value" in the properties group "Other." Select the "Tag..." command from the shortcut menu of the "Dynamic" column. The tag must be a signed 32-bit variable. Select one of the tags from the process layer or from the internal tags in the "Select tag" window.

Export/import configuration

You can save and forward the configured picture assignments for the extended status display by exporting the configuration as an XML file. This is also how you import an existing configuration. You cannot import a configuration of the extended status display that you have exported prior to WinCC V6.2.

Behavior of message priorities in Runtime

When a queued event is acknowledged, it goes to the background regardless of its priority. Events with lower priority that have not yet been acknowledged are displayed prior to events of higher priority that have already been acknowledged.

Lower priority events are not displayed so long as a higher priority event is displayed as "Unacknowledged Outgoing."

Special settings in the properties dialog box

The extended status display has been modified for optimum compatibility with how the group display behaves.

If the "Group Relevant" attribute is set to "Yes" in the object properties, the status tag interconnected under "Group value" enters into the ORing UP of the group display hierarchy. If the "Group Value" attribute is not interconnected, then you must set "Group Relevant" to "No." The process alarm "Group display: tag .EventState not found" would otherwise not be triggered in Runtime.

Property "Other/Acknowledgment mask"

To ensure consistent runtime response, we recommend that you configure the acknowledgment mask for the group display and the extended status display in exactly the same way.

For the extended status display, the supplied PCS7 settings for acknowledgment sample of "17" or "3089" prior to WinCC V7.01 is possibly not suitable for your project and must be adjusted.

Property "Other/Outgoing state visible"

You use the "Outgoing state visible" property to specify whether an outgoing state is visible or not.
Note
If you change the status value formation or add or remove the group value for the display, this changes the possible statuses available on the "Assign pictures" configuration page. A notice warns you that all picture assignments configured so far will be lost. If you wish to retain the picture assignments, you must export and save the existing configuration.

See also
Migration of Extended Status and Analog Displays Prior to WinCC V6.2 (Page 37)

1.8 How to Configure the Extended Analog Display

Introduction
Extended analog display is available only when a PCS 7 OS is installed. The extended analog display enables you to display the value of a tag in runtime in various colors according to the alarm statuses of a block. The alarm status results from the evaluation of the bits of the group value. The group value is controlled by a tag. Other types of dynamizing are not possible. If the group value contains multiple bits, the priority determines which status is displayed.

Display options
The following display options are available for the bits of the group value with regard to the "Came In", "Came In Acknowledged" and "Went Out Unacknowledged" statuses:
- Background color
- Font color
- Flashing and color-flashing of the background and the text

For the "OK" and "Simulation" statuses, you can configure both a background color and a text color in the properties dialog or the configuration dialog. The flashing color is the same for both statuses. You specify whether or not both statuses are to exhibit flashing response in the "Flashing" property in the properties dialog box.

Configuration steps
You configure the extended status display in several steps:
1. Specify the bits of the group value to be used.
2. Specify the priorities for the messaging characteristics in Runtime.
3. If you do not want to accept the default settings, specify the display options of the message types for the utilized bits. Independent of the bits of the group value, you can configure the colors for the "OK" and "Simulation" statuses.
4. Connect the "Value" and "Group value" properties to one tag each.

5. If necessary, configure a simulation tag and the display options for the value of the tags.
Procedure

1. Open the Graphics Designer, go to the Object Palette/Smart Objects and select the object "Analog Display (Extended)."

2. Move the object into the working area using a drag-and-drop operation. This opens the configuration dialog box for the extended analog display.

3. Select the bits that you want to use for the extended analog display from the group value. Use the arrow keys to move a selected bit between the two lists. The default allocation corresponds with the PCS7 standard.
4. Specify the priority order of the utilized bits for the evaluation of the group value. The entries in the "Used Bits" list show the order of the priorities. The top entry has the highest priority (priority 1). Select one entry at a time in the "Used bits" list and change the priority by clicking "Priority higher" or "Priority lower." All entries in the "Unused bits" list have the priority "0." The icons in the "Used bits" and "Unused bits" lists always reflect the PCS 7 standard, even if there are user-defined settings. These settings are indicated under "Format/color."

5. To configure the display for the statuses of a bit, you select the bit from the "Used bits" list. You then select the status from the "Status" list, for whose value you want to change the pre-configured color settings.

6. Click the desired color in the color matrix. The first click changes the background color and the second click changes the text color/foreground color.

7. If the value and/or the background to be displayed for the utilized bit and the selected status is to flash, select the appropriate check box. Specify the flashing colors, as appropriate.

8. If you want to change the format of the value to be displayed, open the object properties of the extended analog display. In the "Text" properties group, double-click the "Format" property and enter the desired format. If you want to output the value as text, double-click "Value as text" in the properties group "Other", or activate the "Display value as text" check box in the configuration dialog box.

9. Configure the display options for additional bits.

10. Click "OK." The settings will be applied.

11. Connect the tags for the value that you want to display and for the group value in the object properties of the extended analog display.

12. Select the "Value" property in the "Other" properties group for this purpose. Select the "Tag..." command from the shortcut menu of the "Dynamic" column. Select the tag from the "Select tag" window.

13. Select the property "Group value" in the properties group "Other." Select the "Tag..." command from the shortcut menu of the "Dynamic" column. The tag must be a signed 32-bit variable. Select one of the tags from the process layer or from the internal tags in the "Select tag" window.

Configuring a simulation

You can configure a simulation for the purpose of replicating a specific situation using different text and background colors. The "Simulation" and "Simulation bit" properties will only be evaluated if the status is "O.K."

1. Select the "Simulation" property in the object properties of the extended analog display. Select the "Tag..." command from the shortcut menu of the "Dynamic" column. Select the tag from the "Select tag" window.

2. Double-click the "Simulation bit" property in the extended analog display "Other" properties group. In the edit box, enter the simulation tag bit that is to be evaluated.

3. In the "Colors" properties group, specify the text and background colors for the simulation.
Export/import configuration

You can forward the configured settings for the extended analog display by exporting the configuration as an XML file. This is also how you import existing configurations. You cannot import a configuration of the extended analog display that you have exported prior to WinCC V6.2.

Behavior of message priorities in Runtime

When a queued event is acknowledged, it goes to the background regardless of its priority. Events with lower priority that have not yet been acknowledged are displayed prior to events of higher priority that have already been acknowledged.

Lower priority events are not displayed so long as a higher priority event is displayed as "Unacknowledged Outgoing."

Special settings in the properties dialog box

The extended analog display has been modified for optimum compatibility with how the group display behaves.

If the "Group Relevant" attribute is set to "Yes" in the object properties, the status tag interconnected under "Group value" enters into the ORing UP of the group display hierarchy. If the "Group Value" attribute is not interconnected, then you must set "Group Relevant" to "No." The process alarm "Group display: tag .EventState not found" would otherwise not be triggered in Runtime.

Property "Other/Acknowledgment mask"

To ensure consistent runtime response, we recommend that you configure the acknowledgment mask for the group display and the extended analog display in exactly the same way.

For the extended analog status display, the supplied PCS7 settings for acknowledgment sample of "17" or "3089" prior to WinCC V7.01 is possibly not suitable for your project and must be adjusted.

Property "Other/Outgoing state visible"

You use the "Outgoing state visible" property to specify whether an outgoing state is visible or not.

Note

The quality code can only be evaluated by the extended analog display if the object property "Value" is made dynamic directly with a tag.

See also

Format Function of the Analog Display (Page 36)
Migration of Extended Status and Analog Displays Prior to WinCC V6.2 (Page 37)
### 1.9 Format Function of the Analog Display

#### Formatting options

You format the value of the tag that will be displayed in the extended analog display as follows:

<table>
<thead>
<tr>
<th>Formatting characters</th>
<th>Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>No characters</td>
<td>Displays the number without formatting.</td>
</tr>
<tr>
<td>( 0 )</td>
<td>Displays a digit or zero. If the expression contains a digit at a position that is occupied by a 0 in the format string, the digit is displayed. Otherwise a zero is output. If the number has less digits than the zeros in the format expression (on both sides of the decimal point), the leading or trailing zeros are displayed. If the number has more decimal places after the decimal point than the zeros in the format expression, the decimal places are rounded to the number of zeros. If the number has more places before the decimal point than zeros in the format expression, the additional places are displayed just as they are.</td>
</tr>
<tr>
<td>( # )</td>
<td>Displays a digit or no output. If the expression contains a digit at a position that is occupied by a # placeholder in the format string, the digit is displayed. Otherwise nothing is displayed at this position. This symbol behaves like a 0 placeholder. However, leading or trailing zeros are not displayed if the format expression contains more # placeholders before or after the decimal separator than there are digits in the number.</td>
</tr>
<tr>
<td>( . )</td>
<td>Placeholder for the decimal separator. In many locales a comma is used as decimal point, and in others a point is used. The placeholder for the decimal separator determines how many places are displayed to the left and right of the decimal separator. If the format expression contains only # placeholder to the left of this symbol, numbers smaller than 1 begin with a decimal character. If you require decimal numbers always to be displayed with a leading zero, you must specify a 0 placeholder for the first digit to the left of the decimal point. The character that is actually output as the decimal separator depends on the system settings for the number format.</td>
</tr>
<tr>
<td>( % )</td>
<td>Placeholder for percent. The expression is multiplied by 100. The percent sign (%) is inserted at the position it occupies in the format string.</td>
</tr>
<tr>
<td>( , )</td>
<td>Thousands separator In many locales a comma is used as the thousands separator, and in others a point is used. The thousands separator divides thousands from hundreds in a number containing four digits or more. A thousands separator is output if the format expression contains the appropriate placeholder and this placeholder is itself surrounded by placeholders for digits (0 or #). Two thousands separators in succession or a thousands separator immediately left of the decimal separator even if no decimal places are specified will cause the number to be divided by 1000 and rounded off. Example: You can use the format string &quot;##0,,&quot; in order to output &quot;100 million&quot; as &quot;100&quot;. Numbers smaller than 1 million are then shown as 0. Two consecutive placeholders for the thousands separator that are not placed immediately to the left of the decimal separator are interpreted as a normal thousands separator and output as such. The character that is actually output as the thousands separator depends on the system settings for the number format.</td>
</tr>
</tbody>
</table>
1.10 Migration of Extended Status and Analog Displays Prior to WinCC V6.2

Introduction

As of WinCC V6.2, you can now integrate all bits of the group value for the extended status and analog display. This extends the message classes that have been used up to now.

Extension and transfer of configuration data

If you open an extended status and analog display configured before WinCC 6.2 with a WinCC version V6.2 or higher, the configuration data is extended or transferred as follows:

<table>
<thead>
<tr>
<th>New in WinCC V6.2</th>
<th>Effect on Previous Configuration Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>New object property &quot;Acknowledgment mask&quot; in the &quot;Miscellaneous&quot; properties group</td>
<td>Transfer of the object property from the group display. The acknowledgment mask of the @EventQuit tag is set to &quot;0&quot; for projects prior to WinCC V6.2.</td>
</tr>
<tr>
<td>New properties group &quot;Message types&quot; of the extended analog display</td>
<td>Transfer of the property group from the group display. The existing object properties for the configured colors of the message classes in the &quot;Colors&quot; properties group are omitted and are transferred to the new properties group.</td>
</tr>
</tbody>
</table>
Overview of process control system options

1.10 Migration of Extended Status and Analog Displays Prior to WinCC V6.2

<table>
<thead>
<tr>
<th>New in WinCC V6.2</th>
<th>Effect on Previous Configuration Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>New object properties for the priorities in the &quot;Status&quot; properties group</td>
<td>The existing object properties for the priorities are transferred to the new object properties for the respective bits of the group value. Additional priorities were added.</td>
</tr>
<tr>
<td>New options for combining statuses for assignment of pictures</td>
<td>The index list of the extended status display has been enlarged. The index of certain states has changed, for example, the operator message in the &quot;Went Out&quot; (OR, -) status previously had the index &quot;25&quot;, and now has the index &quot;34&quot;.</td>
</tr>
<tr>
<td>Flashing of the background and the text can be configured for the bits of the group value</td>
<td>In the extended analog display you can set flashing behavior for the background and the text for all bits of the group value with regard to the &quot;Came In&quot;, &quot;Came In Acknowledged&quot; and &quot;Went Out Unacknowledged&quot; statuses.</td>
</tr>
</tbody>
</table>

Transfer of the background colors and text colors of the extended analog display

The transfer of the former object properties for background color and font color of the message classes in the "Colors" properties group to the new object properties in the "Message types" properties group:

<table>
<thead>
<tr>
<th>Object Property</th>
<th>Message Type</th>
<th>New Object Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Background color (Tolerance)</td>
<td>Bit 27 (Tolerance High)</td>
<td>Came In - Background color ON</td>
</tr>
<tr>
<td></td>
<td>Bit 26 (Tolerance Low)</td>
<td>Came In - Background Color Off</td>
</tr>
<tr>
<td></td>
<td>Came In Acknowledged - Background color ON</td>
<td>Came In Acknowledged - Background color OFF</td>
</tr>
<tr>
<td></td>
<td>Came In Acknowledged - Background color OFF</td>
<td>Went Out Unacknowledged - Background color ON</td>
</tr>
<tr>
<td></td>
<td>Went Out Unacknowledged - Background color OFF</td>
<td>Came In - Background color ON</td>
</tr>
<tr>
<td></td>
<td>Came In - Background Color Off</td>
<td>Came In Acknowledged - Background color ON</td>
</tr>
<tr>
<td></td>
<td>Came In Acknowledged - Background color OFF</td>
<td>Came In Acknowledged - Background color OFF</td>
</tr>
<tr>
<td></td>
<td>Went Out Unacknowledged - Background color ON</td>
<td>Went Out Unacknowledged - Background color OFF</td>
</tr>
<tr>
<td>Font Color (Tolerance)</td>
<td>Bit 27 (Tolerance High)</td>
<td>Came In - Font color ON</td>
</tr>
<tr>
<td></td>
<td>Bit 26 (Tolerance Low)</td>
<td>Came In - Font color OFF</td>
</tr>
<tr>
<td></td>
<td>Came In Acknowledged - Font color ON</td>
<td>Came In Acknowledged - Font color OFF</td>
</tr>
<tr>
<td></td>
<td>Came In Acknowledged - Font color OFF</td>
<td>Went Out Unacknowledged - Font color ON</td>
</tr>
<tr>
<td></td>
<td>Went Out Unacknowledged - Fontcolor OFF</td>
<td>Came In - Font color ON</td>
</tr>
<tr>
<td></td>
<td>Came In - Font color OFF</td>
<td>Came In Acknowledged - Font color ON</td>
</tr>
<tr>
<td></td>
<td>Came In Acknowledged - Font color OFF</td>
<td>Came In Acknowledged - Font color OFF</td>
</tr>
<tr>
<td></td>
<td>Went Out Unacknowledged - Font color ON</td>
<td>Went Out Unacknowledged - Font color OFF</td>
</tr>
<tr>
<td>Object Property</td>
<td>Message Type</td>
<td>New Object Properties</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------------------</td>
<td>----------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Background color</td>
<td>Bit 29 (Warning High)</td>
<td>Came In - Background color ON</td>
</tr>
<tr>
<td></td>
<td>Bit 28 (Warning Low)</td>
<td>Came In - Background Color Off</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Came In Acknowledged - Background color ON</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Came In Acknowledged - Background color OFF</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Went Out Unacknowledged - Background color ON</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Went Out Unacknowledged - Background color OFF</td>
</tr>
<tr>
<td>Font Color (Warning)</td>
<td>Bit 29 (Warning High)</td>
<td>Came In - Font Color ON</td>
</tr>
<tr>
<td></td>
<td>Bit 28 (Warning Low)</td>
<td>Came In - Font color OFF</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Came In Acknowledged - Font color ON</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Came In Acknowledged - Font color OFF</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Went Out Unacknowledged - Font color ON</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Went Out Unacknowledged - Font color OFF</td>
</tr>
<tr>
<td>Background color (Alarm)</td>
<td>Bit 31 (Alarm High)</td>
<td>Came In - Background color ON</td>
</tr>
<tr>
<td></td>
<td>Bit 30 (Alarm Low)</td>
<td>Came In - Background Color Off</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Came In Acknowledged - Background color ON</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Came In Acknowledged - Background color OFF</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Went Out Unacknowledged - Background color ON</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Went Out Unacknowledged - Background color OFF</td>
</tr>
</tbody>
</table>
## Overview of process control system options

### 1.10 Migration of Extended Status and Analog Displays Prior to WinCC V6.2

<table>
<thead>
<tr>
<th>Object Property</th>
<th>Message Type</th>
<th>New Object Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font color</td>
<td>Bit 31 (Alarm High)</td>
<td>Came In - Font color ON&lt;br&gt;Came In - Font color OFF&lt;br&gt;Came In Acknowledged - Font color ON&lt;br&gt;Came In Acknowledged - Font color OFF&lt;br&gt;Went Out Unacknowledged - Font color ON&lt;br&gt;Went Out Unacknowledged - Font color OFF</td>
</tr>
<tr>
<td></td>
<td>Bit 30 (Alarm Low)</td>
<td>Came In - Font color ON&lt;br&gt;Came In - Font color OFF&lt;br&gt;Came In Acknowledged - Font color ON&lt;br&gt;Came In Acknowledged - Font color OFF&lt;br&gt;Went Out Unacknowledged - Font color ON&lt;br&gt;Went Out Unacknowledged - Font color OFF</td>
</tr>
<tr>
<td>Background color</td>
<td>Bit 24 (AS process control error)</td>
<td>Came In - Background color ON&lt;br&gt;Came In - Background Color Off&lt;br&gt;Came In Acknowledged - Background color ON&lt;br&gt;Came In Acknowledged - Background color OFF&lt;br&gt;Went Out Unacknowledged - Background color ON&lt;br&gt;Went Out Unacknowledged - Background color OFF</td>
</tr>
<tr>
<td>Font color</td>
<td>Bit 24 (AS process control error)</td>
<td>Came In - Font color ON&lt;br&gt;Came In - Font color OFF&lt;br&gt;Came In Acknowledged - Font color ON&lt;br&gt;Came In Acknowledged - Font color OFF&lt;br&gt;Went Out Unacknowledged - Font color ON&lt;br&gt;Went Out Unacknowledged - Font color OFF</td>
</tr>
<tr>
<td>Background Color</td>
<td>Bit 25 (AS Control System Fault)</td>
<td>Came In - Background color ON&lt;br&gt;Came In - Background Color Off&lt;br&gt;Came In Acknowledged - Background color ON&lt;br&gt;Came In Acknowledged - Background color OFF&lt;br&gt;Went Out Unacknowledged - Background color ON&lt;br&gt;Went Out Unacknowledged - Background color OFF</td>
</tr>
<tr>
<td>Font Color</td>
<td>Bit 25 (AS Control System Fault)</td>
<td>Came In - Font color ON&lt;br&gt;Came In - Font color OFF&lt;br&gt;Came In Acknowledged - Font color ON&lt;br&gt;Came In Acknowledged - Font color OFF&lt;br&gt;Went Out Unacknowledged - Font color ON&lt;br&gt;Went Out Unacknowledged - Font color OFF</td>
</tr>
</tbody>
</table>
If flashing was configured for message classes of the extended analog display before WinCC V6.2, then flashing is activated for all states as of WinCC V6.2.

### Transfer of the priorities of the extended status and analog displays

The transfer of the previous object properties for the priorities to the new object properties in the "Status" properties group:

<table>
<thead>
<tr>
<th>Object Property</th>
<th>New Object Property</th>
</tr>
</thead>
<tbody>
<tr>
<td>Request for operator input priority</td>
<td>Priority Bit 20</td>
</tr>
<tr>
<td>Fault priority</td>
<td>Priority Bit 25</td>
</tr>
<tr>
<td>Tolerance priority</td>
<td>Priority Bit 27</td>
</tr>
<tr>
<td></td>
<td>Priority Bit 26</td>
</tr>
<tr>
<td>Warning priority</td>
<td>Priority Bit 29</td>
</tr>
<tr>
<td></td>
<td>Priority Bit 28</td>
</tr>
<tr>
<td>Alarm priority</td>
<td>Priority Bit 31</td>
</tr>
<tr>
<td></td>
<td>Priority Bit 30</td>
</tr>
<tr>
<td>Error priority</td>
<td>Priority Bit 24</td>
</tr>
</tbody>
</table>

### Note

Process pictures, in which you have inserted extended analog displays and extended status displays as of WinCC V6.2, cannot be opened with a version before WinCC V6.2.

### See also

How to Configure the Extended Status Display (Page 25)
How to Configure the Extended Analog Display (Page 31)
OS Project Editor

2 Resources

2.1 OS Project Editor

Content

The "OS Project Editor" is used for initializing and configuring the runtime user interface and the alarm system in PCS7.

This documentation shows you the following:

- how to change the layout
- how to configure the behavior of the alarm system in runtime
- how to arrange areas
- how to arrange runtime windows
- how to configure initialized basic data
- how to log the activities of the Project Editor

2.2 General information about the "OS Project Editor"

Introduction

The OS Project Editor is used to configure the currently open WinCC project for use with Basic Process Control and PCS7.

Tasks of the OS Project Editor

The OS Project Editor inserts pre-configured pictures, script actions, and tags in the PCS 7 project. This editor also specifies the typical settings for a PCS 7 project.

When the OS Project Editor is run, the following tasks are completed:

- Creation of the PCS 7 message classes and message types
- Creation of the message blocks
- Creation of the PCS 7 messages
- Configuration of the startup list and the start screen
- Copying of the Dynamic Wizard and the actions
2.2 General information about the "OS Project Editor"

- Creation of tags for controlling the runtime behavior
- Copying of the screen layout
- Creation of the runtime configuration file

Behavior of the project editor

When an OS project is created in the PCS 7 ES, the OS Project Editor is called in the background and initialized with default settings. If you want a configuration other than the default configuration, start the OS Project Editor via WinCC Explorer and configure your desired project settings.

When you create a project in WinCC, you must start the OS Project Editor in WinCC Explorer. The OS Project Editor must run before the User Administrator is opened; otherwise the User Administrator will be initialized with the authorization levels of WinCC.

The first time the OS Project Editor is called, the default settings are displayed. A suitable layout for the runtime user interface is selected on the basis of the screen resolution and project type. If a suitable layout is not found, the OS Project Editor selects the first layout from the list of available layouts in the "Layout" tab.

When you open the OS Project Editor again, the current project settings are displayed. You must first confirm modified basic data picture files and actions in the "Basic Data" tab before these data are accepted in the project.

Activities when processed by project editor

In PCS 7 projects, you can change configuration data during operation using the "Download changes" function ("Online delta download"). Every configuration change via the user interface or programming interface is recognized by the runtime software and accepted during operation.

You set this behavior for the OS Project Editor in the "General" tab. If the configuration of the OS allows modification of data during operation, data that prevent a "Download changes" function are brought into the project during the initial configuration. This applies in particular for alarm configuration and the startup list. Each time the OS Project Editor is run hereafter, only those configurations that do not prevent the "Download changes" function are carried out.

In the case of a complete configuration, all settings are transferred again to the project. Changes to configuration data during operation are lost in the process. You must download the entire OS. After this, you can again switch on the delta mode of "Download changes" in the "General" tab.

Note

The project engineer may not create any tags with @ prefix. Such actions are reserved for handling in the WinCC PCS7 software. You are not allowed to manipulate these system tags. The system tags are necessary for proper functioning of the product.

Note

You must not remove applications placed in the startup list by the OS Project Editor, even if they seem unnecessary. If you do so, subsequent configuration during runtime and an online download of changes will not be possible.
See also

"OS Project Editor" (Page 45)
"General" tab (Page 83)

2.3 "OS Project Editor"

Introduction

Use the OS Project Editor to configure the runtime and alarm systems for a PCS 7 project. For instance, you can change the number and arrangement of runtime windows or assign the authorization of alarms without a specified area to an area.

Overview

In WinCC Explorer, double-click the OS Project Editor icon. This opens the editor. The setting options are summarized in the six tabs of the OS Project Editor. You can use them to enter the relevant settings.

If data have been changed, an asterisk after the identifier in the corresponding tab indicates that this tab has changed. When you click "Apply", the changes you have made are put into effect in the project. The asterisk on the tab disappears once the changes are applied to the project. Click "OK". This closes the editor. When you click "Cancel", the editor is closed without accepting the changes.

It takes some time to configure the project.

See also

"Layout" tab (Page 46)
"Message Configuration" Tab (Page 52)
"Areas" Tab (Page 64)
"Runtime window" tab (Page 71)
"Basic data" tab (Page 78)
"General" tab (Page 83)
The "Layout" tab contains settings for the layout of the runtime user interface. The basic data is organized in the layouts. A layout is defined by a configuration file.

The first time the OS Project Editor is run, the following settings are specified for the layout:
A suitable layout is determined from the resolution of the monitor.

If the settings for the area and server keys are missing from the configuration file and the display of areas on the WinCC client is not supported for a server, the four horizontal and vertical keys are created for each area.

If the settings for the area and server keys are missing from the configuration file and the display of areas on the WinCC client is supported for a server, the three horizontal keys and four vertical keys are created for the area and two horizontal keys and three vertical keys are created for the server.

Available Layouts

The following layouts with different screen resolutions are available for the Runtime interface:

- **SIMATIC Server**: Only for server. You cannot use "SIMATIC Server" for the WebNavigator. The interface is completely unusable with the following five exceptions:
  - LOGIN input dialog field
  - Select User Administrator
  - Displaying the system picture (lifebeat monitoring)
  - Exit Runtime
- **SIMATIC Standard**: "SIMATIC Standard" is the default setting and can be used universally for all projects. "SIMATIC Standard" is ideal for local projects or projects with a server. If several server packages are loaded, the area buttons of all servers are displayed behind each other. The server buttons are not displayed. You can configure the number of area buttons.
- **SIMATIC Serverview**: "SIMATIC Serverview" is ideal for projects with several servers. You see only the area buttons of the selected server. You can configure the number of server buttons and area buttons.

The layouts in screen formats "16:9" (1920*1080) and "16:10" (1680*1050, 1920*1200, 2560*1600) are not approved for the use of Multi-VGA. Only one monitor is supported.

The "Current layout" output box shows the name of the currently selected layout in the project. This layout is automatically selected in the "Available layouts" list. The "Description" output box provides brief information about the selected layout.

You can configure any number of layouts for runtime by selecting another available layout and changing the monitor configuration.

Monitor configuration

In the "Monitor configuration" group you can set the desired screen division for the target device in runtime. Only the supported monitor configurations can be selected for the selected layout. The settings for multi VGA must be made in the Control Panel of the operating systems before running the OS Project Editor.

Expanded Configuration of the Overview

If the layout supports the generic creation of the area buttons in the overview area, the "Detail" is enabled for "Overview extended configuration".
The "Number of area keys" and "Number of server keys" output boxes show the number of keys currently configured. If the layout does not support these functions, the field are empty and the "Detail" button is disabled.

The "Detail" button opens a dialog box for configuring the overview area. You set the number of keys in this dialog box.

**Runtime help**

When you select the "Runtime help available" check box, you specify that the "Help" button is operator-controllable in the second button set of runtime.

**Display**

If you have installed "SIMATIC Logon Service", you can choose here to have the full user name or only the user ID of the user logged displayed in the overview area under "Login".

**Note**

The layout selection must match the monitor setting of the computer. Depending on the graphic card used, problems may occur when runtime is started if the coordinates deviate.
2.4.2 Layout configuration for the overview area

Introduction

The "Detail" button in the "Layout" tab opens the following dialog box for configuring the overview area:

![Layout Configuration Dialog Box]

The "Number of Configured Areas" output box indicates the number of plant sections currently configured in the Picture Tree Manager. The "Number of Configured Servers" output box shows the number of servers available in the packages.

The "Suggestion" button function derives the number of area and server buttons from the configured hierarchy, if the layout so permits. The suggestion will be applied in the input fields of the "Number of Areas" and "Number of Servers" groups.

In the "Number of areas" group, you specify the number of buttons horizontally and vertically directly in the input box, with the slider or spin box. You will find the limits for input are shown alongside the slider.

For the sake of clearly labeling the area buttons it is useful to arrange more areas vertically than horizontally. You will see the difference in the area preview, if for instance you create four horizontal and three vertical area buttons or three horizontal and four vertical area buttons.

If the layout supports "Server View" and server buttons which were generated in the overview window, the "Number of Servers" group is enabled. Use this field to define the buttons in the horizontal and vertical directions for displaying servers.
Area preview

The "Preview" button opens an area preview of the configured buttons in the overview window. The generated overview is displayed schematically. The following area preview shows by way of example three area buttons in the horizontal direction and three area buttons in the vertical direction:

While the preview window is open, you can continue configuring. Each change is immediately updated in the preview.

Note

The setup options of the "Number of Areas" and "Number of Servers" are limited by layout-specific considerations. If there is no entry in the configuration file for the layout concerned, the following settings apply:

- The horizontal and vertical number is limited to between 1 and 8 areas in the "Number of Areas".
- In "Number of Servers" the horizontal number is limited between 1 and 4 buttons, and the vertical number is limited from 1 to 8 buttons.

2.4.3 How to change the configured layout

Introduction

If you do not want the layout predefined by the OS Project Editor, you can change the layout.

Procedure

1. Open the OS Project Editor and select the "Layout" tab.
   Select a layout from the "Available Layouts" list.
2. Check the settings in the "Basic Data" tab to avoid any unwanted data overwrites.

Note

Changes in the "Layout" tab affect settings in the "Areas", "Runtime Windows" and "Basic Data" tabs.
2.4.4 Changing the monitor configuration

Introduction
With the configuration of the monitor, you set the desired screen division for the target device in runtime.

Procedure
1. Open the OS Project Editor. Select the corresponding monitor configuration from the "Layout" tab.
2. Check the settings in the "Basic Data" tab to avoid any unwanted data overwrites.

Note
Changes in the "Layout" tab affect settings in the "Areas", "Runtime Window" and "Basic Data" tabs.
Up to four screens are supported, each screen having one working area, one button area, one overview window and an unrestricted number of pre-configured process windows.
Before using the OS Project Editor you need to set the Multi VGA in the Windows Control Panel.

2.4.5 Adapting the overview window

Introduction
The overview window is a continuous display that offers an overview of the entire plant. Each plant area is represented by an area button in the overview area.

Procedure
1. Open the OS Project Editor. Click "Detail" on the "Layout" tab next to "Overview Extended Configuration". This opens the dialog box for adapting the overview area.
2. Change the number of buttons.
3. Open the preview during configuration. This gives you a better idea of the configuration.
4. Check the settings in the "Basic Data" tab to avoid any unwanted data overwrites.

Note
Changes in the "Layout" tab affect settings in the "Areas", "Runtime Windows" and "Basic Data" tabs.
The first time the "Message Configuration" tab is selected, the OS Project Editor reads the following data from the message system:

- Message classes
- Message types
- Message blocks
- PCS 7 messages

This takes some time. A notice indicating "Data will be read from the message system. One moment please..." is displayed.
Message system settings

On the "Message configuration" tab you specify how the OS Project Editor should configure the message system.

Column widths of the message window

Edit the column width of the message blocks you created in the "Column widths of message window" list. The column widths are preset according to PCS 7 guidelines. Define the desired output format in the "Date" and "Time" message blocks.

Defining the message classes and message types

The PCS 7 standard initially serves as template for the message system. The template is available as "MessageTemplate.cfg" configuration file in "Installation directory\Options\SSM".
If you do not want to use the PCS 7 standard you can use this configuration file as an example for creating customized configuration file. Save the "MessageTemplate.cfg" file under a different name to a folder other than the installation directory before you start the adaptation.

Activate the "Update" check box in the "Message classes/types" group if using the PCS 7 standard or if you prefer to use a customized, industry-specific standard. The "Update" option overwrites the a message class and message type configuration in Alarm Logging with the default PCS 7 settings or with the settings from your custom configuration file if their current configuration does not match. The message classes "11" to "15" you configured them in Alarm Logging remain unchanged in the PCS 7 standard, as these are not used in the PCS 7 standard.

If you only want to use the PCS 7 standard or your custom, industry-specific standard for the purpose of setting up a basic configuration for the message system in the first session of Project Editor, the "Update" check box must be deactivated in all subsequent sessions of Project Editor. You can use the Alarm Logging Editor to adapt the configuration without it being overwritten by the Project Editor.

Activate the "Derive from:" check box if deriving the message class and message type configuration from a custom configuration file. Use the "..." button to select the corresponding configuration file. This configuration file is copied to the project directory once and used as a template file the next time the Project Editor is opened.

The "Message class "Tolerance" has to be acknowledge" option is enabled by default in new projects as of WinCC V7.01. The messages of this message class therefore require acknowledgement. The messages that have come in flash and are also shown in the following message lists:

- Incoming alarm list
- Acknowledged alarm list
- Outgoing alarm list
- List of hidden messages and messages to be hidden
- Single line message window in overview area

Note

In WinCC versions prior to V6.2, the OS Project Editor generates the message classes "AS-process control message" and "OS-process control message" with the message types "System" and "Error" in Alarm Logging. Starting in V6.2, however, these message classes are created with "Failure" and "Error" message types.

In order to activate the name change from "System" to "Failure" in projects prior to WinCC V6.2, you must activate the "Update" check box in the "Message classes/types" group.

Activating system messages

If you activate the "Activate" check box the messages from the "LTMdata.csv" file (installation directory/WinCC/bin) are entered in the message system of the project. The "LTMdaten.csv" file contains system messages from WinCC and Basic Process Control. "System, need not be acknowledged" and "Process control" are used as the message class and message type for all messages. In Runtime the messages are displayed in the control system list as non-flashing,
You can change certain the system messages from "LTMdaten.csv" to process control message in the "Process control and operator input messages" list.

Specify the priority of system messages in the "Message priority" input box. Either enter the value directly in the input field, or use the slider or the spin box. The input limits are predefined and are displayed alongside the slider. Reserve message priority "16" for vital messages of your plant, particularly for "Fatal event messages".

Activating process control and operator input messages

Select the system messages from the "LTMdaten.csv" file to be converted into process control messages from the "Process control and operator input messages" list. You can create additional messages for PCS 7 such as "Simatic Batch" or "SFC".

Activate the check box in leading the list entry. This enables the output of specific process control and operator input messages. Click the check box again in order to deactivate and suppress the messages. All activated messages are created.

If you activate the "Activate" check box in the "System messages" group, all messages listed without a check mark are used as WinCC system messages with lower priority. If you deactivate the "Activate" check box in the "System messages" group, all messages listed without a check mark are deleted from the message system of the project.

You can change the message priority of the process control and operator input messages. Click in the cell of the "Prio" column in the line of the corresponding message number and enter the priority class. Reserve message priority "16" for vital messages of your plant, particularly for "Fatal event messages".

OS process control messages are computer-specific (instance message concept).

Note

If the OS Project Editor is started on a WinCC client project or the option "Configuration that support online delta loading only" was selected in the "General" tab, the "Column width of message window" and "Process control and operator control messages" lists and the "Activate" check box of the system messages cannot be edited.

All objects with "Operator message" property generate an internal operator message in the system after the operator makes an input in runtime. This message is not visible in the "Alarm Logging" editor. The user text blocks of this message are set according to PCS 7 defaults when you run the OS Project Editor. You may not change these user text blocks, as the message is triggered by the system. In order to customize the allocation of user text blocks you must generate a message individually by means of ODK. However, this message is not going to be triggered by events which are monitored by the system.

All process control messages should be activated so that maintenance personnel is informed of any control system faults.
2.5.2 Editing message blocks

Introduction

For each message block created by the OS Project Editor, you can define the column widths entered in the "Message Window Column Width" list on the "Message Configuration" tab.

Editing

Right-click the entry in the "Column width" column. This is how you edit the column width.

In the message blocks "Date" and "Time", a dialog box opens in which you can set up the desired output format. The column width is then automatically adapted to the output format.
Note

You cannot edit the column widths of the message window if you run OS Project Editor in a WinCC client project, or if the "Online Delta Loading Configuration Only" option was selected on the "General" tab.

You cannot change the order of the columns.

See also

"Message Configuration" Tab (Page 52)
Introduction

In the "Message Display" tab you can configure the runtime response of the message system and the display format of the messages in the message pages or group displays.

![Message Display Tab](image-url)
Message filter

You can specify how the messages are displayed in runtime in the "Message filter" group. The filters refer only to the display for the user who is logged in. Hidden messages are still processed by the message server.

You can display all messages unfiltered, filter the messages according to area or display messages in separate lists.

Displaying an extended message line

You can display an extended message line via the working area if the layout supports this setting. You can change the size by selecting the "Half of the working area" and "One quarter of the working area" radio buttons. The extended message line extends across the entire width of the screen.

If you wish to set the display format yourself, activate the "User defined" check box and click "Detail". A dialog box will open. You specify the desired settings here.

Authorization check of messages without a specified area

If messages are assigned neither to a picture heirarchy nor derived from the plant hierarchy of PCS 7, in the "Authorization check of messages without a specified area" group, specify the area for which the messages should be viewed/acknowledged. The user will need the necessary access rights to the assigned area.

If you select "No area" in the drop-down list box, all users can view and acknowledge the messages.

Smart Alarm Hiding

In the message lists, you can use the "Hide/Unhide message" button in the toolbar to hide selected messages temporarily. This prevents minor events from being displayed during this time. It also enables you to maintain a better overview during critical phases. Acknowledgment takes place automatically during hiding and an operator message is generated.

The button is only available if you have, as a minimum, been assigned the authorization level "Higher process controlling" for an area.

If you select the "Key for hiding/showing manually" check box, the "Hide/Unhide message" button is displayed in the toolbar.

The hidden messages are transferred to the list of hidden messages. The operator can use the "List of hidden messages" button from the key set to access this list. From this list, you can use the "Hide/Unhide message" button in the toolbar at any time to make hidden messages reappear.

The temporary hide function is canceled automatically as soon as a set time period defined in the OS Project Editor expires. Enter the maximum time limit for message hiding in the edit box. 30 minutes are preset. You can enter a maximum of 9 days, 23 hours and 59 minutes.
Sorting Message Pages

You set the chronological order of the message window in the message pages. By selecting the "Latest message at top" radio button, the most recent message to arrive is displayed as the first message in the message window. By selecting the "Latest message at bottom" radio button, the most recent message to arrive is displayed as the last message in the message window.

In the extended message line the messages are sorted first by priority, then data and finally by time.

Group display hierarchy

This setting for the group display hierarchy supports you in configuring the group display if you wish to build a group display hierarchy based on the picture hierarchy.

When the "Create/update group display" check box is selected, the additional group displays are created as follows in the process pictures for forming the group display hierarchy:

- When saving the hierarchy in the Picture Tree Manager when creating or migrating a project.
- When running the OS Project Editor for an existing project

The Project Editor calls the corresponding component of Picture Tree Manager. The next time it starts the group displays are no longer automatically generated since they already exist in the project. You then save all future changes in the group display hierarchy, e.g., changes to the pictures or the tree structure, in the Picture Tree Manager.

These group displays are not seen in runtime by default. With loop in alarm via group displays from the area overview, therefore, a process picture can be opened in which no group display flashes or a group display displays another message type. However, you can navigate to the alarm sources using the Picture Tree Navigator.

If you wish to make the generated group display automatically visible, you need to adapt the "GroupDisplay" object in template picture "@CSig_Template.PDL" in the Graphics Designer. Change the property "Other/Display" to "Yes".

Check all settings of the group display object in the template picture before you execute the "Create/update group display" function. This especially applies to the properties "Display", "Group Relevant" and "Acknowledgment mask".

Define each of the desired properties in the template picture. The factory state corresponds to the PCS 7 standard.

Here is how you can use the individually configured and tested group displays from a process picture as a template:

1. Copy the individually configured and tested group displays into the template picture "@CSig_Template.PDL".
2. Use the C action of the original "GroupDisplay" object for the new object.
3. Change the name of the original object from "GroupDisplay" to "OriginalGroupDisplay", for example.
4. Change the name of the new object to "GroupDisplay".

The PCS 7 factory setting of "3089" for the acknowledgment masks may not be suitable for individually configured group displays in your project and may need to be changed. To learn more, read the documentation section for group displays.
Controlling acknowledgment response by means of a tag (Page 314)

Since the group display objects can be interconnected independent from the picture hierarchy, a warning appears when you select the "Create/update group displays" check box.

The "Create/update group display" function deletes all group displays from process pictures which are interconnected with a picture of another system area and whose "Group Relevant" property is set to "Yes". The group display object is not deleted if the "Group Relevant" property is set to "No". Group displays that are connected to a measurement point from another plant section are not deleted regardless of the "Group Relevant" property.

---

**Note**

The "Create/update group display" function cannot be reversed. Group displays automatically inserted into process pictures must be corrected manually if they do not fit. Before using the function, you should check the property settings for the "GroupDisplay" object in the template picture, "@CSIG_Template.PDL".

---

**Adding a block comment for operating messages**

If you check this box, the relevant block comment will be added to the operator message during operator process control by means of a block from the PCS 7 library. The block comment will not be added if:

- Operator messages that are generated as a result of messages being disabled/enabled. This applies to all blocks associated with the picture in the working area and its lower-level pictures.
- Operator messages that are generated as a result of acknowledgment in process pictures or message lists.

**See also**

Message filters (Page 61)
Extended message line (Page 62)

---

**2.6.2 Message filters**

**Introduction**

In the "Message filter" group of the "Message Display" tab, you can specify which messages should be displayed in runtime.

You have the following setup options:
2.6 "Message Display" Tab

- "No filter"
  Disables area-specific filtering of messages. All messages are displayed and can be
  acknowledged, regardless of the area to which they are assigned.

- "Messages with area enable"
  All messages from an area for which a user is granted the "Authorization for area" access
  right are displayed and can be acknowledged.

- "Acknowledgeable messages in separate list"
  The message windows output two message lists. One list shows all messages from the
  area for which the user has the access right for "Process controlling". The user can also
  acknowledge messages from this list.
  The other list shows all messages from the area for which the user has the access right
  "Authorization for area" but not the access right for "Process controlling". The user cannot
  acknowledge messages from this list. The message line in the overview window shows
  only messages which can be acknowledged with the "Process controlling" access right.

- "Acknowledgeable messages on separate page (switch-selectable)"
  Both messages mentioned above are available to the user. The message page with just
  one list shows only the messages from the area for which the user has the access right for
  "Process controlling". The same applies to the message line in the overview window.

**Note**

If the chosen layout does not support the "Message filtering" setting, the buttons are disabled.

See also

"Message Display" Tab (Page 58)

2.6.3 Extended message line

**Introduction**

An extended message line can be displayed via the working area if the layout supports this
setting.

An extended message line is like a New list, but scaled down as appropriate. The window
adapts to the size of picture being displayed. It has no scroll bars and its width cannot be
changed. You can define its height, however, since the extended message line is configured
as a dedicated picture in the layout.
Procedure

1. In the "Message display" tab of the "Extended message line" group, select the "User-defined" check box. The "Detail" button is now enabled.

2. Click "Detail".
   The "Alarm window" dialog box opens.

![Alarm window dialog box](image)
3. Set up the values in the following input boxes either by entering the values straight into the input box or else by using the slider or the spin box:
   - "Window height"
   - "Position top"

   Define a window position which is relative to the coordinate origin of the working area.

   The window always has the same width as the working area.

   The "Horizontally displaced" and "Vertically displaced" fields are disabled, since there is only one window.

4. The "Graphic positioning" field allows you to position the window with ease. To do so, click "Detail".

   **Note**

   The default setting for the extended message line is available in the configuration file the first time you open the OS Project Editor. If this entry is missing, the default setting is "Half of the working area". However, this only applies if the layout supports an extended message line.

**See also**

Graphic positioning of a runtime window (Page 78)
"Message Display" Tab (Page 58)

2.7 **The "Areas" Tab**

2.7.1 **"Areas" Tab**

**Overview**

In the "Areas" tab, you configure the arrangement of the area buttons and server buttons for the overview window. Here, you also specify the user's access to areas for which he has no authorization.

The area buttons result from the plant sections that you have configured in the Picture Tree Manager, and consist of the following:

- A button to open the area
- A group display to show the group value of this area
- A button to open the Picture Tree Navigator

The server buttons are used to visualize a server in the overview window, and consist of the following:
Visible Areas

The "Visible areas" list shows all configured plant sections in the sequence in which they are displayed as area buttons in the overview window. In the default layouts the sequence of the buttons is from left to right and from the top down. So as to define area buttons for any future extension of the plant sections, you can insert empty area buttons as placeholders even at the project creation stage. Do this by using "Empty Buttons", which you include at the required position in the "Visible areas" list.

You can simultaneously select as many entries in the list as you wish, and move them with the "up" and "down" buttons. Click "->" to remove the selected entries, and click ">>" to remove all entries from the "Visible areas" list.
Areas not Needed

The "Areas not needed" list is used when anticipatory planning of a reserve configuration, and shows all the areas in the project that do not appear in the "Visible areas" list. The "Empty Button" entry serves as a placeholder for an area button that you intend to assign to a plant section at some future point in time.

You can select multiple entries and click "<-" to insert them in the "Visible areas" list. Click "<<" to insert all other entries, except the "<Empty Button>" entry.

Alternatively you can configure reserve areas with empty pictures assigned in the Picture Tree Manager for some future extension. Examples:

- Reserve1 - Picture_Reserve1
- Reserve2 - Picture_Reserve2
- Reserve3 - Picture_Reserve3

In this case users would not receive access rights to these reserve areas in the User Administrator. You are not allowed to create areas in the Picture Tree Manager without assigning pictures to them. To configure reserve areas, always use the OS Project Editor option "Areas not needed".

Server assignment

If the chosen layout allows the server to be displayed on the WinCC client, you can arrange the areas for the server selected in the "Server assignment in the area overview" list. If you select another server, the "Visible areas" and "Areas not needed" lists are refilled. You can arrange the selected servers by clicking "Up" and "Down".

In the case of a layout without View on a server, the "Server assignment in the area overview" list cannot be edited. The list shows only the server and the local computer. The lists "Visible areas" and "Areas not needed" then contain all the areas available for display in the overview window.

Preview

Click "Preview". A preview window showing the arrangement of the areas will open. This display shows the generated overview schematically.

While the preview window is open, you can further configure the sequence of the area and server buttons. Each change is immediately updated in the preview.

The "Preview" button can only be used when the selected layout supports the generic creation of area buttons in the overview window.
Access to areas missing authorization

In the User Administrator, you specify the area-specific access rights for users in runtime. However, you can also allow users to select pictures and group displays of areas for which they have no authorization.

Users without access rights to areas have the following access options:

- Picture selection is not possible. The user has no access to this area (standard behavior)
- The picture can be selected using area button. The user can select the pictures of these areas for monitoring purposes. Access to the group displays in the overview and Picture Tree Navigator is not permitted. Area-specific messages are not visible. Operator process controls with PCS 7 picture components are not possible, operator inputs in process pictures depends on the configuration in the pictures.
- Picture can be selected using both the area button and the group display. The user can select the pictures of these areas for monitoring purposes. Access to the group displays in the overview and Picture Tree Navigator is permitted. Area-specific messages are not visible. Operator process controls with PCS 7 picture components are not possible, operator inputs in process pictures depends on the configuration in the pictures.

Note

The first time you call the OS Project Editor, the "Visible areas" list shows all areas that were configured in the Picture Tree Manager of the OS. The servers are listed in package import sequence.

If the sequence has already been configured and further areas or servers are added, these appear at the end of the list. If areas or servers are omitted, they are deleted from the configuration.

See also

How to change the sequence of areas (Page 68)
How to change the sequence of the servers on the WinCC client (Page 67)
How to Hide an Area (Page 69)
How to arrange "Empty buttons" (Page 69)

2.7.2 How to change the sequence of the servers on the WinCC client

Introduction

You can change the sequence and arrangement of the server keys in the overview area of the WinCC client. The servers are ordered from left to right and then from top to bottom.
OS Project Editor

2.7 The "Areas" Tab

Procedure

1. Open the OS Project Editor.
   Select the server from the "Server arrangement in the area overview" list in the "Areas" tab.

2. Move the server to the desired position by clicking "Up" and "Down".

3. If the layout does not support "Server View", this list is not activated. You should then select all areas of the server in the "Visible areas" list and move these to the required position by clicking Up" and "Down".

4. Click "Preview". The "Area preview" window opens, and you can follow the configuration.

5. Check the settings in the "Basic Data" tab to avoid any unwanted data overwrites.

See also

"Areas" Tab (Page 64)
"Basic data" tab (Page 78)

2.7.3 How to change the sequence of areas

Introduction

You can change the sequence and arrangement of the area buttons in the overview window by moving individual areas. The areas are ordered from left to right and then from top to bottom.

Procedure

1. Open the OS Project Editor and the "Areas" tab.
   Select the area from the "Visible Areas" list.

2. Click "Up" or "Down" to move this area to the required position.

3. Click "Preview". The "Area preview" window opens, and you can follow the configuration.

4. If necessary select further areas that you wish to move.

5. Check the settings in the "Basic Data" tab to avoid any unwanted data overwrites.

See also

"Areas" Tab (Page 64)
"Basic data" tab (Page 78)
2.7.4 How to Hide an Area

Introduction
If not all the system areas are intended for runtime operation, for example, reserve areas, you can hide the currently unneeded areas. This procedure is also practical on the WinCC clients, where not all of areas of all servers need to be operated.

Procedure
1. Open the OS Project Editor and the "Areas" tab.
   Select the area from the "Visible Areas" list.
2. Move this area to the list of "Areas not needed" by clicking "->".
3. Click "Preview". The "Area preview" window opens, and you can follow the configuration.
4. Check the settings in the "Basic Data" tab to avoid any unwanted data overwrites.

See also
"Areas" Tab (Page 64)
"Basic data" tab (Page 78)

2.7.5 How to arrange "Empty buttons"

Introduction
"Empty buttons" serve as placeholders for the positioning of area buttons in the overview area. Plant areas are not assigned to these buttons until later. This method avoids having to move a number of area buttons around later. Plant operators work with a familiar area overview, even after an expansion.

Procedure
1. Open the OS Project Editor and select the "Areas" tab.
   Select the "<Empty Button>" entry from the "Areas not needed" list.
2. Click "<-". This entry is placed in the "Visible areas" list.
3. Click "Up" or "Down". You will move this area to the desired position.
4. Click "Preview". The "Area preview" window opens, and you can follow the configuration.
5. Check the settings in the "Basic Data" tab to avoid any unwanted data overwrites.
2.7 The "Areas" Tab

See also

"Areas" Tab (Page 64)
"Basic data" tab (Page 78)
Loop display and process window (Page 73)
Group display (Page 75)
Trend group display (Page 77)
2.8 The “Runtime window” tab

2.8.1 "Runtime window" tab

Introduction

You configure the number and arrangement settings of the pre-configured picture windows in the “Runtime Window” tab. In runtime these picture windows contain pictures and faceplates that overlay the working area.

![Image of OS Project Editor runtime window configuration](image_url)
Picture window display modes

- **Loop Display / Process Window**
  The picture window in the loop display and in the process window is not zoomed in or out to fit the size of the open picture. The window has scroll bars and the size of the window can be changed. You can choose whether you want to position the picture window in a grid or according to the group display. For grid mode, specify the "Number of windows horizontally" and the "Number of windows vertically". If you wish to set the display format yourself, activate the "User defined" check box and click "Detail". A dialog opens allowing you to make the desired settings.

- **Group display / Process window**
  The picture window in the group display and in the process window is zoomed in or out to fit the size of the open picture. The picture window has no scroll bars and the size of the window cannot be changed. When you click "Detail", the "Group Display" dialog box for positioning the windows will open.

- **Trend groups**
  Trend groups you configured using the "Trend online" function are displayed in a picture window which is adapted to fit the size of the open picture. The picture window has no scroll bars and the size of the window can be changed. The picture is scaled to match the change in size. The configuration corresponds to the picture window configuration for the group display.

  In the "Maximum Number of Windows" field, define in each case the maximum number of picture windows permitted to be displayed. Either enter the value directly in the input field, or use the slider or the spin box. The input limits are predefined by the layout and are displayed alongside the slider.

Faceplates in the Picture Window

In this input box, you configure the maximum number of the following faceplates in the picture window:

- **Faceplates that are displayed simultaneously on each monitor**
  Up to four faceplates can be displayed, irrespective of the faceplate instance and of the picture window layout. When a picture component opens and the number of open picture components exceeds the configured number, a faceplate already open is closed.

- **Faceplates that are displayed simultaneously by the same instance of the faceplate**
  Up to four faceplates of the same instance can be displayed, irrespective of the monitor and the picture window layout. When a faceplate opens and the number of open faceplates of the same instance exceeds the configured number, a faceplate of this instance that is already open is closed.

Picture Tree Navigator

In Runtime, click a button to open the Picture Tree Navigator window in the overview area in order to display the picture hierarchy arranged in the Picture Tree Manager.

When you select the "Close window for picture selection" check box, the Picture Tree Navigator window closes as soon as a picture in the hierarchy is selected.
See also

- Loop display and process window (Page 73)
- Group display (Page 75)
- Trend group display (Page 77)

2.8.2 Loop display and process window

Introduction

Loop display gives a detailed display of faceplates. Process windows display processes.

Both the loop display and the process window use windows that do not adapt to the size of picture being displayed. The windows have scroll bars and the size of the windows can be changed. The windows can be displayed either in a grid or in an arrangement similar to the group display.

Grid display

Each window has the same size and is positioned in a grid. The input boxes called "Number of windows horizontally" and "Number of windows vertically" on the "Runtime Windows" tab make dimensioning and positioning the windows in the grid an easy matter. Either enter the number straight into the input field, or else use the slider or the spin box.
User defined display

Activate the "User defined" check box on the "Runtime Windows" tab and click "Detail". The "Loop Display/Process Window" dialog box will open.

Set up the values in the following input boxes either by entering the values straight into the input box or else by using the slider or the spin box:

- "Window Width" and "Window Height"
  Define the window’s dimensions at these parameters.

- "Top" and "Left"
  Define the position of the first window at these parameters relative to the coordinate origin of the working area.

- "Horizontally displaced" and "Vertically displaced"
  Define the position of the next window relative to the previous windows at these parameters.

The "Graphic positioning" allows you to position the windows with ease. To do so, click "Detail".
Note

The settings are limited by layout-specific considerations. If nothing is specified in the configuration file, up to 16 windows are possible. Grids have from 1 to 4 fields available in both dimensions. The following settings are suggested by the OS Project Editor:

- The windows have a size of 150 x 120 pixels.
- The position is 20 pixels from the top and 20 pixels from the left.
- The next window is displaced horizontally and vertically by 10 pixels.

See also

Graphic positioning of a runtime window (Page 78)
"Runtime window" tab (Page 71)

2.8.3 Group display

Introduction

Group displays provide a compressed display of picture modules and use windows that adapt to the size of picture being displayed. The windows have no scroll bars and the size of the windows cannot be changed.
Window settings

Use the "Group Display" dialog box to position windows. Since the size of the windows cannot be changed, you cannot set their width and height. However, you can specify the window position.

Set up the values in the following input boxes either by entering the values straight into the input box or else by using the slider or the spin box:

- "Top" and "Left"
  Define the position of the first window at these parameters relative to the coordinate origin of the working area.

- "Horizontally displaced" and "Vertically displaced"
  Define the position of the window relative to the previous window at these parameters.

The "Graphic positioning" allows you to position the windows with ease. To do so, click "Detail".
Note

The settings are limited due to layout-specific aspects. If an entry in the configuration file is missing, the following settings apply:

- The maximum number of picture windows is limited from 1 to 16.
- The window's size is adapted to fit the picture size.
- The positions of the windows are limited to a value between 0 pixels and the width or height of the working area.
- You can only move the windows within the range from 0 to 100 pixels.

The following settings are suggested by the OS Project Editor:

- The position is 20 pixels from the top and 20 pixels from the left.
- The next window is displaced horizontally and vertically by 10 pixels.

See also

Graphic positioning of a runtime window (Page 78)
"Runtime window" tab (Page 71)

2.8.4 Trend group display

Introduction

Configure the trend groups generated using the "Online Trend Control" function in the same way as for "Loop display". Windows adapt to the size of the picture being displayed. They have no scroll bars and their size can be changed. When you change the size, the picture is also scaled.

See also

Loop display and process window (Page 73)
"Runtime window" tab (Page 71)
2.8.5 Graphic positioning of a runtime window

Introduction

In the picture window display dialog boxes, you can open a dialog box for easier positioning of the windows. To do so, click “Detail” in the “Graphic Positioning” group. The following dialog box will open.

![Graphic positioning dialog box]

Procedure

1. Move the window to the position you want it to occupy in runtime and drag it to the appropriate size with the mouse.

2. Click “OK”.
   This closes the window and enters the size and position “Window Width”, “Window Height”, “Top” and “Left” fields.

You cannot position the window outside the working area of the runtime user interface.

See also

“Runtime window” tab (Page 71)

2.9 "Basic data" tab

Introduction

Basic data includes picture files, actions and standard functions for the purpose of providing a suitable user interface in runtime. The "Basic Data" tab shows which elements of the initialized basic data differ from the basic data that are local to the project. The picture settings are dependent on the layout concerned. The entries in the lists change in step with changes in the picture and script configurations.

In this tab, you can specify which modified files of the project are to be overwritten by files in the delivered state. However, consistent runtime operation must be ensured. You must overwrite the list entries highlighted in red. You cannot deactivate the check boxes.
Overwriting modified basic pictures in the project

The picture files list (upper left) shows all the basic pictures in the project which have time stamps that do not match those of the pictures in the delivered state. This may have arisen due to a newer version of the basic data or the pictures concerned may have been configured by the user.

Entries in the "Project" column show the dates of the files in the project path. Entries in the "Product" column show the dates of the files in the installation folder.

If there is a check mark against an entry in the list, the basic picture will be replaced in the project by the picture that was supplied as the product.
Note

If "BATCH Engineering" or "BATCH Client" is installed on the computer at the same time, the picture "@AlarmJournal.PDL" will be shown to differ from the originally delivered version.

Overwriting project actions that are local to the computer

The list of actions local to the computer (upper right) shows all actions with time stamps that do not match those of the actions in the delivered state. This may have arisen due to a newer version of the basic data or the actions concerned may have been configured by the user.

Entries in the "Project" column show the respective dates of the files in the project path. Entries in the "Product" column show the respective dates of the files in the installation folder.

If there is a check mark against an entry in the list, the modified action will be replaced in the project by the action that was supplied as the product.
Overwriting picture modules in the project

This list is available only in a PCS7 OS. If WinCC and Basic Process Control are installed, the list is disabled and grayed out.

The picture modules list (lower left) shows the picture modules with time stamps that match neither those of the picture modules in the product library in the folder "\<Product>\Options\pdl\FaceplateDesigner_V6" nor those of the picture modules in the user library in the folder "\<Product>\Options\pdl\FaceplateDesigner". This may have arisen due to a newer version of the basic data or the picture modules concerned may have been configured by the user.

Entries in the "Project" column show the dates of the files in the project path. Entries in the "Product Library" column show the dates of the files in the installation folder.

If there is a check mark against an entry in the list, the picture component from the product and user libraries is adopted.
Duplicated picture modules in the product and user libraries

This list is available only in a PCS7 OS. If WinCC and Basic Process Control are installed, the list is disabled and grayed out.

The list (lower right) shows all picture modules that are present in both the product library and the user library. This may have arisen due to a newer version of the basic data or the picture modules concerned may have been configured in the Faceplate Designer.

Entries in the "User Library" column show the dates of the files in the user library in the folder "\<Product>\Options\pdl\FaceplateDesigner".

Entries in the "Product Library" column show the respective dates of the files in the product library in the folder "\<Product>\Options\pdl\FaceplateDesigner_V6".

Picture components with a check mark alongside will be adopted from the user library.

The lower two lists of face plates are interdependent. If a modified picture component that is local to the project and shown in the left-hand list is flagged not to be overwritten, it will in fact not be overwritten by a picture component from the user library.

Updating the Dynamic Wizard scripts

Use the "Update Dynamic Wizard Scripts" check box to define whether all the files associated with the Dynamic Wizard scripts will be overwritten. You cannot select individual files. If the check box is selected, associated files local to the project will be replaced by the files in the delivered state.

Updating the screen composition for startup

If you select the "Update screen for start up" check box, the screen that is local to the project will be overwritten. This is the special screen that is stored for all users of the project as "Default.ssm". Thus, the users have a common start screen, which opens during logon instead of the "Welcome.pdl". A separate start screen can be created for each user. However, this file is not overwritten.

Updating the configuration of the Graphics Object Update Wizard

The Graphics Object Update Wizard requires configuration files that are copied from the OS Project Editor into the project folder. The configuration files make it possible to exchange instance-specific picture information and script information centrally. If you select the "Update Graphics Object Update Wizard configuration" check box, modified configuration files that are local to the project are replaced by the configuration files in the delivered state.

Updating the audio files for the horn

Use the check box headed "Update sound files for the horn" to define whether all the files that the horn uses for output via the sound card will be overwritten. You cannot select individual files. If you select the check box, the sound files local to the project will be replaced by the sound files in the delivered state.
2.10 "General" tab

Introduction

The "General" tab contains settings for the OS Project Editor.

Activities when Processed by Project Editor

In the "Activities when processed by project editor" group, you specify which of the following settings are to be transferred during processing by the OS Project Editor:

- Only the settings that allow changing data in runtime ("Load Online Changes")
- All settings
- Only the settings of the message configuration
Select the "Only configurations capable of online download of changes" radio button if you want to reconfigure all settings except for the alarm system and startup list. All OS Project Editor control fields whose settings are not sent to the project are disabled. This option is the default when the editor is not used for the first time.

When configuration is complete the full runtime system and alarm system are transferred to the project over again. When the OS Project Editor is started for the first time, this is the only available setting in the project. Since a complete configuration is associated with the loss of load online change capability, the following notice appears if the project is still capable of performing "Load Online Changes":

![Warning dialog for online Delta-loading](image)

When you click "Yes", the settings you have made are accepted into the project. When you click "No", the operation is canceled.

If the OS Project Editor has executed a basic run once with the setting "Project documentation for the current configuration", it does not mean that this project has lost the capability for load online changes forever. To restore the load online change capability, you only have to transfer the complete OS from PCS 7 ES once.

The "Message configuration only" radio button is intended for users that want to create a project with STEP 7 and transfer the configured messages to WinCC without having to use the user interface of Basic Process Control or PCS 7. All OS Project Editor control fields whose settings are not sent to the project are disabled. The basic data, such as the graphics, are not transferred into the project. The startup list and starting picture are not set in the computer properties.

**Note**

If you add a client computer to a server project, you must afterward run the OS Project Editor with the setting "Project documentation for the current configuration".

---

**Logging the activities of the project editor**

You can make the settings for the log file in the "Log the actions of the Project Editor" group. The log file contains the most important project settings you have made in the OS Project Editor, for example, the files you have copied or the messages you have created. The log can also included entries about errors that occur.

To create a log, select one of the following options from the "Type of logging" drop down list box:

- No log
- Text log
- HTML log
The log file that is created is placed in one of the following directories:

- Text log: \<Project>\SSM\Projecteditor.txt
- HTML log: \<Project>\SSM\Projecteditor

In the "Display the log file after the configuration is completed" drop down list box, select one of the following options:

- Not displayed
- Always displayed
- Only show in the event of an error.

The log is opened in Notepad if it is registered or in a registered browser.

In the "Behavior if there is already a log file" drop down list box you can specify whether the new log should overwrite the previous entries in the existing log file or whether it should be appended to the current entries. When the OS Project Editor is run often, the "Append" setting can result in very large files. For this reason, we recommend the "Overwrite" setting.

The log is created in the language used for the OS Project Editor. Some of the log entries come from the operating system and are displayed in language selected for the system.

---

**Project Documentation for the Current Configuration**

When you click "Print Project Documentation", you print the configuration data on the assigned printer. Printing begins immediately after you click the button.

When you click "Project-Documentation View", you open a preview of the pages to be printed. Here, you check the page view. It displays the pages as they will look when printed.

When you click "Printer Setup", you configure the print job. In the dialog box tab, you select the printer and the layout, specify the start parameters, and determine the print scope.

**Current configuration**

To use the same project editor configuration for several OS projects, you can export and import the data of the project editor.

If you wish to export the configuration of the project editor, the project editor must have run through the project beforehand. Click "Export...". The file selection dialog box opens. Enter the path and file name in the dialog box. The default path is that of the current WinCC project and the default file extension is "*.exp".

Click "Import..." if you want to import configuration file from the Project Editor. Select this configuration file from the file selection dialog box. The information contained in the imported file is displayed in the project editor. To accept the imported configuration data in the project, click "OK" or "Apply".

**See also**

"OS Project Editor" (Page 45)
2.11 Structure of the configuration file

User-specific configuration file

Pre-configured layouts complete with their respective configuration files are available in the OS Project Editor. You do not have to change anything in the configuration files.

Experienced developers can create a configuration file of their own. For this purpose a sample file has been prepared and is held in the folder of configuration files, to which the developer should refer.

2.12 Overview of the Process Control Messages

Overview of the Process Control Messages

<table>
<thead>
<tr>
<th>Message No.</th>
<th>Message Class</th>
<th>Message text</th>
<th>Created for</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000204</td>
<td>OS process control system messages</td>
<td>Connection @6%s@ not established</td>
<td>WinCC</td>
<td>@6%s@ = Name of the connection</td>
</tr>
<tr>
<td>1000205</td>
<td>OS process control system messages</td>
<td>Connection @6%s@ established</td>
<td>WinCC</td>
<td>@6%s@ = Name of the connection</td>
</tr>
<tr>
<td>1000900</td>
<td>OS process control system messages</td>
<td>PERFMON:@7%s@ is low</td>
<td>System monitor</td>
<td>@7%s@ = Monitored value</td>
</tr>
<tr>
<td>1000902</td>
<td>OS process control system messages</td>
<td>PERFMON:@7%s@ is high</td>
<td>System monitor</td>
<td>@7%s@ = Monitored value</td>
</tr>
<tr>
<td>1000904</td>
<td>OS process control system messages</td>
<td>PERFMON:@7%s@ is low</td>
<td>System monitor</td>
<td>@7%s@ = Monitored value</td>
</tr>
<tr>
<td>1000906</td>
<td>OS process control system messages</td>
<td>PERFMON:@7%s@ is high</td>
<td>System monitor</td>
<td>@7%s@ = Monitored value</td>
</tr>
<tr>
<td>1000908</td>
<td>Preventive maintenance</td>
<td>PERFMON:@7%s@ is low</td>
<td>System monitor</td>
<td>@7%s@ = Monitored value</td>
</tr>
<tr>
<td>1000910</td>
<td>Preventive maintenance</td>
<td>PERFMON:@7%s@ is high</td>
<td>System monitor</td>
<td>@7%s@ = Monitored value</td>
</tr>
<tr>
<td>1000912</td>
<td>PLC process control messages</td>
<td>Loss of redundancy of terminal adapter @2%s@</td>
<td>System monitor</td>
<td>@2%s@ = MAC address</td>
</tr>
<tr>
<td>1000915</td>
<td>PLC process control messages</td>
<td>Terminal adapter @2%s@ disconnected</td>
<td>System monitor</td>
<td>@2%s@ = MAC address</td>
</tr>
<tr>
<td>Message No.</td>
<td>Message Class</td>
<td>Message text</td>
<td>Created for</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>---------------</td>
<td>--------------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>1003101</td>
<td>Operator Input Message</td>
<td>@102%s@: Acknowledgment @9%s@, @8%s@ on @100%s@</td>
<td>WinCC</td>
<td>@102%s@= User @9%s@= Message class @8%s@= Message type @100%s@= Computer name</td>
</tr>
<tr>
<td>1003107</td>
<td>Operator Input Message</td>
<td>@102%s@: Hide Manually @9%s@, @8%s@ on @100%s@</td>
<td>WinCC</td>
<td>@102%s@= User @9%s@= Message class @8%s@= Message type @100%s@= Computer name</td>
</tr>
<tr>
<td>1003108</td>
<td>Operator Input Message</td>
<td>@102%s@: Show Manually @9%s@, @8%s@ on @100%s@</td>
<td>WinCC</td>
<td>@102%s@= User @9%s@= Message class @8%s@= Message type @100%s@= Computer name</td>
</tr>
<tr>
<td>1003109</td>
<td>OS process control system messages</td>
<td>The connection to the master was interrupted</td>
<td>WinCC</td>
<td></td>
</tr>
<tr>
<td>1009000</td>
<td>OS process control system messages</td>
<td>LBMRT:Error</td>
<td>Lifebeat monitoring runtime</td>
<td></td>
</tr>
<tr>
<td>1009999</td>
<td>OS process control system messages</td>
<td>LBMRT: Tag @2%s@ does not exist</td>
<td>Lifebeat monitoring runtime</td>
<td>@2%s@ = Name of the tag of a monitored device</td>
</tr>
<tr>
<td>1010101</td>
<td>OS process control system messages</td>
<td>CAS:Starts archive service</td>
<td>Central Archive Server</td>
<td></td>
</tr>
<tr>
<td>1010102</td>
<td>OS process control system messages</td>
<td>CAS:Archive service is running</td>
<td>Central Archive Server</td>
<td></td>
</tr>
<tr>
<td>1010103</td>
<td>OS process control system messages</td>
<td>CAS: Archive server cannot be started, error: @3%s@</td>
<td>Central Archive Server</td>
<td>@3%s@ = Error text</td>
</tr>
<tr>
<td>1010104</td>
<td>OS process control system messages</td>
<td>CAS:Stops archive service</td>
<td>Central Archive Server</td>
<td></td>
</tr>
<tr>
<td>1010105</td>
<td>OS process control system messages</td>
<td>CAS: Archive service could not be stopped, error: @3%s@</td>
<td>Central Archive Server</td>
<td>@3%s@ = Error text</td>
</tr>
<tr>
<td>1010106</td>
<td>OS process control system messages</td>
<td>CAS: Medium backup '@2%s@' completed successfully.</td>
<td>Central Archive Server</td>
<td>@2%s@ = Database segment</td>
</tr>
<tr>
<td>1010107</td>
<td>OS process control system messages</td>
<td>CAS: Backup process failed, error: @3%s@</td>
<td>Central Archive Server</td>
<td>@3%s@ = Error text</td>
</tr>
<tr>
<td>1010108</td>
<td>OS process control system messages</td>
<td>CAS: Created backup media '@2%s@'</td>
<td>Central Archive Server</td>
<td>@2%s@ = Database segment</td>
</tr>
<tr>
<td>1010109</td>
<td>OS process control system messages</td>
<td>CAS: Closed backup medium '@2%s@'</td>
<td>Central Archive Server</td>
<td>@2%s@ = Database segment</td>
</tr>
<tr>
<td>Message No.</td>
<td>Message Class</td>
<td>Message text</td>
<td>Created for</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>---------------</td>
<td>--------------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>1010110</td>
<td>OS process control system messages</td>
<td>CAS: Connected backup '@2%s@'</td>
<td>Central Archive Server</td>
<td>@2%s@ = Database segment</td>
</tr>
<tr>
<td>1010111</td>
<td>OS process control system messages</td>
<td>CAS: Backup connection failed, error: @3%s@</td>
<td>Central Archive Server</td>
<td>@3%s@ = Error text</td>
</tr>
<tr>
<td>1010112</td>
<td>OS process control system messages</td>
<td>CAS: Backup &quot;@2%s@&quot; disconnected</td>
<td>Central Archive Server</td>
<td>@2%s@ = Database segment</td>
</tr>
<tr>
<td>1010113</td>
<td>OS process control system messages</td>
<td>CAS: Backup disconnection failed, error: @3%s@</td>
<td>Central Archive Server</td>
<td>@3%s@ = Error text</td>
</tr>
<tr>
<td>1010114</td>
<td>OS process control system messages</td>
<td>CAS: Import from archive '@2%s@' started</td>
<td>Central Archive Server</td>
<td>@2%s@ = Archive name</td>
</tr>
<tr>
<td>1010115</td>
<td>OS process control system messages</td>
<td>CAS: Import from archive '@2%s@' failed, error: @3%s@</td>
<td>Central Archive Server</td>
<td>@2%s@ = Archive name, @3%s@ = Error text</td>
</tr>
<tr>
<td>1010116</td>
<td>OS process control system messages</td>
<td>CAS: Import from archive '@2%s@' completed</td>
<td>Central Archive Server</td>
<td>@2%s@ = Archive name</td>
</tr>
<tr>
<td>1010117</td>
<td>OS process control system messages</td>
<td>CAS: archive '@2%s@', Error during application: @3%s@</td>
<td>Central Archive Server</td>
<td>@2%s@ = Archive name, @3%s@ = Error text</td>
</tr>
<tr>
<td>1010118</td>
<td>OS process control system messages</td>
<td>CAS: archive '@2%s@' applied</td>
<td>Central Archive Server</td>
<td>@2%s@ = Archive name</td>
</tr>
<tr>
<td>1010119</td>
<td>OS process control system messages</td>
<td>CAS: Start archive processing '@2%s@'</td>
<td>Central Archive Server</td>
<td>@2%s@ = Archive name</td>
</tr>
<tr>
<td>1010120</td>
<td>OS process control system messages</td>
<td>CAS: Data backup of '@2%s@' started</td>
<td>Central Archive Server</td>
<td>@2%s@ = Database segment</td>
</tr>
<tr>
<td>1010121</td>
<td>OS process control system messages</td>
<td>CAS: Data backup of '@2%s@' successfully completed.</td>
<td>Central Archive Server</td>
<td>@2%s@ = Database segment</td>
</tr>
<tr>
<td>1010122</td>
<td>OS process control system messages</td>
<td>No symbolic name could be assigned to the physical server.</td>
<td>Central Archive Server</td>
<td></td>
</tr>
<tr>
<td>1010123</td>
<td>OS process control system messages</td>
<td>Caution: No license found: Long-term archiving of the SIMATIC PCS7 StoragePlus Servers is therefore disabled</td>
<td>Central Archive Server</td>
<td></td>
</tr>
<tr>
<td>1010130</td>
<td>OS process control system messages</td>
<td>StoragePlus: Cannot create directory '@2%s@'. Error: '@3%s@'</td>
<td>StoragePlus</td>
<td>@2%s@ = Directory name, @3%s@ = Error text</td>
</tr>
<tr>
<td>1010131</td>
<td>OS process control system messages</td>
<td>StoragePlus: Cannot move file '@2%s@' to '@3%s@'. Error '@4%s@'</td>
<td>StoragePlus</td>
<td>@2%s@ = File name, @3%s@ = Directory name, @4%s@ = Error text</td>
</tr>
<tr>
<td>Message No.</td>
<td>Message Class</td>
<td>Message text</td>
<td>Created for</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>--------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>1011000</td>
<td>OS process control system messages</td>
<td>Group display error at start up</td>
<td>Group display</td>
<td></td>
</tr>
<tr>
<td>1011001</td>
<td>OS process control system messages</td>
<td>The group display hierarchy is not up-to-date.</td>
<td>Group display</td>
<td></td>
</tr>
<tr>
<td>1011002</td>
<td>OS process control system messages</td>
<td>Group display: Connection fault in @2%$s@</td>
<td>Group display</td>
<td>@2%$s@ is the tag name</td>
</tr>
<tr>
<td>1011003</td>
<td>OS process control system messages</td>
<td>Group display: Tag @2%$s@ does not exist</td>
<td>Group display</td>
<td>@2%$s@ is the tag name</td>
</tr>
<tr>
<td>1011018</td>
<td>Operator Input Message</td>
<td>@3%$s@: Block is locked to @6%$s@</td>
<td>Group display</td>
<td>@3%$s@ = User @6%$s@ = Computer name</td>
</tr>
<tr>
<td>1011019</td>
<td>Operator Input Message</td>
<td>@3%$s@: Block is released from @6%$s@</td>
<td>Group display</td>
<td>@3%$s@ = User @6%$s@ = Computer name</td>
</tr>
<tr>
<td>1011020</td>
<td>Operator Input Message</td>
<td>@2%$s@: Acknowledge faults in picture @3%$s@</td>
<td>Group display</td>
<td>@2%$s@ = User name @3%$s@ = Name of process picture</td>
</tr>
<tr>
<td>1011022</td>
<td>Operator Input Message</td>
<td>@3%$s@: Acknowledgment @4%$s@. @5%$s@ on @6%$s@</td>
<td>Group display</td>
<td>@3%$s@ = User @4%$s@ = Message class @5%$s@ = Message type @6%$s@ = Computer name</td>
</tr>
<tr>
<td>1011101</td>
<td>OS process control system messages</td>
<td>PTM: Error during startup</td>
<td>Picture Tree Manager</td>
<td>Internal error, please restart runtime. Restart WinCC if the problem persists</td>
</tr>
<tr>
<td>1011201</td>
<td>OS process control system messages</td>
<td>SSM: Error during startup</td>
<td>Split Screen Manager</td>
<td>Internal error, please restart runtime. Restart WinCC if the problem persists</td>
</tr>
<tr>
<td>1011202</td>
<td>OS process control system messages</td>
<td>The project drive is more than @2%$d@% full.</td>
<td>Split Screen Manager</td>
<td>@2%$d@% = Fill level in percentage</td>
</tr>
<tr>
<td>1011203</td>
<td>OS process control system messages</td>
<td>The project was created with the wrong WinCC version</td>
<td>Split Screen Manager</td>
<td></td>
</tr>
<tr>
<td>1011500</td>
<td>Operator Input Message</td>
<td>@2%$s@@3%$s@@4%$s@</td>
<td>@PCS 7</td>
<td>Not used</td>
</tr>
<tr>
<td>1011501</td>
<td>Operator Input Message</td>
<td>Server &quot;@2%$s@&quot; started</td>
<td>@PCS 7</td>
<td>@2%$s@ = Name of the PCS 7 computer</td>
</tr>
<tr>
<td>1011502</td>
<td>Operator Input Message</td>
<td>Server &quot;@2%$s@&quot; stopped</td>
<td>@PCS 7</td>
<td>@2%$s@ = Name of the PCS 7 computer</td>
</tr>
<tr>
<td>1011503</td>
<td>Operator Input Message</td>
<td>S2S: Server-Server link started</td>
<td>@PCS 7</td>
<td></td>
</tr>
<tr>
<td>1011504</td>
<td>Operator Input Message</td>
<td>S2S: Server-Server link stopped</td>
<td>@PCS 7</td>
<td></td>
</tr>
<tr>
<td>1011505</td>
<td>Operator Input Message</td>
<td>S2S: Server disturbed @2%$s@@3%$s@@4%$s@</td>
<td>@PCS 7</td>
<td>Placeholder is not used</td>
</tr>
<tr>
<td>1011506</td>
<td>Operator Input Message</td>
<td>S2S: Server active @2%$s@@3%$s@@4%$s@</td>
<td>@PCS 7</td>
<td>Placeholder is not used</td>
</tr>
</tbody>
</table>
### 2.12 Overview of the Process Control Messages

<table>
<thead>
<tr>
<th>Message No.</th>
<th>Message Class</th>
<th>Message text</th>
<th>Created for</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1011507</td>
<td>Operator Input Message</td>
<td>S2S: Job disturbed @2%s@@3%s@@4%s@</td>
<td>@PCS 7</td>
<td>@2%s@ = Order reference, @3%s@ = Connection status</td>
</tr>
<tr>
<td>1011508</td>
<td>Operator Input Message</td>
<td>S2S: Job active @2%s@@3%s@@4%s@</td>
<td>@PCS 7</td>
<td>@2%s@ = Order reference, @3%s@ = Connection status</td>
</tr>
<tr>
<td>1011509</td>
<td>Operator Input Message</td>
<td>No license found</td>
<td>@PCS 7</td>
<td></td>
</tr>
<tr>
<td>1011510</td>
<td>Operator Input Message</td>
<td>Login: Unknown user: &quot;@2%s@&quot;</td>
<td>Time synchronization</td>
<td>@2%s@ = User name</td>
</tr>
<tr>
<td>1011511</td>
<td>Operator Input Message</td>
<td>Login: Incorrect password for &quot;@2%s@&quot;</td>
<td>Time synchronization</td>
<td>@2%s@ = User name</td>
</tr>
<tr>
<td>1012001</td>
<td>OS process control system messages</td>
<td>@2%s@ switched to Master mode @3%s@</td>
<td>Time synchronization</td>
<td>@2%s@ = Device name, e.g., CP1613, @3%s@ = a) no time-master on bus b) worse time-master on bus</td>
</tr>
<tr>
<td>1012002</td>
<td>OS process control system messages</td>
<td>@2%s@ cannot send time signal</td>
<td>Time synchronization</td>
<td>@2%s@ = Device name, e.g., CP1613</td>
</tr>
<tr>
<td>1012003</td>
<td>OS process control system messages</td>
<td>Time reception service: Poor or failed signal</td>
<td>Time synchronization</td>
<td></td>
</tr>
<tr>
<td>1012004</td>
<td>OS process control system messages</td>
<td>@2%s@ cannot receive time signal</td>
<td>Time synchronization</td>
<td>@2%s@ = Device name, e.g., CP1613</td>
</tr>
<tr>
<td>1012005</td>
<td>OS process control system messages</td>
<td>@2%s@ cannot receive time signal</td>
<td>Time synchronization</td>
<td>@2%s@ = Device name, e.g., CP1613</td>
</tr>
<tr>
<td>1012006</td>
<td>OS process control system messages</td>
<td>@2%s@ no time, switching to backup device: @3%s@</td>
<td>Time synchronization</td>
<td>@2%s@ = Device name, e.g., CP1613, @3%s@ = Device name</td>
</tr>
<tr>
<td>1012007</td>
<td>OS process control system messages</td>
<td>@2%s@ can send time signal properly</td>
<td>Time synchronization</td>
<td>@2%s@ = Device name, e.g., CP1613</td>
</tr>
<tr>
<td>1012008</td>
<td>OS process control system messages</td>
<td>Time reception service functions properly</td>
<td>Time synchronization</td>
<td></td>
</tr>
<tr>
<td>1012009</td>
<td>OS process control system messages</td>
<td>@2%s@ can receive the time signal properly</td>
<td>Time synchronization</td>
<td>@2%s@ = Device name (Device 1)</td>
</tr>
<tr>
<td>1012010</td>
<td>OS process control system messages</td>
<td>@2%s@ can receive the time signal properly</td>
<td>Time synchronization</td>
<td>@2%s@ = Device name (Device 2)</td>
</tr>
</tbody>
</table>

MDM - WinCC/Options for Process Control System Manual, 11/2008,
<table>
<thead>
<tr>
<th>Message No.</th>
<th>Message Class</th>
<th>Message text</th>
<th>Created for</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1012011</td>
<td>OS process control system messages</td>
<td>@2%s@ switched to Slave mode @3%s@</td>
<td>Time synchronization</td>
<td>@2%s@ = Device name, e.g. CP1613 @3%s@ = a) another time-master detected b) because &lt;device-name&gt; switched If two devices have been configured as master and one device switches to standby mode, the other will be forced into standby mode as well. c) lost WinCC mastership If the WinCC server is a redundant server, it has permission to operate as time master on the bus. It then switches its devices to standby mode.</td>
</tr>
<tr>
<td>1012012</td>
<td>Operator Input Message</td>
<td>Time synchronization deactivated</td>
<td>Time synchronization</td>
<td></td>
</tr>
<tr>
<td>1012013</td>
<td>Operator Input Message</td>
<td>Time synchronization activated</td>
<td>Time synchronization</td>
<td></td>
</tr>
<tr>
<td>1012014</td>
<td>OS process control system messages</td>
<td>DCF77 client service has failed</td>
<td>Time synchronization</td>
<td></td>
</tr>
<tr>
<td>1012015</td>
<td>OS process control system messages</td>
<td>DCF-77 client service is working properly</td>
<td>Time synchronization</td>
<td></td>
</tr>
<tr>
<td>1012016</td>
<td>OS process control system messages</td>
<td>@2%s@ switched to Master mode @3%s@</td>
<td>Time synchronization</td>
<td>@2%s@ = Device name, e.g. CP1613 @3%s@ = a) no time-master on bus b) worse time-master on bus</td>
</tr>
<tr>
<td>1012017</td>
<td>OS process control system messages</td>
<td>@2%s@ switched to Slave mode @3%s@</td>
<td>Time synchronization</td>
<td>@2%s@ = Device name, e.g. CP1613 @3%s@ = a) another time-master detected b) because &lt;device-name&gt; switched If two devices have been configured as master and one device switches to standby mode, the other will be forced into standby mode as well. c) lost WinCC mastership If the WinCC server is a redundant server, it has permission to operate as time master on the bus. It then switches its devices to standby mode.</td>
</tr>
</tbody>
</table>
### 2.12 Overview of the Process Control Messages

<table>
<thead>
<tr>
<th>Message No.</th>
<th>Message Class</th>
<th>Message text</th>
<th>Created for</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1012018</td>
<td>OS process control system messages</td>
<td>@2%s@ cannot send time signal</td>
<td>Time synchronization</td>
<td>@2%s@ = Device name, e.g., CP1613</td>
</tr>
<tr>
<td>1012019</td>
<td>OS process control system messages</td>
<td>@2%s@ can send time signal properly</td>
<td>Time synchronization</td>
<td>@2%s@ = Device name, e.g., CP1613</td>
</tr>
<tr>
<td>1012020</td>
<td>OS process control system messages</td>
<td>@2%s@ presents the local time</td>
<td>Time synchronization</td>
<td>@2%s@ = Device name, e.g., CP1613</td>
</tr>
<tr>
<td>1012021</td>
<td>OS process control system messages</td>
<td>LAN Sync: time not synchronized with PC</td>
<td>Time synchronization</td>
<td>@2%s@ = Computer name</td>
</tr>
<tr>
<td>1012022</td>
<td>OS process control system messages</td>
<td>LAN Sync: time synchronization set to PC</td>
<td>Time synchronization</td>
<td>@2%s@ = Computer name</td>
</tr>
<tr>
<td>1012023</td>
<td>OS process control system messages</td>
<td>LAN Sync: time synchronized with PC</td>
<td>Time synchronization</td>
<td>@2%s@ = Computer name</td>
</tr>
<tr>
<td>1012024</td>
<td>OS process control system messages</td>
<td>Configured device name for the time synchronization does not agree with PC installation</td>
<td>Time synchronization</td>
<td></td>
</tr>
<tr>
<td>1012025</td>
<td>OS process control system messages</td>
<td>LAN Sync: Cannot acquire time from the connected WinCC server</td>
<td>Time synchronization</td>
<td></td>
</tr>
<tr>
<td>1012026</td>
<td>OS process control system messages</td>
<td>Time jump - switched to permanent slave mode</td>
<td>Time synchronization</td>
<td></td>
</tr>
<tr>
<td>1012027</td>
<td>OS process control system messages</td>
<td>Time jump - Time synchronization permanently deactivated</td>
<td>Time synchronization</td>
<td></td>
</tr>
<tr>
<td>1012028</td>
<td>OS process control system messages</td>
<td>Time reception service not started</td>
<td>Time synchronization</td>
<td></td>
</tr>
<tr>
<td>1012029</td>
<td>OS process control system messages</td>
<td>Time reception service running</td>
<td>Time synchronization</td>
<td></td>
</tr>
<tr>
<td>1012245</td>
<td>PLC process control messages</td>
<td>RedundancyControl: Loss of serial connection</td>
<td>Redundancy</td>
<td></td>
</tr>
<tr>
<td>1012247</td>
<td>PLC process control messages</td>
<td>OS server (Master) @1%s@ OS server (standby) @2%s@ redundancy error</td>
<td>Redundancy</td>
<td>@1%s@ = Computer name @2%s@ = Computer name</td>
</tr>
<tr>
<td>1012249</td>
<td>PLC process control messages</td>
<td>RedundancyControl: Connection of network card (MAC) address lost</td>
<td>Redundancy</td>
<td></td>
</tr>
<tr>
<td>1012264</td>
<td>PLC process control messages</td>
<td>communication breakdown (@8%s@)</td>
<td>Maintenance</td>
<td>@8%s@ = Name of device to which connection was lost</td>
</tr>
<tr>
<td>Message No.</td>
<td>Message Class</td>
<td>Message text</td>
<td>Created for</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>---------------</td>
<td>--------------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>1012266</td>
<td>PLC process control messages</td>
<td>current project deactivated (@8%s@)</td>
<td>Maintenance</td>
<td>@8%s@ = Name of enabled WinCC project</td>
</tr>
<tr>
<td>1012267</td>
<td>PLC process control messages</td>
<td>AS - OS connection interrupted (@8%s@)</td>
<td>Maintenance</td>
<td>@8%s@ = Name of faulty AS/OS connection (display of AS/OS connection in Simatic Shell)</td>
</tr>
<tr>
<td>1012268</td>
<td>PLC process control messages</td>
<td>Message synchronization for diagnostic messages is running.</td>
<td>Maintenance</td>
<td></td>
</tr>
<tr>
<td>1012269</td>
<td>PLC process control messages</td>
<td>There are more diagnostic messages of the type MAINTENANCE_ERROR.</td>
<td>Maintenance</td>
<td></td>
</tr>
<tr>
<td>1012270</td>
<td>PLC process control messages</td>
<td>There are more diagnostic messages of the type MAINTENANCE_DEMAND.</td>
<td>Maintenance</td>
<td></td>
</tr>
<tr>
<td>1012271</td>
<td>Preventive maintenance</td>
<td>There are more diagnostic messages of the type MAINTENANCE_REQUEST.</td>
<td>Maintenance</td>
<td></td>
</tr>
<tr>
<td>1012272</td>
<td>OS process control system messages</td>
<td>Error while exporting identification data.@2%s@</td>
<td>Maintenance</td>
<td>@2%s@ = Free text The following texts are currently available (in English): - &quot;Initialization error!&quot; - &quot;Failed to build the list of servers!&quot; - &quot;Failed to obtain project path&quot; - &quot;Failed to enumerate server information!&quot; - &quot;I/O Write error!&quot; - &quot;Unspecified error!&quot;</td>
</tr>
<tr>
<td>1012273</td>
<td>PLC process control messages</td>
<td>There are more maximum-priority diagnostic messages.</td>
<td>Maintenance</td>
<td></td>
</tr>
<tr>
<td>1012291</td>
<td>Operator Input Message</td>
<td>@2%s@: Message system cleaned up</td>
<td>Maintenance</td>
<td>@2%s@ = User name</td>
</tr>
<tr>
<td>1012292</td>
<td>Operator input message</td>
<td>@2%s@: Single export @3%s@ @4%s@</td>
<td>Maintenance</td>
<td>@2%s@ = User name</td>
</tr>
<tr>
<td>1012293</td>
<td>Operator input message</td>
<td>@2%s@: Complete export of ident data</td>
<td>Maintenance</td>
<td>@2%s@ = User name</td>
</tr>
<tr>
<td>1012294</td>
<td>Operator input message</td>
<td>@2%s@: Save filtered complete export @3%s@ in @4%s@</td>
<td>Maintenance</td>
<td>@2%s@ = User name @3%s@ = @4%s@ =</td>
</tr>
<tr>
<td>1012295</td>
<td>OS process control system messages</td>
<td>Single export @3%s@ @4%s@. Fault: @5%s@</td>
<td>Maintenance</td>
<td>@3%s@ = @4%s@ = @5%s@ =</td>
</tr>
<tr>
<td>1012296</td>
<td>OS process control system messages</td>
<td>Complete export ident data, Fault: @5%s@</td>
<td>Maintenance</td>
<td>@5%s@ =</td>
</tr>
<tr>
<td>1012297</td>
<td>OS process control system messages</td>
<td>Save filtered complete export @3%s@ in @4%s@. Fault @5%s@</td>
<td>Maintenance</td>
<td>@3%s@ = @4%s@ = @5%s@ =</td>
</tr>
<tr>
<td>Message No.</td>
<td>Message Class</td>
<td>Message text</td>
<td>Created for</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>---------------</td>
<td>--------------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>1012301</td>
<td>OS process control system messages</td>
<td>No Access to the SQL Server, Data Loss Possible.</td>
<td>Common archiving</td>
<td></td>
</tr>
<tr>
<td>1012349</td>
<td>PLC process control messages</td>
<td>RedundancyControl: Connection of network card with MAC address lost @2%s@</td>
<td>Redundancy</td>
<td>@2%s@ = MAC address</td>
</tr>
<tr>
<td>1013001</td>
<td>Operator Input Message</td>
<td>@7%s@ / @6%s@ new = @3%g@ @8%s@ old = @2%g@ @8%s@</td>
<td>Libraries</td>
<td>@7%s@ = Operator, @6%s@ = Operating text, @3%g@ = New value, @8%s@ = Unit, @2%g@ = Old value</td>
</tr>
<tr>
<td>1013002</td>
<td>Operator Input Message</td>
<td>@2%s@ @3%s@ @4%s@</td>
<td>SFC</td>
<td></td>
</tr>
<tr>
<td>1013003</td>
<td>Operator Input Message</td>
<td>@7%s@ @6%s@ new = @5%g@ @8%s@ old = @4%g@ @8%s@</td>
<td>PCS 7</td>
<td>@7%s@ = Operator, @6%s@ = Operating text, @5%g@ = New value, @8%s@ = Unit, @4%g@ = Old value</td>
</tr>
<tr>
<td>1013004</td>
<td>Operator Input Message</td>
<td>@7%s@ @6%s@ new = @5%g@ @8%s@ old = @4%g@ @8%s@</td>
<td>PCS 7, SIMATIC BATCH, libraries</td>
<td>@7%s@ = Operator, @6%s@ = Operating text, @5%g@ = New value, @8%s@ = Unit, @4%g@ = Old value</td>
</tr>
<tr>
<td>1013005</td>
<td>Operator Input Message</td>
<td>@7%s@ @6%s@ new = @5%s@ old = @4%s@</td>
<td>SIMATIC BATCH</td>
<td>@7%s@ = Operator, @6%s@ = Operating text, @5%s@ = New value, @4%s@ = Old value</td>
</tr>
<tr>
<td>1013007</td>
<td>Operator Input Message</td>
<td>@7%s@ @2%s@ @3%s@ @4%s@</td>
<td>SFC</td>
<td></td>
</tr>
<tr>
<td>1013008</td>
<td>Operator Input Message</td>
<td>@7%s@ @4%s@ @5%s@ @6%s@</td>
<td>SFC, SIMATIC BATCH</td>
<td>@7%s@ = Operator, @4%s@ = Free operating text, @5%s@ = Continuation of free operating text, @6%s@ = Continuation of free operating text</td>
</tr>
<tr>
<td>1013009</td>
<td>Operator Input Message</td>
<td>@7%s@ @6%s@ new = @5%s@ @8%s@ old = @4%s@ @8%s@</td>
<td>SIMATIC BATCH</td>
<td>@7%s@ = Operator, @6%s@ = Parameter name, @5%s@ = New value, @8%s@ = Unit, @4%s@ = Old value</td>
</tr>
</tbody>
</table>
2.13 Split Screen Manager

2.13.1 Picture Management in the activated project

Picture management

In an activated project, the Split Screen Manager manages the display data, the picture compositions, and the picture changes according to the picture hierarchy. You can address and retrieve the individual display areas using the API functions of the Split Screen Manager. You can also switch the language to the languages supplied in the Text Library.

The Split Screen Manager runs in the background of the active project. It cannot be accessed via the user interface.

The important features of the Split Screen Manager are the following:

- Manages the screen data
- Saves the screen composition
- Manages the plant membership of all displayed pictures
- Supports picture changes in accordance with the picture hierarchy created in the Picture Tree Manager
- Manages a picture stack (Picture Memory)
- Manages a picture storage (Picture Store)

The functions of the Split Screen Manager are only available in an activated WinCC project. The basic picture of the activated project is displayed in runtime. The upper part of the basic picture contains the overview window with the configured buttons. You call the WinCC pictures of the current project using the buttons.

The Split Screen Manager manages the display areas of all connected monitors using a basic picture. You configure the structure of the basic picture with the aid of the OS Project Editor.

<table>
<thead>
<tr>
<th>Message No.</th>
<th>Message Class</th>
<th>Message text</th>
<th>Created for</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1013010    | Operator Input Message | @7%s@  
@4%s@  
@5%s@  
@6%s@       | SIMATIC BATCH     | @7%s@ = Operator  
@4%s@ = Operating text  
@5%s@ = Function name  
@6%s@ = Reserved       |
| 1013011    | Operator Input Message | @7%s@  
@6%s@  
@8%s@  
@4%s@       | PCS 7             | @7%s@ = Operator  
@6%s@ = Operating text  
@8%s@ = Labeling of the "requirements number"  
@4%s@ = Requirements number specified by the operator       |
Note
The Split Screen Manager is a WinCC option and is only available to you if you have installed the "Basic Process Control" option pack.

2.13.2 Managing the Pictures

Managing the picture memory
In the Split Screen Manager, each working area has a dedicated picture memory in the basic picture. The picture memory is used as a simple way to store a picture in the working area. Such a picture can then be retrieved at any time, even more than once. Storing a new picture will overwrite the previous picture in the picture storage. A separate picture memory is kept for each working area in the basic picture. You use the following keys to save and call the picture in the picture memory:

The contents of the picture memory can be retrieved, changed or deleted using the API functions of the Split Screen Manager.

Managing the picture stack
The Split Screen Manager logs each picture change in the working area and enables you to recall the pictures previously displayed. In each working area in the basic picture there is a dedicated picture stack which stores the last eight picture names selected in each working area. You use the following button to select the previous picture in the stack:

You use the following button to select the next picture in the stack:
You retrieve the contents of the picture stack using the API functions of the Split Screen Manager.

**Note**
The authorizations for the pictures in the picture memory and picture stack are user-specific. Consequently, the picture memory and picture stack of all displays are deleted in their entirety every time the WinCC user changes.

**Support for picture changes in accordance with the picture hierarchy**
Prerequisite for this function is an existing system picture hierarchy that has been created with the Picture Tree Manager.

A picture can also be changed using the API functions of the Split Screen Manager. The runtime of the Split Screen Manager together with the runtime of the Graphics Designer will then perform the picture change according to the configured picture hierarchy.

**Managing the system association of pictures**
Every picture change is carried out via the runtime of the Split Screen Manager.

As a result, the runtime of the Split Screen Manager can provide information at all times about the association of the currently displayed pictures to the system (system hierarchy).

This information is the prerequisite for system-specific user authorization checking. System-specific user authorization checking can be activated and queried with the standard functions of Global Script and the appropriate API functions of the Split Screen Manager.

**Managing the screen data**
The Split Screen Manager supports up to four screens with the following areas:

- Working area
- Button area
- Overview area
- Process window (top window)
- Unrestricted number of pre-configured fields with permanently assigned pictures (special fields).

You can address and retrieve the individual display areas using the API functions of the Split Screen Manager.
2.13.3 Notes on Multi VGA

Introduction
You need a Matrox G450 MMS graphics card for the multi-VGA WinCC option. You can also use the predecessor model Matrox G200 MMS if you are prepared to accept some limitations:
- Matrox G200 MMS is only suitable for projects that do not require high performance.
- Matrox G200 MMS cannot be used with Windows Vista.
You can also use other graphics cards. However, Siemens only provides support for the Matrox G450 MMS graphics card.

Installing the card
The Matrox G450 MMS is a PCI module. Before installing the card, ensure that the corresponding system parameters are correctly set in the BIOS, e.g. "Primary Display = PCI VGA". Otherwise, all of the monitors remain dark and the boot messages are not displayed. Start the PC after installing the card and open the BIOS dialog box once more. Set the system parameter "Reset Configuration Data = 1" and exit BIOS by clicking the "Save" button.

Arranging the monitors
If you wish to configure more than one monitor for the destination device in runtime in the OS Project Editor, you need to arrange the monitors in ascending numerical order in the display properties of the Control Panel of the operating system:
- Two monitors arranged horizontally
  1 2
- Two monitors arranged vertically
  1
  2
- Four monitors arranged horizontally
  1 2 3 4
- Four monitors arranged in a cube
  1 2
  3 4

Note
The 1600 x 1200 resolution is only available for analog control of the monitors. The maximum resolution of 1280 x 1024 can be used on monitors controlled through DVI.
Invisible parts of application windows

Due to the properties of the operating system, application windows must be a certain size in order for all parts of the window to be visible. This, for example, affects windows that are divided or that contain additional output fields in the status bar. Depending on the configured display resolution and the number of screens (size of the desktop), a window might have to exceed the width of a monitor in order for all window parts to be displayed.

The runtime interface is not affected by this.

Using other graphics cards

Other graphics cards may deviate from the performance characteristics of the Matrox G450 MMS. This relates, for example, to the display of notes and objects such as dialog boxes and application windows. Take into consideration the special characteristics of the cards of the various manufacturers.

The following peculiarities are known:

- An object/window to be opened always appears on Monitor 1, the priority monitor.
- An object/window to be opened is displayed over several monitors.
- An object/window to be opened appears on the monitor on which the operation was performed using the mouse.
- An object/window to be opened always appears in its most recent position.

The Runtime user interface is affected by these peculiarities as well.

Depending on the operating system and driver (driver parameter assignment), a given module can react differently. You can download the latest driver version from the manufacturer from the Internet.

---

Note

Online help for multi-VGA

The WinCC online help does not support multi-VGA operation.

Optimizing performance

To optimize the image painting time with several monitors, set the "WinCC Classic" design in the WinCC project properties.

---

2.13.4 How to set the multi-VGA parameters for Windows XP and Server 2003

Introduction

You need to specify the settings of the a Matrox G450 MMS graphics card for the multi-VGA WinCC option.
The multi-VGA option was tested with the listed Matrox modules and with driver version 5.96.005:

- G450 MMS DUAL (order no. 6ES7 652-0XX03-1XE0)
- G450 MMS QUAD (order no. 6ES7 652-0XX03-1XE1)
- G200 MMS DUAL (predecessor of G450 MMS DUAL)
- G200 MMS QUAD (predecessor G450 MMS QUAD).

The 5.96.005 driver is available in "Tools\Drivers\DISPLAY\Matrox_G450_MMS" on your WinCC DVD, or in "Additional_Products\Drivers\DISPLAY\Matrox_G450_MMS" on your PCS7 DVD.

Procedure

1. In the Windows Start menu, select "Settings > Control Panel > Display Adapter".
2. Expand the Windows Desktop to all monitors.
3. Select the color and resolution settings.
4. Click "Advanced...". The Matrox dialog box opens for detailed settings.
5. Set the desired frequency for each monitor in the "Monitor" tab.
6. Clear all unnecessary settings in the "Options" tab. Apply your settings as shown in the follows screen shots:

Matrox module G450 MMS:

![Matrox G450 MMS Options Settings](image)

Matrox module G200 MMS:
7. Do no make any settings in the "Multi-Display Setup" tab. Do not start "Matrox Hybrid Display" under any circumstance.
8. Close the dialog boxes for the screen setting and open the "Matrox Quick Desk" dialog box from the toolbox. Clear all options.
Matrox module G200 MMS and G450 MMS:

9. Troubleshooting in case of error:
Read the information in the "Troubleshooting" tab.
Matrox module G200 MMS:
Matrox module G450 MMS:
When using the "Windows Server 2003" operating system, the manufacturer especially recommends setting the slider for the hardware acceleration to "None". This means that some of the tabs in the dialog box remain hidden so that the corresponding setting options are not available. However, reducing the hardware acceleration to 0% can cause the system to slow down. For this reason, it may be useful to attain an optimal setting as follows:

- Set the slider to "None". Close the dialog box and restart the computer.
- Set the slider to "Maximum". Close the dialog box and restart the computer.
- If this does not correct the problem, reduce the hardware acceleration step-by-step.

**Note**

Depending on the computer / PC BIOS used, detection of some monitors could fail sporadically after installation of the graphics driver. Restart the computer in such situations. Remove the Matrox software by selecting "Start > Settings > Control Panel > Add and Remove Programs." Restart the computer to repeat your installation.
2.13.5 How to set the multi-VGA parameters for Windows Vista

Multi-VGA under Windows Vista

The Matrox module G200 MMS is no longer supported.

Driver 5.99.005 is used under Windows Vista for the Matrox module G450 MMS. Driver 5.96.005 is used under Windows 2003 and Windows XP, in contrast.

Note

The multi-VGA option was tested with the listed Matrox modules and with driver version 5.99.005:
- G450 MMS DUAL (order no. 6ES7 652-0XX03-1XE0)
- G450 MMS QUAD (order no. 6ES7 652-0XX03-1XE1)

You can find driver 5.99.005 on your WinCC DVD under "Tools\Drivers\DISPLAY\Matrox_G450_MMS".

Driver installation

You need to install the driver before initializing the graphics card. Proceed as follows:

1. Remove the previously used graphics card.
2. Shutdown the computer.
3. Install the Matrox G450 MMS graphics card and start the computer.
   The "New hardware found" dialog appears shortly after the computer starts.
4. Insert the WinCC product DVD into the DVD drive.
   In the "New hardware found" Windows dialog, select the option "Search for and install the driver software automatically (recommended) > Do not search online > Disk not available > Show other options > Search for driver software on the computer (advanced) > Browse". Navigate to on the WinCC DVD to the source of the driver installation and confirm with "Next".
5. Confirm the prompt in the "Windows Security" dialog with "Install".
6. Finish the installation with "Close" and restart the computer.

Note

Depending on the computer / PC BIOS used, detection of some monitors could fail sporadically after installation of the graphics driver. Restart the computer in such situations. Remove the Matrox software by selecting "Start > Control Panel > Programs and Functions". Restart the computer to repeat your installation. You can also open the driver folder in Windows Explorer and run "Setup.exe" with double-click.
Procedure

1. In the Windows Start menu, select "Settings > Control Panel > Appearance and Personalization". Select "Display Settings".
2. Expand the Windows Desktop to all monitors.
3. Select the color and resolution settings.
4. Click "Advanced Settings...".
5. Set the desired frequency for each monitor in the "Monitor" tab.
6. In the "Troubleshooting" tab, click "Change Settings" and set the hardware acceleration to "Maximum".
   Close the display settings.
7. Open the "Desktop Management" function by clicking on the "Matrox Power Desk" icon in the Windows task bar.
   Do not start the "Multi-display Setup" function. Do not make any settings under "Matrox Hybrid Display".
8. Clear all options.

9. Troubleshooting in case of error:
   In the "Troubleshooting" dialog, read the information on the various levels of hardware acceleration.
2.13.6 The "Loop in Alarm" Function

Loop in Alarm

The "Loop in Alarm" function is only available at a PCS 7 OS.
For a given measuring point that is exhibiting an alarm, you can use the "Loop In Alarm" function to display the picture component as a pie chart, or a process picture that has been linked with it in the Component List Editor. Open the Alarm Logging editor to configure "Loop in Alarm" function. In the "Loop in Alarm" column or in the Properties dialog box of individual messages you can find the "Loop in Alarm" function on the "Tag/Action" tab. The WinCC default here is "Open Picture".

Note
Skip steps 7 and 8 if the "Matrox PowerDesk" icon is not visible in the Windows taskbar after you installed the graphics driver.
In the "Picture name/Call parameter" input box, enter the measuring point name, e.g. "FIC_752_003". Replace "OpenPicture" with "LoopInAlarm" by selecting the "LoopInAlarm" function in the function browser under "Split Screen Manager" and clicking "OK". If you accidentally start "LoopInAlarm" by double-clicking, then click "Cancel" in the "Parameter Assignment" dialog box.

Note
Do not use the normal "Open Picture" function in the PCS 7 environment. A picture called using this function overlays the entire screen. Operator input is therefore no longer possible.
3.1 Horn

Content

With the "Horn" editor, you configure the output of message-related events on signal modules and PC sound cards.

This documentation includes the following topics:
- Linking signal tags to messages
- Declaring signal tags
- Defining message priorities and authorizations in signal tags
- Assigning signal encoders to a signal tag
- Installing and testing signal modules

3.2 General Information About the Audio Alarm

Functionality

With the horn, you control optical or acoustic sensors. Sound files are output when messages arrive. With the "Horn" editor, you can configure the signal that is to be triggered upon receipt of certain messages.

An incoming message activates a signal tag which then triggers an acoustic or optical signal in the assigned signaling device. If you confirm the message, the signal tag is reset and the signal is terminated.

You open the "horn" editor by double-clicking the horn entry or using the "Open" command from the shortcut menu in WinCC Explorer. You configure activation of the signal outputs by signal tags and the acknowledgement response in a client-server architecture in two tabs.

In the "Message Assignment" tab, you connect certain message properties to signal tags. The following message properties act as filters to trigger a signal:
- Message Class
- Message priority
- Source
In the "Authorization" column, you stipulate additionally whether the horn is to be triggered on a user-specific basis by messages from certain areas if the specified filter criteria are fulfilled. Every line forms a logical "AND" with six inputs. The signal tag is only set to "1" if all six conditions have been fulfilled. In the "Signal Assignment" tab, you configure the signals for the incoming messages. You assign available, physical signaling devices to the signal tags and define the acknowledgement response. Application examples show you the configuration of the acknowledgement response in a client-server system. You use the "Project Documentation" button to print out the configuration data of the horn.

Runtime response of the horn

If configuration is performed during runtime, please note that the horn is reinitialized. The signal transducer is acknowledged but queued alarms are triggered again. The alarm logging system has no influence over this response. Acknowledge the signal transducer once again. On activating runtime, the horn is only activated after the Alarm Logging system has started up. The standard delay is 30 seconds and can be modified in the "SSM.cfg" file of the project in the section "[RTControl]" using the "HornDelay" parameter. The value should not be less than 30 seconds. In the case of large projects, 60 seconds may perhaps be sensible. The signal transducer behaves in different ways, depending on the delay:

- In normal operation, the signal transducer is only triggered by alarms for a certain user, alarms which occur chronologically after the user has logged on. Alarms which occurred before logging on but have not yet departed are included in the new list but no longer trigger the signal transducer.
- If alarms occur between booting runtime and the user logging on, the signal transducer is triggered from the past for these alarms (after HornDelay has expired).

Note

The signal transducer is also triggered in runtime when the user is logged off.

See also

- Linking Signal Tags to Messages (Page 113)
- Minimum Horn Configuration (Page 127)
- General Information about the sound card (Page 128)
- Creating project documentation (Page 129)
- Application Examples for Acknowledgement Behavior (Page 130)
3.3 Limits on Voice Output in the Horn

Use on voice outputs

If you want to use voice outputs in the horn, note the following items when configuring:

- Keep the voice output as brief as possible.
- If possible, create small WAV files by generating the WAV files
  - in mono rather than stereo,
  - with medium, or wherever possible with a low quality (low sampling rate).
- Add up the size of all WAV files configured in the horn for each operating station and increase the RAM accordingly.
- To achieve clearly audible voice output, you must set the option "Limit number of simultaneously playing sounds" to "1" in the "Signal Assignment" tab of the horn. The more complex the spoken text is, the worse the simultaneously occurring outputs sound.

The limitation to one simultaneously playing sound means that if several messages are active only the WAV file of the highest priority is output until the horn is acknowledged. The priority is obtained from the position in the table in the "Signal Assignment" tab. Once the highest priority WAV file is acknowledged, the WAV file with the second highest priority is output, and so on. This can significantly delay the voice output.

Due to human nature, narrow limits are placed on voice output in a message system.

3.4 Linking Signal Tags to Messages

3.4.1 Linking Signal Tags to Messages

Introduction

In the "Message Assignment" tab, you create signal tags that you link with properties of messages. Also define for individual signal tags the access rights for triggering signals.

When a message comes in the signal tag of the assigned message class is set to "1".
3.4 Linking Signal Tags to Messages

Overview of procedure

1. Select the "Message Assignment" tab.

2. Double-click an input box in the "Message Class" column. In this way, you select the message class for which you want to configure a signal output.

3. In the "Priority" column, enter a number for the message priority. The number specifies the relative importance of an incoming message that causes a signal tag to be activated.

4. Specify additional filters in the "Origin", "Area" and "Event" columns, which determine the triggering of a signal.

5. In the "Authorization" column, enter the authorization which will cause the signals to be triggered when this access right is present.

6. Double-click an input box in the "Tag" column. This specifies a signal tag. When a message in the assigned message class comes in, the signal tag is activated.
7. In the "Set Tag" field, define the message status which will cause the signal tag to be set:
   - If the signaling device has to be triggered after every occurrence of an incoming message, select "Message for every incoming". This corresponds to the behavior in WinCC Version 5.
   - If the signaling device only has to be triggered on the first occurrence of an incoming message, select "Not for arrival of an unacknowledged message". Then if the same message occurs again, only one signal is triggered if the previous message has already been acknowledged as "Came In" or "Went Out".

8. Click "Apply". Your settings are saved.

If a message satisfies the conditions of a number of signal tags, only the first assigned signal tag is taken into consideration. This is because a message can only set one signal tag. You can change the assignment order by moving the selected rows in the table up or down using the arrow buttons next to the table.

See also

How to assign the message class to the signal tag (Page 115)
Assigning a Message Priority to a Signal Tag (Page 116)
Setting Additional Filter Criteria for Messages (Page 118)
Creating Signal Tags (Page 118)
Specifying a Triggering Authorization for the Signal Tags (Page 119)
How to assign a signal transducer to a signal tag (Page 121)

3.4.2 How to assign the message class to the signal tag

Introduction

An incoming message of a message class defines whether the signal tag will be activated and, thus, a signal triggered, taking further message properties into account.

All the message classes which exist in a project are available. In addition, access can be made to message classes by means of message class IDs. Name these message classes using the syntax "# ID", where ID is the number of the message class. Example: entry "# 1" corresponds with message class "Alarm". In the "Properties" dialog box of the Alarm Logging Editor, you see the ID numbers of the relevant message class.

If you do not specify a message class, each incoming message activates the signal tag.
3.4 Linking Signal Tags to Messages

Procedure

1. Select the message class from the "Message Class" column on the "Message Assignment" tab.

2. Double-click in a cell. A drop-down combo box appears. Select the required message class. Confirm your selection with the <Return> key, the <Tab> key or by clicking in another cell.

3. Click "Apply". Your settings are saved.

Use the <DEL> key or the <Backspace> key to delete the contents of selected cells.

If insufficient lines are displayed, use the pop-up menu for the table to insert new lines.

3.4.3 Assigning a Message Priority to a Signal Tag

Introduction

In addition to and independent of the message class, the message priority allows you to determine which messages are first to trigger a signal.

You specify the message priorities for individual messages in the Alarm Logging Editor.

Click in a line and enter the number of a message priority. You can use the following entries:
Irrespective of its priorities, messages set the signal tags

<table>
<thead>
<tr>
<th>Entry in &quot;Priority&quot;</th>
<th>Example:</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No entry</td>
<td></td>
<td>Irrespective of its priorities, messages set the signal tags</td>
</tr>
<tr>
<td>Number</td>
<td>5</td>
<td>Exactly one priority</td>
</tr>
<tr>
<td>Number, Number, Number</td>
<td>5, 7, 9</td>
<td>Defined priorities</td>
</tr>
<tr>
<td>Number1 - Number2</td>
<td>5 - 9</td>
<td>Priorities between Number1 and Number2 inclusive</td>
</tr>
<tr>
<td>&lt; number or &gt; number</td>
<td>&lt; 5 or &gt; 5</td>
<td>Priorities less than or greater than the number</td>
</tr>
<tr>
<td>&lt;= number or &gt;= number</td>
<td>&lt;= 5 or &gt;= 5</td>
<td>Priorities less than or equal to or greater than or equal to the number</td>
</tr>
<tr>
<td>Zero</td>
<td>0</td>
<td>the signal tag is set at Priority &quot;0&quot;</td>
</tr>
</tbody>
</table>

A combination of entries, e.g. "1-5, 10, <50", is not possible.

Do not assign to a signal tag a combination of message priority and message class that is already being used in another signal tag. In this case, an incoming message could not set this signal tag, as the first assignment already fulfills the conditions for the triggering of the signal. The following example shows how the system behaves:

### Example 1

<table>
<thead>
<tr>
<th>Message class</th>
<th>Priority</th>
<th>Source</th>
<th>Area</th>
<th>Event</th>
<th>Authorization</th>
<th>Tag</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>&lt;default&gt;</td>
<td>AlarmTag</td>
</tr>
<tr>
<td>Alarm</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>&lt;default&gt;</td>
<td>AlarmHighTag</td>
</tr>
</tbody>
</table>

### Example 2

<table>
<thead>
<tr>
<th>Message class</th>
<th>Priority</th>
<th>Source</th>
<th>Area</th>
<th>Event</th>
<th>Authorization</th>
<th>Tag</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm</td>
<td>&gt;5</td>
<td></td>
<td></td>
<td></td>
<td>&lt;default&gt;</td>
<td>AlarmTag</td>
</tr>
<tr>
<td>Alarm</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>&lt;default&gt;</td>
<td>AlarmHighTag</td>
</tr>
</tbody>
</table>

Incoming messages of message class "Alarm" with priority "10" never activate the signal tag "AlarmHighTag". In both cases the first condition sets the "AlarmTag" signal tag and triggers the associated signal.

### See also

Linking Signal Tags to Messages (Page 113)
3.4.4 Setting Additional Filter Criteria for Messages

Introduction

In addition to the message class and the message priority, you can determine additional message properties as filters for the triggering of the signal. The following message properties are available:

- Source = user text field 1 of the message
- Area = user text field 2 of the message
- Event = user text field 3 of the message

Procedure

1. In the "Source" column, enter text in the lines which determines the message as a filter. The text must agree exactly during the filter evaluation. Capital and small letters are not taken into account. You can also use wildcards. "?" stands for any one character and "***" stands for several characters or none. If the line is empty, every text ("***") is taken into account.
2. In the "Area" column, you determine the message area as a filter criteria. Only the areas that exist locally or from the imported packages can be selected from the dialog.
3. In the "Event" column, enter text in the line which determines the event description of the message as a filter. The text must agree exactly during the filter evaluation. Capital and small letters are not taken into account. You can also use wildcards. "?" stands for any one character and "***" stands for several characters or none. If the line is empty, every text ("***") is taken into account.

The text in the "Source" and "Event" columns is valid for all languages in WinCC-Runtime. If the Runtime language has been changed, source and event of the messages are given new values and the defined filter texts may become ineffective. Compared with this, the area names of the messages are adapted to the Runtime language so that the filter evaluation works correctly.

See also

Linking Signal Tags to Messages (Page 113)

3.4.5 Creating Signal Tags

Introduction

You create a signal tag in the form of a binary data manager tag. This tag is the link between the message and the acoustic or optical signal.
### 3.4 Linking Signal Tags to Messages

#### Procedure

1. Select the "Message Assignment" tab. Select a message class from the "Message Class" column. Now double click in the "Tag" column to define the associated signal tag. For this you have the following options:
   - Click "...". The tag selection dialog box opens. Select a signal tag that has already been created.
   - Enter a new tag directly. Click "Apply". The new tag is applied in the tag management of the project.
   - Enter an existing tag name directly. If this tag does not have the "Binary Tag" data type, the following note is displayed:

![Error Message]

2. Confirm the tag selection using the <> or <> key.
3. Click "Apply". Your settings are saved.

You can assign several message classes or message properties to a signal tag. Signal tags can also be activated as follows:
- by scripts
- by user actions
- with the aid of the "Central Signaling Devices" function in Alarm Logging.

#### 3.4.6 Specifying a Triggering Authorization for the Signal Tags

**Introduction**

In the "Authorization" column on the "Message Assignment" tab, you use an authorization level to define whether the signal tag will be triggered for a specific user. The authorizations of a logged in user are applied on the basis of the User Administrator configuration.

In addition to the configured trigger permission, the audible indicator also checks in runtime if the user has the "Release for area" access right. Only when the user receives the actual messages on which they are based does it make sense to trigger signals for the user.

For example, you have "Watch" permission for the "WarnVar" signal tags. If a message meets the specified filter criteria and comes from an area for which the user has "Watch" permission, the signal tag "WarnVar" is set and the corresponding signal is triggered.
Procedure

1. Select the "Message Assignment" tab.

2. Double click on the cell in the column to open a selection dialog from which you can select the authorization. You can use any of the authorizations defined in the User Administrator.

3. Confirm your selection with the <Return> key or the <Tab> key.

4. Click "Apply". Your settings are saved.

Select the "<default>" entry if no authorization is specified. This entry corresponds to the authorization called "Authorization for Area", which you need in order to view messages.

Deactivating the default authorization test "Release for area"

Deactivate the authorization check for "Release for area" if you do not want to filter the messages in runtime based on the area in the project. For this you can use the message filter setting "No filter" in the OS Project Editor.

When the default authorization check is deactivated, only the configured trigger authorization in addition to the filter criteria are assessed before allowing signals to be triggered in runtime.
3.5 How to assign a signal transducer to a signal tag

Introduction
In the "Signal Assignment" tab, you assign signal outputs to the signal tags. This can be outputs of a signal module or sound files. Several signal tags can be assigned to the same outputs of a signal module or the same sound files. You can combine an output of the signal module with a sound file.
3.5 How to assign a signal transducer to a signal tag

**Procedure**

1. Select the "Signal Assignment" tab.

2. You can transfer the tags that you created in the "Message assignment" tab. In the context menu of the "Tag" column, select the menu command "Transfer tag from message assignment".
   If you want to create a new tag, double-click a line in the "Tag" column. Click the "..." button and select the desired tag from the Tag Management.

3. If you want to assign the output of a signal module to the tag, double-click the "Signal Module" column. The signal devices "Output 1", "Output 2" and "Output 3" of an installed signal module are available.
4. If you want to assign a sound file to the tag, double-click the "Sound" column. Select the desired sound file in WAV format from the file selection. If the files are located in the project directory "<Project directory>\Horn", the cell displays the relative path such as "Horn_Danger.wav" after the selection. If you want to display the absolute path in the cell, select the menu command "Absolute Path" in the context menu of the cell. If the file you wish to select is located outside the project directory, enter the absolute path of the file in the edit box. If you want to display the relative path in the cell, select the menu command "Relative Path" in the context menu of the cell. You cannot use the relative path for a file on another drive. Note that client computers have the same configuration as server computers. Therefore, the paths for the sound files must also be accessible from server computers as well as from client computers. When you use the absolute path, the sound files can be accessed from the server computer and the client computer.

5. Click "Apply". Your settings are saved.

Use the <DEL> key or the <Backspace> key to delete the contents of selected cells. To insert new rows or delete rows, select the corresponding menu commands in the context menu of the table.

### Playing sounds

If several messages are queued, the sounds are not played for each individual signal tag; they are played simultaneously for all set signal tags. You can limit the number of sounds to be played at the same time. For example, in order for a voice output to be clearly audible, it makes sense to play only one sound.

If several messages are queued and the output of sounds is limited, the order of the entries in the "Sound" column determines which sound is played.

### See also

- How to Configure the Acknowledgment Behavior of the Audio Alarm (Page 123)
- Linking Signal Tags to Messages (Page 113)
- Application Examples for Acknowledgement Behavior (Page 130)
- General Information about the sound card (Page 128)

### 3.6 How to Configure the Acknowledgment Behavior of the Audio Alarm

#### Introduction

In the "Signal assignment" tab, you configure the acknowledgment behavior of the horn. The horn can either be acknowledged separately for one computer or in a coordinated manner for multiple computers.
3.6 How to Configure the Acknowledgment Behavior of the Audio Alarm

Local acknowledgment of the horn

The horn is acknowledged using a "@HornReset" tag on a separate, independently acting OS. This tag is acknowledged locally or directly. When a user acknowledges the horn, the acknowledgment tag, and thus all signal tags, are reset. This deactivates the signaling devices.

Multiple acknowledgment of the horn by a group

In a coordinated client-server system, you specify multiple acknowledgment by means of a group of computers. If a user acknowledges the horn on one computer of the group, a multicast communication causes the horn to be acknowledged on all computers of this group and all signal transmitters to be deactivated. Multiple acknowledgment by a group is possible for all WinCC project types. Any combination of letters and numbers can be used for the group name.

If a computer forming part of the client-server system is unable to communicate beyond the router limits using Multicast, you will need to bypass the router by configuring a "Multicast proxy" in the "Simitic Shell" dialog box.

Multiple acknowledgment of the horn by an acknowledgment tag

Multiple acknowledgment by a group is the preferred configuration. Multiple acknowledgment by acknowledgment tags is retained for compatibility reasons.

If you have connected an acknowledgment button for the horn with a binary tag in the AS, you must configure the multiple acknowledgment using one or several acknowledgment tags. The acknowledgment tags must already be configured on the server of the WinCC client or on other servers. You must interconnect the acknowledgment button so that the corresponding tag in WinCC is set to "0" when acknowledgment occurs. The additional acknowledgment tags are synchronized with the local @HornReset tag. When a signal has been activated, as soon as an acknowledgment tag is acknowledged and thus deactivated, the local @HornReset tag is acknowledged, thereby deactivating all signaling devices.
Procedure

1. Select the "Signal Assignment" tab:

   ![Horn Configuration Dialog]

2. If you just want to acknowledge the horn on a separate computer, select the "Only local" check box in the "Horn acknowledgment" area.

3. For multiple acknowledgment by a group, you select the "Multiple acknowledgment in the following group:" check box. Enter any group name in the edit box. Specify the computer that belongs to a group of the same name under "horn". This setting is case-sensitive.

4. For multiple acknowledgment by acknowledgment tags, you select the "Multiple acknowledgment using the following acknowledgment tags:" check box. Click "Edit". You specify the acknowledgment tags in the "Acknowledgment tags" dialog.

5. Click the "Insert tag" button. Select the acknowledgment tags in the tag selection dialog box. Click "OK". The tags are separated by semicolons in the "Horn acknowledgment:" group and displayed as tooltip.

   To delete acknowledgment tags, click "Edit", which opens the "Acknowledgment tags" dialog box. Select the tag and then click "Delete tag".
3.7 Tags for controlling runtime

Note
In WinCC Version 6, you do not always have to stop the sensors separately by means of a button:

- When all the messages that trigger a signal have been acknowledged, the signal is automatically deactivated.
- If the sensors are configured so as not to require acknowledgment, these sensors are not deactivated automatically when the message is suppressed. You must acknowledge the sensors manually.

Note
If a preferred server is entered on a client with a view to a redundant server pair, you cannot configure the central acknowledgment tag on this server pair as the internal tag for the horn.

Help:
- Use an external tag
- Do not configure a preferred server for this server pair
- Configure the acknowledgment tag on a non-redundant server
- When using a signal module, link it externally

See also
How to assign a signal transducer to a signal tag (Page 121)

3.7 Tags for controlling runtime

Tag definitions
Additional tags are defined to control the runtime of the horn.

You use the @HornSettingTagsActive and @HornTriggeringSignalsActive tags to temporarily deactivate or activate the respective horn components. The two tags are defined with the start value "1". After runtime of the horn is activated, the components "Alarm sets signal tag" and "Signal tag sets signaling device" are activated by default.

The "@RestartHorn" tag controls the restart of the horn components. Following a configuration change, you can restart the runtime of the horn. Normally this is not necessary, since each change of configuration is applied automatically.

The binary tag @HornReset controls the way signaling devices and signal tags behave following an acknowledgment. Separate OSs or WinCC clients use a local reset tag for this purpose. WinCC clients and/or servers acting in unison use one or more additional reset tags.
### Tag | Meaning
--- | ---
@HornSettingTagsActive | The "Alarm sets signal tag" component is activated if the value "1" is set at the binary tag. The component pauses and no alarms activate the assigned signal tag if the value "0" is set at the binary tag.

@HornTriggeringSignalsActive | The "Signal tag sets signaling device" component is activated if the value "1" is set at the binary tag. The component pauses and no signal tags activate the assigned signal generator if the value "0" is set at the binary tag. All signaling devices are shut down. Only the synchronization of additional reset tags remains active.

@RestartHorn | The binary tag defines whether the "Alarm sets signal tag" and "Signal tag sets signaling device" components are reactivated. If you set the value of the tag "1", both components reload the configuration data. The signal tags and signal generators are reset. The binary tag is set to "0" at the start of runtime.

@HornReset | The binary tag determines the acknowledgment behavior of the signal generators. The tag is set to "1" if the signal generators are active. The tag is reset to "0" after the signal generator was acknowledged. This behavior applies accordingly to the additional reset tags.

---

**Note**
The project engineer may not create any tags with @ prefix. Such actions are reserved for handling in the WinCC PCS7 software. You are not allowed to manipulate these system tags. The system tags are necessary for proper functioning of the product.

### 3.8 Minimum Horn Configuration

**Introduction**

The following minimum horn configuration is recommended for the PCS7:

**Assignment of message classes to the signal tags**

Assign the following message classes to the corresponding signal tags:

<table>
<thead>
<tr>
<th>Message Class</th>
<th>Priority</th>
<th>Source</th>
<th>Area</th>
<th>Event</th>
<th>Authorization</th>
<th>Tag</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>&lt;default&gt;</td>
<td>Alarm_Tag</td>
</tr>
<tr>
<td>Warning</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>&lt;default&gt;</td>
<td>Warning_Tag</td>
</tr>
<tr>
<td>PLC-PCS message</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>&lt;default&gt;</td>
<td>PLC_PCS_Tag</td>
</tr>
<tr>
<td>OS_PCS message</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>&lt;default&gt;</td>
<td>OS_PCS_Tag</td>
</tr>
</tbody>
</table>

If the user is allowed to view messages, the "<default>" setting checks whether a signal is triggered.
### Assignment of signaling devices to the signal tags

If a signal module is installed, configure the following assignment between signal tags and the signal module:

<table>
<thead>
<tr>
<th>Tag</th>
<th>Signal module</th>
<th>Sound</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm_Tag</td>
<td>Output 1</td>
<td></td>
</tr>
<tr>
<td>Warning_Tag</td>
<td>Output 2</td>
<td></td>
</tr>
<tr>
<td>PLC-PCs_Tag</td>
<td>Output 3</td>
<td></td>
</tr>
<tr>
<td>OS_PCS_Tag</td>
<td>Output 3</td>
<td></td>
</tr>
</tbody>
</table>

If the signals are to be output through a sound card, configure the following assignment between signal tags and the audio file:

<table>
<thead>
<tr>
<th>Tag</th>
<th>Signal module</th>
<th>Sound</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm_Tag</td>
<td></td>
<td>Horn_Danger.wav</td>
</tr>
<tr>
<td>Warning_Tag</td>
<td></td>
<td>Horn_Attention.wav</td>
</tr>
<tr>
<td>PLC-PCs_Tag</td>
<td></td>
<td>Horn_Note.wav</td>
</tr>
<tr>
<td>OS_PCS_Tag</td>
<td></td>
<td>Horn_Note.wav</td>
</tr>
</tbody>
</table>

### Signal triggering behavior

If a message comes in that already exists and has not yet been acknowledged with the status "Came In" or "Went Out", the signal is not triggered again.

### Behavior of the signals on acknowledgment

You only acknowledge the signals locally. You do not configure any additional reset tags for synchronizing behavior with connected computers following acknowledgment.

### See also

- Linking Signal Tags to Messages (Page 113)
- How to assign a signal transducer to a signal tag (Page 121)
- How to Configure the Acknowledgment Behavior of the Audio Alarm (Page 123)

### 3.9 General Information about the sound card

#### Functionality

You use commercially available sound cards in order to output messages acoustically. In this case, a WAV audio file created using commercially available software is played back and repeated until the message is acknowledged.
If several messages from different message classes come in, the assigned sounds are played back simultaneously.

In order to access multimedia hardware, the sound card communicates via the DirectSound component of the standard operating system component "DirectX". "DirectX" takes advantage of all the properties that the sound card driver supports, and emulates those properties which the driver does not support but which are nonetheless needed. Thus, the sound card implementation is independent of the hardware.

To configure the sound card, select "Start > Settings > Control Panel". Double-click "Sounds and Multimedia" to open the dialog box.

The sounds of the WAV files must support the Pulse Code Modulation format. Both mono and stereo are supported.

Corresponding to the three channels of the signal module, three audio files are supplied for the sound card.

### 3.10 Creating project documentation

#### Procedure

You have the following options for printing out project documentation:

<table>
<thead>
<tr>
<th>Button</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Documentation</td>
<td>Clicking this button opens a submenu with the commands &quot;Print&quot;, &quot;Preview&quot; and &quot;Setup...&quot;.</td>
</tr>
<tr>
<td>&quot;Project-Documentation Print&quot;</td>
<td>Click this button to print the configuration data on the assigned printer.</td>
</tr>
<tr>
<td></td>
<td>Printing is started immediately after you clicked the button. If you want to preview the pages to be printed, first click the &quot;Project Documentation Preview&quot; button.</td>
</tr>
<tr>
<td>&quot;Project Documentation - Preview&quot;</td>
<td>Click this button to open a print preview. This allows you to check the page view. It displays the pages as they will look when printed.</td>
</tr>
<tr>
<td>&quot;Project Documentation - Setup&quot;</td>
<td>Click this button to configure the print job. Select the printer and the layout in the tabs of the dialog box. You also specify the start parameters and select the print scope.</td>
</tr>
</tbody>
</table>
3.11 Application Examples for Acknowledgement Behavior

3.11.1 Application Examples for Acknowledgement Behavior

Overview of application examples

The following application examples explain the options available for using the horn, in particular with regard to the acknowledgement behavior:

- Standalone WinCC clients with signaling devices that independently monitor the servers, trigger signals and acknowledge their signaling devices.
- WinCC clients acting in unison, having signaling devices. Each WinCC client can acknowledge the signaling devices of all WinCC clients because they are in a group.
- WinCC clients acting in unison, having signaling devices. Each WinCC client can acknowledge the signaling devices of all WinCC clients using common acknowledgement tags.

See also

Example 1: Automatically acting WinCC clients with signal transducer (Page 130)
Example 2: WinCC Clients with Multiple Acknowledgment in a Group (Page 131)
Example 3: WinCC Clients with Multiple Acknowledgment by Tags (Page 132)

3.11.2 Example 1: Automatically acting WinCC clients with signal transducer

Introduction

The following example shows the configuration of standalone WinCC clients that have signaling devices and that are networked with multiple servers.

Requirement

- Each WinCC client is in a separate room.
- The WinCC clients have one signaling device each, the servers have none.

Requirement

WinCC clients monitor the servers and use their signaling devices in accordance with their access rights. When a WinCC client receives a message, a signal is triggered or acknowledged independently of the other WinCC clients. This does not affect the other WinCC clients.
Procedure

1. Configure the Horn message and signal assignment on every WinCC Client.
2. In each "Signal assignment" tab, select the "Only local" check box.
3. Click "OK" to save your settings.

Runtime behavior

The horn runs on each WinCC client. The signaling devices of individual WinCC clients are triggered by a message independently of one another. Each WinCC client acknowledges its own signaling device. Its own signal tag is reset and the signal is deactivated.

See also

Application Examples for Acknowledgement Behavior (Page 130)

3.11.3 Example 2: WinCC Clients with Multiple Acknowledgment in a Group

Introduction

The following example shows you the configuration of two WinCC clients in a group whose signaling devices are deactivated in a coordinated manner. Starting in WinCC V6.2, this is the preferred configuration for multiple acknowledgment.

Requirement

- The WinCC clients have one signaling device each, the servers have none.

Requirement

Because the WinCC clients are in a group, one WinCC client acknowledges all signaling devices of the WinCC clients.

Procedure

1. Configure the message and signal assignment of the horn on both of the WinCC clients.
2. Select the "Multiple acknowledgment in the following group:" check box each time in the "Signal assignment" tab.
3. Enter the same group name each time in the edit box, e.g., "Horn_Group1". This entry is case-sensitive.
4. Click "OK" to save your settings.
Runtime behavior

The horn runs on the WinCC clients. When one WinCC client acknowledges the horn, the local "@HornReset" tag is reset and the signaling devices are deactivated. Because the other WinCC client is in the same group ("Horn_Group1"), this WinCC client recognizes the acknowledgment and resets its local "@HornReset" tag. This causes its signaling devices to be deactivated.

Note

When configuring a shared acknowledgment, you must be aware that users with different authorizations can be logged on to the WinCC clients. When a message comes in it is possible for, say, WinCC client 1 to see this message and trigger the horn. WinCC client 2 is not authorized to see this message and trigger a signal. However, WinCC client 2 can acknowledge the signaling device on WinCC client 1 at any time, even though it does not see any messages and its signaling device is deactivated.

See also

Application Examples for Acknowledgement Behavior (Page 130)

3.11.4 Example 3: WinCC Clients with Multiple Acknowledgment by Tags

Introduction

The following example shows you the configuration of two WinCC clients acting in unison whose signaling devices are deactivated using acknowledgment tags. Starting in WinCC V6.2, multiple acknowledgment by a group is the preferred configuration. The configuration of the multiple acknowledgment using acknowledgment tags is retained for compatibility reasons.

Requirement

- The WinCC clients have one signaling device each, the servers have none.
- A server has a common acknowledgment tag for both WinCC clients.

Requirement

Since the WinCC clients act in unison, the acknowledgment tag acknowledges all the signaling devices on the WinCC clients.

Procedure

1. On the S1 server, create the binary acknowledgment tag "HornResetMC" with project-wide updating in the Tag Management of WinCC.
2. Configure the message and signal assignment of the horn on both of the WinCC clients.
3. In each "Signal assignment" tab, select the "Multiple acknowledgment by the following acknowledgment tags:" check box.

4. Click "Edit". The "Acknowledgment tags" dialog box opens.

5. Click the "Insert tag" button. Select the acknowledgment tag "S1::HornResetMC" in the tag selection dialog box. Click "OK".

6. The tag is displayed in the box next to "Edit" and is displayed as a tooltip.

7. Click "OK" to save your settings.

Runtime behavior

The horn runs on the WinCC clients. Each WinCC client sets its own signal tags. When a WinCC client acknowledges the signaling device, this automatically resets tag "S1::HornResetMC". The other WinCC client detects this and resets its local "@HornReset" tag. This causes it signal tags to be reset and the signals to be deactivated.

Note

When configuring a shared acknowledgment, you must be aware that users with different authorizations can be logged on to the WinCC clients. When a message comes in it is possible for, say, WinCC client 1 to see this message and trigger the horn. WinCC client 2 is not authorized to see this message and trigger a signal. However, WinCC client 2 can acknowledge the signaling device on WinCC client 1 at any time, even though it does not see any messages and its signaling device is deactivated.

See also

Application Examples for Acknowledgement Behavior (Page 130)

3.12 Signal module

3.12.1 General Information about the Signal Module

Introduction

The signal module is used to control up to three different messaging devices (horn, buzzer, lights, etc.) with an option to connect to a hardware-based acknowledgment button used for acknowledging externally. It also includes a hardware timer (watchdog). It is triggered cyclically by WinCC Runtime via a API call driver. An alarm is triggered if an error, such as a computer failure, occurs so that retriggering no longer takes place. The module also possesses 3 additional binary inputs. The signal module is a PC module that has been specially developed for use in the OS with an 8-bit ISA bus interface (MLFB no.: 6DS 1916-8AA) or a 32-bit PCI bus interface (MLFB no.: 6DS 1916-8RR). You need a 5V PCI slot to operate the signal module with PCI bus interface. It is not possible to operate it in a 3.3V PCI slot.
The signal module is a hardware option to the WinCC system that is offered as an option pack. In the following figure, you can see the general structure of a system and the installation options for the signal module within a system.

If the server operator stations have multiple client operator stations, each terminal can be equipped with a signal module.

**Note**

The signal module is configured separately for each computer. You need to configure each computer. When you use the project duplicator, the settings are not copied.

**See also**

Function Characteristics of the Signal Module (Page 135)
ISA Bus Signal Module (Page 136)
PCI Bus Signal Module (Page 143)
Addressing the ISA Bus Signal Module (Page 141)
Installing the Signal Module (Page 147)
Pin Assignment of the External Interface (Page 150)
Testing the Signal Module (Page 149)
3.12.2 Function Characteristics of the Signal Module

Functionality

The signal module performs the following functions:

- Control of three acoustic or optical sensors
- Watchdog
- Three binary inputs
- Acknowledgment/resetting of the audible signals through software control or external acknowledgment

A 25-pin and a 9-pin Sub-D-plug are located at the front of the module. The watchdog and signaling device functions are carried through the 25-pin Sub-D-plug. The 9-pin plug is not used.

Via the Basic Process Control option pack, the group signal or the group audible indicator is controlled by a logical OR.

When control is through the software, the three signal outputs are reset. When acknowledgment is carried out externally, for instance using keystrokes, all assigned signal tags are set to 0 and the signal outputs are reset at the same time.

All signals sent through the two plugs are isolated and implemented as relay contacts or optical couplers. The 24 V DC supply voltage, which is provided externally by the relay contacts or optical couplers of the signal module, must be 1 A protected by the customer.

See also

General Information about the Signal Module (Page 133)
Testing the Signal Module (Page 149)
Installing the Signal Module (Page 147)
Addressing the ISA Bus Signal Module (Page 141)
3.12.3 ISA Bus Signal Module

The signal module is an ISA bus card for PCs. It is used for controlling up to three external signaling devices and possesses three binary inputs.

Insert the signal module into the motherboard of the operator station PC. Check whether an ISA slot is available. Note the addressing of the module to avoid address conflicts with other PC expansion cards. By default, the I/O address 180H is occupied by the signal module. You will find related topics in the "Addressing the ISA bus signal module" section of this documentation.
Example: 8-Bit ISA Bus Interface Circuit
3.12 Signal module

![Diagram of signal module](image)

Key:
- **K1** = Hauptkontakt
- **RE** = Reset-Eingang
- **RA** = Reset-Ausgang
- **K2** = Watchdog
- **K3** = Ausgang 1
- **K4** = Ausgang 2
- **K5** = Ausgang 3
- **K3-K5** = Detailkontakte

Legend:
- X114
- 24VDC
- Ausgänge
- Löschdiode bei induktiver Last
- Meldegerät

Notes:
- MDM - WinCC/Options for Process Control
- System Manual, 11/2008,
Function Characteristics of the Sensor Output

The make contact of the sensor output is open, if the operator terminal is turned off. The relay contact will remain open after the operator terminal is turned on. If a classified event occurs during the process control, the contact will be closed. Other events will only result in the closing of the sensor output, if an acknowledgment was made prior. You can acknowledge internally by WinCC or via an external confirmation button. It is possible to invert the function of the sensor via the break contact.

Acknowledgment of the Sensor

The following acknowledgments are possible:

- You acknowledge by clicking when the sensor is controlled only from an operator terminal: Bridge X114: 1-3 and 2-4 closed (delivery condition).
- You acknowledge by clicking or externally with the confirmation button when several operator terminals are connected, as shown in the figure above.
  Bridge X114: 1-2 and 3-4 closed.
  The acknowledgment signal is, in this case, looped through several signal modules.

If you remove the jumper X114: 5-6, the sensor function can be disabled (see the previous figure).

Watchdog

With the watchdog function, you monitor the correct operating state of the OS.

After switching on the OS power supply, a monoflop is set cyclically on the signal module. This monoflop is retriggered just in time so as not to drop out.

If the process control of the operator terminal malfunctions, the monoflop on the signal module ceases 3.5 seconds after the last trigger impulse. Depending on how jumper X116 is set, you can invert the watchdog function. Jumper X116: 2-3 is inserted in delivery state (standard watchdog function).

When you connect an external sensor (e.g. a horn), you can switch a miniature relay with the contact. This miniature relay switches the sensor. With inductive loads, you must provide an arc-suppression diode.

Binary Inputs

The signal module has three binary inputs for the purpose of querying external binary signals. These inputs are isolated by optical couplers. These are used for user-specific expansions and can be configured by means of signal tags. The internal tags "@SignalInput1... @SignalInput3" are used in the same way as in Version 5.

See also

Structure of the Switches and Plug-In Jumpers with the ISA Bus (Page 140)
Addressing the ISA Bus Signal Module (Page 141)
3.12.4 Structure of the Switches and Plug-In Jumpers with the ISA Bus

Overview

The following simplified representation of the signal module with 8-Bit ISA bus interface shows the physical arrangement and the pin numbering of the switches and jumpers (seen from the component side). Their use is explained below.

The image shows the factory settings of the jumpers and the default switch positions. These default settings are marked with "*" in the following table.

Configuration / meaning of the jumpers / switches / interfaces

The functions of signal generators, watchdogs, plug control and addressing are set using plug-in jumpers.

<table>
<thead>
<tr>
<th>Slot</th>
<th>Jumper</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>X114</td>
<td>1-3*) 2-4*)</td>
<td>Acknowledgment of signal generator via bus interface</td>
</tr>
<tr>
<td></td>
<td>1-2 3-4</td>
<td>Acknowledgment of a signal generator by means of external signal</td>
</tr>
<tr>
<td></td>
<td>5-6*)</td>
<td>Signal generator function on</td>
</tr>
<tr>
<td></td>
<td>7-8*)</td>
<td>Watchdog function on</td>
</tr>
<tr>
<td>X115</td>
<td>1-2*)</td>
<td>Event-triggered activation of the signal generator relay</td>
</tr>
<tr>
<td></td>
<td>2-3</td>
<td>Event-triggered release of the signal generator relay</td>
</tr>
<tr>
<td>X116</td>
<td>2-3*)</td>
<td>Watchdog function normal</td>
</tr>
</tbody>
</table>
### Slot Jumper Meaning

<table>
<thead>
<tr>
<th>Slot</th>
<th>Jumper</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-2</td>
<td>Watchdog function inverted</td>
<td></td>
</tr>
<tr>
<td>X10</td>
<td>Inserted*)</td>
<td>Addressing in I/O area</td>
</tr>
<tr>
<td>X10</td>
<td>Not inserted</td>
<td>Addressing in the memory area</td>
</tr>
<tr>
<td>X1</td>
<td>25-pin watchdog and signal generator interface</td>
<td></td>
</tr>
<tr>
<td>X2</td>
<td>9-pin hardcopy interface</td>
<td></td>
</tr>
<tr>
<td>S1</td>
<td>DIL switch for addressing the signal module in the I/O or memory area of the PC</td>
<td></td>
</tr>
</tbody>
</table>

The default jumper settings are marked with *). The connectors X117 (1-2-3) are not used in WinCC.

**See also**

ISA Bus Signal Module (Page 136)

### 3.12.5 Addressing the ISA Bus Signal Module

**Overview**

You can address the signal module in either the I/O area or the memory area of the PC. You set the base address for both addressing types using DIP-switch S1. It occupies 16 Bytes in the 0000H-03FFH I/O area and 1 KB in the C0000H-FFFFFH area. From the kernel driver, you use only the I/O addressing.

<table>
<thead>
<tr>
<th>Slot</th>
<th>Jumper</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X10</td>
<td>Closed</td>
<td>Addressing in the I/O area</td>
</tr>
<tr>
<td></td>
<td>Not inserted</td>
<td>Addressing in the memory area</td>
</tr>
</tbody>
</table>

**Signal Module Address Lines**

The signal module manages 12 address lines in the I/O addressing mode, the lowest four of which (A0 - A3) are used for switching the 16 required individual addresses. Therefore, you cannot set these four address lines with DIP-switches. This results in the following assignment of switch to address line, as described above in general form.

<table>
<thead>
<tr>
<th>Switch</th>
<th>Lines A</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>11</td>
</tr>
<tr>
<td>7</td>
<td>10</td>
</tr>
<tr>
<td>6</td>
<td>9</td>
</tr>
<tr>
<td>5</td>
<td>8</td>
</tr>
<tr>
<td>4</td>
<td>7</td>
</tr>
<tr>
<td>3</td>
<td>6</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Switch</th>
<th>Lines A</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>5</td>
</tr>
<tr>
<td>1</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>0</td>
</tr>
</tbody>
</table>
Setting the I/O Address

You now set the I/O address as follows using the available switches:

- Select the I/O address, e.g. 180h; the address must not yet be in use on the PC concerned, otherwise an I/O address conflict will result.
- Convert to binary notation (0001 1000 0000); the conversion is simplified by considering each HEX digit as a 4-Bit block.
- Set and delete the individual address bits
  CAUTION: The DIL switches do not cover the four least significant bits.

The example given (180h) therefore has the following switch positions (default setting):

<table>
<thead>
<tr>
<th>Switch Pin</th>
<th>8</th>
<th>7</th>
<th>6</th>
<th>5</th>
<th>4</th>
<th>3</th>
<th>2</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address Pin</td>
<td>11</td>
<td>10</td>
<td>9</td>
<td>8</td>
<td>7</td>
<td>6</td>
<td>5</td>
<td>4</td>
</tr>
<tr>
<td>Position</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>ON</td>
<td>ON</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
</tr>
</tbody>
</table>

Example for the Address 100H (0001 0000 0000)

<table>
<thead>
<tr>
<th>Switch Pin</th>
<th>8</th>
<th>7</th>
<th>6</th>
<th>5</th>
<th>4</th>
<th>3</th>
<th>2</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address Pin</td>
<td>11</td>
<td>10</td>
<td>9</td>
<td>8</td>
<td>7</td>
<td>6</td>
<td>5</td>
<td>4</td>
</tr>
<tr>
<td>Position</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>ON</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
</tr>
</tbody>
</table>

See also

- ISA Bus Signal Module (Page 136)
- Structure of the Switches and Plug-In Jumpers with the ISA Bus (Page 140)
3.12.6 PCI Bus Signal Module

The signal module is a PCI bus card for PCs. It is used for controlling up to three external signaling devices and possesses three binary inputs.

Insert the signal module into the motherboard of the operator station PC. Check whether a PCI slot is available.
Note
You can only use a PCI card as a signal module if it has a product status $\geq 4$ (see self-adhesive label, e.g. ES4).

See also
Structure of the Switches and Jumpers with the PCI Bus (Page 145)
3.12.7 Structure of the Switches and Jumpers with the PCI Bus

Overview

The following simplified representation of the signal module with 32-Bit PCI bus interface shows the physical arrangement and the pin numbering of the switches and jumpers. Their use is explained below.

The image shows the factory settings of the jumpers and the default switch positions.

Configuration / meaning of the jumpers / switches / interfaces

The functions of signal generators, watchdogs, plug control and addressing are set using plug-in jumpers.

<table>
<thead>
<tr>
<th>Slot</th>
<th>Jumper</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>X6</td>
<td>1-2 jumpered*)</td>
<td>Signal generator function on</td>
</tr>
<tr>
<td></td>
<td>3-4 open*)</td>
<td>Signal generators can only be acknowledged by software</td>
</tr>
<tr>
<td></td>
<td>3-4 jumpered</td>
<td>Signal generator acknowledgment is possible by means of software and externally wired pushbutton</td>
</tr>
<tr>
<td></td>
<td>5-6 open*)</td>
<td>Watchdog function normal</td>
</tr>
<tr>
<td></td>
<td>5-6 jumpered</td>
<td>Watchdog function inverted</td>
</tr>
<tr>
<td></td>
<td>7-8 open</td>
<td>Event-triggered release of the signal generator relay</td>
</tr>
<tr>
<td></td>
<td>7-8 jumpered*</td>
<td>Event-triggered activation of the signal generator relay</td>
</tr>
<tr>
<td></td>
<td>9-10 open</td>
<td>Watchdog function off</td>
</tr>
<tr>
<td></td>
<td>9-10 jumpered*</td>
<td>Watchdog function on</td>
</tr>
<tr>
<td>X4</td>
<td>1-2 jumpered*)</td>
<td>Insertion check is activated by means of jumper between pin 6-8 inside the connector</td>
</tr>
<tr>
<td></td>
<td>2-3 jumpered</td>
<td>Insertion check activated by means of +5 V signal from printer</td>
</tr>
</tbody>
</table>
### 3.12 Signal module

<table>
<thead>
<tr>
<th>Slot</th>
<th>Jumper</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>X1</td>
<td></td>
<td>25-pin watchdog and signal generator interface</td>
</tr>
<tr>
<td>X2</td>
<td></td>
<td>9-pin hardcopy interface</td>
</tr>
</tbody>
</table>

All X6 jumpers are inserted in delivery state. The X4 jumper "1-2" is inserted in delivery state. The jumper settings marked with *) represent the standard configuration for use with PCS7-OS and do not correspond with the delivery state.

**Note**

If several modules are interconnected by way of external wiring it is mandatory that jumper 3-4 at slot X6 is in the same position at all modules. The jumper is usually inserted on all modules.

**See also**

PCI Bus Signal Module (Page 143)
3.12.8 Installing the Signal Module

Procedure

The installation is broken down into multiple steps. Proceed as follows:

1. Hardware Installation:
   - Insert the signal module card into the OS motherboard. The card requires a free ISA slot or PCI slot in the OS. If the OS is a server OS with several client OS's, each client can contain an additional signal module.
   - Before installing the ISA card, check whether the addresses used by the card (default settings) are still available on your PC. If the default settings are in use, the card must be reset via the DIP-switches. The preset address assignment of the signal module is 180H to 18FH in the I/O area. You will find information about how to set another address area in the "Addressing the ISA bus signal module" of this documentation. This can be necessary to prevent address conflicts with other PC expansion cards.
   - You do not have to set the address for the PCI card.

2. Hardware Setup:
   Once you have installed the signal module card, you can test its functionality using the operating system’s "Control Panel". To do so, double-click "Signal Unit Configuration" within the "Control Panel". The "Signal Unit Hardware Setup" dialog box will open. Perform the hardware setup for the signal module plug-in card via this dialog box.
   Note:
   - When you close the dialog box, you must wait approx. 4 seconds before opening it again once the icon comes into focus again.
   - Before activating Runtime, you have to close the "Signal Unit Hardware Setup". The horn is not triggered by message events otherwise.

3. Configuring signal tags:
   - Assign the messages to signal tags in the "Message Assignment" tab of the horn. The access rights are taken into account here.
   - Assign available physical signals to the signal tags in the "Signal Assignment" tab for the horn. In the "Sensor" column, you assign outputs from an installed signal module to the tags by double-clicking in the subsequent dialog box. The available signal outputs are "Output 1", "Output 2" and "Output 3".

4. Testing the signal module:
   - The updated driver with version 1.1.0 is used in all operating systems for the "6DS1916-8RR" signal module as of WinCC V7.0 SP1 / PCS7 V7.1. You can find the driver on your computer in the installation directory <WinCC>\Options\Drivers.
PCI Signal module under Windows XP / Windows Server 2003

Install the PCI signal module as follows:

1. Soon after the restart, the "Wizard for Finding New Hardware" dialog box will open:
   Select the "Install from a list or specific location (for advanced users)" check box.
   Click "Next".

2. In the following dialog box, select the "Do not find; instead, user selects driver to be installed"
   check box.
   Click "Next".

3. In the "Hardware Type" dialog box, select the "Display all devices" check box and click "Next".

4. Click on the "Data carrier" button. Navigate to driver "<WinCC>\Options\Drivers" and click "Open".
   Click "OK" to close the "Install from data carrier" dialog box.

5. In the device list select the entry "Signal Unit PCI Adapter" and click "Next".
   Confirm any warnings or safety notices that may appear by clicking "Yes".

6. In the last dialog box, "Finish Wizard", click "Finish". The installation is then complete.

7. Restart the computer with the following Windows dialog box.

The "Signal Unit PCI Adapter" device now appears under the "PCS 7" group in the device manager. A device conflict is reported incorrectly in the "Properties" dialog box of the "Resources" tab. Ignore this message. Alternatively, start the hardware wizard from the Windows Control Panel.

PCI signal module under Windows Vista

Install the PCI signal module as follows:

1. The "New hardware found" dialog appears shortly after the computer starts.

2. Select the option "Locate and install driver software (recommended) > Do not search online
   > The data carrier is not available. Show me other options. > Search for driver software on
   the computer (extended) > Search".

3. Navigate to the storage location of the driver installation. Confirm with "Next". Use "HmPci.INF" for Vista 32 Bit in this case.

4. Finish the installation with "Close".

The "Signal Unit PCI Adapter" device now appears in the device manager under the "PCS 7" group.

See also

Testing the Signal Module (Page 149)
3.12.9 Testing the Signal Module

Introduction

In order to test the installed signal module, proceed as follows:

Procedure

1. Select "Start > Settings > Control Panel".
2. Double-click this icon to open the "Signal Unit Hardware Setup" dialog box.
3. You can now test the signal module in the "Signal Unit Hardware Setup" dialog box.

Note:
- After having closed the dialog box, you must wait approx. four seconds after the icon is focused again before you re-open the dialog box.
- Close the "Signal Unit Hardware Setup" dialog box before activating Runtime. The horn is not triggered by message events otherwise.

Layout of the "Signal Unit Hardware Setup" dialog box for the ISA bus card.

Activate "Output 1" to "Output 3" check boxes in the "Output Channels" group in order to immediately test the functions of the signal module and connected signal generators.
Dialog boxes

The dialog box settings are defined as follows:

<table>
<thead>
<tr>
<th>Field name</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O address (=..3EFH)</td>
<td>The I/O address of the ISA card must be set within the range from 0 to 3FFH. You must set the I/O address according to the setting of S1 on the module. The signal module uses 16 successive I/O addresses, starting at the set base address. The address is always defined in hexadecimal format. Any change of this address is entered in the registry after you close the dialog by clicking &quot;OK&quot;. The default address is 180H. This setting is not required for the PCI type card.</td>
</tr>
<tr>
<td>Driver</td>
<td>Start or stop the driver using this button.</td>
</tr>
<tr>
<td></td>
<td>Stop: The driver is already active and is stopped by clicking the button.</td>
</tr>
<tr>
<td></td>
<td>Start: The driver is in stop state. A hardware conflict may be active if you click this button and it continues to show “Stop”.</td>
</tr>
<tr>
<td>Trigger Watchdog</td>
<td>The watchdog is triggered once when you click this button. (Test)</td>
</tr>
<tr>
<td>Main Unit</td>
<td>You can only activate the &quot;Main Output&quot; check box in the &quot;Main Unit&quot; group (group message).</td>
</tr>
<tr>
<td>Main Output</td>
<td>After you activated this check box, the connected sensor is activated at the output of the group signal.</td>
</tr>
<tr>
<td>Binary Input Channels</td>
<td>Displays the status of binary inputs 1, 2 and 3.</td>
</tr>
<tr>
<td>Output Channels</td>
<td>A corresponding relay is activated if you select an output.</td>
</tr>
<tr>
<td></td>
<td>The outputs are controlled in system runtime by means of the permanently assigned tags.</td>
</tr>
<tr>
<td>OK</td>
<td>Use this button to close the Setup dialog box. The I/O address and the auto-trigger settings are activated in the registry.</td>
</tr>
<tr>
<td>Cancel</td>
<td>This button is used to close the dialog box. No changes are made to the registry.</td>
</tr>
</tbody>
</table>

Note

The previous "Auto-Trigger Watchdog" option is no longer available, as the PCI version of the signal module does not support auto-triggering of the watchdog.

See also

Installing the Signal Module (Page 147)

3.12.10 Pin Assignment of the External Interface

Pin Assignment Watchdog and Horn Signal Interface (X1)

The sensor output and the channel outputs are directly connected externally. Each contact controls a signaling device. In the event of an error message, the main contact and the assigned detail contact are set. An acknowledgment results in the control software resetting
the main contact and all detail contacts. The acknowledgment is triggered externally via the acknowledgment input or by the software.

The following table shows the wiring of a 25-pin Sub-D plug which is used for connecting external devices (lights, buzzers, bells, buttons, etc.).

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
<th>Description</th>
<th>Connection</th>
</tr>
</thead>
<tbody>
<tr>
<td>*H</td>
<td>*S</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
<td>Signaling device M</td>
<td>Relay center contact</td>
</tr>
<tr>
<td>2</td>
<td>+</td>
<td>Reset output</td>
<td>Optocoupler</td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>Reset output</td>
<td>Optocoupler</td>
</tr>
<tr>
<td>4</td>
<td>+</td>
<td>Reset input</td>
<td>Optocoupler</td>
</tr>
<tr>
<td>5</td>
<td>-</td>
<td>Reset input</td>
<td>Optocoupler</td>
</tr>
<tr>
<td>6</td>
<td></td>
<td>Signaling device R</td>
<td>Relay, normally closed contact</td>
</tr>
<tr>
<td>7</td>
<td></td>
<td>Signaling device A</td>
<td>Relay, front contact</td>
</tr>
<tr>
<td>8</td>
<td></td>
<td>Watchdog M</td>
<td>Relay center contact</td>
</tr>
<tr>
<td>9</td>
<td></td>
<td>Watchdog R</td>
<td>Relay, normally closed contact</td>
</tr>
<tr>
<td>10</td>
<td></td>
<td>Watchdog A</td>
<td>Relay, front contact</td>
</tr>
<tr>
<td>11</td>
<td>+</td>
<td>BI 1 *BI</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>-</td>
<td>BI 1 *BI</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>+</td>
<td>BI 2 *BI</td>
<td>Optocoupler</td>
</tr>
<tr>
<td>14</td>
<td>+</td>
<td>BI 3 *BI</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>-</td>
<td>BI 3 *BI</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td></td>
<td>Output 1 M</td>
<td>Relay center contact</td>
</tr>
<tr>
<td>17</td>
<td></td>
<td>Output 1 A</td>
<td>Relay, front contact</td>
</tr>
<tr>
<td>18</td>
<td></td>
<td>Output 1 R</td>
<td>Relay, normally closed contact</td>
</tr>
<tr>
<td>19</td>
<td></td>
<td>Output 2 M</td>
<td>Relay center contact</td>
</tr>
<tr>
<td>20</td>
<td></td>
<td>Output 2 A</td>
<td>Relay, front contact</td>
</tr>
<tr>
<td>21</td>
<td></td>
<td>Output 2 R</td>
<td>Relay, normally closed contact</td>
</tr>
<tr>
<td>22</td>
<td></td>
<td>Output 3 M</td>
<td>Relay center contact</td>
</tr>
<tr>
<td>23</td>
<td></td>
<td>Output 3 A</td>
<td>Relay, front contact</td>
</tr>
<tr>
<td>24</td>
<td></td>
<td>Output 3 R</td>
<td>Relay, normally closed contact</td>
</tr>
<tr>
<td>25</td>
<td></td>
<td>-</td>
<td>BI 2 *BI</td>
</tr>
</tbody>
</table>

*H = Housing
*S = Shield
*BI = Binary Inputs

25-pin subminiature plug connector (pin connector with screw locking)
Comments

Wire the main signaling device (horn, signal lamp, etc.) to the main contact of the signal module. The main signaling device responds every time a detail contact is set, that is, each time an alarm is reported at the signal module.

You can connect the detail contacts to signal devices such as lamps or buzzers.

You can wire a device which is activated if the relevant signal module is no longer triggered to the watchdog alarm output. This event is triggered by a failure of the corresponding OS.

You must choose whether to reset the signal module using the control software (driver) or an external acknowledgment button.

Take the following measures to use both variants in parallel:

- Interconnect pins 1-2 and 3-4 at jumper X114 of the ISA card in order to enable acknowledgment by means of external pushbutton. You can find related topics in the section "Configuration of switches and jumpers on ISA bus".

- You can interconnect pins 3 and 4 at jumper X6 of the PCI card to enable acknowledgment by means of external pushbutton. You can find related topics in the section "Configuration of switches and jumpers on the PCI bus".

Wire an external pushbutton to the reset input. Wire the reset output accordingly in parallel to this button.

Horn interface (X2)

The module also features a 9-pin hardcopy interface (X2) which is not used for WinCC/PCS7.

See also

ISA Bus Signal Module (Page 136)
PCI Bus Signal Module (Page 143)
Structure of the Switches and Plug-In Jumpers with the ISA Bus (Page 140)
Structure of the Switches and Jumpers with the PCI Bus (Page 145)
4 Resources

4.1 Time Synchronization

Content

The "Time synchronization" editor synchronizes the time over the Local Area Network and the Industrial Ethernet Bus.

This documentation shows you the following:

- how to use the time reception service
- what hardware is supported
- how to configure the synchronization over the Industrial Ethernet Bus
- how to configure the synchronization over the Local Area Network

4.2 General Information on Time Synchronization

Introduction

Time synchronization is a WinCC application that controls the time synchronization throughout the system using the SIMATIC method. The NTP method is not used.

You configure time synchronization with the "Time Synchronization" editor. The time can be synchronized as follows:

- Via the local area network/terminal bus for the operator station
- Via the system bus/Industrial Ethernet Bus for WinCC servers with a link to the automation systems

If an AS is used as the time master, the synchronization interval there should be set to one second. We do not recommend this operating mode because the time will be lost with a memory reset on the AS.

User Rights in Windows

The user logged on under Windows must have the user right "Change the system time."

If the "Time synchronization via terminal bus (Slave)" function should be used, the user accounts of the respective partner stations must be set up on all the computers on which the users log on to the partner stations.
The Master/Slave Principle

A computer or a specialized device, such as Siclock, acts as a master clock. The master sends the time to all other devices, the slaves. Only a master can be active in the network and it generally has an external time signal receiver.

The slaves can use two different techniques to synchronize the time with the master:

- A master is active and sends the time message frames to the bus. The slaves receive the time message frames and synchronize their time based on them. Multiple devices can be configured as masters if they support the standby mode. The masters in standby mode are slaves as long as the active master continues to send time message frames. If a standby master does not detect any time message frames it assumes the function of the active master and starts to broadcast time message frames. The devices that communicate over the system bus use the "master broadcast" technique.

- The slaves are active and periodically query the master for the time for synchronization. Every slave must indicate what device is the master. If a master fails, the slaves cannot take over the functions of the master. The slaves therefore require a list of masters that take over if the original master fails. Computers on the local area network use this "polling" technique.

Time Synchronization in Runtime

Time synchronization is entered in the computer startup list in the case of the following events and is activated when runtime starts:

- when running the OS Project Editor
- after configuration in the "Time Synchronization" editor

After running the OS Project Editor, you must still configure the time synchronization. Once runtime starts, the time synchronization is activated after three minutes, maximum.

Preventing jumps in the time of day

Time jumps on the master are not sent to the system. WinCC does the following to prevent this:

- If the synchronization is performed via the terminal bus or an access point in the system bus is configured as master and another access point is configured as slave, the time synchronization is permanently disabled. A process control message to this effect is sent.

- If the synchronization is performed via the system bus and the access points in the system bus are configured as master, the access points are switched to "slave" mode. The master of another computer takes over the time synchronization and synchronizes the time of the affected computer. A process control message to this effect is sent.
Note

Greenwich Mean Time (GMT) or winter time is used on all devices on the system bus for user data and time message frames. You could only upgrade V5 projects to WinCC V5 online if the "V5-compatible communication mode" check box was activated in the "Parameters" tab of the "Computer Properties" dialog box in the WinCC Explorer. The following default setting is enabled for this option:
- for newly created projects as of WinCC V6: check box is deactivated.
- for projects migrated from WinCC V5: check box is activated.

Note

Up to Version WinCC V 5.1, clock synchronization on the PROFIBUS was supported. This function is no longer directly available as of WinCC V 6.0. For questions concerning this problem, please contact Customer Support.

See also

Hardware Support of Time Synchronization (Page 169)
The "Time Synchronization" editor (Page 156)
How to configure the synchronization through the system bus/CP1613 and CP1623 (Page 159)
How to configure the synchronization over the Local Area Network (Page 165)
Simultaneous use of Time Synchronization over System Bus and Local Area Network (Page 167)
4.3 The "Time Synchronization" editor

Introduction

Open the "Time Synchronization" editor by double clicking on it in the WinCC Explorer. You specify the required settings in the configuration dialog box:

- General Settings:
  - Use time receive utility
  - Deactivate time synchronization

- Synchronization via Terminal Bus (Slave):
  - Use the time from a connected WinCC server
  - Use the time from a specific computer:
    - Computer 1: \DPC4006
    - Computer 2: \DPC4008

- Synchronization via System Bus (Master, Slave):
  - Access point 1:
    - Master
    - Slave
  - Access point 2:
    - Master
    - Slave

- Display symbolic name of the access point

- Process controlling messages
  - Send once
    - Repeat every 2 minutes

- Project documentation
  - Print
  - Preview
  - Setup
Use time receive utility
The time reception service is activated by activating the "Use time receive utility" check box.
If used on the system bus the time synchronization checks now whether the time reception
service is deactivated in slave mode and activated in master mode.
Disable time reception service in slave mode in order to prevent the station time from being
set in parallel by the time synchronization and by the time reception service.

Disabling time synchronization
Time synchronization is deactivated by activating the "Deactivate time synchronization" check
box. The time message frames are no longer transferred and/or the local time is not going to
be set. Time synchronization is only deactivated after you activated the check box and
confirmed this setting by clicking "OK". A corresponding operating message is output in
Runtime each time you activate / deactivate time synchronization.

Synchronization settings
Synchronization can be configured via the system bus, Industrial Ethernet bus, or LAN.
Activate the corresponding check boxes. You can also use both options in parallel.

Synchronization via terminal bus
Time synchronization via terminal bus / LAN is available in WinCC Server projects and on
WinCC Clients. You have three optional configurations:
- The station time is received automatically from an interconnected WinCC Server. This
corresponding service packages must be loaded.
- The time is received from one of the network stations you entered in the "Computer 1" and
"Computer 2" input boxes.
- The time is set by means of an external third-party component.

Synchronization via system bus
Time synchronization via system bus / Industrial Ethernet is only available in WinCC Server
projects. The selection boxes are disabled if the station to be configured is a client.
You can use a BCE network card or up to two CP1613 or CP1623 for the time synchronization.
The "Access point 1" and/or "Access point 2" selection list shows all devices or network cards
installed on the station which support time synchronization via Industrial Ethernet Bus. Select
the device from the drop-down list box to configure it for operation in master or slave mode.
Activate the corresponding check box to specify the device mode.
You can also view the access points whose symbolic names are enclosed by "< >" brackets
on order to configure time synchronization at an ES. Activate the corresponding check box.
These names are assigned to the physical name of the access points during startup of the
target station in runtime.
If you are using two access points with CP1613, the symbolic names are assigned the following
modules in SIMATIC NET:
### Symbolic name

<table>
<thead>
<tr>
<th>Symbolic name</th>
<th>&quot;Set PG/PC Interface&quot; dialog box</th>
<th>&quot;Set PC Station&quot; dialog box</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;CP1613 (1)&gt;</td>
<td>CP1613(ISO)</td>
<td>CP1613</td>
</tr>
<tr>
<td>&lt;CP1613 (2)&gt;</td>
<td>CP1613(ISO)&lt;Board 2</td>
<td>CP1613(2)</td>
</tr>
</tbody>
</table>

The symbolic name "<Softnet (1)>" or "<Softnet (2)>" is used for the BCE network card.

The internal tags "@TimeSyncDevice1State" and "@TimeSyncDevice2State" are used for both access points. These tags display the status of the access points and are used for diagnostics functions in runtime. Possible values are "Slave", "Standby master", "Active master" and "Deactivated".

### Note

The project engineer may not create any tags with @ prefix. Such actions are reserved for handling in the WinCC PCS7 software. You are not allowed to manipulate these system tags. The system tags are necessary for proper functioning of the product.

### Settings for process control system messages

The system outputs PCS messages in Runtime if problems occur during synchronization. You can define how often to display the cyclic process control messages 1012002-1012005, 1012018, 1012021 and 1012028 in runtime by corresponding settings in the "Process control messages" field.

Activate the "Send once" check box to display a process control message only once.

Deactivate the "Send once" check box to output the process control message several times during runtime. Enter the required value directly in the "Send every ... minutes" input box or use the rotary controller.

### Creating project documentation

Click "Print Project Documentation" to immediately print the configuration data on the assigned printer. Click "Preview" to open a preview of the pages to be printed. You can view the pages as they will be printed and check them.

Click "Setup" you configure the print job. The dialog box tabs provide the following options:

- Selecting the printer.
- Selecting the layout.
- Defining start parameters.
- Selecting the print scope.

### Note

Time synchronization takes effect a few minutes after its activation in Runtime. Synchronize the local PC clocks before you activate Runtime if precise time synchronization is required during startup. This may be necessary, for example, in order to receive the PCS messages in the correct sequence.
4.4 How to configure the synchronization through the system bus/CP1613 and CP1623

Introduction

You can use up to two devices to synchronize the time over the system bus. If only one device is being configured, always use "access point 1". With "Access point 2", you have the option of configuring the following tasks:

- Implement one device redundantly
- Synchronize two system buses over a type of "bridge"
- Synchronize two system buses as simultaneous masters

Due to a system feature in connection with the interplay between AS417-4H and CP443-1EX11 (Industrial Ethernet), the time synchronization on the redundant System Bus is only possible as from CP443-1EX11 Firmware Version 2.3.
Procedure

1. Activate option "Synchronization via System Bus (Master, Slave)."

2. Select the desired device from the drop down list box of "Access point 1" and "Access point 2." The drop down list boxes show all devices installed on the computer which support time synchronization via system bus.
3. Activate the corresponding check box to define the device as master or slave.

4. The installed access points are unknown if you configure station time synchronization on a different computer. The symbolic name of access points may be displayed in brackets "< >" for this reason, for example, "<CP1613 (1)>". If you want to use symbolic names for access points, activate the "Display symbolic name of the access point" check box. The symbolic names of the access points are assigned to the physical names of the access points during startup in Runtime.

If two access points such as two CP1613 boards are configured on the same computer, the combination of functionality returns the following behavior:

<table>
<thead>
<tr>
<th>Access point 1</th>
<th>Access point 2</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slave</td>
<td>Slave</td>
<td>The computer always operates in slave mode. This combination is used if a redundant bus is available. The system bus whose master receives the time from an external time signal receiver is used to synchronize the local time of the station.</td>
</tr>
<tr>
<td>Master</td>
<td>Master</td>
<td>The station operates as cooperative master at both access points and bus systems. Either the masters transfer the time message frames to both bus systems, or operate in standby mode as slave on both bus systems. Note that after changing the active master to standby mode on one device, the partner device automatically changes to standby mode. The transmitted time message frames contain information from the master pertaining to the quality of external synchronization. If an access point changes to a different state, the functionality of the active master is forced at the standby master if its external synchronization is operating properly. This ensures that the master with the best external synchronization transmits the time message frames on the bus.</td>
</tr>
<tr>
<td>Master</td>
<td>Slave</td>
<td>This setup results in a &quot;bridge&quot; function. The station synchronizes itself with the time message frames received on bus 2 (access point 2) and acts as a master on bus 1 (access point 1). Access point 1 always operates as active master and acts as though it is handling external synchronization, regardless of whether it really handles external synchronization. This prevents a standby master from taking over the role of the active master. Synchronization between the two bus systems would be split in this case. The station would receive two different times from the two bus systems. Access point 1 assumes the active master function if another master is activated on bus 1 during startup of the station.</td>
</tr>
<tr>
<td>Slave</td>
<td>Master</td>
<td>Acts as the master/slave combination in reverse.</td>
</tr>
</tbody>
</table>

**Note**

The selection boxes are disabled if the station to be configured is WinCC Client.

**See also**

The "Time Synchronization" editor (Page 156)

Simultaneous use of Time Synchronization over System Bus and Local Area Network (Page 167)
4.5 How to Configure the Synchronization through the System bus/BCE

Introduction

You can use a BCE network card to synchronize the time over the system bus. If only one device is being configured, always use "access point 1". With the option "Access point 2", you can configure the following tasks:

- use a second access point with a CP1613.
- synchronize two system buses over a type of "bridge"
- synchronize two system buses as simultaneous masters.

Prerequisite

- Only one BCE network car can be used for time synchronization on an OS.
- The ISO log must be installed and activated for the network card.
- The BCE network card can be used for up to eight connections.
- The time synchronization via a BCE network card cannot be used redundantly.
- A 1 - 10 second grid must be set on the external time transmitter.
- The following target address is used for Multicast with a BCE/CP1612 network card: Address 09-00-06-01-FF-EF.
- Broadcast must not be used.
Procedure

1. Activate option "Synchronization via System Bus (Master, Slave)".

2. The drop down list for "Access point 1" shows all of the network cards and devices installed on the computer. Choose the BCE network card, suitable for time synchronization via the system bus, from the drop down list.

3. The installed access points are unknown if you configure station time synchronization on a different computer. The symbolic name of access points may be displayed in brackets "< >" for this reason, for example, "<Softnet (1)>". If you want to use symbolic names for access points, activate the "Display symbolic name of the access point" check box. The symbolic names of the access points are assigned to the physical names of the access points during startup in Runtime.
4. Activate the corresponding check box to define the device as master or slave.

5. As an option, you can choose a CP1613 card as a second access point.

If two access points such as a BCE network card and a CP1613 card, are configured on the same computer, the combination of functionality returns the following behavior:

<table>
<thead>
<tr>
<th>Access Point 1</th>
<th>Access Point 2</th>
<th>Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slave</td>
<td>Slave</td>
<td>The computer always operates in slave mode. This combination is used if a redundant bus is available. The system bus whose master receives the time from an external time signal receiver is used to synchronize the local time of the station.</td>
</tr>
<tr>
<td>Master</td>
<td>Master</td>
<td>The station operates as cooperative master at both access points and bus systems. Either the masters transfer the time message frames to both bus systems, or operate in standby mode as slave on both bus systems. Note that after changing the active master to standby mode on one device, the partner device automatically changes to standby mode. The transmitted time message frames contain information from the master pertaining to the quality of external synchronization. If an access point changes to a different state, the functionality of the active master is forced at the standby master if its external synchronization is operating properly. This ensures that the master with the best external synchronization transmits the time message frames on the bus.</td>
</tr>
<tr>
<td>Master</td>
<td>Slave</td>
<td>This setup results in a &quot;bridge&quot; function. The station synchronizes itself with the time message frames received on bus 2 (access point 2) and acts as a master on bus 1 (access point 1). Access point 1 always operates as active master and acts as though it is handling external synchronization, regardless of whether it really handles external synchronization. This prevents a standby master from taking over the role of the active master. Synchronization between the two bus systems would be split in this case. The station would receive two different times from the two bus systems. Access point 1 assumes the active master function if another master is activated on bus 1 during startup of the station.</td>
</tr>
<tr>
<td>Slave</td>
<td>Master</td>
<td>Acts as the master/slave combination in reverse.</td>
</tr>
</tbody>
</table>

**Note**

The selection boxes are disabled if the station to be configured is WinCC Client.
4.6 How to configure the synchronization over the Local Area Network

Introduction

There are three types of time synchronization over the Local Area Network/terminal bus:
1. The computer is synchronized automatically via a connected WinCC server.
2. The time is imported from one of the permanently defined computers in the network.
3. The time is set via a third-party component.

The WinCC client queries the computer for its time and synchronizes its time with this time. The following options for setting are available.
4.6 How to configure the synchronization over the Local Area Network

- Import Time from a Connected WinCC Server
- Import Time from Permanently Defined Computers
- Setting time over an external (third-party) component

Client computers are integrated into time synchronization via routers. UTC is used as the time base. If the client computer is located in a different time zone, it will automatically switch to the local time zone for display and output purposes.

Import Time from a Connected WinCC Server

WinCC clients and servers with their own project can use the WinCC servers whose packages they have loaded. If the server that was named as master fails, the WinCC client selects another server from the list of packages. A WinCC server must be in runtime mode to be able to detect a client as the time master. Only the active WinCC master can be the time master for a redundant server pair.

Import Time from Permanently Defined Computers

When you select the "Import Time from permanently defined computers" radio button is selected, the "Computer 1" and "Computer 2" input fields can be edited. Enter the names of the specified computers from which the time will be imported here. Use "Computer 1" as long as it remains available. Then use "Computer 2". The status of the WinCC project on the defined computers is not taken into account. Only the operating system must be fully functional.

The computer name can be a Windows computer name, such as "\kh19074d", or a qualified domain name if a DNS server is available. A complete name would be something like "kh19074d.khe.siemens.de" or "kh19074d", if the slave is in the same DNS domain as the master.

WinCC does not have to be installed on the specified computer. If both specified computers are not available, the time synchronization will be lost.

Setting time over an external (third-party) component

When you select this radio button, you are specifying that the time will be set by an external component. "Time Synchronization" must not set the computer time.

Synchronizing a client without its own project

To synchronize a client without its own project from a server, you will have to enter the application "ccTMTimeSync.EXE" in its startup list. In this case, no additional synchronization may be active on the default client (e.g.: DCF77 Client Service or other 3rd Party Software, which provides the local PC time).

Note

If the DCF-77 time receive utility is used, the "Allow time to be set by external (third-party) component" radio button must not be activated. Instead the "Use time receive utility" check box must be activated.
See also

The "Time Synchronization" editor (Page 156)
Simultaneous use of Time Synchronization over System Bus and Local Area Network (Page 167)

4.7 Simultaneous use of Time Synchronization over System Bus and Local Area Network

Introduction

The time can be synchronized simultaneously over the system bus and the Local Area Network. The local computer time in this case will always be synchronized with that of the Local Area Network. The access points on the system bus can only be configured as masters to forward the time received from the Local Area Network to the system bus.
Configure time synchronization on one computer of a Windows domain

The computer must be synchronized with the domain time to function normally in the domain. Because the Windows synchronization only guarantees a time synchronization of ± 2 seconds, you must configure the synchronization with permanently defined computers.

1. Enter the primary domain controller as “Computer 1”.
2. Optionally, enter an additional Primary Domain Controller as “Computer 2”, if one is available.
3. Configure the access points on the plant bus as masters by enabling the relevant check boxes. Even if you are operating in standby mode, never set the local time.
Note

If the WinCC servers belong to a Windows domain and a specialized device, such as Siclock, operates as the time master on the system bus, the Siclock and the domain must have the same time. We recommend equipping both with an external time receiver.

Synchronization via system bus is not allowed if the "Use the time from a connected WinCC server" check box is activated. This is because it makes no sense to import the time from a server connected to the system bus and then to send this time back to the system bus.

4.8 Hardware Support of Time Synchronization

4.8.1 Hardware Support of Time Synchronization

Industrial Ethernet with automation systems

Time synchronization must have access to the Industrial Ethernet Bus with which the AS communicates. Special hardware boards include the function of sending and receiving time message frames. The following Industrial Ethernet devices support time synchronization:

- CP1613 hardware board
  The software is integrated onboard.
- SoftNet/BCE Hardware/Software solution
  A software driver emulates the hardware.

The two devices have the following properties:

- They have an internal clock.
- They can operate as slaves. They detect when the time message frames are not being received.
- They can operate as active or standby masters.
- The synchronization interval is permanently set at 10 seconds and cannot be configured.

Local Area Network with operator station

The operator station synchronizes its local time over the Local Area Network. All network adapters that support Windows can be used.

External time reception station

The DCF 77 or GPS time signal receivers at the serial port operate with the "DCF77 reception service" program as an external reception station. The reception station synchronizes the internal time of the computer using the received radio waves. The time synchronization cooperates with the time reception service. The software is activated if the computer is an
active master and it is deactivated if the computer is a slave. This enables the time synchronization alone to set the internal computer clock.

An external receiver must be available on both redundant WinCC stations.

See also

Time signal receiver (Page 170)
General Information on the Time Reception Service (Page 172)

4.8.2 Time signal receiver

Introduction

The following time signal receivers are supported WinCC:

- DCF77-Receiver DCFRS
- WINGPS GPS receiver

DCF77-Receiver DCFRS

The DCF77 receiver is an external receiver station for time signals used for synchronizing the computer clock. The receiver is connected to the COM2 serial interface.

The signals are received from the long-wave transmitter DCF77, which has been transmitting time signals in coded form on the 77.5 kHz frequency for over 20 years. Because of its central location in Central Europe (Mainflingen near Frankfurt) and its extensive range up to 2000 km, this transmitter is significant far beyond Germany.
### DCFRS Driver

A driver is supplied for the DCFRS receiver. This must be loaded before the DCFRS receiver is put into operation. The driver and the description are included in the scope of delivery for the DCFRS.

### WINGPS GPS receiver

The GPS receiver is a receiving station for satellite signals for synchronizing the computer connected externally to the COM2 serial port.
WINGPS Driver

A driver is included with the WINGPS receiver. This must be loaded before the WINGPS receiver is put into operation. The driver and the description are included in the scope of delivery for the WINGPS.

Note
During plant configuration, make sure that several applications are assigned to the COM interfaces:

- WinCC redundancy/redundant batch server
- Time receiver (DCF77/GPS)
- Chip-card Reader

It is usually not possible to run all applications simultaneously as standard computers are only equipped with two COM ports.

4.9 General Information on the Time Reception Service

4.9.1 General Information on the Time Reception Service

The DCF-77 time reception service

The DCF77 long-wave transmitter transmits time information in coded form on the 77.5 kHz frequency. Because of its central location in Central Europe and its extensive range up to 2000 km, this transmitter is significant far beyond Germany. The time information that is broadcast is picked up by the two atomic clocks CS1 and CS2 of the "Physikalisch-technische Bundesanstalt" in Mainflingen near Frankfurt, Germany, and represents the official time according to the Time Law of 1978 of the Federal Republic of Germany. It corresponds to central European time or central European daylight-saving time and is derived directly from the internationally accepted "Universal Time Coordinated" scale.

Note
After having installed the DCF77 receiving service you start it using either the Windows system management or you the restart the PC.

The "DCF77 receiving service" software Version V1.22 is used for the connected DCF77 radio receiver or the GPS satellite receiver. Check the version by clicking the DCF77 icon in the station's Control Panel. Click the About button in the dialog box.

If you choose "UTC" as time reference for the "DCF77 Reception Service" dialog, you may not configure any "GMT" time shift for "SICLOCK GPSDEC".

With the exception of the FIFO buffer, the Windows default setting for the COM interface is maintained. Deactivate the "Use FIFO buffer" option at "Advanced settings".
Dialog box for opening time synchronization

You can assign time synchronization parameters on the DCF-77 object in the Control Panel. Open the required dialog box as follows:

1. Select "Start > Settings > Control Panel". This opens the "Control Panel".
2. In the "Control Panel" folder, double-click "DCF-77". This opens the "DCF77 Reception Service" dialog box.
3. You configure all required settings within this dialog box.

Structure of the dialog box

<table>
<thead>
<tr>
<th>Input Box</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signal Source</td>
<td>The entry &quot;Serial&quot; is shown in this input box by default. You cannot edit this input box.</td>
</tr>
<tr>
<td>Connection</td>
<td>Enter the COM port to which the external DCF77 or GPS receiver is connected. The recommended default is COM2.</td>
</tr>
<tr>
<td>Signal Shape</td>
<td>The entry &quot;DCF77 demodulated&quot; is shown in this input box by default. You cannot edit this input box.</td>
</tr>
<tr>
<td>Time reference</td>
<td>In this dialog box, you specify the desired time reference. The following time references can be set: UTC, local time or CET/CEST.</td>
</tr>
<tr>
<td>Check CET/CEST time zone</td>
<td>When this check box is enabled, the setting of the CET/CEST time zone is checked in the Control Panel. The result is saved in the event protocol. If a different time zone is set in the control panel, the check is not made.</td>
</tr>
<tr>
<td>Suppress Synchronization</td>
<td>If this check box is enabled, the system time is not synchronized.</td>
</tr>
<tr>
<td>Balance Deviations Smoothly</td>
<td>If this check box is enabled, the system time is smoothly balanced to the current time if the deviation is below the maximum permissible value (&quot;tolerance&quot;). The internal timing is slowed down or accelerated accordingly by 1 ms per second or 60 ms per minute.</td>
</tr>
<tr>
<td>First update after</td>
<td>In this input box, you specify how many correctly decoded time message frames (= minutes) must occur before the system time is updated for the first time.</td>
</tr>
<tr>
<td>Update Interval</td>
<td>In this input box, you specify how many time message frames (= minutes) must occur following the initial update before a renewed comparison to the system time or, where appropriate, a correction of the system time is made.</td>
</tr>
<tr>
<td>Permitted Deviation</td>
<td>In this input box, you specify the maximum permissible time difference in ms that can occur before the system time is updated.</td>
</tr>
<tr>
<td>Event Log</td>
<td>The events are recorded in the event log. How to open this event log: Select the &quot;Start &gt; Programs &gt; Management (General) &gt; Event Display&quot; command.</td>
</tr>
<tr>
<td>Time Comparisons</td>
<td>When this check box is enabled, all time comparisons are entered in the event log.</td>
</tr>
<tr>
<td>Every Valid Time Message Frame</td>
<td>When this check box is activated, every valid time message frame is entered in the event log.</td>
</tr>
<tr>
<td>Changes in Signal Quality</td>
<td>When this check box is activated, every change of signal quality is entered in the event log.</td>
</tr>
</tbody>
</table>

See also

Effects of the Time Reception Service (Page 174)
4.9.2 Effects of the Time Reception Service

Introduction
If the "Use time receive utility" check box is enabled in the "Time Synchronization" editor, the time synchronization uses the time reception service to set the computer time. This prevents other processes from setting the internal time.

Effects on a computer in slave mode
If the computer is operating as a slave, the time synchronization deactivates the time reception service with a software setting. Otherwise the time synchronization and time reception service would set the local time.

Effects on a computer in active master mode
If the computer is operating as an active master, the time synchronization activates the time reception service and allows it to set the local time. If the active master, e.g. as a result of failure, becomes a passive master, the time reception service deactivates itself internally. The checkmark in the check box remains set, so if the computer becomes an active master again the time reception service is automatically activated.

Effects on a computer in standby master mode
If the computer is operating in standby master mode, the time synchronization deactivates the time reception service. It continues to check that the external synchronization functions correctly. If the incoming time message frames are sent by a master without external synchronization, the standby master takes on the role of the active master. It then sends its own time message frames.

See also
General Information on the Time Reception Service (Page 172)
5 Resources

5.1 Lifebeat Monitoring

Content

The "Lifebeat Monitoring" editor serves to monitor all servers, clients and automation devices that can be reached across PC and industrial networks.

Note

The simultaneous utilization of Lifebeat Monitoring and Asset Management is not supported.

This documentation shows you the following:

- how Lifebeat Monitoring works
- how to configure Lifebeat Monitoring
- how to configure Lifebeat Monitoring with OPC connection.
5.2 General Information About Lifebeat Monitoring

Functionality

Lifebeat monitoring monitors WinCC stations and automation devices that are accessible over PC and industrial networks.

The above sketch illustrates as an example the structure of a lifebeat monitoring system with the computers of the command level and the subordinate process level.

You can configure lifebeat monitoring only via Industrial Ethernet and PROFIBUS connections of the "SIMATIC S7 PROTOCOL SUITE" or via an OPC connection between WinCC stations. NetDDE is not supported.

See also

How to configuring lifebeat monitoring with an OPC connection (Page 178)
Visualizing the Lifebeat Monitoring in Runtime (Page 180)
5.3 Function Principle of Lifebeat Monitoring

Introduction
Lifebeat Monitoring monitors servers, clients, and automation devices. In general, Lifebeat Monitoring runs on a central WinCC client. It provides a view of the lifebeat objects associated with a project and of automation devices and operator stations of other projects. To this end, all plant parts must be connected to a shared network.

Tasks of the Servers
The servers have the following tasks:

- The servers record the data for the process images and messages from the automation devices. To this end, the servers are connected via industrial networks, e.g. PROFIBUS, to the automation devices.
- The servers provide the process data for the WinCC clients and record processing states.

Tasks of the WinCC Clients
The WinCC clients have the following tasks:

- The WinCC clients are used for inter-server operator control and monitoring of the entire system. By double-clicking on the picture of the server, the WinCC client can see all the way to the automation device.
- The WinCC clients obtain the states of the respective servers over the network.

Tasks of the Automation Devices
The automation devices have the following tasks:

- The automation devices perform on-site measurement, control and regulating tasks.

Requirements for monitoring
The following operating states are relevant to monitoring:

- Connection established
- Connection not established
- Disturbed

Monitoring Cycle
You set the monitoring cycle to the values 5 s, 10 s, or 1 minute in the "Lifebeat Monitoring" dialog box. A default monitoring cycle of 10 seconds is preset.
Lifebeat Monitoring

5.4 How to configuring lifebeat monitoring with an OPC connection

Project

The following is assigned to a project:

- a group of automation devices
- or a standalone computer
- or Server computer with one or more WinCC client computers

Note

You cannot create @-prefixed tags yourself. Only the WinCC PCS7 software can do this. You are not permitted to manipulate these system tags. The system tags are required for proper functioning of the product.

While configuring AS and OS monitoring by means of Lifebeat Monitoring, device names should not be identical to pictures in the Picture Tree Manager or like internal tags with the @ name prefix.

5.4 How to configuring lifebeat monitoring with an OPC connection

Introduction

The communication between WinCC and specific types of automation systems is established over a channel. For AS monitoring, you can use Industrial Ethernet and PROFIBUS connections of the "SIMATIC S7 PROTOCOL SUITE". The OPC connection must be used to monitor WinCC stations. Monitoring via the OPC connection is limited to WinCC stations.

Since the software for the OPC-DA server and the OPC-DA client is included in the WinCC basic system, you can use WinCC simultaneously as an OPC-DA server and OPC-DA client. As a WinCC client, the computer can be simultaneously connected to several servers.

Note the following points for the configuration of the lifebeat monitoring in a distributed system or a distributed redundant system:

- The lifebeat monitoring of a server pair monitors its subordinate automation devices.
- Configure the monitoring of all WinCC clients in the network either only from the standard server pair or distribute the monitoring of the WinCC clients over several server pairs.

The OPC-DA client channel uses one channel unit. The channel unit does not require general configuration.
Procedure

1. Start WinCC and enter a new "OPC.CHN" driver in the tag management.

2. Select "OPC Unit #1".
   Open the shortcut menu. Select the "New Connection" command.
   A connection is created.

3. Select the "Properties" command from the shortcut menu of the new connection.
   Click "Properties" in the "General" tab.
4. Enter the name "OPCServer.WinCC" in the "OPC Server Name" box.
5. Enter the name of the computer to be monitored in the "Run the server on this computer" box.
6. Click "Test Server" to determine if the corresponding OPC connection can be established.

Note
Note that OPC connections must be correctly configured and fully operational to enable monitoring of PC stations (WinCC station, PCS7 OS).

5.5 Visualizing the Lifebeat Monitoring in Runtime

General
Note the following when visualizing the Lifebeat Monitoring:
- To call the visualization of the plant configuration, configure, for example, buttons with picture selection on "@Config.PDL".
- When the OS Project Editor is run, pre-configured basic data are created in the current project. This means that the picture selection is already on the system configuration for a button in the key set.
- With a WinCC client project, the connections to the server as well as the status of the lifebeat objects to be monitored by the server is displayed.
- When you click the system configuration, the configuration of the server whose packages have been loaded is displayed. This is not possible if the server has failed. In the "Disturbed" state, the disturbed Lifebeat objects can be displayed.

Note
You have to open and update the "Lifebeat Monitoring" editor on all participating servers in order to created the internal "@LBMRTConfigState" tag. Otherwise, the non-updated server in the "@Config.PDL" of the WinCC client will be shown with the "Disturbed" state in Runtime. The diagnostic window of the GlobalScript shows a non-existent tag.

See also
Function Principle of Lifebeat Monitoring (Page 177)
Practical Example of Lifebeat Monitoring (Page 183)
5.6 How to Design the System Configuration Picture

Introduction

The following possibilities are available for designing the system configuration picture "@Config.PDL":

- Automatically generating the system configuration picture
- Specifying custom positions of the lifebeat objects
- Inserting graphic objects into the system configuration picture
- Specifying custom display sizes of the lifebeat objects
- Specifying custom display forms of the lifebeat objects

Automatically generating the system configuration picture

1. In the "Device positioning in the system configuration" selection box, select the setting "Automatic". Lifebeat Monitoring will be updated.

Note

If the "Device positioning in the system configuration" option is set to "Automatic", the objects are tiled in the picture as of a certain number, depending on their size. If you do not wish this, then select "User-defined" and position the objects with the Graphics Designer.

Specifying custom positions of the lifebeat objects

You can change the positions of the lifebeat objects at any time using the "Graphics Designer" editor. An existing system configuration picture is a requirement.

1. Click "Edit picture". The system configuration picture @Config.PDL opens in the "Graphics Designer" editor.
2. Change the positions of the lifebeat objects and close the Graphics Designer.

Note

If you want to receive the lifebeat object changes, update Lifebeat Monitoring. To do so, select the setting "User-defined" in the "Device positioning in the system configuration" selection box. New lifebeat objects configured in the Lifebeat Monitoring are inserted at the specified positions in the system configuration picture during updating.
Inserting additional graphic objects into the system configuration picture

1. Click "Edit picture". The system configuration picture @Config.PDL opens in the "Graphics Designer" editor.
2. In the Graphics Designer insert additional graphic objects, e.g., standard, smart, or Windows objects, into the system configuration picture and then close the Graphics Designer.

Note
If you want to receive the lifebeat object changes, update Lifebeat Monitoring. To do so, select the setting "User-defined" in the "Device positioning in the system configuration" selection box. You cannot manually insert objects from the typical @ConfigTypicals.PDL into the system configuration picture.

Specifying display sizes of the lifebeat objects in the system configuration picture

Several display sizes for each lifebeat object are saved in the typicals picture @ConfigTypicals.PDL and @ConfigTypicals.PDL. The Lifebeat Monitoring uses the lifebeat object with the object property "type" = "<device type>/1" as the default for updating the system configuration picture.

1. Open the system configuration picture @Config.PDL in the "Graphics Designer" editor.
2. Select the device type whose display size you wish to change, e.g., "OS". Open the object properties in the shortcut menu of the device type.
3. Change the entry for the "type" object property from "OS/1" to "OS/2". The name of device type including the backslash may not be changed. Close Graphics Designer.
4. If you want to receive the lifebeat object changes, update Lifebeat Monitoring. To do so, select the setting "User-defined" in the "Device positioning in the system configuration" selection box.

Note
On a PCS 7 OS, you can also make the display changes using the Graphic Object Update Wizard, "Update the picture objects". Select the desired typical picture and the configuration file "LBMObjects.cfg".

Specifying display form of the lifebeat objects in the system configuration picture

If the supplied display forms for lifebeat objects available in the typical picture "@@ConfigTypicals.PDL" are insufficient, you will need to create your own typical picture.

1. Save the typical picture "@@ConfigTypicals.PDL" as a copy under the name "@ConfigTypicals.PDL". You must not change the "@@ConfigTypicals.PDL" typical file.
2. Create a copy of the existing display forms for the device type for which you wish to generate a new display form.
3. Enter a new identifier after the backslash for the "type" object property of the new object. The name of device type including the backslash may not be changed.
4. Now you can change the display form in the new object. Note that you may not delete any of the existing object properties. Close Graphics Designer.

5. If you want to receive the lifebeat object changes, update Lifebeat Monitoring. To do so, select the setting "User-defined" in the "Device positioning in the system configuration" selection box.

If the file @ConfigTypicals.PDL exists, Lifebeat Monitoring uses this file as the typical picture. Now the variants in the "@ConfigTypicals.PDL" typical file are available to you for designing the system configuration picture.

---

**Note**

You must not open the "Graphics Designer" editor while you are updating Lifebeat Monitoring.

---

**See also**

How to Design the System Configuration Picture (Page 181)

---

### 5.7 Practical Example of Lifebeat Monitoring

#### Introduction

In the figure below, you can see a WinCC operator control and monitoring system in which Lifebeat Monitoring is performed.
Monitoring of Several Projects

The Lifebeat Monitor is Server2, configured for project B. The monitor monitors Client3 and AS3, which belong to the same project B, as well as Server1, Client2 and AS2, which belong to project A.

The monitor also monitors AG4 and AG5 by means of the existing PROFIBUS connection. Server3 and Client4 cannot be monitored, as there is no PC network connection to them.

Error-Free Monitoring Operation

The Lifebeat objects are monitored via the internal tags created by the "Lifebeat Monitoring" Editor. The Lifebeat Monitor Server2 sends the status of the these tags to all configured Lifebeat objects according to the set cycle time e.g. every 10 seconds. In error-free operation, the activated Lifebeat objects reply to Lifebeat Monitor Server2 every time. From the tag status, the Lifebeat Monitor detects error-free operation of all the configured Lifebeat objects belonging to Lifebeat Monitoring.

Failure of Server1

An error occurs in Server1, for example, due to a power failure. After the Lifebeat Monitor (Server2) has sent the status of the tags to Server1, a return message is missing due to the error in Server1. The Lifebeat Monitor Server2 detects this. The appropriate message is sent to Client3, which is configured to Server2.

See also

How to configuring lifebeat monitoring with an OPC connection (Page 178)
Device List of Lifebeat Monitoring (Page 187)
5.8 Dialog box of the Lifebeat Monitoring

5.8.1 Dialog box of the Lifebeat Monitoring

Dialog box

The picture below shows you the structure of the "Lifebeat Monitoring" dialog box.
Procedure

Perform the following steps to open the "Lifebeat Monitoring" dialog box:

1. Double-click "Lifebeat Monitoring" in WinCC Explorer.
   The "Lifebeat Monitoring" dialog box opens.
   Create or edit the configuration in this dialog box.

In this dialog box, you configure the complete Lifebeat Monitoring.

Structure of the dialog box

The dialog box is divided into the following areas:

- **Device list**
  The name of the Lifebeat object is derived from the device name. All of the connections to the lifebeat objects that are to be monitored are entered in the device list. As standard, the device list contains five lines. You can change the number of input lines by clicking "Add" and "Delete".
  In a WinCC client project, the number of lines in the device list corresponds to the number of loaded server packages. The device name and device type are pre-defined at the WinCC client.
  You cannot add any new input lines or delete any input lines.

- **Buttons**
  The buttons are used to insert, delete, print, etc., the devices in the device list. You launch the "Graphics Designer" editor by clicking "Edit picture". In the Graphics Designer, you edit the system configuration picture. The "Add" and "Delete" buttons can not be enabled for the WinCC client.

- **System configuration**
  All configured connections are displayed within this area as a schematic system configuration. This system configuration is created automatically when you click "Update".

- **Monitoring cycle**
  You use these radio buttons to set the monitoring cycle of the connection. The default setting is 10 seconds.

- **Position devices in the system configuration**
  You use these radio buttons to define whether Lifebeat Monitoring should specify fixed positions and display forms for the lifebeat objects, or whether user-defined positions and display forms should be retained during updates.

- **Priority**: This input box allows you to specify a message priority for the process control messages of the lifebeat monitoring. You can enter a number from "0" to "16".

Entering a lifebeat object (only for single-user and multi-user projects)

1. Open the Lifebeat Monitoring editor and make the following entries:
2. Enter the name of the lifebeat object at "Device name".
3. Select an entry from the list at "Device type".
4. Select the previously created connection under "Connection".
5. Click "Update" to generate the system configuration.
The information from the loaded packages is not available for configuration of the lifebeat. After the configuration, the corresponding tag is entered for each device at the corresponding connection.

**Note**

Completely fill in the device list, consisting of device name, device type, and connection. A notice will appear if the list is not complete.

If you create or change a connection in the tag management, you must reassign the connection in the "Lifebeat Monitoring" editor.

No configuration in the "Lifebeat Monitoring" editor is possible on the WinCC client. Instead, an overview of all Lifebeat objects of the installed server project packages is displayed on the WinCC client.

If you can no longer open the lifebeat monitor, check whether the temporary file "Lbmcs.tmp" is available in the WinCC project folder. If yes, delete this file. Start the lifebeat monitor.

---

**See also**

- Buttons of Lifebeat Monitoring (Page 189)
- System Configuration of Lifebeat Monitoring (Page 189)
- General Information About Lifebeat Monitoring (Page 176)
- Practical Example of Lifebeat Monitoring (Page 183)

---

### 5.8.2 Device List of Lifebeat Monitoring

**Introduction**

Lifebeat monitoring is configured by means of the device list. Each device name is stored as a tag within the Tag Management of WinCC. The tag name has the structure "@<device name>". For the device name "Server12", for example, the tag "@Server12" is created. The data type of the tags is of no significance to the lifebeat monitoring, as only the status of the tags is queried.

**Note**

For lifebeat monitoring, a tag "@<device name>" is created for each device name. For the Picture Tree Manager, for each picture that contains a group display, a tag called "@<picture name>" is stored. This can cause conflicts with identical names. To prevent such conflicts, the picture name must not be the same as the device name or system tags with the "@" name prefix.

A message is displayed when this type of conflict occurs. The tag names that cause a name conflict are listed in log file "LifebeatMonitoringCS.log" in the "Diagnosis" folder of the installation directory. Change the device name to resolve the name conflict.
**Lifebeat Monitoring**

5.8 Dialog box of the Lifebeat Monitoring

---

**Note**

Once you delete an S7 connection on the engineering station and perform an OS compilation, the connection and the LBM tags are deleted in the WinCC Tag Management. However, the configured connection in the "Lifebeat Monitoring" editor is retained. You yourself must delete the relevant connection in the editor and save the new plant picture via the "Update" function. If the connection has not been deleted from Lifebeat Monitoring the runtime message "1009999" outputs the text "LBMRT: Tag '...' does not exist".

---

**Structure of the device list**

<table>
<thead>
<tr>
<th>Field name</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device name</td>
<td>Enter a unique device name in this input box. The device name may not exceed a length of 21 characters. The device names are set by default in a WinCC Client project. The symbolic station name is entered as the device name which can may be longer than 21 characters.</td>
</tr>
<tr>
<td>Device type</td>
<td>Specify the device type in this input box. Double-click this input box to open a selection list. The following device types are available: OS, OS-OP, OS-PC, OS/Client, AS-4xx, AS-3xx, AS-2xx, AS, Client. v is set by default in a WinCC Client project. Enter the OS status as the device type.</td>
</tr>
<tr>
<td>Connection</td>
<td>Double-click in this input box to open a selection list. Select your configured connection from this list.</td>
</tr>
</tbody>
</table>

**See also**

- Device List of Lifebeat Monitoring (Page 187)
- System Configuration of Lifebeat Monitoring (Page 189)
- General Information About Lifebeat Monitoring (Page 176)
## 5.8.3 Buttons of Lifebeat Monitoring

### Overview

<table>
<thead>
<tr>
<th>Button</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close</td>
<td>Use this button to close the dialog box.</td>
</tr>
<tr>
<td>Print</td>
<td>Use this button to print the feedback messages from the device list.</td>
</tr>
<tr>
<td>Printer Setup</td>
<td>Use this button to set up the current printer.</td>
</tr>
<tr>
<td>Views</td>
<td>Use this button to output a print preview of the feedback from the device list to the screen.</td>
</tr>
<tr>
<td>Add</td>
<td>Use this button to create a new empty line within the device list. This function is not available in WinCC Client projects.</td>
</tr>
<tr>
<td>Delete</td>
<td>Use this button to delete a line within the device list. Pay attention to the following:</td>
</tr>
<tr>
<td></td>
<td>• The device name is only deleted from the device list. It is not deleted from the tag list of the corresponding connection in WinCC Explorer. Reason: Other modules of the WinCC system can access this tag.</td>
</tr>
<tr>
<td></td>
<td>• Select a line and then click &quot;Delete&quot; to delete the entire line. Click the button with the device number to select a line.</td>
</tr>
<tr>
<td></td>
<td>• When you click &quot;Delete&quot;, you will not be asked whether you really want to delete the selected line.</td>
</tr>
<tr>
<td></td>
<td>• You can only delete single lines. You can not select a group of lines in order to delete this group. This function is not available in WinCC client projects.</td>
</tr>
<tr>
<td>Update</td>
<td>Use this button to create/update the system configuration. The system configuration is created by default with the name &quot;@CONFIG.PDL&quot; and saved to the project-specific picture folder. The geometry of the picture is based on the settings that were made in OS Project Editor. The &quot;Graphics Designer&quot; editor cannot be opened during the update.</td>
</tr>
<tr>
<td>Edit Picture</td>
<td>Open Graphics Designer directly with this button in order to edit the plant configuration picture &quot;@Config.PDL&quot;. You can only operate this button if the plant configuration picture exists.</td>
</tr>
</tbody>
</table>

### See also

- How to configure the object selection
- Device List of Lifebeat Monitoring (Page 187)
- Buttons of Lifebeat Monitoring (Page 189)
- General Information About Lifebeat Monitoring (Page 176)

## 5.8.4 System Configuration of Lifebeat Monitoring

### Introduction

Within the system configuration, all of the components to be monitored are shown as graphics. Components that are currently not ready to function, due to a fault, for example, are crossed out in the graphic with a red line.
Graphical structure of a system configuration

In this picture, you see an example of a system configuration "@Config.PDL":

If a number of automation systems (AS) are connected to an OS, they are shown in series.

The servers in the system configuration are represented as follows on a client:

- **Disturbed** - A device monitored by the server has failed.
- **Failed** - The server itself has failed.
- **Established** - The connection to the server has been established.
See also

Device List of Lifebeat Monitoring (Page 187)
Buttons of Lifebeat Monitoring (Page 189)
System Configuration of Lifebeat Monitoring (Page 189)
Practical Example of Lifebeat Monitoring (Page 183)
6 Resources

6.1 Picture Tree Manager

Content

The "Picture Tree Manager" is used to manage a hierarchy of systems, subsystems and Graphics Designer pictures.

This documentation shows you the following:

- How to create and change the hierarchy of a project
- How to define systems and subsystems
- How to assign pictures to these systems
- How to edit pictures
- How to create containers

6.2 General information about the Picture Tree Manager

Functionality

The Picture Tree Manager is a WinCC option and is only available to you if you selected the option package "Basic Process Control" during installation.

The Picture Tree Manager editor is used to manage a hierarchy of systems, subsystems and Graphics Designer pictures. The Picture Tree Manager provides you with the following functions:

- Create and change a project hierarchy.
- Support during the definition of systems and subsystems
- Support during assignment of pictures to these systems. It arranges the pictures created in the Graphics Designer.
- Support for picture selection in runtime by navigation in the hierarchy tree
Note

When you create new WinCC projects, you should also generate and save a picture hierarchy with the Picture Tree Manager.

Your settings in the Picture Tree Manager relate to the current WinCC project.

Actions that cross projects, such as copying/moving pictures and systems across multiple projects, are not possible.

You can only assign pictures to a system once.

On switching the language in the WinCC Explorer the language in the open Picture Tree Manager is also switched. The container names are only switched to the newly set language after starting the Picture Tree Manager.

Duplicate container names are not allowed in Picture Tree Manager. This is checked by the configuration interface. The container names cannot be manipulated through the Text Library. Trick configuration with the same container names but different numbers of spaces is also not allowed. This is also checked by the configuration editor. In this case as well, the container names cannot be manipulated through the Text Library.

With distributed systems, the area names in the projects of the various WinCC servers must be unique in order to ensure correct filtering and display of the messages according to the area.

It is not possible to configure the picture hierarchy on the WinCC client. Instead in Runtime on the WinCC client a full overview of all server projects imported to the hierarchies by packages is offered in Runtime on the WinCC Client.

The Picture Tree Manager has no limitation with respect to the hierarchy size. However, note that only the first 256 ranges can be configured for user authorization in the User Administrator. Messages or modules that are assigned to a range extended beyond this limit in the ES or OS cannot be selected in Runtime.

See also

Menu bar (Page 195)
Working with the Picture Tree Manager (Page 214)
Handling Tags with the Picture Tree Manager (Page 217)
How to add a new container by Drag&Drop (Page 215)
Effects on other applications (Page 229)
General information on the hierarchy (Page 218)
6.3 Picture Tree Manager Structure

6.3.1 Menu bar

6.3.1.1 Menu bar

Introduction

In the menu bar, all the commands of the Picture Tree Manager are divided into groups and assigned to menus. To execute a menu command, select the relevant menu and click the corresponding command. If necessary, assign parameters to the dialog box that opens.

"Project" menu

The following commands are available in the "Project" menu:

- Save
- Print Project Documentation Hierarchy and View Project Documentation Hierarchy
- Set up Project Documentation Hierarchy
- Print Project Documentation Group Display and View Project Documentation Group Display
- Set up Project Documentation Group Display
- Exit

"Edit" menu

The following commands are available in the "Edit" menu:

- Edit Picture
- Edit Container Name
- Cut Picture
- Cut Container
- Copy
- Insert
- Insert Picture Into Container
- Insert After
- Insert Before
- Insert Into Node
- New Container
- Delete Picture
6.3 Picture Tree Manager Structure

- Delete Container
- Properties

"View" menu

The following commands are available in the "View" menu:
- Standard Toolbar
  - Status Bar
  - Preview
  - Arrange Picture Icons Alphabetically
  - Arrange Picture Icons Automatically
- Large Symbols
- Small Symbols
- List
- Update

"Options" menu

The following commands are available in the "Options" menu:
- Confirm for Replace Picture
- Confirm for Delete Hierarchy
- Recalculate the group display hierarchy completely while saving
- Delta Save

"Help" menu

The following commands are available in the "Help" menu:
- Contents and Index
- Direct Help
- Using Help
- About Picture Tree Manager

6.3.1.2 How to save the hierarchy

Introduction

With the menu command "Save", you save the current hierarchy of the containers and pictures. Changes to the hierarchy affect all applications that are in runtime as Picture Tree Manager clients. Changes only affect the Group Display if the "Completely Recalculate Group Display on Save" option is activated.
Proceedure

1. Select the "Project > Save" menu command.
   or
   click the Save icon on the toolbar
   or
   press the <Ctrl+S> keystroke.
2. The data will be stored in the database of the project.

Note
All changes made while editing the "Picture Tree Manager" will only be accepted after saving the Picture Tree Manager.

Certain menu functions are disabled while data are being saved, for example in the "Project" menu. However, you can still edit the hierarchy.

See also
Menu bar (Page 195)

6.3.1.3 How to print the project documentation hierarchy

Introduction
Use the menu command "Project > Print Project Documentation Hierarchy..." to print the hierarchy on the selected printer. The printer settings you configured using the "Project > Set Up Project Documentation Hierarchy..." menu command are active.

Procedure
1. Select the "Project > Print Project Documentation Hierarchy..." menu command
   or
   click the Print icon on the toolbar

Note
The command starts the printout immediately. You can open a preview of the project documentation for the hierarchy by selecting the "Project > View Project Documentation Hierarchy" command.

See also
Menu bar (Page 195)
How to set up the project documentation hierarchy (Page 198)
### 6.3.1.4 How to set up the project documentation hierarchy

**Introduction**

Select the "Project > Set Up Project Documentation Hierarchy" to define specific criteria for printing the hierarchy tree. You specify these settings on the following three tabs in the dialog box:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Job</td>
<td>On this tab, you enter general information about the print job.</td>
</tr>
<tr>
<td>Selection</td>
<td>On this tab, you enter information about the page range and time range of the print data.</td>
</tr>
<tr>
<td>Printer Selection</td>
<td>In this tab, you specify the output device for the print job. The print job can also be directed to a file.</td>
</tr>
</tbody>
</table>

The appropriate system layout from the Report Designer is used for the printout.

**See also**

Menu bar (Page 195)

### 6.3.1.5 How to print the project documentation group display

**Introduction**

Select the "Project > Print Project Documentation Group Display..." menu command to print the group displays on the selected printer. The printer settings you configured using the "Project > Set Up Project Documentation Hierarchy..." menu command are active.

**Procedure**

1. Select the "Project > Print Project Documentation Group Display..." menu command.

**Note**

The command starts the printout immediately. You can open a preview of the project documentation for the hierarchy by selecting the "Project > View Project Documentation Group Display" command.

**See also**

Menu bar (Page 195)

How to set up the project documentation group display (Page 199)
6.3.1.6 How to set up the project documentation group display

Introduction

Select the "Project > Set Up Project Documentation Group Display" to define specific criteria for printing the group displays. You specify these settings on three tabs in the dialog box:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Job</td>
<td>On this tab, you can enter general information about the print job.</td>
</tr>
<tr>
<td>Selection</td>
<td>On this tab, you can enter information about the page range and time range of the print data.</td>
</tr>
<tr>
<td>Printer Selection</td>
<td>In this tab, you can specify the output device for the print job. The print job can also be directed to a file.</td>
</tr>
</tbody>
</table>

The appropriate system layout from the Report Designer is used for the printout.

See also

Menu bar (Page 195)

6.3.1.7 How to update Picture Tree Manager

Introduction

Select the "View > Update" menu command to update the contents of Picture Tree Manager. When new pictures are created and saved in the Graphics Designer and in the corresponding directory of the current project while the Picture Tree Manager is open, the new pictures only appear in the Picture Tree Manager after an update is performed. When pictures are deleted from the directory, you must perform an update to remove the pictures from the Picture Tree Manager.

Procedure

1. Select the "View > Update" menu command.
   or
   click the Update icon on the toolbar
   or
   press the <F5> key.
2. The existing graphics in the Picture Tree Manager are updated.

See also

Menu bar (Page 195)
6.3.1.8  How to exit the Picture Tree Manager

Introduction
Click "Exit" to close Picture Tree Manager.

Procedure
1. Select the "Project > Exit" menu command.
2. If you have made changes without saving, you will be asked whether you want to save your changes. Click the appropriate button.

See also
Menu bar (Page 195)

6.3.1.9  How to edit a picture

Introduction
Select the "Edit Picture" menu command to start Graphics Designer. Graphics Designer is used to edit the picture. This menu command is only enabled if a picture inserted into the tree has been selected.

Procedure
1. Select the picture you want to modify.
2. Select the "Edit > Edit Picture" menu command or select "Edit Picture" from the shortcut menu.
3. The Graphics Designer is started. You can now edit the picture.

See also
Menu bar (Page 195)

6.3.1.10  How to edit container names

Introduction
Select the "Edit Container Name" menu command to rename the container. You cannot rename the root container (WinCC project name). The container name can have a maximum of 200 characters.
Procedure

1. Select the container which you would like to rename.
2. Select the "Edit > Edit Container Name" menu command or activate editing mode by pressing <Ctrl+E> or select "Edit container name" from the the shortcut menu.
3. The container is in editing mode, You can now change the name.

Note
While in (container) editing mode, the picture name is hidden.

See also
Menu bar (Page 195)

6.3.1.11 How to cut a picture

Introduction
Select the "Edit > Cut Picture" menu command to copy a picture to the clipboard. This menu command is only enabled if a picture has been selected.
The clipboard contents are retained until replaced with a new entry by means of "Cut" or "Copy" menu commands.
The picture name remains visible in the container The picture name is shown in pointed brackets << Picturename.PDL>>. The picture can then be pasted to any other location.

Procedure

1. Click on the desired picture in the hierarchy window.
2. Select the "Edit > Cut Picture" menu command or select "Cut Picture" from the the shortcut menu.
3. The picture name is shown in pointed brackets as << Picturename.PDL>> and copied to the clipboard.
4. Finally you can insert the picture in a different place.

See also
Menu bar (Page 195)
6.3.1.12 How to cut a container

Introduction
Select the "Edit > Cut Container" menu command to cut and then copy a container and its sublevel hierarchy and pictures to the clipboard. The command is only enabled if a container has been selected from the hierarchy window.

The clipboard contents are retained until being overwritten with a new entry by the next "Cut" or "Copy" menu command.

The container remains visible at the cut location until it is pasted at another location.

Procedure
1. Click the desired container in the hierarchy window.
2. Select the "Edit > Cut Container" menu command or press the <Ctrl+X> keystroke.
   or Select the "Cut Container" command from the shortcut menu.
   The container and its corresponding nested hierarchy are copied to the clipboard. The container icons are displayed in gray color.
3. The container can then be pasted to any other location.

See also
Menu bar (Page 195)

6.3.1.13 How to copy a container

Introduction
Select the "Edit > Copy" menu command to copy the empty container in the selection window to the clipboard. The clipboard contents are retained until overwritten with a new entry by the next "Cut" or "Copy" menu command. After the copy operation, you can insert the clipboard contents into the hierarchy.

Procedure
1. Mark the empty container in the selection window.
2. Select the "Edit > Copy" menu command or press the <Ctrl+C> keystroke or select the "Copy" command from the shortcut menu.
3. Now select the container into which the new container should be inserted.

4. Select the "Edit" command from the menu bar or from the shortcut menu, and then select one of the three options "Insert After", "Insert Before" or "Insert Into Node".

**Note**

Inserting a new container into an existing node expands the hierarchy by one level.

If you insert a container before or after a container, the affected hierarchy level is expanded by one container.

**See also**

Menu bar (Page 195)

### 6.3.1.14 How to insert a picture or container

**Introduction**

This command is only available if a picture or a container was copied to the clipboard for pasting it to the selection window.

The "Edit > Paste" menu command pastes any picture saved to the clipboard into the selection window.

This is done likewise if the clipboard contains a container, including any subcontainers and pictures. However, the container name and the structure of the sublevel hierarchy will be lost. A notice will inform you of any possible loss of hierarchy information resulting from this action.

**Procedure**

1. Click in the empty area of the selection window
2. Select the "Edit > Paste" menu command or select the "Paste" command from the shortcut menu.

**See also**

Menu bar (Page 195)

### 6.3.1.15 How to insert a picture into a container

**Introduction**

Select the "Insert Picture Into Container" menu command to paste the clipboard contents into a selected container. The command is only enabled if the clipboard contains a picture.
If the container already contains a picture, it will be replaced by the new picture.
With the "Confirm for replace picture" check box, you change the behavior of the "Picture Tree Manager" with or without confirmation.

**Procedure**

1. Select the container into which you would like to insert the picture contained in the clipboard.
2. Select the "Edit > Insert Picture" menu command
   or
   Select the "Insert Picture Into Container" command from the shortcut menu.
3. The picture is pasted from the clipboard into the selected container. If the container already contains a picture, it will be replaced.

**See also**

Menu bar (Page 195)

**6.3.1.16 How to insert a container after another container**

**Introduction**

Select the "Insert After" menu command to paste the clipboard contents to a position after the selected container. The command is only enabled if a container (not the root-node) has been selected, and one or more containers have been copied into the clipboard.

**Procedure**

1. Select the container after which you would like to insert the contents of the clipboard.
2. Select the "Edit > Insert After" menu command
   or
   select the "Insert After" command from the shortcut menu.
3. The contents of the clipboard will be inserted after the selected container.

**Note**

You cannot insert a container before or after the root node.

**See also**

Menu bar (Page 195)
6.3.1.17 How to insert a container before another container

Introduction
Select the "Edit > Insert Before" menu command to copy the clipboard contents to a position before the selected container. The command is only enabled if a container that is not the root-node has been selected, and one or more containers have been copied into the clipboard.

Procedure
1. Select the container after which you would like to insert the contents of the clipboard.
2. Select the "Edit > Insert Before" menu command or select the "Insert Before" command from the shortcut menu.
3. The contents of the clipboard will be inserted before the selected container.

Note
You cannot insert a container before the root node.

See also
Menu bar (Page 195)

6.3.1.18 How to insert a container into another container

Introduction
Select the "Edit > Insert Into Node" menu command to paste the clipboard contents into the selected container. Each container in the clipboard is inserted as a new node of a sublevel hierarchy. The command is only enabled if a container that is not the root node has been selected, and one or more containers have been copied into the clipboard.

Procedure
1. Select the container into which you want to insert a new node (with the contents of the clipboard).
2. Select the "Edit > Insert Into Node" menu command or select the "Insert Into Node" command from the shortcut menu.
3. The new node (contents of the clipboard) is inserted in a new hierarchy level below the selected container.
6.3.1.19 How to insert a new container

**Introduction**
Select the "Edit > New Container" menu command to insert a new container before, after, or into the selected node.

After inserting the new container, the Picture Tree Manager will assign the name "Container" with a consecutive number, e.g. Container23.

**Procedure**
1. Select the container which is to be the reference for the insertion.
2. Select the "Edit > New Container" menu command and click the position (before, after, or in the node) at which the new container is to be inserted
   or
   select the "New Container" command from the shortcut menu and select the position (before, after, or in the node) at which the new container is to be inserted.
3. The container will be inserted and the editing mode is started.

See also
Menu bar (Page 195)

6.3.1.20 How to delete a picture

**Introduction**
Select the "Edit > Delete Picture" menu command to remove the selected picture from the hierarchy. The picture will automatically be moved into the selection window. This command is only enabled if a picture has been selected in the hierarchy window.

**Procedure**
1. Mark the picture in the hierarchy which you would like to delete.
2. Select the "Edit > Delete Picture" menu command
   or
   select "Delete Picture" from the the shortcut menu.
Note
You can reinsert the picture deleted from the hierarchy at a later time.

See also
Menu bar (Page 195)

6.3.1.21 How to delete a container

Introduction
Select the "Edit > Delete Container" menu command to remove a selected container from the hierarchy. All pictures contained in the deleted nested hierarchy will automatically be moved to the selection window. This command is only enabled if a container with or without subcontainers or with or without pictures has been selected in the hierarchy window.

Procedure
1. Mark the container which you would like to delete.
2. Select the "Edit > Delete Container" menu command or press the <Ctrl+L> keystroke.

See also
Menu bar (Page 195)

6.3.1.22 How to display the properties of a picture

Introduction
You can view the properties of a picture by selecting the "Edit > Properties" menu command.

Procedure
1. Mark the picture whose properties you want to display.
2. Select the "Edit > Properties" menu command or click the properties icon on the toolbar. The properties will be displayed.
6.3.1.23 How to Display the Picture Preview

Introduction
Select the "View > Preview" command to hide or show the picture preview. If the option has been selected, the preview window will automatically display the picture selected from the hierarchy window. If the container does not contain a picture, the preview window remains empty. Regardless of whether or not this option has been selected, the header line of the preview window will always display the name of the picture contained in the container. In the event of resizing the displayed picture will be fitted to the new dimensions.

Procedure
1. Select the "View > Preview" menu command.
2. Activate the check box. The picture preview is selected.

See also
Menu bar (Page 195)

6.3.1.24 How to arrange the picture icons alphabetically

Introduction
The "View > Arrange Picture Icons Alphabetically" menu command is used to set the alphabetic arrangement of pictures in the selection window. You cannot specify this option permanently.

Procedure
1. Select the "View > Arrange Picture Icons Alphabetically" menu command.

See also
Menu bar (Page 195)
6.3.1.25 How to arrange picture icons automatically

Introduction
Select the "View > Arrange Picture Icons Automatically" menu command to activate the automatic arrangement of pictures in the selection window.
If the option is activated, the pictures will be arranged automatically. The gaps will automatically be filled.

Procedure
1. Select the "View > Arrange Picture Icons Automatically" menu command.
2. Activate the check box.
   Automatic picture arrangement is now set.

See also
Menu bar (Page 195)

6.3.1.26 How to specify Confirm for Replace Picture

Introduction
The "Options > Confirm For Replace Picture" menu command is used to you specify that users must confirm the replacement of a picture in the hierarchy.

Procedure
1. Select the "Options > Confirm for Replace Picture" menu command.
2. Activate the check box.
   The picture is replaced after the user has confirmed the prompt.

See also
Menu bar (Page 195)

6.3.1.27 Confirm for Delete Hierarchy

Introduction
The "Options > Confirm for Delete Hierarchy" menu command is used to specify that users must confirm deletion of the hierarchy.
6.3 Picture Tree Manager Structure

Procedure

1. Select the "Options > Confirm for Delete Hierarchy" menu command.
2. Activate the check box.
   The hierarchy is deleted after a user has confirmed the prompt.

See also

Menu bar (Page 195)

6.3.1.28 Recalculating the group display hierarchy completely when saving

Functionality

If the check box "Recalculate the group display hierarchy completely when saving" has been selected, the group display hierarchy of all WinCC pictures will be recalculated completely every time the Picture Tree Manager is saved. If no group displays are used, you can disable this function to allow faster saving.

If WinCC detects that the group display hierarchy is no longer up to date while starting up, the process control message "The group display hierarchy is not updated..." is displayed. You can update the data by saving the picture hierarchy with the check box "Recalculate group display hierarchy completely when saving" selected.

6.3.1.29 Delta Save

Functionality

When the "Delta Save" check box is selected, only the project changes are taken into account every time a save is conducted in the Picture Tree Manager.

This makes creation of Picture Tree Navigator pictures faster in that pictures are no longer newly created. This affects pictures that have not changed, because the associated part of the hierarchy has not changed.

With Delta Save, you enhance the performance considerably.

6.3.1.30 How to call Contents and Index

Introduction

The "Contents and Index" menu command is used to open the online help of Picture Tree Manager.
How to access the online help:

- Select the "Help > Contents and Index" menu command.

For further information about the process, see Windows Help.

6.3.1.31 How to use the online help:

Introduction

The "Help > Using Help" menu command is used to obtain information on using the online help.

How to work with online help

- Select the "Help > Using Help" menu command.

6.3.1.32 About Picture Tree Manager

Introduction

Select the "Help > About Picture Tree Manager" menu command to obtain additional information about the Picture Tree Manager program and platform.

How to obtain additional information about the Picture Tree Manager program

- Select the "Help > About Picture Tree Manager" menu command.

6.3.2 Standard toolbar

Icons

The standard toolbar contains icons are used to execute frequently required commands.

Select the "View > Standard Toolbar" menu command to show or hide the toolbar.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Menu Command</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Icon" /></td>
<td>Project &gt; Save</td>
</tr>
<tr>
<td><img src="image2" alt="Icon" /></td>
<td>Project &gt; Print Project Documentation Hierarchy</td>
</tr>
<tr>
<td><img src="image3" alt="Icon" /></td>
<td>Edit &gt; Properties</td>
</tr>
</tbody>
</table>
### 6.3 Picture Tree Manager Structure

<table>
<thead>
<tr>
<th>Icon</th>
<th>Menu Command</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Help Icon" /></td>
<td>Help &gt; What's This?</td>
</tr>
<tr>
<td><img src="image" alt="View Icon" /></td>
<td>View &gt; Large Icons</td>
</tr>
<tr>
<td><img src="image" alt="View Icon" /></td>
<td>View &gt; Small Icons</td>
</tr>
<tr>
<td><img src="image" alt="View Icon" /></td>
<td>View &gt; List</td>
</tr>
<tr>
<td><img src="image" alt="View Icon" /></td>
<td>View &gt; Refresh</td>
</tr>
</tbody>
</table>

**How to display/hide the toolbar:**

1. Select the “View > Standard Toolbar” menu command. This changes the current selection.

2. Activate the check box. The standard toolbar is now selected.

3. Clear the check box to hide the toolbar.

**See also**

Menu bar (Page 195)

#### 6.3.3 Data window

**Structure**

The data window of Picture Tree Manager is divided into the following areas:

- The left upper hierarchy window displays the hierarchy of the systems, subsystems, functions, and pictures as a tree. The first container, the highest in the hierarchy, has the name of the WinCC project and can neither be moved nor deleted. A container can be empty or, with the exception of the root container, can contain a picture.

- The upper right preview window displays the contents of the picture highlighted in the hierarchy window when it is activated.

- All pictures available in the WinCC project which have not yet been assigned in the hierarchy, as well as the icon of an empty container, are displayed at the bottom of the selection window. System pictures that begin with @ are not displayed.
Each area has information about its contents in the title bar.
You can change the size of the individual operating areas with the mouse.

### 6.3.4 How to activate the status bar

**Introduction**

The status bar provides you with the following information:

- Displays an appropriate help text for a selected function
- Displays the key status (e.g., the Num Lock key).
- Click on the size box to change the window size of the application.

**Procedure**

1. Select the "View > Status Bar" menu command.
2. Select the check box. The status bar is displayed. Clear the check box to hide the toolbar.

**See also**

Menu bar (Page 195)
6.4 Working with the Picture Tree Manager

6.4.1 Working with the Picture Tree Manager

Overview

Start the Picture Tree Manager by double-clicking in WinCC Explorer. The editor has only one window for editing the hierarchy. You can access all of the editing options in this window. The most effective way for you to work is with drag&drop operations. The following functionality is available:

- You can create and change the hierarchy with the aid of the clipboard and the "Cut", "Copy" and "Paste" functions.
- You can access editing functions by using the Menu Bar, the pop-up menu, or with a drag&drop operation.
- You can expand the hierarchy by one container by inserting the empty container from the selection window.
- Cut and paste a picture from the selection window or move it using Drag&Drop to insert a picture into a container in the hierarchy.
- You can also move nested hierarchies (branches) within the hierarchy.
- Pictures that you remove from the hierarchy (hierarchy window) are inserted in the selection window automatically.
- Picture properties, such as change date and size of a selected picture, can be displayed.

Note

None of the changes you make while editing take effect until you save.

See also

How to add pictures by Drag&Drop (Page 216)
How to add a new container by Drag&Drop (Page 215)
General information about the Picture Tree Manager (Page 193)
6.4.2 How to Display the Picture Properties

Introduction

You can show information about every picture, such as date of change or size of picture.

![Properties window](image)

Procedure

1. Select the desired picture and open the pop-up menu.

2. Select the "Properties" menu command.
   or
   select the "Edit > Properties" menu command
   or
   click this toolbar icon.

The picture properties will be displayed.

6.4.3 How to add a new container by Drag&Drop

Introduction

You can insert a new container into the hierarchy window by Drag&Drop. The Picture Tree Manager supports Drag&Drop with the left as well as the right mouse button (Drag&Drop with the pop-up menu). This can be done in both the hierarchy window and selection window.
Procedure

1. Click the container icon in the selection window.
2. Drag-and-drop the container icon to the hierarchy window located above.
   Release the mouse button as soon as the mouse pointer has transformed into the (+) icon.
   The container is inserted after the selected container.
   or
   Drag-and-drop the container icon to the hierarchy window located above.
   Release the mouse button as soon as the pointer has transformed into the (+) icon
   Select the insert position for the new container from the shortcut menu.

Note

When you insert new containers into an existing node, the nested hierarchy of that node is expanded by one level.

If you insert a container before or after a container, the affected hierarchy level is expanded by one container.

You cannot insert a new container before or after the root container.

See also

Working with the Picture Tree Manager (Page 214)
Handling Tags with the Picture Tree Manager (Page 217)
How to add pictures by Drag&Drop (Page 216)
General information about the Picture Tree Manager (Page 193)

6.4.4 How to add pictures by Drag&Drop

Introduction

You can insert pictures into the hierarchy window by drag-and-drop. The Picture Tree Manager supports drag-and-drop with the left as well as the right mouse button (drag-and-drop with the short-cut menu).

You can work with the Picture Tree Manager using drag-and-drop in the hierarchy window as well as in the selection window.
Procedure

1. Click on the icon of the desired picture in the selection window.
2. Use a drag&drop operation to drag the picture icon to the hierarchy window located above.
   Release the mouse button as soon as the pointer has transformed into the (+) icon
   The picture is inserted if the selected container is empty.
   If the selected container is not empty you must confirm replacement of the existing picture.
   or
   Use a drag&drop operation to drag the picture icon to the hierarchy window located above.
   Release the mouse button as soon as the pointer has transformed into the (+) icon

See also

Working with the Picture Tree Manager (Page 214)
Handling Tags with the Picture Tree Manager (Page 217)
How to add pictures by Drag&Drop (Page 216)
General information about the Picture Tree Manager (Page 193)

6.4.5 Handling Tags with the Picture Tree Manager

Introduction

The Picture Tree Manager places a tag named @<picture name> in the "Group Signals" tag group for every picture that contains a group display.

Example: The @PTM tag is created for the picture "PTM.pdl".

Tag group "Group Signals"

If the "Recalculate the group display hierarchy completely when saving" check box is selected, all tags in this group are deleted and created again. For this reason, you are not permitted to create tags within the tag group "Group Signals".

Possible name conflicts

The Picture Tree Manager creates tags with the name @<picture name>. During Lifebeat Monitoring a tag named @<devicename> is created for every device name. This can cause conflicts with identical names. To prevent identical tag names, the picture name must not be the same as the device name or system tags with the @ name prefix.

If this is the case, a corresponding message is issued.

The tag names that cause a name conflict are listed in the log file "PictureTreeManagerCS.log". By changing the picture name, you can resolve name conflicts.

You cannot change picture names in the Picture Tree Manager. Rename the pictures in the WinCC Explorer. Then insert the modified picture into the hierarchy.
Note
The project engineer may not create any tags with @ prefix. Such actions are reserved for handling in the WinCC PCS7 software. You are not allowed to manipulate these system tags. The system tags are necessary for proper functioning of the product.

See also
Recalculating the group display hierarchy completely when saving (Page 210)

6.5 General information on the hierarchy

6.5.1 General information on the hierarchy

General information
In WinCC the interdependence of containers and pictures is illustrated in the form of a hierarchy. Note the following information for this hierarchy:

- The nodes of the hierarchy are always made up of containers.
- All container may be empty or contain a picture of Graphics Designer.
- You can assign any name to the container. However, the container name must be unique and checked by the Picture Tree Manager. If you derive the picture tree from the plant hierarchy, the complete path with separator characters is entered as the container names. However, only the last part of the container name is displayed during runtime.
- You can only include existing pictures in the hierarchy. You cannot change picture names in the Picture Tree Manager.
- The structure of the hierarchy is open, which means there is no height or width limit prescribed for the hierarchy (tree).
- When a hierarchy is created with the help of the Picture Tree Manager, hierarchy information is stored in various OS engineering data, such as the message system, user administrator and component lists. Therefore, it is necessary to specify and retain the OS hierarchy at the earliest possible point in the planning process.
- Subsequent changes to a hierarchy at the area level require manual corrections in the following places:
  - Correction of hierarchy data in the messages
  - Editing user authorizations (User Administrator)
  - Generation of new packages for connected WinCC clients

For more information see "Effects on other applications".
Example configuration

In the following you can see an example based on WinCC with Basic Process Control not based on the plant hierarchy:

This hierarchy is displayed in the following table:

<table>
<thead>
<tr>
<th>Container Name</th>
<th>Picture Name</th>
<th>Father</th>
<th>Left Neighbor</th>
</tr>
</thead>
<tbody>
<tr>
<td>New.MCP</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pre-treatment</td>
<td>Pretreatment.PDL</td>
<td>New.MCP</td>
<td></td>
</tr>
<tr>
<td>Distillery1</td>
<td>Distil1.PDL</td>
<td>Pretreatment</td>
<td></td>
</tr>
<tr>
<td>Distillery2</td>
<td>Distil2.PDL</td>
<td>Pre-treatment</td>
<td>Distillery1</td>
</tr>
<tr>
<td>Distillery3</td>
<td>Distillery3.PDL</td>
<td>Pre-treatment</td>
<td>Distillery2</td>
</tr>
<tr>
<td>BoilerRoom</td>
<td>Boiler room.PDL</td>
<td>New.MCP</td>
<td></td>
</tr>
<tr>
<td>Boiler1</td>
<td>Boiler1.PDL</td>
<td>BoilerRoom</td>
<td>Boiler1</td>
</tr>
<tr>
<td>Boiler2</td>
<td>Boiler2.PDL</td>
<td>BoilerRoom</td>
<td>Boiler2</td>
</tr>
<tr>
<td>Boiler3</td>
<td>Boiler3.PDL</td>
<td>BoilerRoom</td>
<td>Boiler2</td>
</tr>
<tr>
<td>Post-treatment</td>
<td>Posttreatment.PDL</td>
<td>New.MCP</td>
<td></td>
</tr>
<tr>
<td>Cooling1</td>
<td>Cooler1.PDL</td>
<td>Post-treatment</td>
<td></td>
</tr>
<tr>
<td>Cooling2</td>
<td>Cooler2.PDL</td>
<td>Post-treatment</td>
<td>Cooling1</td>
</tr>
<tr>
<td>Cooling3</td>
<td>Cooler3.PDL</td>
<td>Post-treatment</td>
<td>Cooling2</td>
</tr>
</tbody>
</table>
Note
You can also insert empty pictures into the hierarchy. These pictures must already be created in WinCC.

For a future expansion of the plant areas never configure containers with no pictures assigned to them as placeholders. This can result in faulty navigation through the picture tree.

The OS Project Editor makes it easy to configure empty area keys.

See also
Effects on other applications (Page 229)
Creating a Hierarchy (Page 220)
Changing the Hierarchy (Page 224)
deleting in the hierarchy (Page 226)
Handling Tags with the Picture Tree Manager (Page 217)
General information about the Picture Tree Manager (Page 193)

6.5.2 Creating a Hierarchy

6.5.2.1 Creating a Hierarchy

Options
All pictures of the project are in the selection window at the start of building a hierarchy. The hierarchy window contains a root node that contains the name of the project.

A picture cannot be stored in the root node.

You can create the hierarchy in the following ways:
- Drag&Drop
- the pop-up menu
- the menu bar
- by changing the container name

When you save the picture hierarchy, the names of the plants/areas and units/subareas will be entered into the Text Library in all available languages.

NOTICE
Modifications to the hierarchy made in the editor of the Picture Tree Manager are initially local. All changes are lost if not saved before you close Picture Tree Manager.
The “Save” command saves all changes and also reports these to all runtime clients of Picture Tree Manager, for example, to the Group Display. The clients then import the new hierarchy.
6.5.2.2 How to Create the Hierarchy by Drag&Drop:

Procedure

1. Click on the icon of the empty container in the selection window.
2. Use a Drag&Drop operation to drag the container into the hierarchy window.
3. Select the container after which the new container should be inserted. The target container is displayed with a colored background.
4. Release the mouse button.
   The new container is inserted at the same level after the selected container.

See also

General information on the hierarchy (Page 218)
How to Create the Hierarchy by Drag&Drop: (Page 221)
How to create the hierarchy with the Pop-Up Menu (Page 222)
How to create the hierarchy with the Menu bar (Page 222)
How to create the hierarchy - changing the container name (Page 223)
6.5.2.3 How to create the hierarchy with the Pop-Up Menu

Procedure

1. Select a container in the hierarchy window.
2. Open the corresponding shortcut menu.
3. Select one of the three insertion options. You can insert the new container after, before, or in the selected node.

See also

General information on the hierarchy (Page 218)
Creating a Hierarchy (Page 220)
Changing the Hierarchy (Page 224)
Deleting in the Hierarchy (Page 226)
Handling Tags with the Picture Tree Manager (Page 217)
General information about the Picture Tree Manager (Page 193)

6.5.2.4 How to create the hierarchy with the Menu bar

Procedure

1. Select a container in the hierarchy window.
2. Select the “Edit > New Container” menu command to insert a new container.
3. Select one of the three insertion options. You can insert the new container after, before, or beneath the selected node.
Note
Inserting a new container into an existing node expands the hierarchy by one level.
If you insert a container before or after a container, the affected hierarchy level is expanded
by one container.

See also
General information on the hierarchy (Page 218)
Creating a Hierarchy (Page 220)
Changing the Hierarchy (Page 224)
Deleting in the Hierarchy (Page 226)
Handling Tags with the Picture Tree Manager (Page 217)
General information about the Picture Tree Manager (Page 193)

6.5.2.5 How to create the hierarchy - changing the container name

Procedure
1. Select the container which you would like to rename in the hierarchy window
2. Click the selected container
   or select the "Edit Container Name" command from the shortcut menu
   or press the <Ctrl+E> keystroke.
   Editing mode is now active.
3. Change the container name.

See also
General information on the hierarchy (Page 218)
Creating a Hierarchy (Page 220)
Changing the Hierarchy (Page 224)
Deleting in the Hierarchy (Page 226)
Handling Tags with the Picture Tree Manager (Page 217)
General information about the Picture Tree Manager (Page 193)
6.5.3 Changing the Hierarchy

6.5.3.1 Changing the Hierarchy

General information

You can change the hierarchy by moving individual nodes or complete sections of the hierarchy. In doing so, you can move the nodes within one level or between the levels.

You cannot move the root node (WinCC project name).

You can use the following means to change the hierarchy:

- Drag&Drop
- the pop-up menu
- the menu bar

Note

Inserting a new container into an existing node expands the hierarchy by one level.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modifications to the hierarchy are initially local. The changes are lost if you exit the Picture Tree Manager without saving. Select the &quot;Save&quot; command to save all changes and to report these to all runtime client of Picture Tree Manager, for example, to the Group Display. The clients then import the new hierarchy.</td>
</tr>
</tbody>
</table>

See also

General information on the hierarchy (Page 218)
How to change the hierarchy using drag-and-drop: (Page 225)
How to change the hierarchy using the shortcut menu (Page 225)
How to change the hierarchy using the menu bar: (Page 226)
6.5.3.2 How to change the hierarchy using drag-and-drop:

Procedure

1. Click on the container (node) that you want to move in the hierarchy window.
2. Use a Drag&Drop operation to drag the container and its underlying containers to the new position.
3. When you release the mouse button, the container with its underlying containers is inserted in the same level after the selected container.
   or
   Use a Drag&Drop operation to drag the container and its underlying containers to the new position. When you release the mouse button, a pop-up menu will appear. With this pop-up menu, you specify where the container and its underlying containers are to be inserted:

   ![Pop-up menu options]

   Insert After
   Insert Before
   Insert Into Node
   Cancel

   From the three options provided, select the position at which the container should be inserted.

See also

General information on the hierarchy (Page 218)
Creating a Hierarchy (Page 220)
Changing the Hierarchy (Page 224)
Deleting in the Hierarchy (Page 226)
Handling Tags with the Picture Tree Manager (Page 217)
General information about the Picture Tree Manager (Page 193)

6.5.3.3 How to change the hierarchy using the shortcut menu

Procedure

1. Select a container in the hierarchy window.
2. Open the corresponding shortcut menu.
3. Select the "Cut Container" menu command to move the container and all of its sublevel containers to the clipboard. The affected containers are displayed in gray.
4. Select the target container.
5. Open the corresponding shortcut menu.
6. Paste the clipboard contents to the new position using the "Insert After", "Insert Before" or "Insert into Node" menu command.
6.5 General information on the hierarchy

See also
General information on the hierarchy (Page 218)
Creating a Hierarchy (Page 220)
Changing the Hierarchy (Page 224)
Deleting in the Hierarchy (Page 226)
Handling Tags with the Picture Tree Manager (Page 217)
General information about the Picture Tree Manager (Page 193)

6.5.3.4 How to change the hierarchy using the menu bar:

Procedure
1. Select a container in the hierarchy window.
2. Select the "Cut Container" menu command or use the <Ctrl+X> keystroke to move the container including its sublevel containers to the clipboard. The affected containers are displayed in gray.
3. Select the target container.
4. Paste the clipboard contents to the new position using the "Insert After", "Insert Before" or "Insert into Node" menu command.

See also
General information on the hierarchy (Page 218)
Creating a Hierarchy (Page 220)
Changing the Hierarchy (Page 224)
Deleting in the Hierarchy (Page 226)
Handling Tags with the Picture Tree Manager (Page 217)
General information about the Picture Tree Manager (Page 193)

6.5.4 Deleting in the Hierarchy

6.5.4.1 Deleting in the Hierarchy

Options
Deleting the hierarchy in this case means removing individual containers with all their underlying containers from the hierarchy window and thus out of the hierarchy.

You can use the following means to delete the hierarchy:
Drag&Drop
the pop-up menu
the menu bar

Note
With the "Confirm when Hierarchy Deleted" option, you change the behavior of the Picture Tree Manager when you delete the hierarchy (with or without confirmation).

The pictures deleted from the hierarchy are moved to the selection window and can be reinserted into the hierarchy at a later time.

See also
General information on the hierarchy (Page 218)
How to delete the hierarchy using the drag-and-drop function (Page 227)
How to delete the hierarchy using the shortcut menu (Page 228)
How to delete the hierarchy using the menu bar (Page 228)

6.5.4.2 How to delete the hierarchy using the drag-and-drop function

Procedure
1. Click on the container that you want to delete in the hierarchy window.
2. Use a Drag&Drop operation to drag the selected container and its underlying containers to the selection window.
3. When you release the mouse button, all pictures are moved to the selection window. All information of the deleted and underlying containers are lost in this process.

See also
General information on the hierarchy (Page 218)
Creating a Hierarchy (Page 220)
Changing the Hierarchy (Page 224)
Deleting in the Hierarchy (Page 226)
Handling Tags with the Picture Tree Manager (Page 217)
General information about the Picture Tree Manager (Page 193)
6.5.4.3 How to delete the hierarchy using the shortcut menu

Procedure

1. Click on the container that you want to delete in the hierarchy window.
2. Open the corresponding shortcut menu.
3. Select the “Delete Container” menu command and confirm the prompt.
   The container and all its nested containers will be deleted from the hierarchy.
   All pictures are moved to the selection window.
   All information of the deleted and underlying containers are lost in this process.

See also

General information on the hierarchy (Page 218)
Creating a Hierarchy (Page 220)
Changing the Hierarchy (Page 224)
Deleting in the Hierarchy (Page 226)
Handling Tags with the Picture Tree Manager (Page 217)
General information about the Picture Tree Manager (Page 193)

6.5.4.4 How to delete the hierarchy using the menu bar

Procedure

1. Click on the container that you want to delete in the hierarchy window.
2. Select the "Delete Container" menu command or press the <Ctrl+L> keystroke.
   The corresponding container and all its nested containers will be deleted from the hierarchy.

Note

All pictures are moved to the selection window. All information of the deleted and underlying containers are lost in this process.
6.6 Effects on other applications

6.6.1 Effects on other applications

Effects on other applications

The hierarchy created in the Picture Tree Manager has an effect on the following applications:

- User Administrator
- Group display
- Text Library
- Alarm Logging
- OS Project Editor

See also

General information on the hierarchy (Page 218)
Creating a Hierarchy (Page 220)
Changing the Hierarchy (Page 224)
Deleting in the Hierarchy (Page 226)
Handling Tags with the Picture Tree Manager (Page 217)
General information about the Picture Tree Manager (Page 193)
6.6.2 Effects on the User Administrator

Introduction
If changes are made to the hierarchy in the Picture Tree Manager, you must open the User Administrator after saving the changes. Only then will the assignments of the authorizations for the hierarchy be updated.

New parts of the hierarchy
The User Administrator does not have the required information on the user authorizations for newly created containers. After you save the hierarchy, these new system sections are available in the User Administrator.

Deleting parts of the hierarchy
Containers that are deleted from the hierarchy are also deleted in the User Administrator. Upon deletion of this container, all corresponding information contained in the User Administrator is also lost.

See also
Effects on other applications (Page 229)

6.6.3 Effects on the Group Display

Introduction
In certain cases, the hierarchy affects the group display.

The objects of the Group Display can only receive and forward messages if they contain pictures in the hierarchy.

Construct a group display hierarchy according to the picture hierarchy. The OS Project Editor supports you in configuring the group display hierarchy. By selecting the "Create / update group displays" check box in the "Message Display" tab, the group displays in the area overview are automatically integrated in the picture hierarchy. However, you can also interconnect the group display objects independent of the picture hierarchy.

Receiving messages
We recommend that you place the pictures from which you want to receive messages in the hierarchy on the level of the corresponding group object or below this level.
Relaying messages

We recommend that you place the pictures to which you want to relay messages in the hierarchy on the level of the corresponding group object or above this level.

See also

Effects on other applications (Page 229)

6.6.4 Effects on the Text Library

Introduction

The container names are administered in the text library.

When the picture tree is saved the texts are saved in all languages available in the text library. Only the text specified as the current language is used as the text. "Container<Text ID>" is entered for all other languages.

If the name already existed in the text library, the existing text is used.

Language change

After switching languages all container names are displayed in the selected language. Container names for which there is no corresponding name in the selected language are displayed in the language in which they were created.

The language switch is only displayed in the Picture Tree Manager next time it is opened.

If you change languages in runtime, all non-compiled containers are named "Container<Text ID>".

Renaming a text

When a text in the picture tree is renamed, it is only renamed in the current configuration language.

When the text of a container in the text library is renamed in a language that is not the configuration language, this text is not changed when the picture tree is saved. This is the case, for example, when translations are entered in the text library.

Adding a language

When you add a new language in the text library, the texts of the picture tree do not exist in this language. After adding the language, you need to save the picture tree or use the "Compile OS" function to have the texts of the picture tree entered for this language.
Note

A number of WinCC applications store their texts in the text library. Identical texts are only stored once. When a text is changed, such as by changing the name of the container, the text also changes at the positions of the WinCC applications that use an identical text.

See also

Effects on other applications (Page 229)

6.6.5 Effects on the Alarm Logging

Introduction

In Alarm Logging, individual messages are assigned to an area in the created hierarchy. You assign them manually in Alarm Logging. The prerequisite for the message assignment is the picture hierarchy placed in the Picture Tree Manager or created by the data transfer to the OS.

If an area name, such as "Container1", is assigned for a message, the message is only displayed if you have an authorization for this area. If no area name is specified for a message, the message will always appear.

Assignment of the message to the area

1. In Alarm Logging select a message that you want to assign to a specific area.
2. Open the "Properties" shortcut menu.
3. In the "Individual Message" dialog box, select the "Texts" tab. Enter the area name manually in the "Area" input box.

See also

Effects on other applications (Page 229)
7 Resources

7.1 Graphic Object Update wizard

Content

With the "Graphic Object Update Wizard" editor, you export, import or update dynamic user objects from WinCC pictures.

This documentation includes the following topics:

- Creation of Object Templates
- Exporting user object templates
- Importing WinCC pictures
- Updating WinCC pictures
- Changing user object interconnections
- Working with configuration files

7.2 Functionality of the Graphic Object Update Wizard

Functionality

You use the Graphic Object Update wizard to export, import or update dynamic user objects from WinCC pictures in the Graphics Designer. The interconnection with the assigned tags is retained. This wizard functionality is only available in a PCS 7 OS.

With the Graphic Object Update wizard, you update existing objects in WinCC pictures on the basis of a new template.

To change dynamic information, you export it into a Microsoft Excel spreadsheet. Thereafter, you re-import the dynamic information.

With the Graphic Object Update wizard, you edit dynamic WinCC pictures as follows:

1. You copy the dynamic WinCC pictures.
2. You change the interconnection in the exported Microsoft Excel spreadsheet, e.g., for another unit.
3. You re-import the dynamic WinCC pictures.
Alongside the interconnection information of the process pictures, you can also update the instances of scripts and triggers when importing and updating the objects. The expanded functionality can be executed by means of a configuration file.

**Note**

When the import/export wizard is used, it is assumed that the process pictures for valves, motors, controls, etc., are available in WinCC in the form of user objects.

The selection of faceplates for process control remains user-specific: You use either standard OCX, e.g., from the technological library of PCS 7, or specific user objects/WinCC operating pictures.

In order to be able to use the functionality of the wizard, the OS Project Editor must run first. This enables you to copy the dynamic wizard scripts and the configuration files into the project.

**See also**

Dynamic Wizard of the Graphics Designer (Page 236)

Structure of the configuration file (Page 240)

File Format of the Export/Import File (Page 245)

### 7.3 Example: Creation of Object Templates

**Introduction**

You need object template for central storage of user objects, in which you save the user objects created.

**Example:**

There is a common template for all valves in the mimic diagrams of a project. You must change this template centrally, if necessary.

This object template is called a "template picture". The name of the template picture has to start with the symbol "@". During the import process, the user object templates are copied to the respective process pictures with connection information.

This is only possible if the user objects present in a process picture do not have to be adapted on an instance-specific basis. Otherwise the import causes the loss of object information. Only the tag connection is adapted on an instance-specific basis. For example, if you need a script to call a specific faceplate, it must be identical for all user objects of one type. You achieve this when the script automatically accesses the connection information when you click the user object (= AS block name) and derives the name of the faceplate from it.

The user objects must have the "type" object property. In this property, the customized object type is entered, e.g. "VALVE". This entry in the "type" object property is the identifier for the object.
Give a unique identifier to the newly created objects. The "tag" object property exists for this purpose. If this object property is present, the current text is also exported into the "tag" column of a Microsoft Excel file during the export. You can then change the entries in Microsoft Excel. For the next import, these values are then entered in the "tag" object property for the corresponding customized object. The optional "trend" object property is available. This object property is intended for trend group call-ups or other texts specific to user objects. The existing text is exported or imported into/from the "Trend" column of the export file.

**Template pictures "Create / update block symbols" function**

The "Create / update block symbols" function uses the following template pictures

- Template pictures from "@@PCS7Typicals"
- The ten template pictures, maximum, created by the project engineer. These template pictures begin with "@PCS7Typicals".

The function opens all pictures and determines the priority of the pictures alphabetically based on their names.

Priority 1: "@PCS7Typicals**, of which the last picture in alphabetical order.

Priority 2: "@PCS7Typicals"

Priority 3: "@@PCS7Typicals"

The pictures of the highest priority are inserted.

The "Create/update diagnostic pictures" function uses the template pictures from "@@MaintenanceTypicals" correspondingly.

**Note**

The descriptions of the object properties only match if the supplied Template Control is used. If you have named the descriptions of the object properties in the configuration file yourself, these object properties are used.

**See also**

- Structure of the configuration file (Page 240)
- File Format of the Export/Import File (Page 245)
- Functionality of the Graphic Object Update Wizard (Page 233)
- Dynamic Wizard of the Graphics Designer (Page 236)
7.4 Dynamic Wizard of the Graphics Designer

7.4.1 Dynamic Wizard of the Graphics Designer

Functionality

The Graphic Object Update Wizard provides the following Dynamic Wizards for the exchangeability of process symbols:

Dynamic Wizard "Exporting Picture Objects"

This Wizard exports all user objects with type identification contained in the current WinCC picture or project into a Microsoft Excel spreadsheet in CSV format. The object type and connection information are exported, among other things.

The Wizard can recognize the object type from the entry in the object property that you have configured as the identifier of the user object. For the supplied TemplateControl, the object property is "type".

Dynamic Wizard "Importing Picture Objects"

The Wizard imports user objects into WinCC pictures that you have previously exported with the "Export Picture Objects" Dynamic Wizard. When importing, the customized objects specified in the file/Microsoft Excel spreadsheet will be recreated. Here, template objects that must be stored in the template picture are accessed.

Dynamic Wizard "Updating Picture Objects"

The Wizard updates all of the user objects with type identifier in the current WinCC picture or in the project. The Wizard can recognize the object type from the entry in the object property that was configured as the identifier of the user object. Here, template objects that must be stored in the template picture are accessed.

Dynamic Wizard "Changing the Connection of the Customized Object"

This Wizard is used for the later change of individual connections of customized objects in WinCC pictures (e.g. connection to another AS block instance).

See also

Exporting customized object templates (Page 237)
How to import WinCC pictures (Page 237)
How to update WinCC pictures (Page 238)
How to change the customized object connection (Page 239)
7.4.2 Exporting customized object templates

Requirement

To export user object templates from a WinCC picture into a CSV file (ASCII file), open the corresponding WinCC picture with the Graphics Designer.

Procedure

1. In the Graphics Designer, select the Dynamic Wizard "Exporting Picture Objects" from the "Picture Functions" group. The Dynamic Wizard leads you through a series of dialog boxes to create the export file.

2. You can make the following settings:

   - Select whether the export file is to be generated only from the picture currently opened in the Graphics Designer or from all WinCC pictures of the project. In general, do not export any template pictures with user object templates and PCS 7 system pictures. You can identify files of this type by the prefix "@...".

   - Specify the name of the export file. "Export.csv" in the folder of the current project is suggested as the default name.

   - Specify the name of the configuration file here. "TemplateControl.cfg" in the folder / Wscripts of the current project is suggested as the default name.

   - Split the tag name into two parts. This option makes sense particularly for PCS 7 users who work with the plant hierarchy (PH) of SIMATIC Manager. In this case, the tag name is separated by the separator "/" into up to six individual names, which provides more options to edit the export file.

See also

Dynamic Wizard of the Graphics Designer (Page 236)
Structure of the configuration file (Page 240)

7.4.3 How to import WinCC pictures

Requirement

To import a WinCC picture, open the WinCC picture in the Graphics Designer into which the picture stored in the Microsoft Excel file is to be imported. Create a back-up copy of the pictures to be imported because you cannot undo this procedure.
**Procedure**

1. Before the import, all objects that have an entry in the object property "type" and also are present in the template picture are deleted in the pictures to be imported (column 1 of the Microsoft Excel spreadsheet). Therefore, export the current version before you import a picture. The name of your template picture has to start with the symbol "@".

2. Open the "Import Picture Objects" Dynamic Wizard in the "Picture Functions" tab and import the objects.

3. When doing so, make the following settings:
   - Specify the name of the import file.
     Specify the name of the import file here. "Export.csv" in the folder of the current project is suggested as the default name.
   - Specify the name of the template picture.
     Here, specify the name of the template picture containing the template objects. "@TEMPLATE.pdl" in the directory "GraCS" of the current project is proposed.

If the import file contains objects that are not found in the template picture, a warning message is displayed. These "unknown" objects will not be imported. If objects have been added to the import file by copying existing lines, they will be regenerated.

The WinCC tag names of the import file will not be checked for their validity or presence in WinCC Tag Management.

**Note**

The descriptions of the object property "type" only match if the supplied TemplateControl is used. If you have named the description of the object property in the configuration file yourself, this object property is used.

**See also**

Structure of the configuration file (Page 240)
Dynamic Wizard of the Graphics Designer (Page 236)

**7.4.4 How to update WinCC pictures**

**Requirements**

If you do not have to post-process the export file, use the "Updating Picture Objects" Wizard instead of exporting and then importing the picture objects. Open the relevant picture in the Graphics Designer. Create a back-up copy of the picture because you cannot undo this procedure.
Procedure

1. Update the objects with the "Update Picture Objects" Dynamic Wizard. Open the Wizard in the "Picture Functions" tab.

2. Make the following settings:
   - Select whether to only update the active picture that is open in the Graphics Designer or all of the pictures in the project. In general, do not update any template pictures with user object templates and no PCS 7 system pictures. Files of this type can be identified by the prefix "@...".
   - Specify the name of the template picture containing the template objects. 
     "@TEMPLATE.pdl" in the directory "GraCS" of the current project is proposed.
   - Specify the name of the configuration file in which the information about the updated picture object is retained.

This Wizard replaces the following picture objects with those from the template picture:

- Picture objects that have an object property to identify the object, e.g. "type"
- Picture objects that are present in the template picture.

In the process, no export file is created. If the export file is not required for editing purposes, this makes sense.

See also

Structure of the configuration file (Page 240)
Dynamic Wizard of the Graphics Designer (Page 236)

7.4.5 How to change the customized object connection

Introduction

With this Wizard, you change the dynamic connection on a user object. In doing so, you replace the instance name in the tag in front of the period. Dynamics with internal tags are not affected by this.

Procedure

1. Open the picture in the Graphics Designer and select the user object.

2. Open the Dynamic-Wizard "Replace User Object Connection" in the "Picture Functions" tab to edit the object.

3. Specify the new instance name or select one. If you do not specify a name here, the instance name is deleted from the tag connections.

See also

Dynamic Wizard of the Graphics Designer (Page 236)
7.5 Structure of the configuration file

7.5.1 Structure of the configuration file

Introduction

Under normal circumstances, there will be no need for the user to modify the configuration files supplied with the system.

With a configuration file, you can replace all instance-specific picture and script information centrally. In this file, you configure up to 100 properties for the objects that are newly copied to the template picture. You specify the entries locally for each project.

When the OS Project Editor runs, the following configuration files are copied to the "<Project Directory>\WScripts" directory of the open project:

- "@@ConfigTypicals.cfg" for updating the lifebeat monitoring
- "@@MaintenanceTypicals.cfg" for the "Create/update diagnostic pictures" function
- "@@PCS7Typicals.cfg" for the "Create/update block icons" function
- "ChangeOCXtoUdo.cfg" for migration of the PCS 7 library V5 to PCS 7 library V6 with the dynamic wizard
- "CSIG.cfg" for configuration of the group display object with the dynamic wizard
- "LBMObjects.cfg" for configuration of the plant configuration picture with the dynamic wizard
- "TemplateControl.cfg" for the standard behavior

The first three configuration files are selected automatically by the system. You can create a separate configuration file for the respective function. Store these in the same directory under the name "@@ConfigTypicals.cfg", "@@MaintenanceTypicals.cfg" or "@@PCS7Typicals.cfg". If these user-created configuration files are found, they will be used.

Structure of the configuration file

The configuration file is structured like an INI file and is divided into several sections. Using the default settings in the "TemplateControl.CFG" file as an example, the layout of the configuration file appears as follows.

The editable object types are specified in the first section of the configuration file.

Disable any objects that are not required in order to increase performance.

```ini
[AnalyzedObjects]
Customized_Object = 1 ; customized objects, enabled by default = 1
OCX_Objects = 0 ; OCX, disabled by default = 0
AdvancedStateDisplay_Objects = 0 ; Advanced state display, disabled by default
```

MDM - WinCC/Options for Process Control
System Manual, 11/2008,
AdvancedAnalogDisplay_Objects = 0; Advanced analog display, disabled by default
CSIG_Objects = 0; Group display object, disabled by default

In the second section of the configuration file, you specify whether a log file should be output.

[Trace]
LogFile = 0 ; no log file is output.

In the third section of the configuration file, you specify what happens during exchanges.

[General]
ChangeTag = 0
ChangeLink = 0

With the "ChangeTag" entry, you enable the tag exchange. The default setting is "0". The Wizard only exchanges the tag connections of dynamic object properties. When you enter the value "1", all used tags in C scripts, triggers and the content of the "tagname" object property for faceplates are updated.

With the "ChangeLink" entry, you specify the tag replacement type of the tag connections. The default setting is "0". The wizard replaces the tag connections of dynamic display object properties with the structure instance information of the tag connection. The structure instance name does not have to appear at the tags. When you enter the value "1", the tag connections are replaced according to the structure instance names.

In the fourth section of the configuration file, you specify the unique identifier of the object that is indicated in the "Object type" column of the export/import file. A maximum of 10 entries are permitted in ascending order without blank lines.

[IdentifierObjecttype]
Objecttype0 = tagtype
......
Objecttype9= type

A property of the group display objects can be entered as an identifier in the "CSIG.cfg" configuration file. "CSIG.cfg" contains "UserValue1" by default.

These entries are compared sequentially with the properties of the object to be edited. When a match is found, the wizard accepts this property as an identifier.

In the fifth section of the configuration file, you specify the columns of the export/import file. The descriptions of the columns are located in the first line of the export/import file. A maximum of 100 entries are permitted in ascending order without blank lines. The data type of the associated object property is specified. Only the following data types are permitted:

- Numerical = 3
- Alphanumerical = 8
- Binary (Boolean) = 11

[Columns]
Column00 = X-Pos
Type00 = 3
In the "CSIG.cfg" configuration file, the column for the collective value is named "CollectValue". A link identifier is provided instead of the data type:

- "0" for the static value of the "Collective value" property
- "1" for the tag name of the "Collective value" property

"Link02 = 1", for example, means that the dynamic value is written to the export/import file by means of the tag name.

During import, the descriptions are compared with the configuration file settings. If the import and configuration files do not match, the import is aborted.

In the next sections of the configuration file, you specify the assignment of the object properties to the columns of the export/import file. You can assign multiple entries for each column that was defined in the fifth section. A maximum of 10 entries are permitted in ascending order without blank lines.

```
[Column00]
Property0 = Left
Property1 = PosX

[Column01]
Property0 = Top
```

These entries are compared sequentially with the properties of the object to be edited. As soon as a match is found, the Wizard links this property to the corresponding column.

See also

- Application of the configuration file (Page 242)
- How to exchange script- and instance-specific picture information (Page 243)

### 7.5.2 Application of the configuration file

#### Introduction

After you have created your project-specific configuration file, the Graphic Object Update Wizard calibrates the user objects.

#### Exporting the picture objects

During export of a picture object, the Graphic Object Update Wizard creates an export file. In addition, the Wizard saves the configuration file under the name of the export file in CFG format.
In the course of a subsequent import you can interpret the export file in accordance with the settings of the original configuration file. The picture objects with the object properties created accordingly are then determined from the picture or pictures. The data are written to a file that can be edited with Microsoft Excel. The structure corresponds to the settings of the configuration file.

**Importing the picture objects**

The picture objects named in the export file are copied from the template picture into the pictures of the project. The configuration corresponds to the settings of the export file.

When the objects are imported, the Wizard reads the configuration from the file "name of export file.cfg". If this file does not exist, the import takes place via the project-specific file.

**Updating the picture objects**

If the export file does not have to be edited, the "Update the picture objects" Wizard basically uses the project-specific file to replace the objects changed in the template picture.

**See also**

Structure of the configuration file (Page 240)

7.5.3 **How to exchange script- and instance-specific picture information**

**Introduction**

When objects are imported and updated, alongside the tag connections of dynamic object properties, the structure instance names of the following tags are also recognized and exchanged:

- Tags used in C scripts
- Tags used in triggers
- The content of the object property "tagname" of the faceplates

**Prerequisite**

Observe the following restrictions:

In the case of scripts, the tag is defined in the declaration, e.g.:

```c
// WINCC:TAGNAME_SECTION_START
#define TagNameInAction "Tag1.ui"
// WINCC:TAGNAME_SECTION_END
```

Tags which are stored directly in the code are ignored.
The tag of the object in the template picture has a structure instance name that is specified for each object property for a tag interconnection of the object, e.g.:

Correct: \#define TagName "Tag1.ui"

The structure instance is "Tag1".

Incorrect: \#define TagName ".ui"

The structure instance is missing. The structure instance is not entered in the template picture of the picture object.

Procedure

The structure instance with picture object in the template picture is determined on the basis of a user-specific object property of a tag interconnection. The tag information can not be replace if neither an object property of this kind, nor a structure instance for this object property are available. The structure instance must be the same for all object properties of the tag interconnection, for otherwise it is selected at random.

Replacement of the structure instance works according to the following principle:

- A structure instance name entered as a whole is also replaced as a whole; for example, \#define TagNameInAction "Instance1" > \#define TagNameInAction "Instance2".

- The instance-specific part is replaced at all tag databases which access a part of the structure instance name, for example, \#define TagNameInAction "Instance1.ui" > \#define TagNameInAction "Instance2.ui".

The scripts you edited are recompiled if the instance-specific part of the tag file is replaced.

Configuring the replacement process

Structure instance information on the objects is provided only on a limited basis for extended replacements. You can configure the replacement behavior of the Graphic Object Update. Corresponding settings can be made in the "[General]" section of the configuration file.

[General]
ChangeTag = 0
ChangeLink = 0

The "ChangeTag" entry enables tag replacement. The default setting is "0". The Wizard only replaces the tag interconnections of dynamic object properties. By entering the value "1" you update all used tags in C scripts, triggers and the content of the "tagname" object property at faceplates.

The "ChangeLink" entry is used to specify how the tag interconnections are to be replaced. The default setting is "0". The tag interconnections of dynamic object properties are replaced by the structure instance information of the tag interconnection, similar to the previous version. The structure instance name does not have to appear in the tag. By entering the value "1" you replace the tag interconnections according to the structure instance names. The replacement also takes place for tags in the scripts, however, not for tags in Trigger. The structure instance name must always appear at the tags.

This results in the following replacement options:
### 7.6 File Format of the Export/Import File

#### Introduction

The export/import file contains the following columns in this order:

- Picture Name
- Object Type
- Link1 to Link6
- Object name
- Individually configured columns from the configuration file

#### Example of an export and import file

The Export Wizard generates a file in the *.csv format as illustrated below. You can change or expand the file as needed. The Import Wizard regenerates objects, e.g. motors or valves with this file.

<table>
<thead>
<tr>
<th>Picturename</th>
<th>Object type</th>
<th>Link1</th>
<th>Link2</th>
<th>Link3</th>
<th>Segment4</th>
</tr>
</thead>
<tbody>
<tr>
<td>MyPic.Pdl</td>
<td>MOTOR</td>
<td>-</td>
<td>-</td>
<td>MAIN</td>
<td>TYPICALS</td>
</tr>
<tr>
<td>MyPic.Pdl</td>
<td>MOTOR</td>
<td>-</td>
<td>-</td>
<td>MAIN</td>
<td>TYPICALS</td>
</tr>
<tr>
<td>MyPic.Pdl</td>
<td>VALVE</td>
<td>-</td>
<td>MAIN</td>
<td>BEF</td>
<td>DT1BA1</td>
</tr>
<tr>
<td>MyPic.Pdl</td>
<td>VALVE</td>
<td>-</td>
<td>MAIN</td>
<td>BEF</td>
<td>DT1BA1</td>
</tr>
<tr>
<td>MyPic.Pdl</td>
<td>VALVE</td>
<td>-</td>
<td>MAIN</td>
<td>BEF</td>
<td>DT1BA1</td>
</tr>
<tr>
<td>MyPic.Pdl</td>
<td>VALVE</td>
<td>-</td>
<td>MAIN</td>
<td>BEF</td>
<td>DT1BA1</td>
</tr>
</tbody>
</table>

Continuation of the Table
### Segment5 | Segment6 | Objectname | X-Pos | Y-Pos | Tag (Identifier) | Trend
--- | --- | --- | --- | --- | --- | ---
SD0001 | SDRIVE | MOTOR | 200 | 120 | SD0001 | Trend_2
SD0003 | SDRIVE | MOTOR | 190 | 230 | SD0003 | Trend_3
Y71 | SVALVE | VALVE | 20 | 20 | Y71 | Trend_6
Y78 | SVALVE | VALVE | 20 | 70 | Y78 | Trend_xxx
Y78 | SVALVE | VALVE | 710 | 90 | Y78 | Trend_test
Y79 | SVALVE | VALVE | 20 | 20 | Y79 | Trend_test2

**Comment:** The name of a tag consists of the columns "Link1" to "Link6". Example of line 1: HAUPT/TYPICALS/SA0001/SANTRIEB. The names in the table must not have blank spaces.

**See also**

Functionality of the Graphic Object Update Wizard (Page 233)
8 Resources

8.1 Component List Editor

Content
The Component List Editor is used for the configuration of entry point pictures and the areas of measuring points.

This documentation shows you the following:
- how to create a new measuring point
- how to edit a measuring point
- how to find a measuring point

8.2 General Information About the Component List Editor

Introduction
You can use the Component List Editor, for example, to configure the properties of the measurement points that are needed for the PCS 7 OS runtime.

- Type
- Entry point picture (Loop In Alarm)
- Area assignments

The function is only available in one PCS 7-OS.

Overview
The component list is usually derived from the PCS 7 ES configuration in the course of the AS-OS engineering ("Compile OS"). The AS-OS engineering distributes all relevant runtime properties of the measurement point in the WinCC configuration data, such as data manager, alarm logging, and the component list. Following configuration changes in the PCS 7 ES, you can use the AS-OS engineering to ensure that specific data on the OS remains consistent.

You can create new measurement points yourself using the Component List Editor. The editor shows you all the information of the component list regardless of the source. However, you can only change data in the editor that you have entered with the editor. You cannot change data derived from the PCS 7 ES, recognized by the label "System ES" in the "Owner" column in the Component List Editor.
Open the Component List Editor by double-clicking it in the WinCC Explorer.

Using the editor

The Component List Editor is only available for WinCC single-user projects and multi-user projects. The configured component list of the loaded server packages is used on the WinCC client.

You apply the settings made in the dialog boxes of the Component List Editor by double-clicking the "OK" button. The settings are always based on the currently opened WinCC project.

You sort the entries in the Component List Editor as follows:

- When you click one of the column headers, the entries in this column are sorted in ascending order.
- When you click this column header again, the entries are sorted in descending order.

Requirements for using the Component List Editor

If you have created a PCS 7 OS but did not do so on a PCS 7 ES, you must first run the OS Project Editor in WinCC. The OS Project Editor defines the basic properties of the component list. You will not be able to edit the component list in the Component List Editor unless you have gone via the OS Project Editor.
Effect in Runtime

Use the "LoopInAlarm" function for active alarms. You can configure an entry point picture for each measurement point using the Component List Editor. Measurement points for which no entry point picture is configured, are displayed as a loop at the corresponding faceplate by the "LoopInAlarm" function.

The "Picture via measurement point" is usually used for informational purposes in runtime. Only the measuring points that are entered in the Component List Editor are entered in the runtime dialog box. You can select among five display formats:

- Process picture in the working area
- Process picture as window
- Group display
- Loop display in working area
- Loop display as window

If no entry point picture is configured, the default setting is "Loop display in working area".

8.3 Functionality of the Component List

Introduction

The component list offers a storage system for the following important runtime properties of the measurement point in the PCS 7 OS and allows them to be edited:

- Measurement point name
- Measurement point type
- Area location
- Entry point picture
- Name of the block icon in the entry point picture

Generating the component list

The component list derives the project-specific data from the PCS 7 ES configuration in the course of the AS-OS engineering ("Compile OS").

For measurement points entered by the user in the Component List Editor, the entry point picture and the name of the block icon are generated (if they do not already exist) from the calculation of the group display hierarchy of the Picture Tree Manager for the area. If the owner is neither the user nor AS-OS engineering, the project-specific data is updated.

If a picture configuration exists already, the entry point picture is determined for the "LoopInAlarm" function. If a block instance is in several pictures, the system selects one of the pictures as the entry point picture. However, if you wish to designate a specific picture as the entry point picture, you must change the entry point picture for the measurement point in the Component List Editor.
The entries in the component list receive an owner which serves to establish the origin of the data. The owners have the following properties:

- In the entries created by AS-OS engineering, they can change the entry point picture. These entries have the owner "System ES".
- You can change and delete properties of the entries you yourself have created. These entries have the owner "User".

**Updating the entries in the component list**

AS-OS engineering after editing the component list guarantees the update of entries. The existing entries are deleted and newly created ones are assigned the "System ES" as the owner. If the entry point picture resulted from calculation of the group display hierarchy, the entry point picture is determined once again.

If another owner deletes a measurement point in the component list or renames the entry point picture, the name of the previous measurement point or the original entry point picture remains in the component list following the AS-OS engineering.

If you change the entry point picture to a module, you must also change the object name accordingly. You must save the group display hierarchy again in the "Picture Tree Manager" editor or load the project.

During delta compilation, the "Type" and "Area" properties of deleted or renamed measurement points are individually deleted. The entry point picture created from the group display, the measurement point name and the object name of the previous measurement point remain in the component list.

The measurement point name continues to be shown in the "Picture via measurement point" dialog box although the "old" measurement point no longer has properties.

You clean up the component list using the "Options > Garbage Collection" menu command. The deleted or "old" measurement points are then removed from the "Picture via measurement point" dialog box.

**Meaning of the "Owner" column**

The entries in the component list are generated by several methods and internally identified by different Creator IDs. The Component List Editor only contains one entry in the "Owner" column. This entry comes from the owner who created the measuring point and can read as follows:

- no entry when a measurement point has yet to be created
- "System ES" when at least one property has been entered by the "Compile OS" function
- "user" when a property has been manually edited or entered by the calculation of the group display (complete or delta)

The project documentation distinguishes the component list based on the creator of the properties. "System ES", "User" or "Group display" can be entered as the creator of a property.

**See also**

General Information About the Component List Editor (Page 247)
8.4 How to create a new measurement point

Prerequisite

A new measuring point in the Component List Editor can always be created if no AS-OS engineering has been performed in the ES. In this case you can configure the necessary data in the Component List Editor and create a new measuring point.

Procedure

1. Select the "Edit > Create New Measuring Point" menu command.

2. Click the toolbar button 🍂, or double-click in a blank line of the Component List Editor. The following dialog box opens:

3. Configure the data in the four input boxes. You can select the text from the options provided or enter a text using the keyboard:

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition/Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measuring point</td>
<td>Click 📞 to open the tag selection dialog box. Select a configured WinCC tag. Click &quot;OK&quot;. The selection is saved.</td>
</tr>
<tr>
<td>Type</td>
<td>Select the measuring point type you want to assign to the specified measuring point from the drop down list box. Only the types configured as structure tags are offered for selection.</td>
</tr>
<tr>
<td>Area</td>
<td>Select the hierarchy area you want to assign to the specified measuring point from the drop down list box. The areas configured in the Picture Tree Manager are offered for selection.</td>
</tr>
<tr>
<td>Entry point picture</td>
<td>Click 📩 to open the entry point picture selection dialog box. Select the picture. Click &quot;Open&quot;.</td>
</tr>
<tr>
<td>OK</td>
<td>Use this button to save your settings and close the dialog box.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Use this button to close the dialog box. Your entries are not saved.</td>
</tr>
</tbody>
</table>
8.5 How to find a measuring point

Procedure

1. Select the "Edit > Find measuring point" command, or click the toolbar button.

The following dialog box opens:

![Find dialog box]

2. Configure the search criteria:

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition/Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find what:</td>
<td>Enter the search criterion in this input box.</td>
</tr>
<tr>
<td>Match whole word only</td>
<td>If the &quot;Match whole word only&quot; check box is activated, only whole words are included in the search for measuring points.</td>
</tr>
<tr>
<td>Match case</td>
<td>If you enable the &quot;Match case&quot; check box, the search only covers measuring points whose lower and upper case lettering match the specification at &quot;Find what.&quot;.</td>
</tr>
<tr>
<td>Find Next</td>
<td>Click this button to start the search.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Click this button to exit the dialog box. The search function is canceled.</td>
</tr>
</tbody>
</table>
8.6 How to edit a measuring point

Prerequisite

You can edit data in the Component List Editor under the following conditions:

- You can only change the entry point picture for measurement points created by the owner "System ES" using AS-OS engineering.
- You can change the entry point picture, the type and the area at measurement points created by the owner "User".

Procedure

1. Select a measuring point.
2. Select the "Edit > Edit measuring point" command, or double-click in the line which contains the selected measuring point.
   The following dialog box opens:

   ![Edit measuring point dialog box](image)

3. Configure the edit settings: You can select the text from the options provided or enter a text using the keyboard:

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition/Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measuring point</td>
<td>Displays the measuring point to be edited.</td>
</tr>
<tr>
<td>Type</td>
<td>This is where you can edit the measuring point type. Only the &quot;User&quot; owner can change the measuring point type.</td>
</tr>
<tr>
<td>Area</td>
<td>Select the hierarchy area you want to assign to the specified measuring point from the drop down list box. The areas configured in the Picture Tree Manager are offered for selection.</td>
</tr>
</tbody>
</table>
   | Entry point picture | In order to change the entry point picture, click ![...].  
   The entry point picture selection dialog box opens.  
   Select the picture.  
   Click "Open". |
   | Object name       | Shows the name of the block icon in the entry point picture. The object name cannot be changed. |
   | Owner             | Indicates the data origin of the selected measuring point. The owner cannot be changed. |
Field Definition/Action

OK Save your changes and close the dialog box by clicking this button.

Cancel Click this button to close the dialog box. Your entries are not saved.

You can also select and edit a number of measuring points in the editor window. The entry "<various>" is displayed in the input boxes. Configured changes are valid for all selected measuring points. However, only the entry point picture is changed at measuring points created by the owner "System ES".

Note

If you change the entry point picture the existing object name is deleted from the component list. The new object name is derived from the new entry point picture. If a suitable block icon is found, its object name is entered in the component list. The first of several block icons found in the same entry point picture is used.

8.7 How to Select a Picture via the Measurement Point

Introduction

The tag selected in the measuring point list represents a measuring point that is highlighted according to the configured display format. Example:

<table>
<thead>
<tr>
<th>Index</th>
<th>55</th>
<th>75</th>
<th>85</th>
<th>95</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unit</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Prerequisite

Appropriate area authorizations must be assigned in the User Administrator to the logged on user.
Procedure

1. Click the "Picture via measurement point" button in runtime within button set 1.

The "Picture selection via measurement point" dialog box opens. Any block comment of the measuring point is also displayed in the table beside the measuring point. The block comment is also displayed in the window bar of the faceplate which can be opened by clicking the block icon. The comment originates from the "#comment" block structure/tags and is configured at the block in CFC.

2. Make the required settings here:
### Component List Editor

#### 8.8 How to configure the "Loop in Alarm" function

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition/Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer</td>
<td>This drop down list box is only active if the dialog box is opened from within a WinCC client project. In addition, you must have downloaded the package from the selected server to the WinCC client.</td>
</tr>
<tr>
<td>Measuring point</td>
<td>Select the measuring points to be displayed from this drop-down list box. &quot;&lt;All&gt;&quot; is displayed by default.</td>
</tr>
<tr>
<td>including</td>
<td>In the filter function, you can enter a filter criterion. Then only the measurement points that comply with the filter criterion are displayed.</td>
</tr>
<tr>
<td>excluding</td>
<td>You can use the negative filter to exclude measurement points from the display. The list displays only measurement points that comply with the filter criterion and that do NOT comply with the negative filter criterion. If you enter e.g. &quot;<strong>&quot; in the &quot;including&quot; field and &quot;b</strong>&quot; in the &quot;excluding&quot; field, all measurement points that do not begin with a &quot;b&quot; are displayed.</td>
</tr>
<tr>
<td>Load</td>
<td>Loads the current filter.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves the current filter.</td>
</tr>
<tr>
<td>Representation</td>
<td>You can select one of five display formats from the Show as area. The default setting is &quot;Process picture in working area&quot;.</td>
</tr>
<tr>
<td></td>
<td>Process picture in the working area: The measuring point is visualized as a process picture in the working area.</td>
</tr>
<tr>
<td></td>
<td>Process picture as window: The measuring point is visualized as a window.</td>
</tr>
<tr>
<td></td>
<td>Loop display in working area: The measuring point is visualized as loop display in the working area.</td>
</tr>
<tr>
<td></td>
<td>Loop display as window: The measuring point is visualized as loop display window.</td>
</tr>
<tr>
<td></td>
<td>Group display: The measuring point is visualized as group display.</td>
</tr>
</tbody>
</table>

**Note**

Measurement points for which the area is unknown do not possess any operator authorization.

If the measuring point selection fails, check in the Component List Editor to determine whether the measuring point has been assigned an area. There, specify the area for which the user has authorization.

If no entry point picture is configured, the faceplate for which the measuring point was configured is displayed. The default setting of the display mode is then "Loop display in working area". The first two radio buttons in the Show as area are then disabled.

---

### 8.8 How to configure the "Loop in Alarm" function

#### Introduction

The "Loop in Alarm" function is only available at a PCS 7 OS.

The "Loop In Alarm" function is used to visualize a measuring point which triggered an alarm in a loop display on the faceplate, or as process picture that has been linked in the Component List Editor.
Procedure

1. Start the "Alarm Logging" editor. You can select the "Loop in Alarm" function from the "Tag/Action" tab or from the "Loop in Alarm" column in the message "Properties" dialog box. The WinCC default here is "Open Picture".

![Function Browser](image)

2. In the "Picture name/Call parameter" input box, enter the measuring point name, e.g. "FIC_752_003". Go to the "Split Screen Manager" in the Function Browser to select the "LoopInAlarm" function. Click "OK". "OpenPicture" is replaced by "LoopInAlarm". Caution: Do not double-click "LoopInAlarm"! If this occurs accidentally, then click "Cancel". The additional "Parameter Assignment" dialog box will close.

Note

The standard function "Open Picture" may not be used in the PCS 7 environment. A picture opened with this function overlays the standard runtime environment. Now, operator input is no longer possible.
Process control runtime

9 Resources

9.1 Process control runtime

Content

This documentation provides an overview of the runtime functionality in PCS 7.

This chapter shows you the following:

- how to use the key and button functions
- how to navigate the picture hierarchy
- how to display message lists
- how to work with graphic pictures
- how to show alarm sources in the group display

9.2 Product Overview

About the Manual

The operating manual provides operating personnel with a guide to operating and monitoring a process. The operating manual provides information about the system structure and describes possible operations.

In addition to these functions, WinCC allows the user to configure new, user-specific operations. These operations are not described in this manual.

Due to the large number of options available during picture configuration, the pictures or picture components used for your installation may be completely different. The operations described here are examples using the existing base data.

Due to differences in screen resolution and/or product developments or runtime changes, any of the pictures of user interface elements shown in the manual (menus, windows, dialog boxes) may differ (in content or scale, etc.) from the pictures actually displayed on the screen. These pictures are intended as examples only and claim neither to represent the original nor to be complete.

In its delivered state, the "Libraries" product includes certain complex operating elements of conventional technology such as controllers, motors, valves, or operating and display elements. This package has been designed for use with SIMATIC S7 components.
Assumption

The functions described in this user manual assume that you have used the optional Basic Process Control package to configure your plant.

Usage

The runtime system is used to monitor and guide automatic processes.

The well-arranged graphical user interface with windows technology gives the user a fast overview of the entire plant down to detail level. The user is supported in this task by function-oriented operation and extensive help functions.

Group displays for the alarm and warning functions in the different system areas, together with the "Loop in alarm" function in respect of messages, help to ensure for the user fast reaction and sharply focused intervention.

9.3 System Structure

Overview

WinCC Runtime is an operator system for central operating and monitoring. The following system configurations are possible:

- WinCC computer with one screen
- WinCC computer with up to four screens through a Multi-VGA card

The following screen arrangements are supported:

OS Project Editor configures the screen arrangement and screen resolutions (1024x768, 1280x1024, 1152x864 or 1600x1200 pixels) for the WinCC computers.

Project

A "project" is a consistent database which contains the configuration data for executing the entire Runtime.

Working on multiple screens with a mouse and keyboard

To work with the screens, you require only a keyboard and a mouse.

How to work with the mouse:
• Put the mouse pointer onto any screen and move it out of the screen area. The direction of the permitted cursor movement depends on the screen arrangement (left/right, up/down, diagonal). The mouse pointer moves to the next screen.
• You can use the mouse to activate all functions on the screen selected in this way, just as you would on any of the other connected screens.
A single keyboard may be used for all entries on any of the screens.

Example:

This example shows four screens arranged in a row. The user can move the cursor freely from left to right and vice versa.

9.4 How to set up and load the project

Introduction

This chapter describes how to select and set up a new project and then activate it for runtime.

Overview

When you have created a project, you may wish to load it into the runtime system. To do this, perform the following steps.
• Select the project.
• Assign a computer to the project.
• Configure and initialize the runtime interface with the aid of the OS Project Editor.
• Set up the message system with the standard default values via the OS Project Editor.
When you have started WinCC for the first time, the following dialog box is displayed:

1. Select the "Open an existing project" check box and then click "OK". The file selection dialog box opens.
2. Double-click the "<Name>.mcp" file in the file selection dialog box to display the selected project in WinCC Explorer.
3. If you already started WinCC and want to download a project, select the "File > Open" menu command:

Selecting a computer

If the computer is not entered in the computer list for the opened project, use the following procedure to add the computer to the project:

- Single-user project
  - Right-click "Computer" in WinCC Explorer to open the shortcut menu.
  - Select the "Properties" menu command.
    The "Properties" dialog box opens.
    - Enter your computer name.
- Multi-user project
  - Modify a configured computer, or add your own computer as an additional operator station.

You set the properties of the computer on which the project is to run in the "Computer Properties" dialog box:
1. Click on "Computer" in WinCC Explorer and double click on the appropriate computer name in the "Name" column. The following dialog box opens:

2. Specify your settings for your computer configuration in the "General" tab.
3. Switch to the "Startup" tab:
If the Basic Process Control optional package is being used, the entries shown above are made in the "Additional Tasks/Applications" list of the OS Project Editor.

**Note**

The OS project editor automatically activates the startup applications Alarm Logging Runtime, Global Script Runtime and Graphics Runtime in the "Startup" tab. In addition, the application "CCCSigRTServer" is automatically linked.

**See also**

How to activate a project for Runtime operation (Page 265)
9.5 How to activate a project for Runtime operation

Introduction

Activate the project after having completed all preparations.

Procedure

1. Click on "File" in the WinCC Explorer. The "File" menu opens:

   ![File menu screenshot]

2. Select the "Activate" menu command. WinCC Runtime starts.

9.6 Overview of the button functions in runtime

The table below lists all buttons which are available in runtime and their functionality:

<table>
<thead>
<tr>
<th>Functionality</th>
<th>Key</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Button set 2</td>
<td>![Key image]</td>
<td>Displays button set 2.</td>
</tr>
<tr>
<td>Change Button Set</td>
<td>![Key image]</td>
<td>Displays button set 1.</td>
</tr>
<tr>
<td>System control elements</td>
<td>![Key image]</td>
<td></td>
</tr>
</tbody>
</table>
### Functionality Key Meaning

<table>
<thead>
<tr>
<th>Functionality</th>
<th>Key</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password</td>
<td></td>
<td>Open the LOGIN dialog box (authorization required: none).</td>
</tr>
<tr>
<td>Exit Runtime</td>
<td></td>
<td>Exits runtime in a defined manner (authorization required: system change).</td>
</tr>
<tr>
<td>Switch language</td>
<td></td>
<td>Changes to a different language (authorization required: monitoring).</td>
</tr>
<tr>
<td>Online Help</td>
<td></td>
<td>Opens the online help. (authorization required: none).</td>
</tr>
<tr>
<td>Display the Plant Picture</td>
<td></td>
<td>Displays lifebeat monitoring (authorization required: none).</td>
</tr>
<tr>
<td>Save Screen Composition</td>
<td></td>
<td>Saves the current composition of displayed pictures on all screens (authorization required: authorization for area).</td>
</tr>
<tr>
<td>Recall Screen Composition</td>
<td></td>
<td>Displays the saved screen composition again (authorization required: authorization for area).</td>
</tr>
<tr>
<td>Delete the screen composition</td>
<td></td>
<td>Deletes the saved screen composition (authorization required: authorization for area).</td>
</tr>
<tr>
<td>Reports</td>
<td></td>
<td>Displays an overview of all report jobs (authorization required: authorization for area).</td>
</tr>
<tr>
<td>Picture information</td>
<td></td>
<td>Displays information on the currently displayed picture (authorization required: none).</td>
</tr>
<tr>
<td>Activate BATCH</td>
<td></td>
<td>Starts &quot;BATCH flexible&quot; (authorization required: none).</td>
</tr>
<tr>
<td>User authorization</td>
<td></td>
<td>Select User Administrator (authorization required: User Administration).</td>
</tr>
<tr>
<td>SFC Visualization</td>
<td></td>
<td>Visualization and setup/change of SFC charts (authorization required: none).</td>
</tr>
<tr>
<td>Route Control Center</td>
<td></td>
<td>Starts &quot;Route Control Center&quot; (authorization required: none).</td>
</tr>
</tbody>
</table>

*MDM - WinCC/Options for Process Control System Manual, 11/2008,*
<table>
<thead>
<tr>
<th>Functionality</th>
<th>Key</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lock messages</td>
<td>![Key Image]</td>
<td>The lock applies to all blocks of the picture in the working area and to all child pictures of a parent picture (authorization required: process control elements).</td>
</tr>
<tr>
<td>Free alarms</td>
<td>![Key Image]</td>
<td>The release applies to all blocks of the picture in the working area and to all nested pictures of the picture (authorization required: process control elements).</td>
</tr>
<tr>
<td>Group acknowledgement</td>
<td>![Key Image]</td>
<td>Process pictures: Acknowledges all group display objects and faceplates created accordingly in the picture (authorization required: none). Message list: Acknowledges all unacknowledged messages (authorization required: none). The signaling devices are automatically acknowledged.</td>
</tr>
</tbody>
</table>

**Overview Area**

<table>
<thead>
<tr>
<th>Area Selection Button</th>
<th>![Key Image]</th>
<th>Select area. Displays the area identified on this button (authorization required: depends on the setting in the &quot;Areas&quot; tab of OS Project Editor pertaining to the picture selection in areas with missing authorization).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Selection Button</td>
<td>![Key Image]</td>
<td>Select server area. Displays the server package identified by the name on this button (authorization required: none).</td>
</tr>
<tr>
<td>Group display</td>
<td>![Key Image]</td>
<td>All messages of an area are interconnected with the display by means of logical &quot;OR function&quot; (authorization required: depends on the setting in the &quot;Areas&quot; tab of OS Project Editor pertaining to the picture selection in areas with missing authorization).</td>
</tr>
<tr>
<td>Select Alarm Source (Open Picture)</td>
<td>![Key Image]</td>
<td>Displays a picture with the alarm source if an alarm is active and if you press one of the four buttons (authorization required: depends on the setting in the &quot;Areas&quot; tab of OS Project Editor pertaining to the picture selection in areas with missing authorization).</td>
</tr>
<tr>
<td>Acknowledge message</td>
<td>![Key Image]</td>
<td>Acknowledges the message displayed in the message line (authorization required: none).</td>
</tr>
<tr>
<td>Layout of the plant overview</td>
<td>![Key Image]</td>
<td>Displays the Picture Tree Navigator (authorization required: none).</td>
</tr>
<tr>
<td>Extended Message Line</td>
<td>![Key Image]</td>
<td>Displays the list of entered messages (required authorization: none).</td>
</tr>
<tr>
<td>Loop in Alarm</td>
<td>![Key Image]</td>
<td>Selects the picture showing the alarm source (authorization required: none).</td>
</tr>
<tr>
<td>Highest priority messages</td>
<td>![Key Image]</td>
<td>Display of the list of highest priority messages. This button flashes if a priority &quot;16&quot; message was activated. (authorization required: none). This function is only available on a PCS 7 OS.</td>
</tr>
<tr>
<td>Login</td>
<td>![Key Image]</td>
<td>Selects the logon dialog box (authorization required: none).</td>
</tr>
<tr>
<td>Screen Dump</td>
<td>![Key Image]</td>
<td>Prints the screen content to the default printer (authorization required: none).</td>
</tr>
</tbody>
</table>

**Pictures**
### Functionality

<table>
<thead>
<tr>
<th>Functionality</th>
<th>Key</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Picture by name</td>
<td>![Icon]</td>
<td>Selects a picture by means of the picture name (authorization required: none).</td>
</tr>
<tr>
<td>Picture via measurement point</td>
<td>![Icon]</td>
<td>Selects a picture via measurement point (authorization required: none). This function is only available on a PCS 7 OS.</td>
</tr>
<tr>
<td>Store Picture</td>
<td>![Icon]</td>
<td>Saves the current picture (authorization required: none).</td>
</tr>
<tr>
<td>Recall picture</td>
<td>![Icon]</td>
<td>Displays the saved picture again (authorization required: none).</td>
</tr>
<tr>
<td>Previous picture</td>
<td>![Icon]</td>
<td>Displays the process picture which is saved to the picture stack before the current process picture in the working area (required authorization: none).</td>
</tr>
<tr>
<td>Next picture</td>
<td>![Icon]</td>
<td>Displays the process picture that is stored in the picture stack after the current process picture in the working area (authorization required: none).</td>
</tr>
</tbody>
</table>

### Navigate in the picture tree

<table>
<thead>
<tr>
<th>Functionality</th>
<th>Key</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Detail screen</td>
<td>![Icon]</td>
<td>Switches from the area level or sublevel to the next lower level (authorization required: none).</td>
</tr>
<tr>
<td>Picture up</td>
<td>![Icon]</td>
<td>Change to the next higher area level or sublevel (authorization required: none).</td>
</tr>
<tr>
<td>Picture left</td>
<td>![Icon]</td>
<td>Changes to the next sublevel of the current level (authorization required: none).</td>
</tr>
<tr>
<td>Picture right</td>
<td>![Icon]</td>
<td>Changes to the next sublevel of the current level (authorization required: none).</td>
</tr>
</tbody>
</table>

### Messages / Alarms

<table>
<thead>
<tr>
<th>Functionality</th>
<th>Key</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Previous graphics picture</td>
<td>![Icon]</td>
<td>Exits message system (authorization required: none).</td>
</tr>
<tr>
<td>Message system</td>
<td>![Icon]</td>
<td>Displays the message system with the associated button set. The incoming alarm list is displayed immediately (authorization required: none).</td>
</tr>
<tr>
<td>Incoming alarm list</td>
<td>![Icon]</td>
<td>Displays the acknowledgeable incoming alarm list, provided that separate acknowledgeable alarm lists are to be displayed (authorization required: none).</td>
</tr>
<tr>
<td>Functionality</td>
<td>Key</td>
<td>Meaning</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>-----</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Acknowledged alarm list</td>
<td></td>
<td>Displays the acknowledged alarms list (authorization required: none).</td>
</tr>
<tr>
<td>Acknowledged alarm list, quitable</td>
<td></td>
<td>Displays the acknowledged alarm list, provided that separate acknowledgeable message lists are to be displayed (authorization required: none).</td>
</tr>
<tr>
<td>Outgoing alarm list</td>
<td></td>
<td>Displays the outgoing alarm list (authorization required: none).</td>
</tr>
<tr>
<td>Outgoing alarm list, quitable</td>
<td></td>
<td>Displays the acknowledgeable outgoing alarm list, provided that separate acknowledgeable message lists are to be displayed (authorization required: none).</td>
</tr>
<tr>
<td>Process alarms</td>
<td></td>
<td>Displays the process alarm list (authorization required: none).</td>
</tr>
<tr>
<td>Operation list</td>
<td></td>
<td>Displays the operation list (authorization required: none).</td>
</tr>
<tr>
<td>Journal list</td>
<td></td>
<td>Displays the journal list (authorization required: none).</td>
</tr>
<tr>
<td>Hidden list</td>
<td></td>
<td>Displays the hidden list of alarms (authorization required: none).</td>
</tr>
<tr>
<td>List of messages to be hidden</td>
<td></td>
<td>Display list of messages to be hidden (authorization required: none).</td>
</tr>
<tr>
<td>Print message sequence report</td>
<td></td>
<td>Prints a chronological list of messages (authorization required: none).</td>
</tr>
</tbody>
</table>

| Trend system                          |     |                                                                         |
| Recall / compile trend groups         |     | Recalls and displays trend groups online (authorization required: none). This function is only available on a PCS 7 OS. |

**Note**

The "SFC Visualization", "BATCH flexible", and "Route Control Center" buttons are only displayed in button set 2 in runtime if the corresponding optional packages have been installed.

Each of these optional packages must be ordered separately from the "WinCC Basic Process Control" optional package.
9.7 User Interface

9.7.1 User Interface

Übersicht

This section describes the layout of the user interface and the basic control elements of WinCC Runtime.

Prerequisite: The Basic Process Control optional package was used during configuration.

WinCC Runtime

This example shows a project from chemical industry. After the project has been activated, the following startup screen is displayed:
User Interface

The user interface is divided into three areas:

- Overview Area
- Working Area
  The pictures of the plant areas are displayed on the working area.
- Button Area

See also

Overview Area (Page 271)
Working Area (Page 274)
Button Area (Page 274)

9.7.2 Overview Area

Introduction

The overview window is a continuous display that provides an overview of the entire plant. Each plant area is represented by an area selection button in the overview window. With an area selection list, the user can select the top process picture in the picture hierarchy. The Picture Tree Navigator and certain key combinations support the user during navigation in the picture tree.

Description of elements

This example overview window includes the following elements:

<table>
<thead>
<tr>
<th>Functionality</th>
<th>View</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message line: Displays the most recent incoming message of the highest priority</td>
<td></td>
</tr>
<tr>
<td>Extended message line: Opens a list displaying all incoming messages.</td>
<td></td>
</tr>
<tr>
<td>Loop in Alarm (alarm source picture selection): Selects the picture with the alarm source</td>
<td></td>
</tr>
</tbody>
</table>
Button for the "Highest priority messages" list:
- The button is only available during the installation of a PCS 7-OS. This button flashes if a priority "16" message was activated. The button also flashes after the message was acknowledged. The button disappears when the message is gone.
- The "Highest priority messages" list appears when the button is clicked. Displays the list of all activated messages, including the activated and acknowledged messages of priority "16".
- An additional message which is not assigned to a specific area is generated if diagnostics functions are used in the PCS 7 project and a priority "16" message is assigned to the "Diagnostics" area. The message which is not assigned to an area is generated as soon as at least a highest priority message was activated. This message is deactivated after the highest priority messages were cleared from the "Diagnostics" area. The highest priority message is therefore visible to users who are not granted access to the "Diagnostics" area.
- Message classes with the configuration "without status went out" will be handled separately. The messages disappear from the "Highest priority messages" list after acknowledgement.
- The settings for the message filter also apply to the "Highest priority messages" list. Make sure that you apply message classes requiring acknowledgement to an acknowledgable message list.
- Hidden messages with priority "16" do not cause the button to flash and are not shown in the list.

Message confirmation button: Acknowledges the currently displayed message

Visualization of redundancy monitoring in the area overview:
This function is only available in a PCS 7 OS.
As of WinCC V7.0 SP1, the right section of the area overview on the client displays the status of all redundant and non-redundant servers which were loaded by means of packages:
- Green display: The servers monitored are in Runtime and their status is "OK".
- Red display:
  - Not all monitored servers are in Runtime.
  - Not all monitored servers have the status "OK".
  - Not all monitored servers have a fault-free network connection.
- No display:
  - The "CCEmergencyWatchRTServer.exe" process is missing in the startup list on the client.
  - No packages are loaded on the client.

Area selection button: Displays the area picture in the working area. The button labels correspond to the container names of the picture configured in the top level of the Picture Tree Manager.

Loop in Alarm (alarm source picture selection for group display):
Selects the picture with the alarm source

Group display:

Opens the process window of the Picture Tree Navigator. The button is only enabled when there is a hierarchy below the area.

Current date and time: Shows the date and time in digital format
Login:
Shows the name of the current user

Screen hardcopy:
Prints out the contents of the current screen to the computer's standard printer.

**Picture Tree Navigator**

Clicking this button opens the process window of the Picture Tree Navigator, which displays the hierarchy assembled in the Picture Tree Manager for this area. The Picture Tree Navigator allows you to select the individual pictures in the area.

![Picture Tree Navigator Diagram]

You can also select pictures in the hierarchy using the keyboard. If you are using multiple screens with multi VGA, the screen selection with the keyboard always acts on the first screen.

<table>
<thead>
<tr>
<th>Key / Key combination</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Picture up&gt;</td>
<td>Moves one picture up in the current hierarchy level, for example from Container 7 to Container 6</td>
</tr>
<tr>
<td>&lt;Picture down&gt;</td>
<td>Moves one picture down in the current hierarchy level</td>
</tr>
<tr>
<td>&lt;Shift + Picture up&gt;</td>
<td>Moves up one hierarchy level, for example from Container 9 to Container 7</td>
</tr>
<tr>
<td>&lt;Shift + Picture down&gt;</td>
<td>Moves down one hierarchy level</td>
</tr>
</tbody>
</table>

When you right-click an icon in the Picture Tree Navigator, the name of the picture containing the message source is displayed. Each icon can refer to a different message source.

![Right-Click Icon Example]
9.7 User Interface

9.7.3 Working Area

Übersicht

Individual pictures of the various areas of a plant are displayed in the working area. The process is displayed, controlled and operated in the working area.

You have the following options for displaying a picture in the working area:

- You select the picture in the overview area.
- You use the navigation buttons of the picture hierarchy.
- You use picture selection dialog boxes.
- You use configured picture changes.

See also

User Interface (Page 270)
Working Area (Page 274)
Button Area (Page 274)

9.7.4 Button Area

Übersicht

Displayed in the button area are buttons that trigger operator activity. Two button sets are defined in runtime.

See also

User Interface (Page 270)
Working Area (Page 274)
Button Area (Page 274)
Button set 1

Button set 2

Colored button display

There are two color display modes for individual buttons:

- Shaded:
  The buttons are not active. These buttons cannot be used.
- Colored:
  The buttons are active. These buttons may be used.

Switching between the button sets

With these buttons, you switch between the two button sets.

When you move the cursor over a button, a What's This? help item with the button description will be displayed. When you click the button, the corresponding function is executed.

Note

You can find an overview of the buttons and their functions in "Overview of button functions of runtime"

See also

User Interface (Page 270)
Working Area (Page 274)
Overview Area (Page 271)
Overview of the button functions in runtime (Page 265)
9.7.5 Runtime Window

Introduction

The behavior of the Runtime windows in process control system options has changed in Version 6 of WinCC. The runtime user interfaces contain the following different window types:

- Pre-configured picture windows containing pictures that overlay the working area. These top windows are pictures in a process window or picture components in loop display and group display mode.
- Pre-configured picture windows containing only one picture that overlays the working area. These special fields include such items as warning boxes or information windows.
- The Picture Tree Navigator, that displays the hierarchy of the plant pictures.

Top window

The behavior of the top window can be configured in the OS Project Editor. If the default behavior is not to your liking, then use that editor to change the behavior of the window.

The "Runtime Window" tab in the OS Project Editor offers you the following configuration options:

- Loop display mode for picture components.
  The windows are automatically adapted to fit the size of the picture on opening. Their size cannot be changed. You can configure the number and position of the windows. With the "Detail" button, you open a configuration dialog in which you set up the position of the first window and the position of the other windows relative to the previous one.

- Group display mode for picture components and for windows in the function "Picture by Name".
  The windows open with predefined dimensions which can be changed. If you activated the "User defined" check box, you can use the "Detail" button to open a configuration dialog box in which you configure the number, position and size of the windows. Alternatively you can display the windows in a grid. For example, with a 2x2 grid, each window takes up one quarter of the working area. Sets of two windows opened next to each other and one below the other.

- Trend display mode for windows configured with the "Trend Online" function.
  The windows are adapt to fit the size of the picture. Their size can be changed. The trends are displayed using pre-configured pictures which you dimension in the Graphics Designer. The configuration options are the same as for the loop display mode.

Special fields

"Special fields" are picture windows that you assign to a particular picture during configuration, for example a warning notice. You configure the default settings in the "@1001.pdl" picture. In runtime, the picture is placed in the configured position each time it is opened.
Number of faceplates in the picture window

In the "Runtime Window" tab of the OS Project Editor you can set the maximum number of faceplates in the picture window that can be simultaneously displayed on each monitor or by the same instance. Up to four faceplates can be displayed. When you open a faceplate, and the number of open faceplates exceeds the configured number, a faceplate already open is closed.

Picture Tree Navigator

The Picture Tree Navigator is opened in runtime at the pre-configured position and in the maximum picture size. The size of the window can be changed. However, if the picture tree is large, the window is not larger than the working area, otherwise the user cannot select the lower ranks of the hierarchy. You can close the Picture Tree Navigator after opening a picture from the Picture Tree Navigator. You can specify the response of the Picture Tree Navigator after opening a picture in the "Runtime Window" tab of the OS Project Editor.

9.8 System operator input

9.8.1 System operator input

Overview

The following functions are described in this section:

- Logon in Runtime: Logon to the system with smart card or password
- Cursor, keys, picture information: General explanations
- Exiting runtime
- Acknowledging signaling devices/alarms
- Language switch
- Displaying the Content of the Picture Stack
- "BATCH flexible" selection
- "SFC Visualization" selection
- "Route Control Center" selection
- Displaying the system configuration picture (lifebeat monitoring)
- Selecting the plant area
- Navigation through the picture hierarchy
- Screen composition
- Displaying reporting jobs
• Selecting the User Administrator
• Locking and releasing messages

See also
How to log on in runtime (Page 278)
Basic control elements in Runtime (Page 279)
How to exit runtime (Page 280)
Acknowledging Signaling Devices and Alarms (Page 280)
How to switch languages (Page 281)
"BATCH flexible" selection (Page 282)
"SFC Visualization" selection (Page 282)
"Route Control Center" selection (Page 282)
Displaying the System Configuration Picture (Lifebeat Monitoring) (Page 283)
How to select the plant section (Page 284)
Navigation through the picture hierarchy (Page 322)
How to Display the Content of the Picture Stack (Page 282)
How to save a screen composition (Page 287)
How to display reporting jobs (Page 288)
How to call the User Administrator (Page 289)
Disabling and enabling messages (Page 290)

9.8.2 How to log on in runtime

Übersicht

You have two options for logging on in runtime:
• If a chip card reader is connected, you can use a chip card.
• You enter a logon name and password in the logon dialog box.
If a user has not been created in the User Administrator, runtime can be used by all users.
Procedure

1. Click on this button or click on the login field in the Overview window. The "System Login" dialog box opens.

2. Enter your "login" name and the "password". You are then authorized to operate runtime.

9.8.3 Basic control elements in Runtime

In the following table, the basic operations are listed:

<table>
<thead>
<tr>
<th>Function</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cursor in runtime</td>
<td><img src="image" alt="Cursor" /></td>
<td>When the cursor assumes the shape of a lightening bolt, you can activate a function (button or input) or enter process information. If the lightening bolt cursor is not displayed, you cannot make any entries.</td>
</tr>
<tr>
<td>Button functionality</td>
<td><img src="image" alt="Button" /></td>
<td>When you move the cursor over a button and let it hover there, a What's this? help item with the button functionality is displayed.</td>
</tr>
<tr>
<td>Picture information</td>
<td><img src="image" alt="Picture" /></td>
<td>The picture information displays information about the complete picture currently being displayed. When the complete picture changes, the picture information is updated, as well. Click the button shown to display the picture information:</td>
</tr>
</tbody>
</table>

![Picture Information](image)

**Note**
The picture information displayed always refers to the picture in the working area, not to a picture displayed in the process window.
9.8.4 How to exit runtime

Übersicht

You exit runtime using the "Exit runtime" icon in button set 2.

Procedure

1. Switch to button set 2, if this button set has not yet been set.

2. Click this button.
   A message dialog box opens:

   ![Exit Runtime dialog box]

   - Are you sure to deactivate the runtime session?
     If you agree push the "Deactivate" button.

   - Deactivate
   - Cancel

3. Click "Deactivate".
   Runtime will be deactivated.

9.8.5 Acknowledging Signaling Devices and Alarms

With this button, you acknowledge the signaling device, e.g., a horn, but not the triggering alarm.
With this button, you acknowledge the alarms or messages displayed on the screen. The signaling devices are automatically acknowledged.

If the message system is open, all messages visible in the message window will be acknowledged.

If the message system is not open, all alarms pending in the working area will be acknowledged, e.g., in group displays and faceplates. Messages associated with lower-level pictures are not acknowledged.

### 9.8.6 How to switch languages

Übersicht

In runtime, you can change the language currently set up for process controlling and for all runtime functions. The language will change immediately.

**Procedure**

1. Click this button in button set 2.
   The "Change Language" dialog box will open, displaying the available languages:

   ![Change Language](image)

   - german (Germany)
   - english (USA)
   - french (France)
   - italian (Italy)
   - spanish (Spain)

2. Select the check box with the desired language.
   The language will change.
9.8.7 How to Display the Content of the Picture Stack

You can use the "Previous picture" button to have the process picture that is stored before the current process picture in the picture stack displayed in the working area.

You can use the "Next picture" button to have the process picture that is stored after the current process picture in the picture stack displayed in the working area.

9.8.8 "BATCH flexible" selection

You can start one of the displayed applications of BATCH flexible by means of this dialog box. The buttons of the respective components are activated only if they were installed correctly. For related topics, consult the PCS 7 BATCH flexible manual.

9.8.9 "SFC Visualization" selection

Use this dialog box to visualize, program or edit SFC charts. The buttons of the corresponding components are only activated if properly installed.

You can find related information in the PCS 7 manual "SFC Visualization".

9.8.10 "Route Control Center" selection

You can use this dialog box to start "Route Control Center". The buttons of the respective components are activated only if they were installed correctly.

You can find related information in the PCS 7 manual "Route Control Center".
9.8.11 Displaying the System Configuration Picture (Lifebeat Monitoring)

Overview

Lifebeat monitoring is responsible for continuously monitoring the individual systems, OS and AS, and generating the process control message. The horn is triggered if you have configured the horn in the process control message and installed a signal module or sound card.

The monitoring of the configured components is automatically initiated following a restart and is repeated cyclically. If a component fails to answer after repeated attempts, a message is generated.

Structure of a system picture

In runtime, all monitored components are displayed graphically. Components that are currently not functional, for instance due to a fault, are shown struck through in the graphic.

The following figure shows an example of a process representation:
If a number of automation systems (AS) are connected to an OS, they are shown in series. The servers in the system configuration are represented as follows on a client:

- Disturbed - A device monitored by the server has failed.
- Failed - The server itself has failed.
- Established - The connection to the server has been established.

**Procedure**

1. ![Click this button.](image)
   
   Click this button.
   
   This displays the current process picture.

2. ![Click this button to exit the process picture.](image)
   
   Click this button to exit the process picture.

**9.8.12 How to select the plant section**

**Übersicht**

The pictures of the individual plant sections are displayed in the work area. You can select the pictures in the overview area.
Button Display

There are three color display modes for the area buttons:

- No color (gray):
  The button is not active. No pictures can be selected. This is the case if the user currently logged on does not possess the "Authorization for Area".

- Black lettering on gray background:
  The buttons are active. You can select the area picture.

- Black lettering on cyan-colored background:
  The picture displayed in the working area is located in the plant area of the hierarchy tree, within the area picture that is represented by the button.
Procedure

1. Click the relevant button to display the plant area:

Example:

When you click **Container4**, the process picture associated with the process picture is displayed:
9.8.13 How to save a screen composition

Overview

The runtime of the Split Screen Manager manages the user-defined screen composition. In the button bar, the buttons for saving, recalling and deleting a screen composition are provided:

- The buttons are only activated, if a user is logged on.
- When saving, the screen compositions are assigned to the currently logged on user.
- Each user can save any number of screen compositions.

The user-defined plant view can be recalled while in runtime or after a restart of runtime.

Note

Every logged on user can save a screen composition under the name "Default". This screen composition is opened automatically when the user logs on, i.e. it is the user's personal start picture.

A screen composition can only be saved, recalled or deleted, if a user is logged on.

Procedure

1. Click this button.
   The "Save Screen Composition" dialog box will open:

   ![Save Screen Composition Dialog](image)

   If the user who is logged on has already saved screen compositions, these screen compositions are displayed in the list. Screen compositions of other users are not displayed.

2. Enter a name for the screen composition or select an existing screen composition in order to delete it.

3. Click on the "Save" button.
   The pictures currently displayed on all screens are saved.

See also

How to recall the screen composition (Page 288)
How to delete a Screen Composition (Page 288)
9.8.14 How to recall the screen composition

Procedure

1. Click this button.
The "Recall Screen Composition" dialog box will open:

If the user who is logged on has already saved screen compositions, these screen compositions are displayed in the list. Screen compositions of other users are not displayed.

2. From the list, select one of the displayed picture compositions.
3. Click "Recall".
   All the pictures that were saved are displayed again on all screens.

9.8.15 How to delete a Screen Composition

Procedure

1. Click this button.
The "Delete Screen Composition" dialog box will open:

If the user who is logged on has already saved screen compositions, these screen compositions are displayed in the list. Screen compositions of other users are not displayed.

2. From the list, select one of the displayed picture compositions.
3. Click "Delete".
   All the pictures selected on all screens are deleted.

9.8.16 How to display reporting jobs
Übersicht

An overview of all reporting jobs belonging to the project currently started is displayed.

Procedure

1. Click this button.
   This displays the "Reports" window:

   ![Report window]

2. Select a report job to print it or display a print preview.
3. Exit the window with the standard acknowledgment procedure.

9.8.17 How to call the User Administrator

Übersicht

You manage and supervise user access rights in the User Administrator. The main task of the User Administrator in runtime is to monitor system login and access rights.

If you have not set up any user authorizations in your project because no users have yet been configured, all operating options are available to all users at all times. On the other hand, if you have set up users for the project, restricted operations will only be available to those users who possess the required authorizations.

Berechtigung

Only the user who has authorization for the User Administration level also has the authorization to start the User Administrator.

All changes to user authorizations take immediate effect in runtime.
Procedure

1. Click this button.
   The User Administrator will open.

Operating the User Administrator

The operation of the User Administrator is described in the "User Administrator" manual.

9.8.18 Disabling and enabling messages

Disabling/enabling messages from specific measuring points of an area

In certain process phases it may be useful to disable the messages from all measurement points of an area and re-enable these at a later time. The operator can disable and re-enable all messages of group-relevant measurement points with a single action. The measurement points can be disabled and re-enabled separately in any area.

Procedure

Click this button in the second button set to disable the messages
- of all measurement points of the work area
- from the sublevel measurement points in the group display hierarchy of an area

When messages are disabled
- the measurement point stops reporting
- a corresponding operator message is entered to indicate the disabled state of reporting at a measurement point
The disabled state is displayed at the measurement points
The disabled state is displayed in the group display of the higher-level group display hierarchy and the area overview.

Click this button of the second button to enable the messages for
- all measurement points of the working area
- the sublevel measurement points in the group display hierarchy of an area

When messages are re-enabled
- the measurement point starts reporting again
- a corresponding operator message is entered to indicate the enabled state of reporting of a measurement point
- the display of the disabled state at the measurement points is reset
- the display of the disabled state in the group display of the higher-level group display hierarchy and of the area overview is reset if no other messages are disabled in the hierarchy

Disabling/enabling messages of a measuring point

Enable and disable the messages of a specific measurement point in the faceplate belonging to the measurement point. Click the message disable or enable buttons which correspond to the buttons of the second key set.

9.9 Message system

9.9.1 Message system

Introduction

This section shows how to display and edit messages in runtime.

Function of the Message System

The control and monitoring system records the messages from the automation system and writes these in chronological order to the message log. The messages can be viewed in various message lists in the message window. The message lists contain a selection of all messages in the log.

The following different message types exist:
Process messages report events that occur during the automated process. Process events include, for example, limit violations of measured values or status information.

Process control messages are error messages caused or detected by SIMATIC PCS 7 components. With process control messages, events ranging from a component failure to a wire break message from a connected I/O are reported.

Operator input messages are generated during operation of process variables, such as a controller mode change.

System messages are generated by WinCC.

Line-based message sequence report on page-oriented printer
The message list button set features a button for printing a message sequence report which can be used to print a line-based message sequence report. You can find additional information under "How to Output Online Data with the Message Sequence Report" in "Printing the Message Sequence Report in Page Layout".

Printing the message sequence log with a client without its own project
The message sequence report can be configured in WinCC either only on the server or only on one client.

To use a message sequence log on one of the clients you need to enter the parameter "/CLIENT" in the upper case in the "Report Runtime" startup list.

See also
How to Display Message Lists (Page 297)

9.9.2 Alarms

Structure of a message
A message consists of system information and various parameters that are displayed as columns in a table. In WinCC these columns are called message blocks.

The message blocks consist of three sections:

- **System blocks** contain system data issued by Alarm Logging. These data include date, time, or report ID.
- **Process value blocks** contain the values returned by the process, e.g. critical fill levels or temperatures.
- **User text blocks** are texts that contribute to general information and understanding, e.g. information about messages, fault locations, or causes of messages.

Whereas the system blocks are permanently associated with the message, the user may add process value blocks and user text blocks to a message.

During configuration in Alarm Logging CS, you configure each individual message in one line.
Example of a message line

<table>
<thead>
<tr>
<th>Date</th>
<th>Time of Day</th>
<th>Priority</th>
<th>Source</th>
<th>Event</th>
<th>Status</th>
<th>Info</th>
<th>Co</th>
</tr>
</thead>
<tbody>
<tr>
<td>05/03/08</td>
<td>08:01:47</td>
<td>0</td>
<td>WINNC2008</td>
<td>Group display error at start up</td>
<td>C</td>
<td>R X</td>
<td></td>
</tr>
</tbody>
</table>

**Message state**

In a message, a distinction is made between the state of the message source (process value 0/1) and the acknowledgment status (not acknowledged/acknowledged).

As a result the message status is a combination of the state of the message source and the acknowledgment status.

Depending on the acknowledgment concept, a message may have up to four acknowledgment statuses:

- Came in
- Came in, acknowledged
- Came in, went out, not acknowledged
- Came in, went out, acknowledged

The current status of the message is indicated as follows:

- The color/flashing of the elements
- The text in text elements
- The time stamps in the message line

**Messages and their acknowledgment**

The following table shows the acknowledgment concept of the available message classes.

<table>
<thead>
<tr>
<th>Message class</th>
<th>Message type</th>
<th>Acknowledgment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm</td>
<td>AlarmHigh, AlarmLow</td>
<td>incoming, flashing on</td>
</tr>
<tr>
<td>Warning</td>
<td>WarningHigh, WarningLow</td>
<td>incoming, flashing on</td>
</tr>
<tr>
<td>Tolerance *</td>
<td>ToleranceHigh, ToleranceLow</td>
<td>No acknowledgement, no flashing Option as of V7.01: incoming, flashing on</td>
</tr>
<tr>
<td>AS process control messages</td>
<td>Fault, Faults</td>
<td>incoming, flashing on</td>
</tr>
<tr>
<td>OS Process control system messages</td>
<td>Fault, Faults</td>
<td>Came in, flashing on, without state went out</td>
</tr>
<tr>
<td>Preventive maintenance</td>
<td>Maintenance (maintenance request)</td>
<td>incoming, flashing on</td>
</tr>
<tr>
<td>Process message</td>
<td>Process message</td>
<td>incoming, flashing on</td>
</tr>
<tr>
<td>Operating message</td>
<td>Process message</td>
<td>No acknowledgement, no flashing</td>
</tr>
<tr>
<td>Operator prompt</td>
<td>Operator prompt</td>
<td>No acknowledgement, no flashing</td>
</tr>
</tbody>
</table>
### Message class

<table>
<thead>
<tr>
<th>Operator Input Message</th>
<th>Operator Input Message</th>
<th>No acknowledgment, no flashing, without cleared state</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status message</td>
<td>Status AS, Status OS</td>
<td>No acknowledgment, no flashing, without cleared state</td>
</tr>
<tr>
<td>System, requires acknowledgment</td>
<td>Process control, system messages</td>
<td>Not used in the Basic Process Control and PCS 7</td>
</tr>
<tr>
<td>System, does not require acknowledgment</td>
<td>Process control, operator messages</td>
<td>No acknowledgment, no flashing, without cleared state</td>
</tr>
</tbody>
</table>

* Configured by default for new projects as of WinCC V7.01. The option for acknowledgment response for the "Tolerance" message class is enabled in the OS project editor.

### 9.9.3 Message Window

#### Overview

Messages are displayed in message windows in runtime. You can restrict the content of the message window with freely definable filters.

You can move around inside the table in the message window using preconfigured icons. With a PCS7 OS, you can call an entry point picture that shows the message cause for each message (Loop in Alarm). You can configure the entry point picture in the component list editor.

The message archive enables you to archive messages on a suitable mass storage device such as a hard disk.

#### Select messages

You can display and edit lists with messages in runtime. The messages displayed in the lists refer exclusively to the current project.
## Message selection

The following message lists are offered for a better overview:

<table>
<thead>
<tr>
<th>Message List</th>
<th>Contents</th>
<th>Message classes</th>
<th>Access to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incoming alarm list</td>
<td>Messages that have not yet been acknowledged</td>
<td>Alarm, Warning, Tolerance*, PLC process control messages, OS process control system messages, Preventive maintenance, Process message, Operator prompt</td>
<td>Current messages</td>
</tr>
<tr>
<td>Acknowledged alarm list</td>
<td>Acknowledged messages that have not yet exited</td>
<td>Alarm, Warning, Tolerance*, AS process control message, OS process control message, Preventive maintenance, Process message.</td>
<td>Current messages</td>
</tr>
<tr>
<td>Outgoing alarm list</td>
<td>Unacknowledged messages that have exited</td>
<td>Alarm, Warning, Tolerance*, PLC process control message, Preventive maintenance, Process message.</td>
<td>Current messages</td>
</tr>
<tr>
<td>Process alarm list</td>
<td>Process control messages</td>
<td>AS process control message, OS process control message, Preventive maintenance, System message, no acknowledgment required - Process control message</td>
<td>Message Archive</td>
</tr>
<tr>
<td>Operation list</td>
<td>Operator input messages</td>
<td>Operator input message, System message, no acknowledgment required - Operator input message</td>
<td>Message Archive</td>
</tr>
<tr>
<td>Journal list</td>
<td>Messages, besides operator input messages</td>
<td>Alarm, Warning, Tolerance, AS process control message, OS process control message, Preventive maintenance, Process message, Operating message, Status message</td>
<td>Message Archive</td>
</tr>
<tr>
<td>List of hidden messages</td>
<td>Hidden messages that have not exited</td>
<td>Alarm, Warning, Tolerance*, PLC process control message, Preventive maintenance, Process message, Operator prompt</td>
<td>Current messages</td>
</tr>
<tr>
<td>List of messages to be hidden</td>
<td>Hidden messages that have exited</td>
<td>Alarm, Warning, Tolerance*, PLC process control message, Preventive maintenance, Process message, Operator prompt</td>
<td>Current messages</td>
</tr>
</tbody>
</table>

* Configured by default for new projects as of WinCC V7.01. The option for acknowledgment response for the "Tolerance" message class is enabled in the OS project editor.
You can display the journal list, process alarms, and operation list again with the "Update" button and the "F5" key.

**Determine the selection of messages with user filters**

Using the "Set user filters" button, you can restrict the selection of messages in the message lists with one or more filters by check or unchecking the filters.

Use the "Disable all user filters" button to deactivate all active user filters with one click. The settings for each message list are reset to the PCS7 default.

**Note**

If messages come in and go out several times without having been acknowledged, the older messages are removed from the incoming alarm list. The journal list (archive) contains all messages.

The single-line message window in the overview window does not display messages of the classes "Operator prompt", "Tolerance", and "Operation message", as messages in these classes cannot be acknowledged. Otherwise, a message that cannot be acknowledged would eclipse all other messages, including those with higher priority, until it is changed to the "Went Out" status or a new message is received. Messages of message class "Tolerance" are shown in the single line message window, if the option "Message class Tolerance requires acknowledgement" is activated.

**See also**

How to Display Message Lists (Page 297)

**9.9.4 Message behavior**

**Introduction**

You can configure a different message behavior in the message window in runtime. Depending on the authorization held by a user, the user can either be restricted to viewing messages only, or may also be able to acknowledge messages.

- Message windows which allow acknowledgment display all messages which may be acknowledged by a currently logged in user who has the "Process controlling" authorization.
- Message windows which allow messages to be viewed display all messages which may be viewed but not acknowledged by a currently logged in user who has the "Authorization for area" authorization.

You can set the message behavior in the OS Project Editor. The properties of the message window can be set in the "Message filter" group of the "Message Display" tab.

In runtime, users who can view messages but not acknowledge them need message windows with two message lists. In one of these message lists the user with the "Process controlling"
authorization can acknowledge messages in the areas. In the other message list the user is able only to view messages in areas with the "Authorization for area" authorization. The message line in the Overview window shows only the messages which can be acknowledged.

The option "Acknowledgeable messages on separate page (switch-selectable)" enables a user to switch between the double window display and the message window which allows acknowledgment.

9.9.5 How to Display Message Lists

Procedure

- Click this button in button set 1.

The entered state list and a new button set will be displayed. If it is intended that separate lists of messages that can be acknowledged should be displayed, the appropriate buttons are displayed in the button set. The user displays the individual lists with the following buttons:

<table>
<thead>
<tr>
<th>Key</th>
<th>Message list</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Key Icon]</td>
<td>Incoming alarm list</td>
</tr>
<tr>
<td>![Green Check Icon]</td>
<td>Incoming alarm list, acknowledgeable</td>
</tr>
<tr>
<td>![Key Icon]</td>
<td>Acknowledged alarm list</td>
</tr>
<tr>
<td>![Green Check Icon]</td>
<td>Acknowledged alarm list, acknowledgeable</td>
</tr>
<tr>
<td>![Key Icon]</td>
<td>Outgoing alarm list</td>
</tr>
<tr>
<td>![Green Check Icon]</td>
<td>Outgoing alarm list, acknowledgeable</td>
</tr>
<tr>
<td>![Key Icon]</td>
<td>Process alarm list</td>
</tr>
</tbody>
</table>
### 9.9 Message system

<table>
<thead>
<tr>
<th>Key</th>
<th>Message list</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Operation list" /></td>
<td>Operation list</td>
</tr>
<tr>
<td><img src="image" alt="Journal list" /></td>
<td>Journal list</td>
</tr>
<tr>
<td><img src="image" alt="List of hidden messages" /></td>
<td>List of hidden messages</td>
</tr>
<tr>
<td><img src="image" alt="List of messages to be hidden" /></td>
<td>List of messages to be hidden</td>
</tr>
<tr>
<td><img src="image" alt="Previous graphics picture" /></td>
<td>Previous graphics picture. Exits the message system, opens the last displayed process picture and shows button set 1.</td>
</tr>
</tbody>
</table>

**Example:**

When the user has selected the "entered state list" function the following window, for example, is displayed:
Process control runtime
9.9 Message system

<table>
<thead>
<tr>
<th>Date</th>
<th>Time</th>
<th>Priorit</th>
<th>Source</th>
<th>Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>06/10/08</td>
<td>08:45:28.670</td>
<td>0</td>
<td>SIEMENSAG</td>
<td>Group display error at start up</td>
</tr>
</tbody>
</table>

MDM - WinCC/Options for Process Control

299
Content of the message line

The following table shows the meaning of the individual columns (message blocks) in a message line:

<table>
<thead>
<tr>
<th>Terminology</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>Date for Incoming, Outgoing, and Acknowledged.</td>
</tr>
<tr>
<td>Time</td>
<td>Every time the status of the message changes, the associated time element (time stamp of the status change) is displayed.</td>
</tr>
<tr>
<td>Priority</td>
<td>Displays the priority of the message.</td>
</tr>
<tr>
<td>Source</td>
<td>Technological assignment of the message source: Plant ID, consisting of the hierarchy, chart name and block name, input as placeholder. Location ID (LID) for driver components.</td>
</tr>
<tr>
<td>Event</td>
<td>Contains a user-definable message text for technological blocks. In the case of driver blocks, contains a message text with integrated associated values for line/rack/slot or error identifier/block number/relative address.</td>
</tr>
<tr>
<td>Message duration</td>
<td>Length of time a message was queued.</td>
</tr>
<tr>
<td>State</td>
<td>Status of the acknowledgment: C = Message activated, G = Message deactivated, QS = Message acknowledged, CG = Message activated/deactivated, QuitSystem = Message acknowledged by the system</td>
</tr>
<tr>
<td>Info</td>
<td>You can configure an information text for each message.</td>
</tr>
<tr>
<td>Comment</td>
<td>The operator can subsequently add a comment to any message.</td>
</tr>
<tr>
<td>Batch name</td>
<td>Contains the batch ID, batch name, and consecutive step number entered by means of associated values.</td>
</tr>
<tr>
<td>Area</td>
<td>Area ID</td>
</tr>
<tr>
<td>Loop in Alarm</td>
<td>When this check box is selected, Loop in Alarm is configured for this message.</td>
</tr>
<tr>
<td>Type</td>
<td>Message types, e.g., Alarm High or Tolerance High.</td>
</tr>
<tr>
<td>Operation</td>
<td>Operator message with logged on user who performed the operation, including the type of operation.</td>
</tr>
</tbody>
</table>

Operator input in the message lists

The following table shows how you can navigate in the message lists and edit individual messages:

<table>
<thead>
<tr>
<th>Function</th>
<th>Icon</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single acknowledgement</td>
<td><img src="image" alt="Single acknowledgement" /></td>
<td>Acknowledges an individual message</td>
</tr>
<tr>
<td>Group acknowledgement</td>
<td><img src="image" alt="Group acknowledgement" /></td>
<td>Acknowledges all visible messages in the message window that are queued and require acknowledgment, unless they require individual acknowledgment.</td>
</tr>
<tr>
<td>Long-term archive list</td>
<td><img src="image" alt="Long-term archive list" /></td>
<td>Shows the archived messages from the long-term archive list in the journal list.</td>
</tr>
<tr>
<td>Hit list</td>
<td><img src="image" alt="Hit list" /></td>
<td>Shows statistical information for the messages in additional columns in the journal list.</td>
</tr>
<tr>
<td>Function</td>
<td>Icon</td>
<td>Explanation</td>
</tr>
<tr>
<td>---------------------------</td>
<td>------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Set user filters</td>
<td><img src="image" alt="Icon" /></td>
<td>Opens a dialog box for selecting messages. Set one or more filters with selection criteria in the dialog. All messages that do not meet the criteria of the active filter are not displayed (but are archived).</td>
</tr>
<tr>
<td>Disable all user filters</td>
<td><img src="image" alt="Icon" /></td>
<td>Deactivates all active user filters and resets the settings for each message list to the PCS7 default.</td>
</tr>
<tr>
<td>Sort dialog</td>
<td><img src="image" alt="Icon" /></td>
<td>Opens a dialog box for customizing the sorting of displayed messages, for example, based on priority.</td>
</tr>
<tr>
<td>Printing</td>
<td><img src="image" alt="Icon" /></td>
<td>Creates a paper documentation.</td>
</tr>
<tr>
<td>First message</td>
<td><img src="image" alt="Icon" /></td>
<td>Shows the start of the list. The cursor moves to the first list element. You must first switch off the autoscroll.</td>
</tr>
<tr>
<td>Previous message</td>
<td><img src="image" alt="Icon" /></td>
<td>Cursor moves to the previous list element. You must first switch off the autoscroll.</td>
</tr>
<tr>
<td>Next message</td>
<td><img src="image" alt="Icon" /></td>
<td>Cursor moves to the next list element. You must first switch off the autoscroll.</td>
</tr>
<tr>
<td>Last message</td>
<td><img src="image" alt="Icon" /></td>
<td>Shows the end of the list. The cursor moves to the last list element. You must first switch off the autoscroll.</td>
</tr>
<tr>
<td>Info Text</td>
<td><img src="image" alt="Icon" /></td>
<td>Opens a window for displaying pre-configured, supplemental message texts.</td>
</tr>
<tr>
<td>Loop in Alarm</td>
<td><img src="image" alt="Icon" /></td>
<td>Shows a picture for the selected message or triggers a script.</td>
</tr>
<tr>
<td>Auto-Scroll On/Off</td>
<td><img src="image" alt="Icon" /></td>
<td>Activates or deactivates automatic scrolling for the latest message. If the function is not activated, you can scroll manually. This function is only available if the &quot;Latest message at bottom&quot; option was set in the &quot;Message display&quot; tab of OS Project Editor.</td>
</tr>
<tr>
<td>Refresh</td>
<td><img src="image" alt="Icon" /></td>
<td>Updates all messages in the process list, operation list and journal list. The messages are displayed again.</td>
</tr>
<tr>
<td>Comment</td>
<td><img src="image" alt="Icon" /></td>
<td>Opens a dialog where the user can retroactively enter a comment for a message in the process list, operation list and journal list.</td>
</tr>
<tr>
<td>Hide message</td>
<td><img src="image" alt="Icon" /></td>
<td>Hides the selected message from the message list and enters it in the list of hidden messages.</td>
</tr>
</tbody>
</table>

9.10 Trend system

9.10.1 Configuring, Saving and Loading Trend Groups

Introduction

The following rules apply to the configuration, saving and loading of trend groups:
Trend groups configured on a server in a "Multi-user project" are always stored locally on this computer. You can load these trend groups only on this computer.

Trends which were configured in online mode are not user-specific. Users are always offered all trend groups, including any trend groups created by other users.

On a WinCC client you can display tags configured on a server in trends WinCC Runtime. Prerequisite for configuring, saving and loading trend groups is that you have loaded the corresponding server packages.

You have two options of saving trend groups you configured for a "Client project" on a WinCC client.

1. Standard server configured for Split Screen Manager
   Configuration data of the trend groups are automatically saved to the standard server for Split Screen Manager which you configured in the "Standard Server" dialog box of the Server Data shortcut menu on the WinCC client. Other WinCC clients can also specify this server as the standard server for Split Screen Manager. The configured trend groups are also available to these WinCC clients. The trend groups created on the clients cannot be called from the server.
   The trend group data on a redundant server is automatically synchronized with the data on its redundancy partner. If the redundant standby station has assumed master mode the WinCC clients are still be able to load all configured trend groups.

2. No standard server configured for the Split Screen Manager
   The configured trends are saved locally on a WinCC client which does not contain a configured standard server for Split Screen Manager. Other WinCC clients cannot display these trend groups in WinCC Online Trend Control. Likewise, these trend groups cannot be displayed on the actual server and on its connected clients.

   **Note**
   If you are configuring online tags for "Trends Online" on a client with its own project, you may not use any local tags of the client if a default server has been configured for "SSM" under "Server data".

---

**See also**

"New Trend Group" Dialog Box (Page 305)
Configuring Online Trends (Runtime) (Page 302)

**9.10.2 Configuring Online Trends (Runtime)**

**Introduction**

The "Online Trends" dialog box can be used to select tags from Tag Management in WinCC Runtime and to visualize these in a WinCC Online Trend Control. A distinction is made between online tags and archive tags.
The functionality is only available at one PCS 7-OS. The "Trend online" button can only be accessed if a picture is open and originates from an area for which the logged on user has been assigned authorization level "2" (allowing selective access) or a general authorization.

History values cannot be displayed because online tags are not saved to the database. As long as it is open, the trend control will buffer the values itself for the duration of the time configured in WinCC Online Trend Control.

Archive tags, however, are saved to the database so that you can also page to older values using the function buttons in the curve control.

Note
The "Load/Configure Trend Groups" function is available in WinCC Runtime. The trend traces are not displayed in the Tag Logging application window. An archive of trend values is no longer created in Tag Logging.

See also
"New Trend Group" Dialog Box (Page 305)
Configuring, Saving and Loading Trend Groups (Page 301)

9.10.3 "Online Trends" dialog box
Prerequisite

Users require the "Authorization for area" authorization for the picture window in the working area to open the "Trend Online" dialog box. Click "Load/configure trend groups" in button set 1 WinCC Runtime to open the "Online Trends" dialog box:

This dialog box displays all last created trend groups, including their contents and the date/time of the last change.

Dialog Description

<table>
<thead>
<tr>
<th>Functionality</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show</td>
<td>Displays the selected trend group in WinCC Online Trend Control.</td>
</tr>
<tr>
<td>New</td>
<td>Opens the &quot;New Trend Groups&quot; dialog box. In this dialog box, you configure the settings for a new trend group.</td>
</tr>
<tr>
<td>Removing</td>
<td>Deletes the selected trend group. You can also delete several trend groups.</td>
</tr>
<tr>
<td>Rename</td>
<td>Opens the &quot;New Trend Group Name&quot; dialog box, in which you can enter a new name for the selected trend group. This button is only active if you have selected a trend group.</td>
</tr>
<tr>
<td>Save as</td>
<td>Creates a copy of the selected trend group.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Closes the dialog box without saving the changes.</td>
</tr>
</tbody>
</table>

See also

"New Trend Group" Dialog Box (Page 305)
Configuring Online Trends (Runtime) (Page 302)
Configuring, Saving and Loading Trend Groups (Page 301)
9.10.4 "New Trend Group" Dialog Box

Introduction

You open the "New Trend Group" dialog box by clicking "New..." in the "Online Trends" dialog box:

[Image of the "New Trend Group" dialog box]

Dialog Description

<table>
<thead>
<tr>
<th>Functionality</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of new trend group. Special characters and spaces are not allowed. The default setting of the input box is &quot;Unnamed&quot;.</td>
</tr>
<tr>
<td>Contents</td>
<td>Specifies whether archive tags or online tags are visualized as trends in WinCC Online Trend Control. Activate the required check box.</td>
</tr>
<tr>
<td>Template pictures</td>
<td>Displays the available template pictures. The two template pictures &quot;@TRG_Default.Pdl&quot; for WinCC Online Trend Control prior to WinCC V7.0 and &quot;@TRG_Standard.Pdl&quot; for the new WinCC OnlineTrendControl as of WinCC V7.0 are now available as standard. We recommend that you use one of these template picture in WinCC Runtime to visualize trends in WinCC Online Trend Control. To create a customized template picture, generate a copy of the product template pictures and then rename it. In order for this template picture to be identified as such its name must start with the &quot;@TRG_&quot; prefix. Perform this procedure on each server and client, as the template pictures are always saved locally. You can insert any of the objects provided in Graphics Designer into user-defined template pictures and interconnect these.</td>
</tr>
<tr>
<td>Create</td>
<td>Closes the &quot;New Trend Group&quot; dialog box and opens the &quot;Properties of WinCC Online&quot; dialog box.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Closes this dialog box without saving the changes.</td>
</tr>
</tbody>
</table>
9.10 Trend system

Note

If you want to use template pictures from WinCC v5.1 in WinCC v6.x, you must perform the following steps:

1. Open the old template picture in Graphics Designer.
2. Open the "@TRG_Default.Pdl" template picture as well.
3. Delete the trend control from the old template picture.
4. Copy the trend control in the "@TRG_Default.Pdl" template picture and paste it into the old template picture.
5. Save the old template picture.

See also

Configuring Online Trends (Runtime) (Page 302)
Configuring, Saving and Loading Trend Groups (Page 301)

9.10.5 "Properties of WinCC Online Trend Control" dialog box

Introduction

The "Properties of WinCC Online Trend Control" dialog box is used to assign either an archive tag or an online tag to each trend. The system saves all settings made in the configuration dialog box.

The dialog box contains no entries when opened the first time. Click "+" to display the "Trend1" entry in the "Trends" list. Define the data source for the selected trend in the "Archive/tag selection" box. Click the "Selection" button to select the required tag.
Click "Help" to view additional information on configuration options in WinCC Online Trend Control.

See also

Configuring Online Trends (Runtime) (Page 302)
"New Trend Group" Dialog Box (Page 305)
Configuring, Saving and Loading Trend Groups (Page 301)
9.11 Group display

9.11.1 Group display

Introduction

Group displays are used to visualize process states (message states) in compressed graphical format. There are 16 different message types. The group display object is triggered by a tag which represents the message status. You can use this tag to display the group display states in the other WinCC components. Other types of dynamizing are not possible.

The response of the group display can be freely configured using the object properties. This allows you to assign individual buttons to message types and configure texts, colors, flashing and acknowledgment display of the buttons.

The effect of the group display default setting is described below.

Displaying process, process control system and operating displays

The group display object is visualized in the area overview, the Picture Tree Navigator, the faceplate and by group displays in the process picture. The display varies with the global design setting.

The group displays in the area overview and in the picture tree navigator are always only related to the system area (picture tree) in which it is displayed.

- General Display in the overview area and the Picture Tree Navigator.

- Differentiated display in the process picture:

- Display in the PCS7 faceplate:

<table>
<thead>
<tr>
<th>Process displays</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>A Alarm</td>
<td>white on red</td>
<td>flashing = activated</td>
</tr>
<tr>
<td></td>
<td></td>
<td>quiet = acknowledged</td>
</tr>
<tr>
<td>W Warning</td>
<td>black on yellow</td>
<td>flashing = activated</td>
</tr>
<tr>
<td></td>
<td></td>
<td>quiet = acknowledged</td>
</tr>
<tr>
<td>T Tolerance *</td>
<td>white on blue</td>
<td>quiet (no acknowledgment required)</td>
</tr>
</tbody>
</table>
Configured by default for new projects as of WinCC V7.01. The option for acknowledgment response for the "Tolerance" message class is enabled in the OS project editor.

### Process alarm display

<table>
<thead>
<tr>
<th>Message Type</th>
<th>Display Color</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>S Fault</td>
<td>yellow on black</td>
<td>flashing = activated, quiet = acknowledged</td>
</tr>
<tr>
<td>F Error</td>
<td>yellow on black</td>
<td>flashing = activated, quiet = acknowledged</td>
</tr>
<tr>
<td>MR maintenance request (Maintenance request)</td>
<td>yellow on black</td>
<td>flashing = activated, quiet = acknowledged</td>
</tr>
</tbody>
</table>

### Operator displays

<table>
<thead>
<tr>
<th>Message Type</th>
<th>Display Color</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>OR Operator prompt</td>
<td>white on dark magenta</td>
<td>quiet (no acknowledgment required)</td>
</tr>
</tbody>
</table>

### Disable displays

<table>
<thead>
<tr>
<th>Message Type</th>
<th>Display Color</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>X Measuring point locked</td>
<td>white on gray</td>
<td>quiet</td>
</tr>
</tbody>
</table>

### Priorities of message types

Three of the five buttons of the group display object are assigned several functions. The status with the highest priority is displayed if various states are active simultaneously at a button due to the value of its linked tags. The table below defines the corresponding rules.

It contains all default message types and the priorities of multiple functions (top to bottom in descending order).
### Message type

<table>
<thead>
<tr>
<th>Message type</th>
<th>View</th>
<th>Priority</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm High</td>
<td>All, AL</td>
<td>&quot;High&quot; overrides &quot;Low&quot;, however &quot;not acknowledged&quot; always overrides &quot;acknowledged&quot;</td>
</tr>
<tr>
<td>Alarm Low</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Warning Low</td>
<td></td>
<td>2. &quot;Warning High&quot; overrides &quot;Warning Low&quot;, however, &quot;not acknowledged&quot; always overrides &quot;acknowledged&quot;.</td>
</tr>
<tr>
<td>Tolerance High</td>
<td>TH, TL</td>
<td>3a. For interconnection with process values: &quot;Tolerance High&quot; overrides &quot;Tolerance Low&quot;, however, &quot;not acknowledged&quot; always overrides &quot;acknowledged&quot;.</td>
</tr>
<tr>
<td>Tolerance Low</td>
<td></td>
<td>3b. For interconnection with nested pictures: &quot;Tolerance High&quot; overrides &quot;Tolerance Low&quot;, regardless of the acknowledgment state. For more information, refer to the section &quot;Influencing acknowledging response via @EventQuit tag&quot;</td>
</tr>
<tr>
<td>AS Control System Fault</td>
<td>S, F, MR</td>
<td>&quot;AS Control System Fault&quot; overrides &quot;AS process control error&quot;, which in turn overrides &quot;Maintenance request&quot;, however &quot;not acknowledged&quot; overrides &quot;acknowledged&quot;.</td>
</tr>
<tr>
<td>AS process control error</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maintenance request</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operator prompt</td>
<td>OR</td>
<td>No multiple function assignment</td>
</tr>
<tr>
<td>Measuring point locked</td>
<td></td>
<td>No multiple function assignment</td>
</tr>
<tr>
<td></td>
<td>X</td>
<td>Response similar to V6.0 if the &quot;Display disabled state&quot; property is activated.</td>
</tr>
</tbody>
</table>
Notes on the group display

Note the following when using a group display:

- The group displays in the area overview are derived by means of a logical OR from the sum of all group displays that belong to the pictures associated with the area.

- In the PCS 7 Context, the assignment of the module-related error messages to the corresponding message types of the group display are stipulated and cannot be amended.

- "Alarm", "Warning" and process control message require acknowledgment. The messages based on these displays in the PCS 7 context also trigger a configured signal generator. With new projects as of WinCC V7.01, you can configure messages of the "Tolerance" message class to require acknowledgement by default. The option is enabled in the OS project editor.

Note

It takes around 50 seconds from the time Runtime is activated until the group display is updated in the area overview.

Note

With WinCC V6.0 SP3 (PCS7 V6.1), the "S" for "OS Process Control Message" is replaced by "M" or "MR" for "Maintenance request." For projects migrated to WinCC V6.0 SP3 (PCS7 V6.1), group displays in process pictures continue to show "S" for "OS process control message". The new "M" for "Maintenance request" is displayed in the area overview and in the Picture Tree Navigator. The new group displays inserted in process pictures based on WinCC V6.0 SP3 (PCS7 V6.1) have the same default setting as before the migration.

See also

How to display the alarm source via the group display (Page 311)
Influencing the Acknowledgement Behavior via the @EventQuit Tag (Page 314)

9.11.2 How to display the alarm source via the group display

Alarm Source

Alarm events are displayed in a field of the group display. The operator can view the picture in which the alarm has occurred.

Procedure

How to call the picture with the alarm source:
1. Click on the button for the group display that is showing an alarm whose source you wish to view. The picture is displayed with the alarm source. If it is not possible to uniquely identify this picture because the same event is queued in several sources, the first picture in the search results is displayed. The affected measurement point is highlighted, for example:

![Group display example]

2. Right-click the group display button to open a message which indicates the picture from which a message originated.

**Note**

If there is no connection to a WinCC tag, or the configuration is faulty, the buttons of a group display object appear dark gray in a picture and cannot be operated.

These buttons if in "pressed" state are visualized in light gray color in the group displays of the overview area.

---

**Hierarchy of the Group Displays**

The group display usually consists of several individual displays associated with an area or subarea. This generates a kind of hierarchy for group displays. When bringing up the alarm source, the picture shown will always be the one of the lowest level that still permits an association with a particular alarm.

The OS Project Editor supports you in configuring the group display hierarchy. By selecting the "Create / update group displays" check box in the "Message Display" tab, the group displays in the area overview are automatically integrated in the picture hierarchy. You can also interconnect the group display objects independent of the picture tree.

The figure below shows a possible hierarchy of the group messages.
Explanation of the shown group display hierarchy

The figure shows how the alarm source for a warning is displayed by clicking on the group display.

A warning is shown for Area 8. We examine the warning for Area 8.1.

The warning originates in Areas 8.1.1.1 and 8.1.1.2

Select the warning by clicking in area 8.

The alarm source in Area 8.1.1 is displayed.

Reason: It is impossible in area 8.1.1 to determine to which of the sublevel areas the warning belongs.

If for instance there is no warning in Area 8.1.1.2, the picture for Area 8.1.1.1 will be displayed.
9.11.3 Influencing the Acknowledgement Behavior via the @EventQuit Tag

Overview

The events "ToleranceLow", "ToleranceHigh", "Operator prompt" and "Measuring point disable" are not acknowledgeable events in the PCS 7 environment. Using the "@EventQuit" tag and the "Acknowledgment mask" attribute in the group display in Runtime, these events are automatically indicated as acknowledged to prevent flashing during the calculation of the group displays and the display of the area overview. The start value of the attribute is 0x00000011 (17) by default. The value of the "Acknowledgment mask" attribute should be identical for all group display objects, extended analog display and extended status display, and for the "@EventQuit" tag.

The "@EventQuit" tag is created directly by Basic Process Control as a signed 32-bit value under "Internal tags."

You can set the acknowledgment response for "Tolerance" in the OS Project Editor.

You can set further acknowledge tags to ensure that other events are also automatically identified as acknowledged when group displays are being calculated.

When group acknowledgment is carried out via the "Group Acknowledgment" button, all acknowledgement bits for the measurement points in the picture concerned that require acknowledgment are set to 65535.

For technical reasons it is necessary to delete all the status bits of the measurement points requiring acknowledgment for the group acknowledgment.

If you do not want the status bits to be deleted following acknowledgment, the bits in the status word (most significant word) of the "@EventQuit" tag must be set (0xFFFF). When combined with the acknowledgment bits (least significant word) this gives the start value 0xFFFF0C11, which means -62447 for a signed 32-bit value or 4294904849 for an unsigned 32-bit value.

In projects prior to WinCC V7.01, the events "ToleranceLow", "ToleranceHigh", "Operator prompt" and "Measuring point disable" are not acknowledgeable events in the PCS 7 environment. By default, the tag has the start value 0x00000C11 (3089). These are precisely the acknowledgment bits for "ToleranceLow", "ToleranceHigh", "Operator prompt" and "Measuring point disabled."

See also

Group display (Page 308)
How to display the alarm source via the group display (Page 311)
9.12 Process Controlling, Graphic Pictures

9.12.1 Process Controlling, Graphic Pictures

**Introduction**

With the configured graphic system, you can control and monitor process events during process control. Process control takes place in the working area. The graphics system has the following tasks:

- Displaying the plant in a plant overview
- Displaying process pictures in the working area
- Operating the process and system
- Displaying the status of alarms
Graphic Pictures

Graphic pictures are freely configured pictures which in general display plant or plant components, and enable process actions and events to be operated. Graphic pictures are displayed in the working area.

Elements in Graphic Pictures

Graphic pictures consist of static and dynamic elements:

- **Static picture elements** do not change in representation.
- **Dynamic picture elements** display process tags or statuses and their change during the process. This includes the following picture elements:
- Numeric values
- Bar graph
- 3D bar graph
- Output and input texts
- Status displays
- Status and analog displays

**Dynamic picture elements**

Depending on the configuration, both the static and the dynamic elements may allow user interactions.

<table>
<thead>
<tr>
<th>Process values</th>
<th>Meaning</th>
</tr>
</thead>
</table>
| **Digital Value** | Numeric values from the process are displayed in the form of numeric output. A unit can be displayed next to the numeric value. Numeric input is used for setting setpoint values or other parameters. Numeric values may be distinguished according to their display format:  
  - Integer (whole numbers with 2 to 9 places)  
  - Fixed point numbers (fixed position of the decimal point, preceded by between 2 and 9 digits and followed by 0 to 5 digits)  
  - Floating point numbers (variable position of the decimal point depending on the value, preceded by 2 to 8 digits and followed by 1 to 7 digits)  
  - Exponential number  
  Such things as limit value violations can be displayed by changing the background color or pattern.  
  Example: |
| **Bar graph** | Bar graphs display process values in analog form. The current value is visualized on a scaleable bar. The object properties of the bar are user-definable. Limit value violations can be displayed by changing the color.  
  Example: |
### Process values

<table>
<thead>
<tr>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>3D bar graph</strong></td>
</tr>
<tr>
<td><strong>Input Text</strong></td>
</tr>
<tr>
<td><strong>Output text</strong></td>
</tr>
<tr>
<td><strong>Trends</strong></td>
</tr>
<tr>
<td><strong>Status display</strong></td>
</tr>
<tr>
<td><strong>Extended Status Display</strong></td>
</tr>
<tr>
<td><strong>Extended Analog Display</strong></td>
</tr>
</tbody>
</table>

### 9.12.2 How to Select a Picture via a Measurement Point

**Introduction**

In a PCS 7 OS, you can also change a picture via the measurement point.

The tag selected in the measurement point list represents a measurement point that is displayed highlighted in the selected display format.
Prerequisite

Appropriate area authorizations must be assigned in the User Administrator to the logged on user. This function is only available in a PCS 7 OS.

Procedure

Click "Picture via measurement point" in runtime in button set 1. The "Picture selection via measurement point" dialog box opens. Any block comment of the measuring point is also displayed in the table beside the measuring point. The block comment is also displayed in the window bar of the picture component, which can be opened by clicking the block icon. The comment originates from the "#comment" block structure/tags and is configured at the block in CFC.
### Dialog Description

<table>
<thead>
<tr>
<th>Functionality</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer</td>
<td>This drop down list box is only active if the dialog box is opened from within a WinCC client project. In addition, you must have downloaded the package from the selected server to the WinCC client.</td>
</tr>
<tr>
<td>Measuring point</td>
<td>Select the measuring points to be displayed from this drop-down list box. &quot;&lt;All&gt;&quot; is displayed by default.</td>
</tr>
<tr>
<td>including</td>
<td>In the filter function, you can enter a filter criterion. Then only the measurement points that comply with the filter criterion are displayed.</td>
</tr>
<tr>
<td>excluding</td>
<td>You can use the negative filter to exclude measurement points from the display. The list displays only measurement points that comply with the filter criterion and that do NOT comply with the negative filter criterion. If you enter e.g. &quot;<em>&quot; in the &quot;including&quot; field and &quot;b</em>&quot; in the &quot;excluding&quot; field, all measurement points that do not begin with a &quot;b&quot; are displayed.</td>
</tr>
<tr>
<td>Load</td>
<td>Loads the current filter.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves the current filter.</td>
</tr>
<tr>
<td>Representation</td>
<td>The &quot;Display mode&quot; group provides five display modes for the measurement points to be displayed. The default setting is &quot;Process picture in working area&quot;.</td>
</tr>
<tr>
<td></td>
<td>• Process picture in working area</td>
</tr>
<tr>
<td></td>
<td>• Process picture as window</td>
</tr>
<tr>
<td></td>
<td>• Loop display in working area</td>
</tr>
<tr>
<td></td>
<td>• Loop display as window</td>
</tr>
<tr>
<td></td>
<td>• Group display</td>
</tr>
</tbody>
</table>

**Note**

Measurement points for which the area is unknown do not possess any operator authorization.

If the measurement point selection fails, check in the Component List Editor to determine whether the measuring point has been assigned an area. If necessary, specify the area for which the user has authorization.

If no entry point picture is configured, the picture component for which the measurement point was configured is displayed. The default setting of the display mode is then "Loop display in working area". In this case, the first two display mode options cannot be selected.

### 9.12.3 How to Select a Picture via the Name

**Introduction**

From a list of all graphic pictures that belong to the current project and are stored in the project folder, pictures can be selected and displayed in the working area or in a process window. During the selection, a check will determine whether the area authorizations assigned in the User Administrator are present.
Procedure

Click "Picture via name" in runtime in button set 1. The "Picture Selection by Name" dialog box opens. If you created a plant hierarchy in Picture Tree Manager and assigned pictures to the containers, the table displays the picture names and the associated picture hierarchy.
Dialog Description

<table>
<thead>
<tr>
<th>Functionality</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer</td>
<td>This drop down list box is only active if the dialog box is opened from within a WinCC client project. In addition, you must have downloaded the package from the selected server to the WinCC client.</td>
</tr>
<tr>
<td>including</td>
<td>In the filter function, you can enter a filter criterion. Only the pictures satisfying the filter criterion will then be displayed.</td>
</tr>
<tr>
<td>excluding</td>
<td>You can use the negative filter to exclude pictures from the display. The list displays only pictures that comply with the filter criterion and that do NOT comply with the negative filter criterion. If you enter e.g. &quot;<em><strong>&quot; in the &quot;including&quot; field and &quot;b</strong></em>&quot; in the &quot;excluding&quot; field, all pictures that do not begin with a &quot;b&quot; are displayed.</td>
</tr>
<tr>
<td>Load</td>
<td>Loads the current filter.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves the current filter.</td>
</tr>
<tr>
<td>Representation</td>
<td>The &quot;Display mode&quot; group provides two display modes for the picture to be displayed. Display in the working area Display in the process window</td>
</tr>
<tr>
<td>Preview</td>
<td>If the &quot;Display&quot; check-box is activated, the picture to be displayed is shown in the preview window.</td>
</tr>
</tbody>
</table>

9.12.4 Navigation through the picture hierarchy

Selecting a Subsection

If a selected section has further subsections, you can select them via the buttons shown above. Highlighted arrows indicate that additional subsections can be accessed.

Navigating through the Picture Hierarchy

A section and its subsections exhibit the structure that you have selected. You can navigate through this plant hierarchy.

The following picture uses the plant hierarchy shown to show how the user moves around in the plant hierarchy in runtime:
Changes from one area level or subsection to another subsection level, e.g., from subsection level 1 to subsection level 2.

Changes within a subsection level to the pictures contained within this subsection level, e.g. in subsection level 1, from picture 1 to picture 2 and back.
9.12.5 Selecting Graphic Pictures Directly

Selection options

There are various ways in which you can select graphic pictures directly.

Selecting graphic pictures via the picture stack

The Split Screen Manager logs every picture change in the working area. This enables you to select pictures that have been displayed previously.

In each working area in the basic picture there is a dedicated picture stack which stores the last eight picture names selected in each working area.

You use the following button to select the picture that is stored in the picture stack in front of the current process picture:

You use the following button to select the picture that is stored in the picture stack after the current process picture:

Note

The authorizations for the pictures in the picture memory and picture stack are user-specific. Consequently, the picture memory and picture stack of all displays are deleted in their entirety every time the WinCC user changes.

Selecting graphic pictures from the picture memory

The picture memory is used as a simple way to store a picture from the working area.

The picture in the picture memory can be called at any time (also multiple times).

When you save a new picture, the original picture in the picture memory is overwritten.

A separate picture memory is kept for each working area of the basic picture.

- Click the adjacent button to save the picture in the picture memory.

- Click the adjacent button to display the picture in the picture memory. You can be in any plant view.
Note
The authorizations for the pictures in the picture memory are user-specific.
The complete picture memory of all screens is deleted each time there is a user change in WinCC.

9.12.6 Operator Activity in Graphic Pictures

Overview

When the cursor takes on the form shown here, you can operate an object, for example, you can enter values.

The following types of operations exist:

- **System operator input**, which change the display in the graphic window. They have no effect on the process. They affect only the OS and permit the handling of pictures and dialog boxes. System operations include selecting further pictures/dialog boxes and repositioning pictures in their window.

- **Operator process controls**, which affect the sublevel control. They adjust values such as setpoints or valve positions in the automation system.
10 Resources

10.1 Chip card reader

Content

The "Chip Card Reader" option serves to integrate a chip card reader into the WinCC environment. If the "Chip card Reader" option is installed, WinCC User Administrator supports the chip card readers named in chapter "General information on the chip card reader." This option must not be confused with the "SIMATIC login."

This documentation shows you the following:
- An overview of chip card readers that can be used
- How to set the interface
- How to write to a chip card
- How to check a chip card

10.2 General Information About the Chip Card Reader

Introduction

The smart card reader is an external device for reading and writing to smart cards. You connect the smart card reader to a serial COM1 interface or USB. Do not confuse this WinCC option with the SIMATIC Logon.

The following provides a description of smart card readers that can be used.

CardMan Desktop serial 3111 by Omnikey

The serial smart card reader "CardMan Desktop serial 3111" replaces serial smart card readers "B1 CardMan 9010" and "B1 CardMan 9011." "CardMan Desktop serial 3111" has two LEDs, only one of which is currently used. The LED turns a solid green when the smart card reader is correctly detected and the driver for the smart card reader is started. The LED begins to flash green/red when communication with an inserted smart card begins.

The "CardMan Desktop 3111" smart card reader is installed manually. Proceed as follows:
1. Connect the smart card reader when the PC is switched off. The power supply runs via the PS2 port. The plug is connected between the computer and the keyboard.

2. Check the COM1 interface setting in the Windows device manager. More information is provided in chapter "How to set up the interface."

3. Save the necessary files on your PC by downloading them from http://omnikey.aaitg.com/index.php?id=69&L=1:
   - CardMan3111_V1_1_2_1.exe (CardMan 3111 PC/SC Windows)
   - CT-API_V4_0_2_2.exe (CT-API for Windows)

4. Double-click on the saved "CardMan3111_V1_1_2_1.exe." Follow the setup and extract the driver software to the "C:\Omnikey" directory.

5. Double-click on the saved "CT-API_V4_0_2_2.exe." Follow the setup and extract the CT-API to the "C:\Omnikey" directory.

6. To install the driver, start the Windows Hardware Assistant. Go to "C:\Omnikey\CardMan3111 PCSC driver V1.1.2.1" for the source of the driver installation. Optionally, open the device manager under Windows VISTA and update the driver by right-clicking the "Smart card reader" icon. Follow the on-screen instructions. Go to "C:\Omnikey\CardMan3111 PCSC driver V1.1.2.1" for the source of the driver installation.

7. Open the "C:\Omnikey\CT-API_V4_0_2_2" directory to install the API with Windows Explorer. To begin, double-click on "SETUP.EXE." Follow the setup and install the API to the suggested directory.

8. Restart the computer.

9. Open the "WinCC Chipcard Terminal" dialog via the Windows Control Panel. Activate the connection via port 1 or port 45. The "Use existing smart card reader" check box must be cleared for this.

The "CardMan Desktop 3111" smart card reader is now ready to use. Insert the cards into the smart card reader so that the chip is facing the LED.

After the reinstallation, the previously used models "B1 CardMan 9010" and "B1 CardMan 9011" can still be used. Open the "WinCC Chipcard Terminal" dialog box via the Windows Control Panel. First activate the function "Use existing smart card reader (not Plug&Play)". Then select the connection via COM1. The previously used smart card readers are now ready for use.

CardMan Desktop USB 3121 by Omnikey

The smart card reader "CardMan Desktop USB 3121" is functionally identical with the model "CardMan Desktop serial 3111", but is equipped with a USB connection.

The "CardMan Desktop USB 3121" smart card reader is installed manually. Proceed as follows:
1. Connect the smart card reader to a free USB port of the computer. Depending on the operating system, a universal driver for smart card readers is automatically installed by Microsoft. Ignore this installation.

2. Save the necessary files on your PC by downloading them from http://omnikey.aaitg.com/index.php?id=69&L=1:
   - CardMan3x21_V1_1_2_4.exe (CardMan 3x21 PC/SC)
   - CT-API_V4_0_2_2.exe (CT-API for Windows)

3. Double-click on the saved "CardMan3x21_V1_1_2_4.exe". Follow the setup and extract the driver software to the "C:\Omniikey" directory.

4. Double-click on the saved "CT-API_V4_0_2_2.exe." Follow the setup and extract the CT-API to the "C:\Omniikey" directory.

5. If a Microsoft driver is already installed, you have to update this driver with the Omnikey driver. Open the device manager. Update the corresponding driver by right-clicking on the "CardMan 3x21" or "USB Smart Card reader" icon. Follow the on-screen instructions. Go to "C:\Omniikey\CardMan3x21 PCSC driver V1.1.2.4" for the source of the driver installation.
   If no Microsoft driver is installed, start the Windows Hardware Wizard. Go to "C:\Omniikey\CardMan3x21 PCSC driver V1.1.2.4" for the source of the driver installation.

6. Open the "C:\Omniikey\CT-API_V4_0_2_2" directory to install the API with Windows Explorer. To begin, double-click on "SETUP.EXE." Follow the setup and install the API to the suggested directory.

7. Restart the computer.

8. Open the "WinCC Chipcard Terminal" dialog via the Windows Control Panel. Activate the connection via port 1 or port 80. The "Use existing smart card reader" check box must be cleared for this.

The "CardMan Desktop USB 3121" smart card reader is now ready to use. Insert the cards into the smart card reader so that the chip is facing the LED.

After the reinstallation, the previously used models "B1 CardMan 9010" and "B1 CardMan 9011" can still be used. Open the "WinCC Chipcard Terminal" dialog box via the Windows Control Panel. First activate the function "Use existing smart card reader (not Plug&Play)". Then select the connection via COM1. The previously used smart card readers are now ready for use.

B1 CardMan 9010/9011 by Omnikey

The "B1 CardMan 9010/9011" smart card readers are discontinued old devices that can be used. After the installation of WinCC they can used as before. They have a LED which alternately remains dark, is lit green or flashes red.

The "dark" state indicates the following:
- No power supply
- Reset mode
- Self test. The self test only lasts a few seconds.

The "green" state indicates the following:
10.2 General Information About the Chip Card Reader

- A successful self test
- Smart card reader is ready
- Card is not inserted or is not recognized

The "red (flashing)" state indicates the following:
- Self test not successful, smart card reader defect, exchange device

Related information about the smart card reader "B1 CardMan 9010/9011" is available at "www.omnikey.com".

Table-top unit "ifc B1" by Siemens Nixdorf
The "ifc B1" smart card reader is a discontinued device that can be used.

Table-top unit "CT B1 Snuggle" by Smart Solutions
The smart card reader "CT B1 Snuggle" is a discontinued device that can be used. The "CT B1 Snuggle" has an LED which is lit alternately green or orange. If the LED is green, no smart card is inserted or the reader does not recognize the card.

Smart card and software
The software of the card reader types is compatible. Each smart card reader can read smart cards that were written on a different type. The smart card readers read and write to smart cards with the operating systems TCOS 1.2 and TCOS 2.0.

You insert the smart cards into the card reader in such a way that the memory chip is on the same side as the respective company logo.

Warning
The smart card readers have different power supplies. While the old ifc B1 smart card reader is operated from an external plug-in power supply unit, the CT B1 Snuggle and the Card Man obtain their power supply directly from the PC via the PS2 port. To this end, you need to disconnect the keyboard and interpose the female connector.

The smart card reader with PS2 port cannot be replaced or re-started while the system is running. You must switch off the PC using the power switch. If you disconnect the PS2 plug while the computer is running, the operating system will crash.

Note
You must make the hardware connections between the smart card reader and the computer before the computer starts up.
Smart card and redundancy

The smart card is configured separately for each computer. You configure each computer separately. When you use the project duplicator, the settings are not copied.

Note

During plant configuration, make sure that the following applications are assigned to the COM interfaces of the computer:

- WinCC redundancy/redundant batch server
- Time receiver (DCF77/GPS)
- Smart card reader

Since a computer generally has only one COM interface, you cannot use all applications simultaneously.

See also

"Chip Card" Option in User Administrator (Page 334)

10.3 How to set the interface

Requirements

The following requirements apply if you want to use WinCC with a chipcard:

- The "Chipcard" option is installed
- An interface ("COM1" or "COM2", for example) is assigned to the chipcard reader.
Procedure

To activate the menu in User Administrator, perform the following steps after you have installed the WinCC "Chipcard" option:

1. Double-click the "WinCC Chipcard Terminal" icon on the Control Panel of the operating system. You need Windows administrator rights for the "WinCC Chipcard Terminal Configuration" dialog.

2. In the open "WinCC Chipcard Terminal Configuration" dialog box, select the "Terminal active" check box.

3. From the "Connection" drop-down list box, select the required interface and click "OK". Your input will be accepted.

When you then open the User Administrator, the "Chipcard" menu will appear.

If you select the "Terminal disabled" check box in the "WinCC Chipcard Terminal Configuration" dialog box on the Control Panel, the "Chipcard" menu is hidden when you restart the User Administrator.

You do not need administrator rights to operate WinCC, write to chip cards, or use the chip cards in runtime.

If the "COM" interface does not work, check its settings against the following settings.
Note

The "Chipcard" menu is disabled in runtime mode because the functions can only be used in the configuration system.
10.4 Chip Card in User Administrator

10.4.1 "Chip Card" Option in User Administrator

Introduction

If you install WinCC with the options, the User Administrator functionality is extended. For example, the "Basic Process Control" option changes the number of displayed authorizations in the table window.

The "Chip card" option inserts the "Chip card" menu with the associated menu commands. The "Login only with chip card" check box can be selected. This setting is user-specific.

See also

General Information About the Chip Card Reader (Page 327)
"Chip Card" menu extension (Page 335)
10.4.2 "Chip Card" menu extension

10.4.2.1 "Chip Card" menu extension

Introduction

The User Administrator provides functions for controlling a chip card read/write device. In the configuration system you use these functions to write to chip cards and to check them.

See also

How to write to a chip card (Page 335)
How to check a chip card (Page 336)
How to set the interface (Page 331)

10.4.2.2 How to write to a chip card

Introduction

When you write to a chipcard, all data on the card are deleted. The user name and the password are stored on the card.

![Write to Chip Card](image)

Procedure

1. Select the menu command "Chipcard > Write to chipcard ".
2. From the list, select the user for whom the chipcard was created.
3. If an additional password has to be entered manually during login during runtime, select the corresponding check box.
4. Insert the chipcard into the read/write device.
5. Click "Write to Chip Card". User Administrator transfers the data to the chipcard.
6. Close the dialog box.

**Note**
This menu command can only be selected if the "Chipcard" option is installed.

### 10.4.2.3 How to check a chip card

**Introduction**

If you want to check whether the data were entered correctly, read the chipcard out again.

![Check Chip Card](CheckChipCard.png)

**Procedure**

1. Select the menu command "Chipcard > Check chipcard ".
2. Insert the chipcard into the read/write device.
3. Select the "Read card" switch.

User Administrator reads out the card data. The login name of the card that was read is displayed in the "User" dialog box. If the login name already exists in User Administrator, the "Card is valid" message will appear. If the login name does not exist, the "Card is invalid" message is displayed.

If there is an error when the chipcard is read, this error is noted in this dialog box, and no user name is specified.

**Note**
This menu command can only be activated if the "Chipcard" option is installed.
10.4.3 Chip card reader in runtime

Introduction

To log on to the operator control and monitoring system, insert your chipcard in the chipcard reader. The required data are read out. When a card is inserted in the chipcard reader, it is not possible to log on to the system manually. You will remain logged on to the system until you remove the card from the chipcard reader. When you use the chipcard, the "Automatic logout" function is disabled.

If when you are reading or writing to a chipcard a message appears on the screen telling you that the "card is inserted incorrectly or is defective", proceed as follows:

1. Remove the chipcard.
2. Close the dialog box with the message.
3. Slowly reinsert the chipcard into the chipcard reader.

Always make sure to insert or withdraw the chipcard smoothly.

Note

This menu command can only be activated if the "Chipcard" option was installed.

In runtime, the "Chip Card" menu is disabled, since the functions can only be used in the configuration system.
Index

3
3D bar graph, 315

A
Accept
Faceplate, 78
Access point, 159, 162
Access rights, 289
Acknowledge, 280
Group acknowledgment, 280
Message, 292
Signaling devices, 280
Acknowledge button, 271
Acknowledged alarm list, 294
Acknowledged messages, 61
Acknowledgement response, 314
Action, 78
Activate
Runtime, 265
Activating a faceplate, 78
Activating runtime, 265
Active master, 153, 174
Adapting
Message line, 62
Overview window, 51
Alarm, 52, 292, 311
Alarm logging, 292
Alarm Logging, 232
Defining the area name, 232
Alarm Source
Display via Group Display, 311
Alarm window, 62
Alarms
Disable, 290
Enable, 290
Selection criteria in RT, 294
Analog display
Extended, 31
Archive tag, 302
Area, 64, 69
Hide, 69
Area buttons, 49, 64, 285
Area preview, 49, 64
Areas tab, 64
Area-specific filtering, 58

Arrange
Empty button, 69
Picture Icons Alphabetically, 208
Picture Icons Automatically, 209
Audio alarm, 23
Authentication, 58
Authorization, 324

B
Bar graph, 315
Basic data, 78, 259
Basic data tab, 78
Basic picture, 95, 96, 324
Batch flexible, 282
Batch Visualization, 282
BCE, 162
Beenden
Runtime, 280
Benutzer, 289
Benutzerverwaltung, 289
Blank pictures, 218
Button Area, 274
Button functions
In Runtime, 265

C
Call
Online Help, 210
Change
Container name, 223
Hierarchy, 224
Name, 223
Change by means of drag-and-drop
Hierarchy, 225
Change using the menu bar
Hierarchy, 226
Change using the shortcut menu
Hierarchy, 225
Changes
Download, 11
Changes in Picture Tree Manager, 193
Check
Authorization, 20
Chipcard, 336
Index

Chip card
  Login in Runtime, 278
  Menu extensions, 335
  Option, 334
Chipcard
  check, 336
  Operation in runtime, 337
  write to, 335
Client, 196
Color of the area buttons, 285
Colored display, 274
Component list
  Generating, 249
Component List Editor, 24, 247
Component List Editor documentation
  Content, 43, 247
Computer, 261
  Computer list, 261
  Name, 261
Configuration
  in the PCS 7 environment, 12
  Server, 14
  WinCC Client, 14
Configuration file, 240, 242
Create, 86
Configuring
  Loop in Alarm, 256
  Overview window, 49
  Synchronization via Local Area Network, 165
  Synchronization via system bus/BCE, 162
  Synchronization via system bus/Industrial Ethernet bus, 159
  Trend groups, 301
Configuring in the PCS 7 environment
  Behavior with a Faulty Server, 15
  Example configuration, 16
  Message configuration, 15
  Picture configuration, 15
  User authorization, 15
Confirm
  Delete hierarchy, 209
  For replacing pictures, 209
Container, 218
Copy, 202
Cut, 202
Delete, 207, 226
Insert, 215
Insert after container, 204
Insert before container, 205
Insert into container, 205
Insert new, 206
Renaming, 223
Container name, 200
Content
  Component List Editor documentation, 247
  Documentation, 11, 193
  OS Project Editor documentation, 43
Content of the picture stack
  Display, 282
Copy
  Container, 202
CP1613, 159
CP1623, 159
Create
  Configuration file, 86
  Hierarchy, 220
  New measuring point, 251
Create using the menu bar
  Hierarchy, 222
Create using the shortcut menu
  Hierarchy, 222
Creating
  Object templates, 234
  Creating by means of drag-and-drop
    Hierarchy, 221
CSIG.cfg, 240
Cursor, 279
Cut
  Container, 202
  Picture, 201

D
Date, 271
Date format, 52
Defining the area name
  Alarm Logging, 232
Delete
  Container, 207, 226
  Hierarchy, 226
  Picture, 206, 226
Delete by means of drag-and-drop
  Hierarchy, 227
Delete using the menu bar
  Hierarchy, 228
Delete using the shortcut menu
  Hierarchy, 228
Deleting the Hierarchy, 226
Delta Save, 210
Dialog box
  Properties of WinCC Online Trend Control, 306
Digital Value, 315
Disable
  Alarms, 290
Index

Disable user filters, 294
Display
  Alarm Source via Group Display, 311
  Content of the picture stack, 282
  Plant configuration picture, 284
  Reporting job, 289
Distributed systems
  Overview, 12
Documentation
  Content, 11, 193
Download
  Changes, 11
Drag-and-drop, 214
Dynamic integration
  Modify, 239
Dynamic picture elements, 315
Dynamic Wizards, 236

E
Edit
  Measuring point, 253
Editing
  Container name, 200
  Picture, 200
  Visualization of message blocks, 56
Editor
  Audio alarm, 23
  Component List Editor, 24
  OS Project Editor, 23
  Picture Tree Manager, 22
Editors, 20
  Install, 20
  Lifebeat Monitoring, 22
  Time Synchronization, 25
Effects
  Alarm Logging, 232
  Group display, 230
  Hierarchy, 229
  On the text library, 231
  Time reception service, 174
  User Administrator, 230
Empty Button
  Arrange, 69
Enable
  Messages, 290
Entry point picture
  Modify, 253
Exit
  Picture Tree Manager, 200
  Exponential number, 315
Export
  Object templates, 237
Export file
  File format, 245
Extended analog display, 31
Extended Analog Display, 37
Extended status display, 25
Extended Status Display, 37

F
Faulty server
  Configuring in the PCS 7 environment, 15
File format
  Export file, 245
Filter, 294
Filtering
  area-specific, 58
Find
  Measuring point, 252
Floating point, 315
Floating point number, 315
Format Function of the Analog Display, 36
Full screen, 279
Functionality, 233

G
Garbage Collection, 249
Generating
  Component list, 249
Graphic Pictures, 324
  Operating, 315
Graphic positioning, 78
Graphics Designer, 200
Group acknowledgement, 280, 294
Group display, 62, 75, 196, 210, 224, 230, 259, 271, 308, 311
  Hierarchy, 311
Group display hierarchy, 58, 249, 311
Group message, 308
Group value, 25, 31
Grouping
  Trend groups (online), 302
Guide, 259

H
Hardcopy, 271
Hardware
   for time synchronization, 169
   Smart card, 327
Hide
   Area, 69
   Status bar, 213
   Toolbar, 211
Hide messages, 58
Hierarchy, 218
   Change, 224
   Change by means of drag-and-drop, 225
   Change using the menu bar, 226
   Change using the shortcut menu, 225
   Container, 218
   Create, 220
   Create using the menu bar, 222
   Create using the shortcut menu, 222
   Creating by means of drag-and-drop, 221
   Delete, 226
   Delete by means of drag-and-drop, 227
   Delete using the menu bar, 228
   Delete using the shortcut menu, 228
   Effects, 229
   Managing, 193
   Modify, 214
   Node, 218
   Print, 197
   Restraints, 218
   Root node, 220
   Save, 196
   Setup, 198
Hierarchy window, 212
Highest priority messages, 271

I
Icons
   Meaning, 211
Import
   Picture objects, 238
Incoming alarm list, 294
Industrial Ethernet Bus, 156, 159, 162
Information
   Picture Tree Manager, 211
Input Text, 315

Insert
   Container, 215
   Container after container, 204
   Container before container, 205
   Container into container, 205
   New container, 206
   Node, 205
   Picture, 203, 216, 218
   Picture in container, 203
Install
   Editors, 20
   Integer, 315
   Interface
      setting, 331

J
   Journal list, 294

L
Language
   Changeover, 281
   Language change, 193, 231
   Layout, 49
   Layout configuration, 49
   Lifebeat, 283
   Lifebeat Monitoring, 22
   Load
      Trend groups, 301
   Local Area Network, 156, 165
   Log file, 83
   Logging, 83
   Login, 271, 278
      With chip card, 278
      With password, 278
   Long-term archiving, 294
Loop display
   Modify, 73
Loops
   Loop In Alarm, 109, 247, 259, 271
      Configuring, 256
   Loop In Alarm, 294

M
Manage
   Picture memory, 96
Managing
   Hierarchy, 193
   Mapper, 249
   Master/Slave, 153
Index

Meaning
Icons, 211
Measuring point
Edit, 253
Find, 252
Selecting a picture, 318
Menu bar, 195
Menu commands, 195
Menu extensions
Chip card, 335
Message
Acknowledge, 292
Acknowledgment concept, 292
Message block, 292
Operating, 292
Operator prompt, 292
Process, 292
Process control, 292
Process value block, 292
Select, 294
Source, 292
States, 292
Structure, 292
System block, 292
User text block, 292
Message archive, 294
Message behavior, 296
Message block, 292
Message blocks
Editing the layout, 56
Message cause, 294
Message classes, 52
Message configuration, 52, 83
Configuring in the PCS 7 environment, 15
Message filter, 58
Message filters, 61
Message line, 58, 271
Adapting, 62
Contents, 294
Message lists, 291, 294, 297
Operating, 294
Message pages, 58
Sorting, 58
Message priority, 52
Message selection
Acknowledged alarm list, 294
Incoming alarm list, 294
Journal list, 294
Operation list, 294
Outgoing alarm list, 294
Process alarm list, 294
Message system, 291
Message window, 52
Message Window, 294
Migration, 37
Extended Analog Display, 37
Extended Status Display, 37
Modifications, 220
Modify
Dynamic integration, 239
Entry point picture, 253
Hierarchy, 214
Loop display, 73
Monitor configuration, 51
Process window layout, 73
Server assignment, 67
Trend group display, 77
Monitor configuration
Modify, 51
Monitoring, 260, 283, 315
Motor, 259
Move
Node, 224
Multi-VGA, 98
N
Naming conflicts, 217
New measuring point
create, 251
Node, 224
Insert, 205
Move, 224
O
Object templates
Creating, 234
Export, 237
Object Type, 236, 240
Online Help
Call, 210
Use, 211
Online tag, 302
Online trends, 304
Open-loop control, 259
Operating, 260
Graphic Pictures, 315
Operating elements, 259
Operation, 325
Operation list, 294
Operator displays, 308
Operator input message, 291
Operator input messages, 52
Operator process control, 325
Operator prompt of a, 292
Option
  Chip card, 334
OS online delta download, 11
OS project editor
  Configuration file, 83
OS Project Editor, 23, 43, 83
  Configuration file, 86
Outgoing alarm list, 294
Output format, 52
Output text, 315
Overview
  Distributed systems, 12
Overview Area, 271
Overview window, 64
  Adapting, 51
  Configuring, 49
Owner, 249

P
PCS 7 Web Client, 17
Performance range, 260
Picture, 218, 315
  Basic picture, 324
  Composition, 287
  Cut, 201
  Delete, 206, 226, 288
  Edit, 200
  Information, 215
  Insert, 203, 216, 218
  Load all, 288
  Operation, 325
  Paste picture into container, 203
  Save all, 287
  Selecting directly, 324
  Selection by name, 320
  Selection via measurement point, 318
Picture by measurement point, 247
Picture change, 96, 324
Picture change memory, 324
Picture configuration
  Configuring in the PCS 7 environment, 15
Picture element, 315
Picture hierarchy, 96, 274, 322
Picture icons
  Arrange alphabetically, 208
  Arrange Automatically, 209
Picture information, 279
  Replace, 244
Picture management, 95
Picture memory
  Manage, 96
Picture objects
  Export, 236
  Import, 236, 238
  Modify interconnection, 236
  Update, 236, 239
Picture preview
  View, 208
Picture properties
  View, 207, 215
Picture stack, 96
Picture Tree Manager, 22
  Exit, 200
  Functions, 193
  Information, 211
  Start, 214
  Update, 199
Picture Tree Navigator, 271
Pictures, 274
Plant area
  Select, 286
Plant configuration picture
  Display, 284
Plant hierarchy, 193, 322
Plant view, 287
Preview, 64, 208
Preview window, 212
Previous picture, 282
Print
  Group display, 198
  Hierarchy, 197
Print hierarchy
  Project documentation, 197
Print Project Documentation Group Display
  Project documentation, 198
Printing the message sequence log with a client without its own project, 292
Priorities, 25, 31
Process, 274
  Control, 274
  Display, 274
  Monitoring, 259
  Operating, 259, 274
Process alarm, 308
Process alarm messages, 52, 86, 156, 291, 292
Process alarm list, 294
Process control, 315
Process control messages, 52, 86, 156, 291, 292
Index

Process control system options, 11, 20
Process message, 291
Process value block, 292
Process window, 73
Process window layout
  Modify, 73
Project, 260
  Close, 261
  Example, 270
  Select, 261
  Setting, 261
Project documentation
  Print hierarchy, 197
  Print Project Documentation Group Display, 198
  Setting up the hierarchy, 198
  Setup Group Display, 199
Properties of WinCC Online Trend Control, 306

R
Recalculating the group display, 210
Renaming, 223
Replace
  Picture information, 244
Replace pictures
  Confirm, 209
Reporting job
  Display, 289
Reports, 294
Restrictions When Using a Web Client, 17
Rights, 289
Root container, 200
Root node, 220, 224
Route Control Center, 282
Runtime, 259
  Button functions, 265
  Exiting, 280
  Operate chipcard, 337
Runtime response of the horn, 112
Runtime Window, 276

S
Save, 224
  Hierarchy, 196
  Recalculating the group display, 210
  Trend groups, 301
Screen composition, 287
  Call, 288
  Delete, 288
  Memorize, 287
  Screen Dump, 271
Select
  Message, 294
  Picture (select), 324
  Picture by name, 320
  Picture via measurement point, 254, 318
  Plant area, 286
  Select picture via measurement point, 254
  Selection button, 271
  Selection window, 212
Server
  Configuration, 14
  Server assignment, 64
    Modify, 67
  Server buttons, 49, 64
  Server-Server Communication, 18
Setting
  Interface, 331
  Setting up the hierarchy
    Project documentation, 198
Settings
  Time reception service, 172
Setup
  Output of the hierarchy to a printer, 198
  Print Group Display, 199
Setup Group Display, 199
  Project documentation, 199
SFC Visualization, 282
Shared OS data, 18
Show
  Status bar, 213
  Toolbar, 211
Signal, 283
Simultaneous use
  System bus and Local Area Network, 167
Smart Alarm Hiding, 58
Smart card
  Hardware, 327
Softnet, 162
Sorting
  Message pages, 58
  Split message pages, 61
Sprachumschaltung, 281
Standby master, 153, 174
Start
  Picture Tree Manager, 214
  Start screen, 270
State
  Of a, 292
Static picture elements, 315
Index

Status bar
   Hide, 213
   Show, 213
Status display, 315
   Extended, 25
Status text, 315
Sublevel hierarchy, 214
Subsection, 322
Switching
   Language, 281
Synchronization, 153
   Configuring via Local Area Network, 165
   Configuring via system bus/Industrial Ethernet bus, 162
   How to configure with the system bus/CP1613, 159
Synchronization interval, 169
System block, 292
System bus and Local Area Network simultaneous use, 167
System messages, 52, 291
System operator input, 325
System pictures, 212

T
Tab, 83
   Message configuration, 52
   Message display, 58
Tag group, 217
Text Library, 231
Time format, 52
Time of day, 271
Time receiving station, 169, 170
Time reception service, 169
   Effects, 174
   Settings, 172
Time signal receiver for WinCC, 170
Time synchronization, 153, 156
Time Synchronization, 25, 153
Tolerance, 292
Toolbar, 211
   Hide, 211
   Show, 211
Trend group display, 77
   Modify, 77
Trend groups
   Archive tag, 302
   Configuring, 301
   Grouping, 304
   Load, 301
   Loading, 304
   New Trend Group dialog box, 305
   Online configuration, 302
   Save, 301
   Template pictures, 305
Trends, 315

U
Updating
   Picture objects, 239
   Picture Tree Manager, 199
Upgrade
   in Run, 11
Use
   Online Help, 211
User, 292
User administrator, 289
User Administrator, 230
User authentication, 20
User authorization
   Configuring in the PCS 7 environment, 15
User filters, 294
User Interface, 270
User text block, 292
Users, 287

V
Valve, 259
View
   Picture preview, 208
   Picture properties, 207, 215
Visible areas, 64
Visible messages, 61

W
Warning, 292
WinCC
   Time signal receiver, 170
WinCC Chipcard Terminal, 331
WinCC Client, 193
   Configuration, 14
Working Area, 96, 274
write to
    Chipcard, 335